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Introduction

IBM® Planning Analytics for Microsoft Excel is a Microsoft Excel-based tool that professional report
authors use to build sophisticated, multiple-sheet, multiple-query reports against multiple databases.

Audience
This guide assumes that you are familiar with IBM Cognos® products, such as IBM Cognos for Microsoft
Office, and IBM TM1®. You should also be familiar with Microsoft Office applications, such as Microsoft
Excel.

Finding information
To find product documentation on the web, including all translated documentation, access IBM
Knowledge Center (http://www.ibm.com/support/knowledgecenter).

Accessibility features
Accessibility features help users who have a physical disability, such as restricted mobility or limited
vision, to use information technology products. IBM Planning Analytics for Microsoft Excel has
accessibility features. For information on these features, see the accessibility section in this document.
For more information about the accessibility features in IBM Planning Analytics for Microsoft Excel, see
Appendix B, “Accessibility features,” on page 311

IBM Cognos HTML documentation has accessibility features. PDF documents are supplemental and, as
such, include no added accessibility features.

Forward-looking statements
This documentation describes the current functionality of the product. References to items that are not
currently available may be included. No implication of any future availability should be inferred. Any such
references are not a commitment, promise, or legal obligation to deliver any material, code, or
functionality. The development, release, and timing of features or functionality remain at the sole
discretion of IBM.

Samples disclaimer
The Sample Outdoors Company, Great Outdoors Company, GO Sales, any variation of the Sample
Outdoors or Great Outdoors names, GO New Stores, Planning Sample, and SData depict fictitious
business operations with sample data used to develop sample applications for IBM and IBM customers.
These fictitious records include sample data for sales transactions, product distribution, finance, and
human resources. Any resemblance to actual names, addresses, contact numbers, or transaction values
is coincidental. Other sample files may contain fictional data manually or machine generated, factual data
compiled from academic or public sources, or data used with permission of the copyright holder, for use
as sample data to develop sample applications. Product names referenced may be the trademarks of their
respective owners. Unauthorized duplication is prohibited.

© Copyright IBM Corp. 2009, 2021 xi
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Chapter 1. What's new in Planning Analytics for
Microsoft Excel

Read about what's new or updated in IBM Planning Analytics for Microsoft Excel.

2.0.64 - Feature updates, May 10, 2021
IBM Planning Analytics for Microsoft Excel was refreshed on May 10, 2021 to include the following
features and notices.

Updates to each version of Planning Analytics for Microsoft Excel are cumulative. To see what was new in
previous releases, see What's new in Planning Analytics for Microsoft Excel (https://www.ibm.com/
support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_nfg_pax_test.html).

Planning Analytics for Microsoft Excel 2.0.64 compatibility with Cognos
Office Connection

Users that use both Planning Analytics for Microsoft Excel as well as Cognos Office Connection are
affected in their ability to upgrade to the latest release of Planning Analytics for Microsoft Excel.

Planning Analytics for Microsoft Excel 2.0.64 is not compatible with the latest release of Cognos Office
Connection. This is due to conformance updates implemented in Planning Analytics for Microsoft Excel
2.0.63. These updates are fundamental to future feature development and improving the overall product
experience, including the installation and post-installation experience.

Users that use both Planning Analytics for Microsoft Excel as well as Cognos Office Connection are
affected in their ability to upgrade to the latest release of Planning Analytics for Microsoft Excel. Users
who utilize either Cognos Office Connection or Planning Analytics for Microsoft Excel on their own may
continue using the latest releases of each. For those who utilize both Planning Analytics for Microsoft
Excel as well as Cognos Office Connection for their reporting needs may continue using Planning Analytics
for Microsoft Excel 2.0.62 alongside the latest release of Cognos Office Connection.

If you are upgrading from Planning Analytics for Microsoft Excel version 2.0.62 to Planning Analytics for
Microsoft Excel version 2.0.63 or 2.0.64, you must uninstall Planning Analytics for Microsoft Excel version
2.0.62 before upgrading. Failing to uninstall Planning Analytics for Microsoft Excel version 2.0.62 before
upgrading will result in an error message.

In an upcoming release, the Planning Analytics add-in will be converted from an installer-based delivery
to a single file a fraction of the size. This will also enable easier self service in enabling and disabling the
add-in. Following this, a new release of Cognos Office Connection will enable the link with the installer-
less Planning Analytics for Microsoft Excel.

© Copyright IBM Corp. 2009, 2021 1
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View formula in a Custom Report is displayed by default
The view formula in a Custom Report is now displayed by default.

The first row of a Custom Report contains the view's formula. In previous version of Planning Analytics for
Microsoft Excel, the first row of a Custom Report was hidden by default. As of Planning Analytics for
Microsoft Excel 2.0.64, the first row of a Custom Report is displayed by default.

Custom Reports indented based on hierarchy level
Custom Reports are now indented based on the hierarchy level of each row.

In previous versions of Planning Analytics for Microsoft Excel, the rows in a Custom Report were not
indented. As of Planning Analytics for Microsoft Excel 2.0.64, the rows of a Custom Report are indented
based on the hierarchy level of the row.

New API methods for the Task Pane
You can now use new API methods to interact with the Task Pane.

Four new API methods have been added as of Planning Analytics for Microsoft Excel 2.0.64. You can use
the new Task Pane API methods to Show, Hide, Refresh, and return the visibility state of the Task Pane.

To learn more about the new Task Pane API methods, see the following topics:

• Hide (Task Pane)
• IsVisible (Task Pane)
• Refresh (Task Pane)
• Show (Task Pane)

2.0.63 - Feature updates, April 12, 2021
IBM Planning Analytics for Microsoft Excel was refreshed on April 12, 2021 to include the following
features and notices.

Updates to each version of Planning Analytics for Microsoft Excel are cumulative. To see what was new in
previous releases, see What's new in Planning Analytics for Microsoft Excel (https://www.ibm.com/
support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_nfg_pax_test.html).

Note: If you are upgrading from Planning Analytics for Microsoft Excel version 2.0.62 to Planning
Analytics for Microsoft Excel version 2.0.63, you must uninstall Planning Analytics for Microsoft Excel
version 2.0.62 before upgrading.
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New CreateFromCVS API method
You can now use the CreateFromCVS API method to generate a new Exploration View or Quick Report
using a common view specification (CVS).

A common view specification (CVS) is JSON that is composed of two major parts; the MDX query and a
sidecar for additional state information. Data driven mechanisms, such as TurboIntegrator are only
concerned with the MDX query, however user interfaces will also consume the sidecar to ensure
presentation consistency. As of Planning Analytics for Microsoft Excel 2.0.63, you can use the
CreateFromCVS API method to generate a new Exploration View or Quick Report using a CVS.

For more information, see CreateFromCVS (Exploration View) and CreateFromCVS (Quick Report).

To learn more about Common View Specifications, see Common View Specification(https://
www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_pax_cvs.html).

Conformance compatibility update
Planning Analytics for Microsoft Excel 2.0.63 contains conformance updates fundamental to improving
the overall product experience including the installation and post-installation experience.

The 2.0.63 update of Planning Analytics for Microsoft Excel is not compatible with the current release of
Cognos Office Connection. Users that use both Planning Analytics for Microsoft Excel as well as Cognos
Office Connection are affected in their ability to upgrade to the latest release of Planning Analytics for
Microsoft Excel.

Users who utilize either Cognos Office Connection or Planning Analytics for Microsoft Excel on their own
may continue using the latest releases of each. For those who utilize both Planning Analytics for Microsoft
Excel as well as Cognos Office Connection for their reporting needs may continue using Planning Analytics
for Microsoft Excel 2.0.62 alongside the latest release of Cognos Office Connection.

If you are upgrading from Planning Analytics for Microsoft Excel version 2.0.62 to Planning Analytics for
Microsoft Excel version 2.0.63, you must uninstall Planning Analytics for Microsoft Excel version 2.0.62
before upgrading. Failing to uninstall Planning Analytics for Microsoft Excel version 2.0.62 before
upgrading will result in an error message.

In an upcoming release, the Planning Analytics add-in will be converted from an installer-based delivery
to a single file a fraction of the size. This will also enable easier self service in enabling and disabling the
add-in. Following this release shortly, Cognos Office Connection will enable the link between the two
products once again.
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2.0.62 - Feature updates, March 08, 2021
IBM Planning Analytics for Microsoft Excel was refreshed on March 08, 2021 to include the following
features and notices.

Updates to each version of Planning Analytics for Microsoft Excel are cumulative. To see what was new in
previous releases, see What's new in Planning Analytics for Microsoft Excel (https://www.ibm.com/
support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_nfg_pax_test.html).

New Report ribbon group
You can show reports, highlight report areas, and view report properties with the new Report ribbon
group in Planning Analytics for Microsoft Excel.

Planning Analytics for Microsoft Excel now features a new group in the ribbon area, called Report. The
Report ribbon group contains buttons which you can use to quickly show the report of a highlighted cell,
highlight the report area of a highlighted cell, and view the report properties of a highlighted cell.

For more information on this feature, see User interface overview(https://www.ibm.com/support/
knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/c_pax_userinterface.html)

2.0.61 - Feature updates, February 9, 2021
IBM Planning Analytics for Microsoft Excel was refreshed on February 9, 2021 to include fixes only.

Updates to each version of Planning Analytics for Microsoft Excel are cumulative. To see what was new in
previous releases, see What's new in Planning Analytics for Microsoft Excel (https://www.ibm.com/
support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_nfg_pax_test.html).

Timeouts in IBM Planning Analytics for Microsoft Excel
Planning Analytics for Microsoft Excel is now enforcing an inactivity timeout if the user does not interact
with a TM1 Server component for 60 minutes.

There is a new inactivity timeout for Planning Analytics for Microsoft Excel users when configured with
Planning Analytics Workspace on Cloud version 2.0.61 or newer. The new inactivity timeout is designed to
enhance security.

If the user does not interact with any TM1 Server components in Planning Analytics for Microsoft Excel for
60 minutes, they will be disconnected and will be required to log in again. Examples of TM1 Server
components in Planning Analytics for Microsoft Excel include the set editor, the task pane, and sending
and retrieving data in general.

Note: When a user is disconnected due to an inactivity timeout, they do not experience a loss of state.
Upon logging back in, the user does not lose any changes or data due to the timeout.

For more information on the inactivity timeout, see Connection timeouts in Planning Analytics Workspace
on Cloud.
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2.0.60 - Feature updates and known issues, December 17, 2020
IBM Planning Analytics for Microsoft Excel was refreshed on December 17, 2020 to include the following
features and notices.

Updates to each version of Planning Analytics for Microsoft Excel are cumulative. To see what was new in
previous releases, see What's new in Planning Analytics for Microsoft Excel (https://www.ibm.com/
support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_nfg_pax_test.html).

Show and hide your TM1 servers
You can now select specific TM1 servers to hide in Planning Analytics for Microsoft Excel.

In previous versions of Planning Analytics for Microsoft Excel, you were shown a full list of all of the TM1
servers in your TM1 datasources when connecting to a TM1 datasource from the ribbon or from the task
pane. As of Planning Analytics for Microsoft Excel version 2.0.60, you can now select specific TM1 servers
to hide from these menus. For more information on this feature, see Show and hide servers in a TM1
datasource(https://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/
com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/c_pax_hide_tm1_server.html)

Saving or renaming a view in the set editor
When you save or rename a view in the set editor, the title bar in the set editor now updates to display the
name of the view. A view saved from the set editor now also automatically appears in the task pane.

In previous versions of Planning Analytics for Microsoft Excel, the title bar of the set editor did not update
to show the name of the view. As of Planning Analytics for Microsoft Excel version 2.0.60, when you save
or rename a view, the title bar of the set editor shows the updated view name. The task pane now also
shows new views that are saved from the set editor without the need to manually refresh the task pane.

Quick Report sheet names in the task pane
Quick Report sheet names are updated in the Workbook tab of the task pane.

In previous versions of Planning Analytics for Microsoft Excel, the Workbook tab only displayed the sheet
number of a sheet. As of Planning Analytics for Microsoft Excel version 2.0.60, Quick Report sheets in the
Workbook tab now display a sheet name in the following format: Sheet[sheet number] [cube
name]: [report name] [Report ID number].

Planning Analytics for Microsoft Excel: login or server access may fail in new
experience

This issue may occur only when authenticating against a local TM1 database in the Planning Analytics
new experience. You will not encounter this issue when authenticating against a local database in
Planning Analytics classic or any Planning Analytics on Cloud database.

When attempting to log in to a TM1 database from Planning Analytics for Microsoft Excel, you may receive
the following error under certain configurations or conditions: Cannot load the requested view.

To work around this issue, you can dismiss the error and again select the desired TM1 database and
continue to log in with a valid user name.

This issue will be corrected in an upcoming release.

2.0.59 - Feature updates and known issues, November 13, 2020
IBM Planning Analytics for Microsoft Excel was refreshed on November 13, 2020 to include the following
features and notices.

Updates to each version of Planning Analytics for Microsoft Excel are cumulative. To see what was new in
previous releases, see What's new in Planning Analytics for Microsoft Excel (https://www.ibm.com/
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support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_nfg_pax_test.html).

MDX and TM1 Server views are listed together in the source tree
The source tree now presents MDX views and TM1 Server views combined in a single group, sorted
alphabetically.

In previous versions of Planning Analytics for Microsoft Excel, MDX views were listed in one group, while
TM1 Server views were listed a separate group,

Planning Analytics for Microsoft Excel: login or server access may fail in new
experience

This issue may occur only when authenticating against a local TM1 database in the Planning Analytics
new experience. You will not encounter this issue when authenticating against a local database in
Planning Analytics classic or any Planning Analytics on Cloud database.

When attempting to log in to a TM1 database from Planning Analytics for Microsoft Excel, you may receive
the following error under certain configurations or conditions: Cannot load the requested view.

To work around this issue, you can dismiss the error and again select the desired TM1 database and
continue to log in with a valid user name.

This issue will be corrected in an upcoming release.

2.0.58 - Feature updates and known issues, October 20, 2020
IBM Planning Analytics for Microsoft Excel was refreshed on October 20, 2020.

Updates to each version of Planning Analytics for Microsoft Excel are cumulative. To see what was new in
the previous release, see 2.0.57 - Feature updates, September 14, 2020 (https://www.ibm.com/support/
knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_pax_new_features_2_0_57.html).

Updates to the IBM Planning Analytics with Watson ribbon
The IBM Planning Analytics with Watson ribbon has been updated in Planning Analytics for Microsoft
Excel.

As of Planning Analytics for Microsoft Excel version 2.0.58, the IBM Planning Analytics with Watson
ribbon has been updated to improve usability and to maximize space.

Quick Reports
The ribbon group for Quick Reports has been removed, however all functionality is still accessible either
from the Data ribbon group or from the task pane. For more information, see:

• Clearing all data from a Quick Report
• Refresh
• Commit data in a Quick Report

Dynamic Reports
The Dynamic Reports ribbon group has now been renamed to Dynamic. All functionality remains the
same.
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Planning Analytics for Microsoft Excel: login or server access may fail in new
experience

This issue may occur only when authenticating against a local TM1 database in the Planning Analytics
new experience. You will not encounter this issue when authenticating against a local database in
Planning Analytics classic or any Planning Analytics on Cloud database.

When attempting to log in to a TM1 database from Planning Analytics for Microsoft Excel, you may receive
the following error under certain configurations or conditions: Cannot load the requested view.

To work around this issue, you can dismiss the error and again select the desired TM1 database and
continue to log in with a valid user name.

This issue will be corrected in an upcoming release.

2.0.57 - Feature updates, September 14, 2020
IBM Planning Analytics for Microsoft Excel was refreshed on September 14, 2020 to include fixes only.

Updates to each version of Planning Analytics for Microsoft Excel are cumulative. To see what was new in
the previous release, see 2.0.56 - Feature updates, August 12, 2020 (https://www.ibm.com/support/
knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_pax_new_features_2_0_56.html).

2.0.56 - Feature updates, August 12, 2020
IBM Planning Analytics for Microsoft Excel was refreshed on August 12, 2020 to include the following
features and notices.

Updates to each version of Planning Analytics for Microsoft Excel are cumulative. To see what was new in
the previous release, see 2.0.55 - Feature updates, July 16, 2020 (https://www.ibm.com/support/
knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_pax_new_features_2_0_55.html).

Cube Viewer
Starting in IBM Planning Analytics for Microsoft Excel version 2.0.56, you can change the font size and
save views in the Cube Viewer.

Changing the font size
If you're working with large dimensions or sets, you can change the font size of the Cube Viewer to display
more data.

For more information about changing the font size in the Cube Viewer, see Change the font size(https://
www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_pax_cube_viewer_zoom.html).

Save views as part of the cube
After you are finished working in the Cube Viewer, you can save your views as part of the cube. To use this
feature, ensure that you also have IBM Planning Analytics Workspace version 2.0.56 or later installed.

For more information about saving views from the Cube Viewer, see Save a view from the Cube
Viewer(https://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/
com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/t_pax_save_cube_viewer.html).
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Changing hierarchies
If your dimension contains multiple hierarchies, you can use the set editor or Cube Viewer to change the
hierarchy that's being used in your report.

For more information about changing the hierarchy of a report, see Change the hierarchy(https://
www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_pax_change_hierarchy.html).

2.0.55 - Feature updates, July 16, 2020
IBM Planning Analytics for Microsoft Excel was refreshed on July 16, 2020 to include the following
features and notices.

Updates to each version of Planning Analytics for Microsoft Excel are cumulative. To see what was new in
the previous release, see 2.0.54 - Feature updates, June 12, 2020 (https://www.ibm.com/support/
knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_pax_new_features_2_0_54.html).

Converting reports
As of 2.0.55, if you are converting reports in IBM Planning Analytics for Microsoft Excel, you can define
whether or not the converted report uses Microsoft Excel's stylesheet formatting.

You can decide whether or not your converted reports use stylesheet formatting. When you convert a
report directly from an Exploration View, the converted report uses stylesheet formatting if you have Use
Excel Formats enabled. If you are creating or converting a report from the source tree, the cube viewer, or
another path, the converted report defaults to using stylesheet formatting.

For more information about converting reports, see Converting a report from an Exploration View(https://
www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_pax_convert_reports.html).

2.0.54 - Feature updates, June 12, 2020
IBM Planning Analytics for Microsoft Excel was refreshed on June 12, 2020 to include fixes only.

Updates to each version of Planning Analytics for Microsoft Excel are cumulative. To see what was new in
the previous release, see 2.0.53 - Feature updates, May 15, 2020 (https://www.ibm.com/support/
knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_pax_new_features_2_0_53.html).

2.0.53 - Feature updates, May 15, 2020
IBM Planning Analytics for Microsoft Excel was refreshed on May 15, 2020 to include fixes only.

Updates to each version of Planning Analytics for Microsoft Excel are cumulative. To see what was new in
the previous release, see 2.0.52 - Feature updates, April 16, 2020 (https://www.ibm.com/support/
knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_pax_new_features_2_0_52.html).

2.0.52 - Feature updates, April 16, 2020
IBM Planning Analytics for Microsoft Excel was refreshed on April 16, 2020 to include the following
features and notices.

Updates to each version of Planning Analytics for Microsoft Excel are cumulative. To see what was new in
the previous release, see “2.0.51 - Feature updates, March 06, 2020” on page 10 (https://
www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_pax_new_features_2_0_51.html).
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All connections are switching to IBM Planning Analytics Workspace
As of 2.0.52, if you are using TM1 Server 2.0.9 or newer and have any connections through PMHub in IBM
Planning Analytics for Microsoft Excel, your connections will be switched to solely go through Planning
Analytics Workspace.

All new connections in Planning Analytics for Microsoft Excel currently go through Planning Analytics
Workspace. Existing PMHub connections will be switched to Planning Analytics Workspace connections if
you are using Planning Analytics for Microsoft Excel 2.0.52 or newer with TM1 Server 2.0.9 or newer.

Improvements to the set editor
As of 2.0.52, the set editor has a number of improvements to make it easier to work with large
dimensions.

To use the updated set editor, ensure that you have IBM Planning Analytics Workspace version 2.0.52 or
later installed. Refer to the Planning Analytics for Microsoft Excel conformance requirements.

Note: If you are using IBM Planning Analytics for Microsoft Excel versions 2.0.51 and older with Planning
Analytics Workspace versions 2.0.52 and newer, you will see all of the new set editor features, however
any changes made in the default view settings for the Available Members and Current Set panes will not
be saved.

Focus on one area at a time
You can hide the pane that you are not currently working in to enable you to focus on one area at a time.

Maximize the set editor

Quickly maximize the set editor by clicking the Max icon .

Note: If you added the set editor from the tree, you can resize the set editor by dragging the grab handles.

Drag and drop
Drag members into the Current Set from Available Members. Dragging uses the default insert settings

. If there are a lot of members in the Current Set, you can scroll down the pane while dragging the
selection into the correct position.

Easy access to functions
The new toolbar makes it easy to edit the members in the current set, with the most frequently used
functions available.

Configure default view settings for the Available Members and Current Set panes
For the Available Members pane, you can choose to display Default set, All roots, All members, or All
leaves by default. For the Current Set pane, you can choose whether to display the members as a
Hierarchy, or as a Definition (MDX).
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Click  to access the Settings menu.

For more information about the set editor, see Sets(https://www.ibm.com/support/knowledgecenter/
SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/c_paw_set.html).

Version requirements for using IBM Planning Analytics for Microsoft Excel
2.0.52 with TM1 Server.

Improvements in IBM Planning Analytics for Microsoft Excel 2.0.52 are tested on the current supported
TM1 Server versions (For more information on supported TM1 Server versions, see IBM Planning Analytics
for Microsoft Excel conformance requirements. Please note that some functionality will not work as
expected in TM1 Server versions 2.0.5 and older.

2.0.51 - Feature updates, March 06, 2020
IBM Planning Analytics for Microsoft Excel was refreshed on March 06, 2020 to include the following
features and notices.

Updates to each version of Planning Analytics for Microsoft Excel are cumulative. To see what was new in
the previous release, see “2.0.50 - Feature updates, February 7, 2020” on page 11 (https://
www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_pax_new_features_2_0_50.html).

Update the datasource or package for Exploration Views in bulk
As of version 2.0.51, you can now bulk update the datasource or package for multiple Exploration Views
at the same time.

To bulk update the datasource or package for your Exploration Views, you need to use the
BulkSerializeUtil command. For more information, see Bulk update the datasource or package for
Exploration Views(https://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/
com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/t_pax_exploration_bulk_update_server.html)
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2.0.50 - Feature updates, February 7, 2020
IBM Planning Analytics for Microsoft Excel was refreshed on February 7, 2020 to include the following
features and notices.

Updates to each version of Planning Analytics for Microsoft Excel are cumulative. To see what was new in
the previous release, see “2.0.49 - Feature updates, December 19, 2019” on page 11 (https://
www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_pax_new_features_2_0_49.html).

Improvements to Design Mode
As of 2.0.50, use Design Mode to preserve or clear DBRW formulas when you are copying and pasting
values into cells.

Design Mode is a handy tool that can be used to enable or disable the refreshing of an Exploration View
upon every change. You can now also use Design Mode to preserve or clear DBRW formulas when you are
copying and pasting values into cells. Simply enable or disable Design Mode from the Data group in the
IBM Planning Analytics ribbon.

For more information about Design Mode, see Design Mode(https://www.ibm.com/support/
knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/c_pax_design_mode.html).

2.0.49 - Feature updates, December 19, 2019
IBM Planning Analytics for Microsoft Excel was refreshed on December 19, 2019 to include the following
features and notices.

Updates to each version of Planning Analytics for Microsoft Excel are cumulative. To see what was new in
the previous release, see “2.0.48 - Feature updates, November 20, 2019” on page 12 (https://
www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_pax_new_features_2_0_48.html).

Quickly access views from the IBM task pane
As of 2.0.49, you can open views from the IBM task pane.

You can now quickly access views from the IBM task pane by double-clicking a cube or Views node. You
can also open a view by right-clicking a cube or Views node and selecting Open in viewer from the right-
click menu.

Additionally, when you right-click a cube or Views node on the task pane, you can choose to run as one of
the available report types.
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For more information about the IBM task pane and how you can open views from the task pane, see IBM
task pane(https://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/
com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/c_pax_taskpane.html).

2.0.48 - Feature updates, November 20, 2019
IBM Planning Analytics for Microsoft Excel was refreshed on November 20, 2019 to include the following
features and notices.

Updates to each version of Planning Analytics for Microsoft Excel are cumulative. To see what was new in
the previous release, see 2.0.47 - Feature updates, October 15, 2019 (https://www.ibm.com/support/
knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_pax_new_features_2_0_47.html).

Show the information header in a Quick Report
Starting in 2.0.48, you can show or hide header information in a Quick Report. The header information
includes the host URL, server name, and the cube name for the Quick Report.

For more information about the information header, see Show the information header in a Quick
Report(https://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/
com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/t_pax_qr_header_informtion.html).

For more information on enabling the information header, see Manually enabling features in the
tm1features.json file(https://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/
com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/r_pax_tm1features.html).

Dimension names are automatically displayed in a Quick Report
When you create or open a Quick Report, the names of the dimensions used in the Quick Report are
automatically displayed at the top of the report.

For more information about Quick Reports, see Quick Reports(https://www.ibm.com/support/
knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/c_ug_cxr_powersheets.html).

Deprecation notice for the Reorder/Rename feature in Exploration Views
and lists

In IBM Planning Analytics for Microsoft Excel version 2.0.49, the Reorder/Rename feature in Exploration
Views and lists will be deprecated.

The Reorder/Rename feature:
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• You can use the set editor to reorder your members. For more information, see Reorder members in a
set(https://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/
com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/t_set_editor_reorder_members.html).

• You can still use aliases to rename a member.
• To rename a calculated column or row, edit the column or row header. For more information, see

Rename a calculated column or row(https://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/
com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/t_pax_exploration_rename_calculation.html).

2.0.47 - Feature updates, October 15, 2019
IBM Planning Analytics for Microsoft Excel was refreshed on October 15, 2019 to include fixes only.

Updates to each version of Planning Analytics for Microsoft Excel are cumulative. To see what was new in
the previous release, see 2.0.46 - Feature updates, September 13, 2019 (https://www.ibm.com/support/
knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_pax_new_features_2_0_46.html).

2.0.46 - Feature updates, September 13, 2019
IBM Planning Analytics for Microsoft Excel was refreshed on September 13, 2019 to include fixes only.

Updates to each version of Planning Analytics for Microsoft Excel are cumulative. To see what was new in
the previous release, see 2.0.45 - Feature updates, August 16, 2019 (https://www.ibm.com/support/
knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_pax_new_features_2_0_45.html).

2.0.45 - Feature updates, August 16, 2019
IBM Planning Analytics for Microsoft Excel was refreshed on August 16, 2019 to include fixes only.

Updates to each version of Planning Analytics for Microsoft Excel are cumulative. To see what was new in
the previous release, see 2.0.44 - Feature updates, July 30, 2019 (https://www.ibm.com/support/
knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_pax_new_features_2_0_44.html).

2.0.44 - Feature updates, July 30, 2019
IBM Planning Analytics for Microsoft Excel was refreshed on July 30, 2019 to include the following
features.

Updates to each version of Planning Analytics for Microsoft Excel are cumulative. To see what was new in
the previous release, see 2.0.43 - Feature updates, June 19, 2019 (https://www.ibm.com/support/
knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_pax_new_features_2_0_43.html).
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Save your Exploration Views to the Planning Analytics Workspace Content
Store!

As of 2.0.44, you can save your Exploration Views to the Planning Analytics Workspace Content Store.
Save your Exploration View to the Planning Analytics Workspace Content Store

Saving your Exploration Views to the Planning Analytics Workspace Content Store allows you to save
enhanced views, and share your views between IBM Planning Analytics Workspace and IBM Planning
Analytics for Microsoft Excel.

Share views between Planning Analytics Workspace and Planning Analytics for Microsoft Excel
Saving your Exploration View to the Planning Analytics Workspace Content Store allows you to share
your views toPlanning Analytics Workspace and Planning Analytics for Microsoft Excel. Simply access
the Planning Analytics Workspace from either product and open the view for quick and flexible
collaboration.

The versatility of MDX Views
MDX expressions can be a powerful tool for storing and generating views. When you save your
Exploration View to the Planning Analytics Workspace Content Store, the view is stored as an MDX
expression. Just like in an MDX View, you can store calculations or headers, and define asymmetric
axes when you save your Exploration Views to the Planning Analytics Workspace Content Store.

Compatibility
Planning Analytics for Microsoft Excel version 2.0.44 used with Planning Analytics Workspace version
2.0.44 will receive full support for saving to the Planning Analytics Workspace Content Store.
You also need IBM Planning Analytics version 2.0.7 IF 3 or newer installed. It is recommended that
you install IBM Planning Analytics version 2.0.8 or newer.

For more information about saving your Exploration Views to the Planning Analytics Workspace Content
Store, see Methods for saving an Exploration View(https://www.ibm.com/support/knowledgecenter/
SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/c_pax_exploration_save.html).

Enhanced clear functionality for Exploration Views
The clear functionality when applied to an Exploration View has been improved as of 2.0.44.

Using Clear workbook, Clear worksheet, or Clear data on an Exploration View or list view will now also
clear any items in the context area drop zone.

For more information about clearing Exploration Views, see Clearing all data from an Exploration View or
list view(https://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/
com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/t_pax_clear_data_exploration.html).

MDX button disabled after clearing an Exploration View or list view
As of 2.0.44, the MDX button will be temporarily disabled after a user clears an Exploration View or list
view.

When you clear data in an Exploration View or list view, the cleared cells remain as blank cells on the
report. Clearing the content does not break the link to the datasource. As of version 2.0.44, when you
clear data in an Exploration View or list view, the button to open the MDX editor is temporarily disabled.
This feature prevents other users from viewing the worksheet's MDX expression, which may contain
information about the datasource.

The button to open the MDX editor is enabled again if the Exploration View or list view is refreshed by the
user that initially cleared the data. When the view is refreshed, the context dimensions will query for the
first available member for each subset and update the selections and the MDX expression is updated.

For more information about clearing Exploration Views, see Clearing all data from an Exploration View or
list view(https://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/
com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/t_pax_clear_data_exploration.html).
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Actions to prompt a Constrained Calculation
As of 2.0.44, you can use a number of actions to prompt a Constrained Calculation in IBM Planning
Analytics for Microsoft Excel.

Constrained Calculations can be used in Planning Analytics for Microsoft Excel to limit recalculations
strictly to a specified worksheet. Because Planning Analytics for Microsoft Excel is only recalculating the
single worksheet, you may notice improved performance when refreshing a single worksheet. The 2.0.44
release of Planning Analytics for Microsoft Excel has enabled new actions that will prompt a recalculation
when Constrained Calculations are enabled.

To learn more about the actions you can use to prompt a recalculation, see Actions that prompt a
Constrained Calculation(https://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/
com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/r_pax_constrainedcalculationgestures.html).

To learn more about Constrained Calculations, see Constrained Calculations(https://www.ibm.com/
support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_pax_constrainedcalculations.html).

2.0.43 - Feature updates, June 19, 2019
IBM Planning Analytics for Microsoft Excel was refreshed on June 19, 2019 to include the following
features.

Updates to each version of Planning Analytics for Microsoft Excel are cumulative. To see what was new in
the previous release, see 2.0.42 - Feature updates, May 13, 2019 (https://www.ibm.com/support/
knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_pax_new_features_2_0_42.html).

Support for Microsoft Excel 2019
Starting in version 2.0.43, IBM Planning Analytics for Microsoft Excel will now be compatible with
Microsoft Excel 2019.

You can now use Planning Analytics for Microsoft Excel with Microsoft Excel 2019. For more information
on supported software environment, see the IBM Software Product Compatibility Reports (https://
www.ibm.com/software/reports/compatibility/clarity/index.html).

2.0.42 - Feature updates, May 13, 2019
IBM Planning Analytics for Microsoft Excel was refreshed on May 13, 2019 to include the following
features.

Updates to each version of Planning Analytics for Microsoft Excel are cumulative. To see what was new in
the previous release, see 2.0.41 - Feature updates, April 12, 2019 (https://www.ibm.com/support/
knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_pax_new_features_2_0_41.html).

Quickly access the set editor from the IBM task pane
As of 2.0.42, you can open the set editor from the IBM task pane.

You can now quickly access the set editor from the IBM task pane by double-clicking a dimension or
named set, or by right-clicking a dimension or named set and opening the set editor from the right-click
menu.

For more information about the IBM task pane and how you can open the set editor from the IBM task
pane, see IBM task pane(https://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/
com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/c_pax_taskpane.html).
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Set data refresh options for your views
As of 2.0.42, you can set a data refresh option for your views from the cube viewer.

Using the Cube Viewer, you can define how data refreshes are triggered in your view.

For more information about how you can set data refresh options for your views, see Set data refresh
options for a view(https://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/
com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/t_pax_cubeviewer_autorecalc.html).

Use Planning Analytics for Microsoft Excel without Performance Manager
Hub

Planning Analytics for Microsoft Excel no longer requires IBM Cognos Performance Management Hub
(PMHub) to access the TM1 Server or TM1 Admin Server.

For more information about how you can use Planning Analytics for Microsoft Excel without Performance
Manager Hub, see Using Planning Analytics for Microsoft Excel without Performance Manager Hub
(https://www-01.ibm.com/support/docview.wss?uid=ibm10883120).

2.0.41 - Feature updates, April 12, 2019
IBM Planning Analytics for Microsoft Excel was refreshed on April 12, 2019 to include the following
features.Updates to each version of Planning Analytics for Microsoft Excel are cumulative. To see what
was new in the previous release, see 2.0.40 - Feature updates, February 22, 2019 (https://www.ibm.com/
support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_pax_new_features_2_0_40.html).

Speed up your worksheet refreshes with Constrained Calculations
As of 2.0.41, you can improve the performance and speed of your single worksheet refreshes using
Constrained Calculations.

When you refresh your worksheet, IBM Planning Analytics for Microsoft Excel will recalculate every
worksheet in your workbook. Using Constrained Calculations is an easy way to narrow the scope of the
recalculates to just your active worksheet.

For more information about Constrained Calculations, see Constrained Calculations(https://
www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_pax_constrainedcalculations.html).

2.0.40 - Feature updates, February 22, 2019
IBM Planning Analytics for Microsoft Excel was refreshed on February 22, 2019 to include fixes.Updates
to each version of Planning Analytics for Microsoft Excel are cumulative. To see what was new in the
previous release, see 2.0.39 - Feature updates, December 21, 2018 (https://www.ibm.com/support/
knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_pax_new_features_2_0_39.html).

2.0.39 - Feature updates, December 21, 2018
IBM Planning Analytics for Microsoft Excel was refreshed on December 21, 2018 to include fixes.Updates
to each version of Planning Analytics for Microsoft Excel are cumulative. To see what was new in the
previous release, see 2.0.38 - Feature updates, November 27th, 2018 (https://www.ibm.com/support/
knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_pax_new_features_2_0_38.html).
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New API function for Quick Reports
As of 2.0.39, you can use the ReplaceWithFormats function to replace the MDX statement in a Quick
Report with another MDX statement. ReplaceWithFormats also has an option to preserve or destroy
the existing sheet formatting in the Quick Report.

To find out more, see ReplaceWithFormats (https://ibm.github.io/paxapi/#replacewithformats).

2.0.38 - Feature updates, November 27, 2018
IBM Planning Analytics for Microsoft Excel was refreshed on November 27, 2018 to include fixes.Updates
to each version of Planning Analytics for Microsoft Excel are cumulative.
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Chapter 2. Getting started
This topic will help you get started using IBM Planning Analytics for Microsoft Excel and get you oriented
as you navigate through the user interface.

Planning Analytics for Microsoft Excel provides an interactive drag-and-drop environment for you to
explore and analyze data, helping you find answers to your important business questions.

You can also use Planning Analytics for Microsoft Excel to achieve the following goals:

• Find and focus on items that are important to your business.
• Understand trends and anomalies.
• Compare data, such as details to summaries, or actual results to budgeted results.
• Assess performance by focusing on the best or worst results.
• Share your findings with others.
• Multi-dimensional analysis and exploration of large data sources within a familiar Excel environment.

Before you begin
Before you use IBM Planning Analytics for Microsoft Excel, ensure that you accomplish the following
tasks.

Configure your anti-virus software
To run Planning Analytics for Microsoft Excel, you must first configure your anti-virus software to allow
connections from both Microsoft .NET Runtime and Microsoft Excel.

For more information, see Configure your anti-virus software in the Planning Analytics Local Installation
and Configuration documentation.

Set up connections for TM1 Rest APIs
Planning Analytics for Microsoft Excel uses TM1 REST APIs from the IBM TM1 Server. An administrator
needs to configure the HTTP port number in the IBM TM1 Server configuration files for each TM1 Server.

For more information, see Setting up connections for TM1 REST APIs in the Planning Analytics Local
Installation and Configuration documentation.

Internet browser requirements
Planning Analytics for Microsoft Excel requires Internet Explorer 11.

Upgrade existing workbooks
You need to update the original TM1 server connections to the Planning Analytics Workspace URI if you
have workbooks from earlier versions of Planning Analytics for Microsoft Excel. Update your connections
by editing the connections in the Options screen.

For more information, see “Update Connection URLs” on page 45.

Use the Update connection utility to update Exploration View and Quick Report connections.

For more information, see “Utilities” on page 47.
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Disable automatic hyperlinking
Microsoft Excel by default enables Internet and network paths with hyperlinks, an AutoCorrect setting
which automatically turns text that represents Internet and network paths into hyperlinks. This setting
may interfere with TM1RPTROW functions. Follow these steps to disable this setting:

1. Open Microsoft Excel.
2. Click File > Options > Proofing.
3. Click AutoCorrect Options....
4. Click the AutoFormat As You Type tab.
5. Uncheck Internet and network paths with hyperlinks under Replace as you type.

Note: For TM1RPTROW functions that were already converted into hyperlinks, remove the link and
republish the report to remove the hyperlink from published reports:

1. Right-click the TM1RPTROW function that contains the hyperlink.
2. Click Edit hyperlink.
3. Click Remove link.

Optimize for high DPI displays
For user interface elements to render properly on high DPI displays, you need to optimize Microsoft
Office. You can optimize Microsoft Office by ensuring that the display setting in Microsoft Office is set to
Optimize for compatibility.

If you do not see the Optimize for compatibility display setting, downgrade your version of Microsoft
Office to version 1803.

For instructions and more on changing your display settings in Microsoft Office, see Office support for high
definition displays (https://support.office.com/en-us/article/office-support-for-high-definition-
displays-6720ca0e-be59-41f6-b629-1369f549279d?ui=en-US&rs=en-US&ad=US).

Getting oriented
When you start Microsoft Excel, the IBM Planning Analytics tab opens in the ribbon. The IBM Planning
Analytics tab is your starting point for working with IBM TM1 data in Microsoft Excel. When you log on to
an IBM TM1 system and create reports, you see other user interface features for working with IBM TM1
data.

The IBM Planning Analytics for Microsoft Excel user interface includes the IBM Planning Analytics tab,
the IBM task pane, which contains a source tree and several commands.

This video demonstrates how to set up connections to servers
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User interface overview
This topic shows you a few of the major areas of the IBM Planning Analytics for Microsoft Excel user
interface

Figure 1. Planning Analytics for Microsoft Excel user interface

The following legend describes the areas that are referenced in the previous image:

1. IBM Planning Analytics ribbon

The IBM Planning Analytics ribbon contains ribbon groups, which you can use to explore your data in
Planning Analytics for Microsoft Excel.

• Getting Started

The Getting Started group contains buttons, which you can use to connect to your datasource, view
your data in a tree, set options, and find additional help.

– Connect: The Connect button allows you to add or select a datasource. For more information, see
Chapter 4, “Connecting to datasources,” on page 37.

– Task Pane: The Task Pane button allows you to access the source tree, controls for opening
datasources, and active workbooks. For more information, see “IBM task pane” on page 24.

– Options: The Options button allows you to see the options that you can set in Planning Analytics for
Microsoft Excel. For more information, see “IBM Planning Analytics settings” on page 48.

– Help: The Help button allows you to find additional help content related to Planning Analytics for
Microsoft Excel.

• Content

The Content group contains buttons, which you can use to open and publish your workbooks.

– Open: The Open button allows you to find and open a workbook. For more information, see “Opening
workbooks from the TM1 Server Application folder” on page 41.

– Publish: The Publish button allows you to publish your workbooks. For more information, see “Share
your analysis” on page 94.
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• Add

The Add group contains buttons, which you can use to add Explorations, Lists, or Action Buttons to your
worksheet.

– Exploration: The Exploration button allows you to add an Exploration View to your worksheet. For
more information, see “Create an Exploration View from scratch” on page 102.

– List: The List button allows you to add a List View to your worksheet. For more information, see
“Create a list” on page 101.

– Action Button: The Action Button button allows you to add an Action Button to your worksheet. For
more information, see Chapter 10, “Action buttons,” on page 245.

• Data

The Data group contains buttons, which you can use to explore, refresh, or modify your workbook.

– Refresh: The Refresh button allows you to refresh your worksheet. For more information, see
“Refresh data” on page 93.

– Commit: The Commit button allows you to commit changes in your Exploration View or Quick Report
to the TM1 Server.

For more information about committing changes in a Quick Report, see “Commit data in a Quick
Report” on page 124.

For more information about committing changes in an Exploration View, see “Commit data in a TM1
Exploration View ” on page 113.

– Discard: The Discard button allows you to reset the values in a sandbox that you have changed, but
not committed. For more information, see “Virtual sandbox dimensions” on page 150

– Design Mode: The Design Mode button allows you to enable or disable the automatic refreshing of an
Exploration. For more information, see “Design Mode” on page 87.

– Clear: The Clear button allows you to clear data from your workbook or worksheet. For more
information, see “Clearing data” on page 73.

– Snapshot: The Snapshot button allows you to convert reports in a workbook into a snapshot. For
more information, see “Convert dynamic data to snapshots (static data)” on page 77.

– Drill Through: The Drill Through button allows you to perform a drill through on your data. Drilling
through on a cell provides detailed data on the cell, and shows you information from the data source.
You can drill through on cells in Exploration Views, Custom Reports, Quick Reports, and Dynamic
Reports. For more information, see “Drill through to detailed data” on page 198

• Report

The Report group contains buttons, which allows you to show or highlight your reports, and set report
properties.

– Show Report: The Show Report button opens the workbook tab in the Task Pane and selects the
report that contains the highlighted cell. If the highlighted cell is not within a report, the Show Report
button shows all of the reports in the current worksheet in the Task Pane.

– Properties: The Properties button can be used with Exploration Views and Quick Reports. The
Properties button shows the properties of the report that contains the highlighted cell. If the
highlighted cell is not contained within a report, the Properties button shows all of the reports in the
current worksheet in the Task Pane.

– Highlight Report: The Highlight Report button highlights the report area of the highlighted cell, if the
cell is contained within a report. The Highlight Report button can be used with Quick Reports. If the
highlighted cell is not contained within a report, the Highlight Report button shows all of the reports
in the current worksheet in the Task Pane.

• Exploration

The Exploration group contains buttons, which you can use to work with your Exploration View or list.
For more information on the Exploration group, see “Exploration Views and lists” on page 99.
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• Dynamic

The Dynamic group contains buttons, which you can use to work with your Dynamic Report. For more
information on the Dynamic group, see “The Dynamic ribbon group” on page 125.

• Sandbox

The Sandbox group contains buttons, which you can use to work with your sandboxes.

– New: The New button allows you to create a new sandbox.
– Delete: The Delete button allows you to delete the current sandbox.
– Rename: The Rename button allows you to rename the current sandbox.
– Clone: The Clone button allows you to clone the current sandbox.
– Merge: The Merge button allows you to commit changes from your sandbox to the case. For more

information, see “Virtual sandbox dimensions” on page 150.

2. Overview area

The overview area is displayed when you are viewing an Exploration View or a list. Use the overview area
as a convenient place to quickly explore and change the contents of the Exploration View or list.

For Exploration Views, the overview area displays the Rows, Columns, and Context areas. You populate
the Exploration View with data by adding items from the data source to these areas. For example, you can
place a Department dimension in the rows and a Source dimension in the columns. The items that you
place in the context area are used to filter the values. For example, you can filter the Exploration View to
display data for a specific year by selecting a year in the Time dimension. Each box in the rows, columns,
and context area represents a set of data in the data source.

3. IBM task pane

The IBM® task pane is a component in Planning Analytics for Microsoft Excel that provides you access to
the source tree, controls for opening datasources, and active workbooks.

4. Source tree

The source tree in the task pane displays the cube and related items of the data source, such as views.

5. Work area

The work area is Microsoft Excel worksheet where you create and view reports.

When you create a new Exploration View or list, the work area displays a visual guide to help you build the
report. Drop zones show you where you can drag items from the source tree to create the report. You can
change, limit, or expand the items that you see in an Exploration View by using techniques such as
filtering and drilling, to quickly focus on the most significant items on your worksheet.

If you want to use a more flexible report layout, rather than visual guides, you can create other types of
reports such as Quick Reports, Dynamic Reports, and Custom Reports.

IBM Planning Analytics tab
The IBM Planning Analytics tab in the ribbon displays commands for starting IBM Planning Analytics for
Microsoft Excel, logging on to IBM TM1 systems, setting options, opening reports that are published to an
IBM TM1 Server Application folder, and other tasks.

Start Planning Analytics for Microsoft Excel by creating a new workbook in Microsoft Excel and opening
the IBM Planning Analytics tab.
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Find the version information for IBM Planning Analytics for Microsoft Excel
You can find the version information for Planning Analytics for Microsoft Excel in the IBM Planning
Analytics ribbon.

Procedure
1. Click the IBM Planning Analytics tab to open the IBM Planning Analytics ribbon.
2. Click the Help drop down, located in the Getting Started group.
3. Click About.
4. Click Show Version... to open the version text file.
5. The CORCSP_version line contains the version number for your installation of Planning Analytics for

Microsoft Excel.

Example
If the value of CORCSP_version is COR-AW64-ML-RTM-2.0.47.4-0, the version number is 47.4.

IBM task pane
The IBM task pane is a component in Planning Analytics for Microsoft Excel that provides you access to
the source tree, controls for opening datasources, and active workbooks.

The IBM task pane consists of two tabs:

• The first tab contains the source tree and controls for opening data sources.
• The Workbook tab contains the components of the active workbook. For example, any Exploration

Views, Quick Reports or Dynamic Reports that the workbook contains are listed.

The IBM task pane opens when you start IBM Planning Analytics for Microsoft Excel. You can move and
resize the pane.

The source tree displays the data sources that you selected.

• For TM1 data sources, the tree displays the cube, with its associated dimensions, members, and levels.
The source tree also displays saved views and TurboIntegrator processes.

• For IBM Cognos Analytics packages based on dimensionally modeled relational (DMR) and OLAP data
sources, the source tree displays a dimensional view of your data. The tree is organized into dimensions,
hierarchies, levels, and measures.

• For IBM Cognos Analytics packages based on relational data sources, the source tree displays query
subjects, which are organized into lists of data items.

You can add objects to a report by dragging them from the source tree to a worksheet.

Tip: Ensure that all of the dimensions that you use in a report are from the same cube that was used to
create the report. Using dimensions from outside of this cube can cause object reference errors.

Trouble: If the IBM Planning Analytics tab is not displayed on the ribbon, see “The Cognos Office
interface fails to initialize in Microsoft Office ” on page 292.

Open the set editor from the IBM task pane
There are several ways that you can open the set editor from the IBM task pane.

To open the set editor from the task pane:
Double-click the dimension name

You can double-click on a dimension name in the IBM task pane to open the default set in the set
editor.

Double-click a named set
You can double-click on a named set in the IBM task pane to open the named set in the set editor.
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Right-click a dimension name
You can right-click a dimension name, then click Edit set to open the default set in the set editor.

Right-click the set name
You can right-click a named set, then click Edit set to open the named set in the set editor.

Launch the viewer from the IBM task pane
There are several ways that you can launch the viewer from the IBM task pane.

To open the viewer from the task pane:
Double-click the cube name

You can double-click on a cube name in the IBM task pane to open the default view in the viewer. A
new view opens if a default view does not exist.

Double-click a Views node
You can double-click on a Views node in the IBM task pane to open the default public view in the
viewer. A new view opens if a default view does not exist.

Double-click a private Views node
You can double-click on a private Views node in the IBM task pane to open the default private view in
the viewer. A new view opens if a default view does not exist.

Right-click the cube name, a Views node, or a Private Views node
You can right-click a cube name, a Views node, or a Private Views node, then click Open in viewer to
open the default view in the viewer. A new view opens if a default view does not exist. You can also
select one of the available report types to open it as a report.

Filter items in the IBM task pane
You can choose to filter control objects, processes, or dimensions in the IBM task pane.

About this task

Use the Show and hide  icon in the task pane to select the type of items that you want to filter in the
tree view. You can add or remove filters for control objects, processes, or dimensions.

Note: Processes or dimensions with names beginning with the } character are treated as a control object.
If your process or dimension name begins with the } character, it will be filtered by the Show control
objects option.

Procedure
1. Open the task pane.

2. Click the Show and hide  icon.
3. Select the type of item that you want to filter.

• Show control objects adds or removes a filter for control objects in the tree view.
• Show processes adds or removes a filter for processes in the tree view.
• Show dimensions adds or removes a filter for dimensions in the tree view.

Overview area
The overview area is displayed when you are viewing an Exploration View or a list. Use the overview area
as a convenient place to quickly explore and change the contents of the Exploration View or list.

For Exploration Views, the overview area displays the Rows, Columns, and Context areas. You populate
the Exploration View with data by adding items from the data source to these areas. For example, you can
place a Department dimension in the rows and a Source dimension in the columns. The items that you
place in the context area are used to filter the values. For example, you can filter the Exploration View to
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display data for a specific year by selecting a year in the Time dimension. Each box in the rows, columns,
and context area represents a set of data in the data source.

Work area
The work area is a Microsoft Excel worksheet where you create and view reports.

When you create a new Exploration View or list, the work area displays a visual guide to help you build the
report. Drop zones show you where you can drag items from the source tree to create the report. You can
change, limit, or expand the items that you see in an Exploration View by using techniques such as
filtering and drilling, to quickly focus on the most significant items on your worksheet.

If you want to use a more flexible report layout, rather than visual guides, you can create other types of
reports such as Quick Reports, Dynamic Reports, and Custom Reports.

Show or hide the IBM Planning Analytics with Watson ribbon
When you start IBM Planning Analytics for Microsoft Excel, an IBM Planning Analytics tab is displayed in
the ribbon. You can hide this tab if you decide to resume work on non-IBM TM1 workbooks and want to
show only Microsoft Excel commands and buttons.

Procedure
1. To hide the IBM Planning Analytics tab in Microsoft Office 2010 or 2013, click File, Options, and then

Customize Ribbon.
2. Under Customize the Ribbon, clear the IBM Planning Analytics check box.
3. Click OK.

To hide the IBM Planning Analytics tab in earlier versions of Microsoft Office, click Tools > Customize.

• To show or hide the IBM pane, select or clear the IBM check box.
• To show or hide the IBM Planning Analytics tab, select or clear the IBM Cognos for Microsoft
Office check box.

Report types
IBM Planning Analytics for Microsoft Excel offers you the flexibility to create various report types, from
simple lists and Exploration Views to complex formula-based reports.

The report types that you can use depends on whether you are using an IBM TM1 data source or an IBM
Cognos Analytics package.

Figure 2. Report types
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You can create an Exploration View that shows sales by product line and then create a Quick Report that
shows budget projections by product line. You can then create Microsoft Excel calculations that reference
cells in the two reports.

If you have both TM1 and IBM Cognos Analytics available, you can create workbooks that contain both
TM1 and IBM Cognos Analytics reports.

You can also combine TM1 and IBM Cognos Analytics data in a single report by using formulas.

For example, you can create a Custom Report that uses a IBM Cognos Analytics package, add TM1
formulas, and then use the IBM Cognos Analytics and TM1 data in Microsoft Excel calculations.

Planning Analytics for Microsoft Excel report types
When you are using data from an IBM Planning Analytics with Watson data source, you can work in
multiple ways: Exploration Views, lists, Quick Reports, Dynamic Reports, or Custom Reports (reports
based on formulas). You can use multiple types of report in a workbook. Each report type has its own
benefits and limitations.

Lists
A list shows data in rows and columns. Each column shows the members of a dimension or set.

When you create a list, you use a single drop zone, columns, to create a list of members. A drop zone is an
area where you can drag items to include in a report. You can add more columns to populate the list with
additional information.

Use list explorations to show detailed information from a data source, such as customer lists or product
lists.

You can also create a list to look up the value of a member, and then use the value in another worksheet,
for example.

Some of the strengths that are associated with lists include drag-and-drop capabilities and visual cues
that are provided by the zone in the overview area. With lists, you can view all of the members in a
dimension or set easily and quickly.

Use a list:

• To create a list of members in a dimension

Exploration Views
An Exploration View shows data in rows and columns. An Exploration View also has a context area, which
you can use to filter the data in the Exploration View.

When you create an Exploration View, you use drop zones to add objects from the source tree to the rows,
columns, and context area of the report. A drop zone is an area where you can drag items to include in a
report.

Some of the strengths that are associated with Exploration Views include drag-and-drop capabilities and
visual cues that are provided by the drop zones in the overview area.

Use Exploration Views to compare and manipulate data so that you can better understand relationships
between data and the relative importance of individual data items.

For example, you look at revenue for the years 2012 - 2015 by sales region. You notice a dip in the
revenue for 2014. You focus the Exploration View on 2014 only and expand 2014 to show revenue results
by quarter. You then replace the sales region dimension with the products dimension to explore revenue
in 2014 from a different perspective.

Use an Exploration View:

• To find answers to simple questions that can be found in your data source, such as the revenue for Tents
in the Americas for 2015
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• To build interactive Exploration Views that you or another user can drill up and down in
• When you are not concerned with formatting
• To build a data set to convert and use in a more complex analysis, such as a formula-based report or a

Dynamic Report

Quick Reports
A Quick Report shows data in rows and columns. A context area above the Quick Report shows the
context members.

When you use Quick Reports, you drag-and-drop objects onto the regions of the report: rows, columns,
context, and data. You can create Quick Reports by using existing Exploration Views or views. You can
create multiple Quick Reports on a worksheet. You can also use multiple data sources.

For example, you create three Quick Reports on a worksheet to show different views of financial
performance by region. You then add a fourth Quick Report that uses a different IBM Planning Analytics
with Watson data source. You then create a Microsoft Excel calculation that references cells in the four
Quick Reports to add more information to the report.

Some of the strengths that are associated with Quick Reports include the ability to present multiple views
that use the same or different data sources in a worksheet, the ability to build complex layouts, and the
ability to add Excel calculations, charts, and formatting. With Quick Reports, you can move beyond simple
Exploration View layouts while still having the advantage of visual cues provided through the Quick Report
regions.

Use Quick Reports:

• To build complex, highly formatted reports
• To use multiple data sources or servers
• When the row and column definitions will not change

Custom Reports
When you use Custom Reports, you use TM1 worksheet functions to build the report. You can create a
Custom Reports report from scratch, you can build an Exploration View or Quick Report and convert it to
formulas, or you can create Custom Reports from a cube view.

Some of the strengths that are associated with Custom Reports include the ability to use multiple data
sources in the same worksheet; the ability to move cells, rows, and columns; and the ability to add Excel
calculations, charts, and formatting. With formula-based reports, you can move to a custom or complex
layout.

Use Custom Reports reports:

• To build a complex report that cannot be easily achieved with Quick Reports or Dynamic Reports
• To work with data from multiple servers and data sources in a report
• When formatting is important

Dynamic Reports
A Dynamic Report shows data in rows and columns. A context area above the Dynamic Report shows the
context members. Dynamic Reports use TM1 functions to define the components of the report, such as
context members, row members, and display properties. Dynamic Reports also use formulas to apply
formatting to rows automatically. You can create a Dynamic Report from scratch or by converting an
Exploration View to a Dynamic Report.

Some of the strengths that are associated with Dynamic Reports include the ability to have dynamic row
members with customized formatting, the ability to expand and collapse rows, and the ability to use Excel
calculations and other Excel features in the report. With Dynamic Reports, you can create more complex
reports while still using interactive features, such as expanding and collapsing rows.
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Use Dynamic Reports:

• To build a complex report that cannot be easily achieved with Quick Reports
• To apply formatting automatically to rows

IBM Cognos Analytics report types
When you are using data from an IBM Cognos Analytics package, you can work in three different ways:
Exploration Views, lists, or Custom Reports. You can move between the methods. Each of these methods
has its own benefits and limitations.

Lists
When you create a list, you use a single drop zone, columns, to create a list of items. A drop zone is an
area where you can drag items to include in a report. You can add more columns to populate the list with
additional information. In a list, each column shows all the values for a data item in the database.

Some of the strengths that are associated with lists include drag-and-drop capabilities and visual cues
that are provided by the drop zone in the overview area. With lists, you can view all the items in the tables
of your database easily and quickly.

You can open list reports in IBM Cognos Analytics - Reporting and IBM Cognos Workspace Advanced. You
also publish lists to Cognos Connection.

Data sources can be relational, OLAP, or dimensionally modeled relational (DMR).

Use a list:

• To create a comprehensive group of items in a query subject or table of the database
• To enumerate the members of an OLAP dimension

Exploration Views
When you create an Exploration View, you use drop zones to add objects from the source tree to the rows,
columns, measures, and context area of the report. A drop zone is an area where you can drag items to
include in a report. Exploration Views provide automatic formatting based on the underlying data.

Some of the strengths that are associated with Exploration Views include drag-and-drop capabilities and
visual cues that are provided by the drop zones in the overview area.

You can open Exploration Views in IBM Cognos Analysis Studio, IBM Cognos Analytics - Reporting, and
IBM Cognos Workspace Advanced. You also publish Exploration Views to Cognos Connection.

Use an Exploration View:

• To find answers to simple questions that can be found in your data source, such as the revenue for Tents
in the Americas for 2015

• To build interactive Exploration Views that you or another user can drill up and down in
• When you are not concerned with formatting
• To build a data set to convert and use in a more complex cell-based analysis

Custom Reports
When you use Custom Reports, you drag-and-drop objects directly onto the cells of a worksheet.

Some of the strengths that are associated with Custom Reports include the ability to use multiple
packages in the same worksheet; the ability to move cells, rows, and columns; and the ability to add Excel
calculations, charts, and formatting. With cell-based reports, you can move beyond simple Exploration
View layouts. From a single cell, it is easy to create a detailed report.

Data sources can be dimensionally modeled relational (DMR) or OLAP. Relational data sources are not
supported.
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Use Custom Reports:

• To add data and calculations that are not in the original data source
• To work with data from multiple data sources, packages, and servers
• To create layouts with complex layouts, rather than a simple Exploration View
• When formatting is important
• When you are presenting a final view that does not require interactive exploration

Manually enabling features in the tm1features.json file
There are some features in Planning Analytics for Microsoft Excel that will need to be manually enabled
before use. This topic will provide you with a list of features that need to be manually enabled and how
you can manually enable certain features in Planning Analytics Workspace.

How do I edit the tm1features.json file?
1. Ensure that no Microsoft Office applications are open.
2. Navigate to the C:\<user profile path>\Cognos\Office Connection folder.
3. Open tm1features.json in a text editor.
4. Edit the desired parameter.
5. Save the tm1features.json file.

Tip: You can also find the Office Connection folder in Planning Analytics for Microsoft Excel by clicking
Options > IBM > View logs and then navigating up one level.

Note: If the tm1features.json file does not exist, you can create one by using an empty text file and
naming it tm1features.json. Be sure to save it to C:\<user profile path>\Cognos\Office
Connection\.

List of features in Planning Analytics Workspace that need to be manually enabled
Constrained Calculations

To enable Constrained Calculations, you need to set the r41_EnableConstrainedCalcScope
parameter to true.

{ "r41_EnableConstrainedCalcScope": true }

Quick Report headers
To enable the information header in a Quick Report, you need to set the
r48_QuickReportLabeling parameter to true. By default, the parameter is set to false, and the
header information is hidden.

{ "r48_QuickReportLabeling": true }

30  IBM Planning Analytics: Planning Analytics for Microsoft Excel



Chapter 3. Notes for IBM TM1 Perspectives users
If you are coming from using IBM TM1 Perspectives, you will notice some differences and improvements
in IBM Planning Analytics for Microsoft Excel.

Note: Some features might not work if Planning Analytics for Microsoft Excel and IBM TM1 Perspectives
are enabled concurrently in Microsoft Excel.

TM1 Perspectives features not implemented in Planning Analytics
for Microsoft Excel

There are some features in TM1 Perspectives that are not implemented in Planning Analytics for Microsoft
Excel.

The following are TM1 Perspectives features that are not implemented in Planning Analytics for Microsoft
Excel:
Modeling

Modeling is not available in Planning Analytics for Microsoft Excel. Instead, you can use Planning
Analytics Workspace to create and maintain models, applications, or security permissions.

TM1 macro functions
The TM1 macro functions are not available. The Planning Analytics for Microsoft Excel API can be
used for macro automation instead.

Note: You may experience differences in performance and/or functionality if you are directly porting
macro automation from TM1 Perspectives to Planning Analytics for Microsoft Excel. You should design
and evaluate macro automation specifically for Planning Analytics for Microsoft Excel.

Various spread methods
The following methods to spread data are not available: Relative Proportional Spread, Relative
Percent Adjustment.

Dynamic Report cell and password protection
Dynamic Reports are supported in Planning Analytics for Microsoft Excel, except for cell and password
protection.

User defined consolidations
User defined consolidations are not available. This includes the usage of DBRW worksheet functions
that use subset names as a dimension element reference.

Holds in formula reports
Holds in formula reports are not visible in Planning Analytics for Microsoft Excel.

Referencing non-default hierarchies
Referencing non-default hierarchies is not supported in formula or legacy reports. The default
hierarchy must be the same-named hierarchy.

The Print Report Wizard
The Print Report Wizard is not currently implemented in Planning Analytics for Microsoft Excel.

Undo to revert data entry changes
The Undo capability to revert data entry changes is currently not implemented in Planning Analytics
for Microsoft Excel.

Annotations in formula reports
The capability to add annotations in Dynamic Reports and Custom Reports is currently not
implemented in Planning Analytics for Microsoft Excel.
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Differences in implementation for TM1 Perspectives features
TM1 Perspectives is TM1-native API based, whereas Planning Analytics for Microsoft Excel is REST API
and MDX based. This difference affects how some of the features are implemented.

The following are some TM1 Perspectives features that are implemented differently in Planning Analytics
for Microsoft Excel:
Consumption patterns for macro automation

The consumption patterns for macro automation in TM1 Perspectives and Planning Analytics for
Microsoft Excel are not directly comparable. You might experience differences in performance or
functionality if you are directly porting macro automation from TM1 Perspectives to Planning Analytics
for Microsoft Excel. You should design and evaluate macro automation specifically for Planning
Analytics for Microsoft Excel.

Exporting reports from the Cube Viewer
Instead of slicing from the Cube Viewer into an Excel worksheet, in Planning Analytics for Microsoft
Excel you can right-click a view and insert it as the type of report you want. If you want to manipulate
the view first, insert it as an Exploration View, manipulate the view, and then convert it to the type of
report you want.

Refreshing a Dynamic Report
When you refresh a Dynamic Report, the formatting is updated only if the number of rows in the data
area was changed or if a value in the ID column of the format range was changed. Otherwise, rebuild
the Dynamic Report (ALT+F9) to update the formatting. In TM1 Perspectives, the formatting is
updated when you recalculate (F9) a Dynamic Report.

Rebuilding a Dynamic Report
When you rebuild a Dynamic Report, rows and columns are inserted or deleted from the existing rows
or columns. In TM1 Perspectives, all rows and columns are deleted and then re-added.

Dynamic Report header rows
In Dynamic Reports, any change to the header row (the row with the TM1RPTROW formula) of the
report requires you to re-create the report. For example, if you change the formula or add a column,
you must re-create the Dynamic Report to see the results.

Dynamic Report nested rows
In Dynamic Reports with nested rows, the member names in the nested rows are not grouped.
Instead, the member names are repeated.

Zero suppression
Zero suppression is done based on the column tuples that are present. In TM1 Perspectives, zero
suppression is done based on the product of the members of each dimension on the column
(symmetric column).

Blank dimension elements in a DBRW argument
A blank dimension element in a DBRW argument is displayed as an empty result in TM1 Perspectives,
but is displayed as #VALUE in Planning Analytics for Microsoft Excel. This difference is because
Planning Analytics for Microsoft Excel returns a true error response to an invalid element, which is
displayed as #VALUE. For more information, see How to correct a #VALUE! error (https://
support.office.com/en-us/article/how-to-correct-a-value-error-15e1b616-
fbf2-4147-9c0b-0a11a20e409e).

DBRA function
The DBRA function is currently read-only in Planning Analytics for Microsoft Excel. If you are using
DBRA functions for writeback in TM1 Perspectives and you want to perform write back in Planning
Analytics for Microsoft Excel, you can use the DBRW function against
the }ElementAttributes_DimensionName control cube in Planning Analytics for Microsoft Excel
instead. Alternatively, you can write back by using the control cube in an Exploration View or a Quick
Report.
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The benefits of using Planning Analytics for Microsoft Excel over
TM1 Perspectives

There are benefits to using Planning Analytics for Microsoft Excel over TM1 Perspectives.

The following are some benefits of using Planning Analytics for Microsoft Excel over TM1 Perspectives:

• Planning Analytics for Microsoft Excel reports are designed to work even in a wide area network
environment, without the need for Citrix.

• Planning Analytics for Microsoft Excel offers the following improvements to formulas:

– DBR is equivalent to DBRW and DBS is equivalent to DBSW. DBR, DBRW, DBS, DBSA, and DBRA are
optimized to reduce network traffic and improve performance on wide area networks.

– If a SUBNM formula references a set, a drop-down arrow is displayed when you click the SUBNM cell.
You can use the drop-down list to select a different member in the set. You must be logged on to the
TM1 server to use this feature.

– The TM1USER function returns the user name, not the internal CAMID.
• You can copy and paste values multiple times in Planning Analytics for Microsoft Excel. In TM1

Perspectives, you can copy only one time, and then the clipboard is empty. You can also copy and paste
values across multiple cells in Planning Analytics for Microsoft Excel.

• Planning Analytics for Microsoft Excel uses named styles, which means you can customize the
appearance of your reports easily.

• Reports that you open from the Application folder on an IBM TM1 server open with their actual names
and not a generated random name.

Enable trust access to the VBA project object model
Trust access to the VBA project object model is required for IBM Planning Analytics for Microsoft Excel.
Macros developed for IBM Planning Analytics for Microsoft Excel may not work properly if trust access to
the VBA project object model is not granted.

Procedure
1. Start Microsoft Excel.
2. Open a workbook.
3. Click File and then Options.
4. In the navigation pane, select Trust Center.
5. Click Trust Center Settings....
6. In the navigation pane, select Macro Settings.
7. Ensure that Trust access to the VBA project object model is checked.
8. Click OK.

Results
Trust access to the VBA project object model will be granted for IBM Planning Analytics for Microsoft
Excel.

Open an IBM TM1 Perspectives workbook
You can open an IBM TM1 Perspectives workbook in IBM Planning Analytics for Microsoft Excel.

About this task
Before you open a TM1 Perspectives workbook, note the following points:
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• If you open a workbook from a IBM Planning Analytics datasource and convert it, you must publish the
converted workbook to make it available on the server.

• If the workbook contains action buttons, you are asked if you want to upgrade them. If you choose to
upgrade them, a backup copy of the workbook is saved, and then an upgrade process runs.

• You cannot edit or use an action button that was created in TM1 Perspectives unless you covert it.
• Background images are not maintained.
• Cells with an invalid parameter reference in TM1 Perspectives return a *key_err notification. Cells

with an invalid parameter reference in Planning Analytics for Microsoft Excel will display #VALUE.
• Cells with a blank parameter reference in TM1 Perspectives are displayed as blank cells. Cells with a

blank parameter reference in Planning Analytics for Microsoft Excel will display #VALUE.

Procedure
1. Start Microsoft Excel.
2. Open a TM1 Perspectives workbook.
3. If you are prompted to convert action buttons, select an option and click OK.
4. If you are prompted for the host, either select a TM1 system from the list or type the system URL, and

then click OK.

The format of the URL is http://[server]:[port number], for example http://
myserver:9510

5. Log on to the TM1 server.

Results
The report is displayed in IBM Planning Analytics for Microsoft Excel. The formulas in the report reference
the TM1 system that you specified.

Upgrade IBM TM1 Perspectives action buttons
This setting upgrades IBM® TM1® Perspectives action buttons to allow them to be used in IBM Planning
Analytics for Microsoft Excel.

About this task
Upgrading IBM TM1 Perspectives action buttons allows them to be used in IBM Planning Analytics for
Microsoft Excel. When upgrading action buttons, note the following points:

• Trust access to the VBA project object model must be granted in Microsoft Excel. See “Enable trust
access to the VBA project object model” on page 33.

• You must have a TM1 Perspectives workbook that contains one or more action buttons.
• An administrator may upgrade action buttons in public and private workbooks.
• A non-administrator may only upgrade action buttons in private workbooks.
• Once action buttons are converted for use in IBM Planning Analytics for Microsoft Excel, they will no

longer work in TM1 Perspectives. It is recommended that a backup of all TM1 Perspectives workbooks
is created before upgrading action buttons.

Procedure
1. On the IBM Planning Analytics toolbar, click Options .
2. In the navigation pane, click IBM Planning Analytics.
3. Under Action Button Settings, click Upgrade Action Buttons.
4. Optional: Under Backup Excel Files, click Browse and define a backup directory. This step will create

a backup of the TM1 Perspectives workbooks.
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5. Under Conversion Log, click Browse and define a log directory.
6. Click OK.
7. Using the drop down menu, select the system that contains a TM1 Perspectives workbook that needs

to be upgraded.
8. Select the server that contains a TM1 Perspectives workbook that needs to be upgraded.
9. Select a TM1 Perspectives workbook that contains the action buttons that need to be upgraded.

10. Click Upgrade.
11. Click OK.

Results
A dialog will indicate the number of files upgraded. In this instance, a file is a workbook that has had
action buttons within it upgraded for use in IBM Planning Analytics for Microsoft Excel.

Note: If the workbook containing the action buttons was open during the upgrade process, you will need
to close and reopen the upgraded workbook from the IBM Planning Analytics datasource to complete the
upgrade.

Tip: By selecting the parent server or folder to upgrade, you can upgrade action buttons in multiple TM1
Perspectives workbooks.

Chapter 3. Notes for IBM TM1 Perspectives users  35



36  IBM Planning Analytics: Planning Analytics for Microsoft Excel



Chapter 4. Connecting to datasources
Connecting to a datasource allows you to use many IBM Planning Analytics for Microsoft Excel features,
including to exploring data, creating reports, and publishing your work.

Connect to IBM Planning Analytics with Watson
You can connect to an IBM Planning Analytics with Watson datasource that is configured to be accessible
from IBM Planning Analytics Workspace version 2.0.0 or later.

Users
If you are a user in IBM Planning Analytics for Microsoft Excel, you can use a Planning Analytics
datasource to do the following tasks:

• Create reports
• Open workbooks that are published on a TM1 Server Application folder
• Explore data in a model or package
• Save your data and work locally
• Publish your workbooks to a TM1 Server Application folder
• You can also modify data. For example, if your administrator distributes an enterprise-wide budget plan,

you can use IBM Planning Analytics for Microsoft Excel to create an Exploration View to review, analyze,
and update the portion of the plan that is assigned to you

Modelers
If you are a modeler in Planning Analytics Workspace, you can publish your models to a Planning
Analytics datasource. You can also include TurboIntegrator processes in the model and then use them in
IBM Planning Analytics for Microsoft Excel.

Administrators
If you are an administrator in Planning Analytics Workspace, you can use the Planning Analytics
Workspace Administration tool to configure the Planning Analytics URIs and authentication servers.

Connect to IBM Cognos Analytics
You can explore data that is published to an IBM Cognos Analytics server.

For IBM Cognos Analytics systems, the packages that you use to generate explorations are based on
models that are created in a modeling tool, such as Framework Manager.

A modeler uses a modeling application, such as Framework Manager, to create a package. A package can
be based on relational, dimensionally modeled relational (DMR), or OLAP data sources. A relational
package presents query subjects, which are organized into lists of data items. DMR and OLAP packages
present a dimensional view of data. The data in these packages is organized into dimensions, hierarchies,
levels, and measures. The modeler publishes the package to an IBM Cognos Analytics server, which you
can then access in IBM Planning Analytics for Microsoft Excel.

To work with IBM Cognos Analytics packages, you connect to an IBM Cognos Analytics server and then
select a package. You can use the package to create your own reports. You can also open and download
reports that are published to IBM Cognos Connection. You can explore the data and save your work
locally. You can also publish your workbooks to IBM Cognos Connection or to an IBM Cognos studio to
share them with other users.
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Set up a connection to a datasource
Access and share content by setting up your connections to a datasource.

A connection to an IBM Cognos Analytics system provides access to relational, OLAP, and dimensionally
modeled relational (DMR) packages. If you have a connection to an IBM Cognos Analytics system, you can
also open a report from IBM Cognos Connection and publish a Microsoft Office document to IBM Cognos
Connection.

You need to set up a connection to an IBM Planning Analytics Workspace URL if you want to access IBM
Planning Analytics datasources and share content.

You can use only datasources that were previously created and published to IBM Planning Analytics or
IBM Cognos Analytics. For more information about creating datasources, see the IBM Cognos TM1
Performance Modeler or the IBM Cognos TM1 Operation documentation.

For more information about creating Cognos BI packages (also known as IBM Cognos Analytics
packages), see the Framework Manager User Guide.

This video demonstrates how to set up a connection to a datasource

Before you begin
Contact your administrator for the URLs you'll need to connect to a datasource. The URL identifies the
location of the datasource.

• Syntax of a URL for an IBM Cognos Analytics system:

http://<host>:<port number>/bi/v1/disp

Do not use localhost to refer to the local computer that the IBM Cognos Analytics (IBM Cognos BI)
gateway is running on. By using localhost, the information sent to the server is routed back to the local
computer. As a result, requests to the report server will fail when importing prompted reports.

Note: The values for host are variables and depend on the exact settings that are used. Contact your
IBM Cognos administrator for more information about these settings.

Example of a URL without a Cognos Analytics gateway:

http://cognos-analytics.ibm.com:9300/bi/v1/disp

Example of a URL with a Cognos Analytics gateway:

http://cognos-analytics.ibm.com:80/analytics/bi/v1/disp

Example of a URL if your Cognos system is using Microsoft Internet Information Services (IIS):

http://10.121.25.121/ibmcognos/cgi-bin/cognosisapi.dll

• Syntax of a URL for a IBM Planning Analytics Workspace datasource:

http://<IP of the system / system name>

Procedure
1. Open the IBM Planning Analytics ribbon.

2. Click Options to open the Options dialog box.
3. In the navigation pane of the Options dialog box, click IBM.
4. Click Add to create a new connection to a datasource.
5. In the Datasource Type box, select the datasource.
6. In the Connection URL box, enter the URL provided by your administrator.
7. In the Friendly Name box, enter a name for your new connection.
8. Click Test Connection to test if the URL that you entered is live.
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If the connection fails, contact your administrator to verify the connection information.
9. Click Save.

Results
The saved connections appear in the IBM connections list and the friendly name appears in the Connect
drop-down on the ribbon.

Log on to a datasource
To use a datasource as an authenticated user, open and log on to the datasource that contains the model
or package that you want to use.

Procedure
1. Open the IBM Planning Analytics ribbon.
2. Click Connect.
3. Select the datasource that contains the model or package that you want to use.
4. If there is more than one namespace, select a Namespace.
5. Enter your User Name and Password, and then click Login.
6. If the Select Package dialog box is displayed, select a server or package, and then click OK.

The Select Package dialog box is displayed if IBM Planning Analytics is running.

Results
You are logged on to a datasource as an authenticated user. If you work in more than one datasource, you
can also be logged on to multiple datasources at the same time.

Open a model or package
Models and packages contain data that you can use to generate your reports. This topic guides you
through how you can open a model or a package from IBM Planning Analytics for Microsoft Excel.

For those using IBM Cognos Analytics systems, the packages that you use to generate reports are based
on models that are created in a modeling tool, such as Framework Manager. A model is a set of related
objects, such as query subjects, dimensions, filters, and calculations. Packages can be either relational or
dimensionally modeled datasources. Dimensionally modeled datasources can be rendered by using either
lists or Exploration Views.

Before you begin
Before you can open a model or package, check with your administrator to ensure that you have the
correct security permissions to the datasource containing the model or package.

Procedure
1. Open the IBM Planning Analytics ribbon.
2. Click Task Pane.

3. In the Task Pane, click Open.
4. Select the datasource that contains the model or package that you want to use.

If you selected a Cognos Analytics system, log on to the system.
5. Select the model or package that you want to use.
6. If prompted, log on to the datasource.
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7. For IBM Planning Analytics datasources, you can choose to show control objects and processes. Click

the control and processes icon  and select your preferred option.

Results
Objects from the selected model or package, such as data items, appear in the source tree.

Refresh a datasource, model, or package
Perform a refresh in the Task Pane to get the most recent version of the datasource, model, or package.

If something new was added to the datasource, model, or package that you're working on, you might not
see it in the Task Pane until you refresh. You can refresh in two ways:

• To refresh a model or package, right-click the highest level node in the Task Pane, and then click
Refresh.

• To refresh a datasource, click the refresh icon in the Task Pane.

Change the datasource and datasource type
You can change the datasource and datasource type that is used by a report.

Refer to the following topics:

• For Exploration Views or lists, see “Change the cube or datasource used by an exploration” on page
117.

• For Quick Reports, see “Change the cube and datasource used by a Quick Report” on page 124.
• For TM1 formulas and Custom Reports, see “Change the cube and datasource of Custom Reports” on

page 135.
• For Dynamic Reports, see “Change the model and cube used by a Dynamic Report” on page 130.
• For Custom Reports using IBM Cognos Analytics data, see “Change the server and package used by a

Custom Report” on page 229.

Show and hide servers in a TM1 datasource
You can choose to show or hide specific servers in a TM1 datasource.

Hide a server
If your TM1 datasource contains a lot of servers, you can choose to hide specific servers to reduce visual
clutter.

1. Click the IBM Planning Analytics tab.
2. Click Options to open the Options window.
3. Click IBM Planning Analytics in the left hand menu.
4. Under Server settings, click Set Hidden Servers.
5. Select the TM1 datasource that contains the server that you want to hide.
6. Select the server that you want to hide.
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7. Click Hide.

Unhide all hidden servers
You can unhide all of the TM1 servers that you have hidden.

Note: This action unhides every hidden TM1 server in every TM1 datasource.

1. Click the IBM Planning Analytics tab.
2. Click Options to open the Options window.
3. Click IBM Planning Analytics in the left hand menu.
4. Under Server settings, click Unhide Hidden Servers.

Open and download workbooks
You can open workbooks that are published to an TM1 Server Application folder.

You can also download workbooks from IBM Cognos Connection.

To refresh your data or make enhancements, you can open or download published Microsoft Excel
workbooks and then use Microsoft Excel to make changes.

You can also open locally saved workbooks.

Note: If your workbook is in the xslb file format, you must be connected to the datasource that it is in
before you open the book.

If you are opening a workbook from an earlier version of a IBM Planning Analytics for Microsoft Excel, any
custom properties settings that were specified for the workbook is applied to the settings in the Options
dialog box.

For example, if a workbook from an earlier version of a Planning Analytics for Microsoft Excel is opened,
the address for the gateway might appear in the list of addresses under IBM connections, in the Options
dialog box.

Opening workbooks from the TM1 Server Application folder
The TM1 Server Application folder is a content store inside each of your models. You can store the
workbooks that you create or modify on the TM1 Server Application folder. You can use the TM1 Server
Application folder to share a report with a report author who is working in a different environment. You
can also save those workbooks on your computer or to a source code-controlled directory on a local
network or drive.

Before you begin
Before you can open a workbook from the TM1 Server Application folder, ensure that the following
statements are true:
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• Workbooks are published to a public folder on a TM1 Server Application folder.
• The datasource URL where workbooks are published is added to your list of connections.
• You know the name of the TM1 Server Application folder where workbooks are published.

Procedure
1. Click the IBM Planning Analytics tab.

2. In the ribbon, click Open .
3. In the Open dialog box, select the datasource connection that contains the workbook that you want to

open.
4. Select the model that contains the workbook that you want to open.
5. If prompted, log on.
6. Navigate to the folder that contains the workbook you want to open.

Tip: To return to the list of models in the datasource, click Servers.
7. Click the workbook, and click Open.

Results
The workbook opens. You can make changes, manipulate data, and publish it to TM1 Server Application
folder for sharing.

Open a report from IBM Cognos Connection
You can store the reports that you create or modify on the IBM Cognos Analytics server. You can also open
and save those reports on your computer. This is useful if you want to send a report to a report author who
is working in a different environment, or you want to save the report to a source code controlled directory
on a local network or drive.

Folders in IBM Cognos Connection are logically labeled and organized to help you locate reports. Entries
in Public Folders are of interest to and can be viewed by many users. Entries in My Folders are accessible
by you only when you are logged on.

If you are working from IBM Cognos Connection, you can also download a Microsoft document and open it
in the application that was used to create it.

Before you begin
You must have write access to a folder to create entries.

Procedure

1. On the IBM Planning Analytics toolbar, click Open .
2. Select the server that contains the report that you want.
3. Choose the type of folder in which the report is saved:

• To view files in public folders, click Public Folders.
• To view only your files, click My Folders.

4. Click the report that you want, and click OK.

Results
The report appears in your workbook, slide, or document. You can make changes and manipulate data,
and publish it to IBM Cognos Connection for sharing.
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Open a workbook containing Planning Analytics for Microsoft Excel styles

About this task
Note: Opening a workbook with Protected View enabled may prevent Microsoft Excel from loading
Planning Analytics for Microsoft Excel styles. In order to ensure that Microsoft Excel loads Planning
Analytics for Microsoft Excel styles in a workbook with Protected View enabled, you should:

Procedure
1. Save the workbook with Protected View disabled.
2. Close Microsoft Excel.
3. Open the workbook and launch Planning Analytics for Microsoft Excel.
4. Enable Protected View and save the workbook.
5. Close Microsoft Excel.

Download a workbook from IBM Cognos Connection
You can download a Microsoft Excel workbook from IBM Cognos Connection if it was published in one of
the IBM TM1 applications, such as IBM Planning Analytics for Microsoft Excel.

You can download documents created in Microsoft Excel, Microsoft PowerPoint, and Microsoft Word. The
default action for any Microsoft Office document is to download it.

For more information, see the IBM Cognos Analytics Administration and Security Guide.

Before you begin
You must have read and traverse permissions to access Microsoft Office documents in IBM Cognos
Connection.

Procedure
1. In IBM Cognos Connection, locate the workbook that you want to open.
2. Click more on the actions toolbar next to the document that you want to download.

The IBM Cognos Connection Actions page opens.

3. For a Microsoft Excel workbook, click View most recent document in Excel .

The File Download window appears.
4. Click Save and follow the prompts that appear.

You must save the workbook before using it with IBM Planning Analytics for Microsoft Excel.

Results
You can now perform the same actions that you would perform for any workbook.
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Chapter 5. Settings
Customize your experience by setting options that apply to IBM Planning Analytics for Microsoft Excel.

You can also set options that apply to specific explorations. For more information, see “Set properties” on
page 115.

IBM settings

Start application
You can choose the startup application. Click the application icon that best meets your needs.

Procedure
1. On the IBM Planning Analytics tab on the ribbon, click Options .
2. In the navigation pane, click IBM.
3. Choose the startup application.
4. Click OK.

Update Connection URLs
If the URL of an IBM system changes, you can edit the information to use the new URL.

Editing the URL updates the saved connection for the IBM Planning Analytics for Microsoft Excel
application, but not the connections for the reports in the workbook. To update the connections for
Exploration Views or Quick Reports in an open workbook, use the Update connection utility. For more
information, see “Utilities” on page 47.

About this task
When running this command, the name of the data source or package remains the same. You can use this
command to change only one server, such as a test server to another server, such as a production server.
You choose the URLs from the list of systems that you enter in the IBM connections section of the
Options dialog box.

Procedure
1. Open the file you want to update.

2. On the IBM Planning Analytics tab, click Options .
The Options dialog box is displayed.

3. In the navigation pane, click IBM.
4. Select the system you want to update and click Edit.
5. Select the Datasource type.
6. Type the new Connection URL in the field.
7. Update the Friendly name field as required.
8. Test the connection and click save.
9. Click OK.

Results
The open IBM enabled files are searched and the server information is updated.
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Set up forms-based user authentication
Forms-based authentication is not supported for connections to IBM Planning Analytics servers, it is only
supported for connections to IBM Cognos Analytics servers.

If your company uses Web-based access management software, such as SiteMinder, to provide single
signon in your security infrastructure, you must enable forms-based authentication. The forms-based
authentication service allows you to enter your credentials, such as your user name and password,
through a form on a Web page. If the credentials are valid, you are logged on to the site. The credentials
persist until you explicitly log off.

Procedure
1. On the IBM Planning Analytics tab, click Options .
2. In the navigation pane, click IBM.
3. Under Authentication, select the Enable forms based authentication check box.
4. Click OK.

Logging
A log file is an important diagnostic tool for investigating the behavior of applications. It can help you
troubleshoot problems by recording information about the environment, exceptions, and entry and exit
functions.

You can specify whether information is logged and at what level of detail. By default, log activities are
saved to the user_root_directory.

Enable logging if you are attempting to troubleshoot unexpected behavior. In this situation, the support
staff will want a copy of the entries in the log file.

Writing to log files may result in performance degradation.

Procedure
1. On the IBM Planning Analytics tab, click Options .
2. In the navigation pane, click IBM.
3. Under Logging, select the Log level.

• To turn logging off completely, click None.
• To record only critical issues and events in the log, click Critical.
• To record errors as well as critical issues and events, click Error.
• To record warnings as well as errors and critical issues and events, click Warning.
• To record information as well as warnings, errors, and critical issues and events, click Information.
• To record all events and issues, even routine items, click All.

4. Click OK.

The log file is created in %APPDATA%\Local\Cognos\Office Connection\Logs.

The naming format for log files is yymmdd_hhmmss.txt.

Results
The next time that you start the application, activities and information about the environment are logged
in the file. From the Options dialog box, click the View logs button to open the folder that contains the log
files.
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Cache management
You can reduce the file size of a workbook by clearing the cache.

About this task
For each workbook that you open or create during or after logging on, a cache worksheet is created. This
worksheet holds information about the data that needs to be rendered. You can clear the cache of
packages used in workbooks that use Planning Analytics for Microsoft Excel. Clearing the package cache
reduces the size of the workbooks by deleting unused data and metadata associated with formulas. The
Clear Cache button works for all the data sources and packages defined in Planning Analytics for
Microsoft Excel. After you clear the cache, you must save workbooks to see a reduction in file size.

Clear the cache when workbook size matters or when it is not necessary to store report results for faster
processing times. If the size of your workbook is too large due to extensive data, the clear cache function
reduces the size of the workbook. However, there is a trade-off: the processing time for populating the
workbook with data increases because the data must be retrieved from the IBM TM1 server instead of
relying on the data that is saved in the cache.

Alternatively, you can specify to clear the local cache of retrieved data each time that you save the
workbook or save the workbook with a new file name. You can do this by selecting the Clear cache on
save check box.

You can also automate the process for clearing the cache. For more information, see https://ibm.github.io/
paxapi/#clearcache .

Procedure
1. Start Planning Analytics for Microsoft Excel.
2. Open a workbook.
3. From the IBM Planning Analytics tab, click Options and then click IBM.
4. Under Cache Management, choose how you want to clear the cache:

• To clear the local cache for the active workbook, click Clear Cache.

The cache is cleared and the size of the workbook is reduced. You can now open and save additional
workbooks. To avoid creating a cache worksheet for non-IBM TM1 workbooks, you must exit
Microsoft Excel.

• To clear the local cache each time that you save a workbook, or save a workbook with a new file
name, select the Clear cache on save check box.

Note: Data displayed in the workbook is cleared only when using the Clear All Data button  on
the IBM Planning Analytics tab.

5. Click OK, and then save the workbook.

Utilities
The Update connection utility updates the connections for Exploration Views or Quick Reports in an open
workbook.

Procedure
1. Open the file containing the reports that you want to update.

2. On the IBM Planning Analytics tab, click Options .
The Options dialog box is displayed.

3. In the navigation pane, click IBM.
4. Scroll to the Utilities section and click Update connection utility.
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5. Select the connection that you want to upgrade from in Old connection.

Note: The Update connection utility does not differentiate between connection names where the only
variance is case sensitivity. If you have multiple connection names with varying case sensitivity, you
can use the bulk update tool to update each connection name separately. For more information, see
“Bulk update the datasource or TM1 instance for Exploration Views” on page 118.

6. Select the new connection and click OK.
7. Choose whether you want to refresh the data in the report. If you select Yes, then determine whether

you want to refresh just the data, or the data and report formatting.
8. After you have made your selection, you are prompted to log onto the server on the new connection.
9. Refresh your workbook to complete the update.

IBM Planning Analytics settings

Application settings

Load recently used data source or package
This setting automatically loads the most recently used data source or package when you start IBM
Planning Analytics for Microsoft Excel.

About this task
If you usually work with the same data source or package, you can automatically load the most recently
used data source or package when you start IBM Planning Analytics for Microsoft Excel. This is most
useful when you use the data source or package regularly and you want an easy way to access it so that
you can quickly begin or resume work.

If the most recently used data source or package is inaccessible or missing, no source tree is shown.
Select another package to replace the missing one.

Procedure
1. On the IBM Planning Analytics tab, click Options .
2. In the navigation pane, click IBM Planning Analytics.
3. Under Application settings, select the Load most recently used system and package check box.

4. Click OK.

Member display count limit
This setting defines the number of members shown in the source tree, drop zones, and search results.

About this task
You can limit the number of members shown in the Task Pane.

For IBM Cognos Analytics packages, this setting applies to dimensionally modeled data. It does not apply
to relational packages.

Procedure
1. On the IBM Planning Analytics tab, click Options .
2. In the navigation pane, click IBM Planning Analytics.
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3. If you want to limit the number of members shown in the source tree and in the search result dialog
box, under Application settings, in the Member display count limit box, type the maximum number
of members that can appear in the source tree before showing the More or Search option.

4. Click OK.

Results
Member display count limit: 7

Member display count limit: 3

Default expand direction
This setting defines the expand direction when you double click on a consolidated cell in an Exploration
View or list view.

About this task
Using this setting, you can define which direction your Exploration View or list expands when double
clicked. You can set the default to expand either above or below.
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Note: This setting will only apply to new explorations created using dimensions after the option is
enabled. This setting will not apply to explorations which have already been created.

You can set your Exploration View or list to expand in the following directions when double clicked:
Expand Above

Double-clicking a consolidated member expands the children above their parent.

Expand Below

Double-clicking a consolidated member expands the children below their parent.

Procedure
1. On the IBM Planning Analytics tab, click Options .
2. In the navigation pane, click IBM Planning Analytics.
3. Under Application settings, use the drop down below Default expand direction to select the default

expand direction.
4. Click OK.

Task Pane double-click action
This setting defines the default action for when you double-click a node in the Task Pane.

About this task
Using this setting, you can define the default action for when you double-click a node in the Task Pane.
You can set the default to either open the double-click options dialog box, expand the node, or open the
set editor.
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Prompt
The double-click options dialog box will open when a node in the Task Pane is double-clicked.

Expand
A node in the Task Pane will expand when double-clicked.

Launch
A set or dimension in the Task Pane will launch the set editor when double-clicked.

Procedure
1. On the IBM Planning Analytics tab, click Options .
2. In the navigation pane, click IBM Planning Analytics.
3. Under Application settings, use the drop down below Task Pane double-click action to select the

default double-click action.
4. Click OK.

Hide commit confirmation
This setting disables the confirmation prompt, which appears before a commit is performed.

About this task
Disable the confirmation prompt which appears before a commit is performed. Committing a change in a
worksheet will result in a confirmation prompt which appears before the commit is performed. This
setting will disable the confirmation prompt.

Procedure
1. On the IBM Planning Analytics tab, click Options .
2. In the navigation pane, click IBM Planning Analytics.
3. Under Application settings, select the Hide commit confirmation check box.
4. Click OK.

Results
Unselected
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Auto spread consolidated inputs
This setting proportionally spreads values entered in a consolidated cell across nested cells.

About this task
If you enable the Auto spread consolidated input option, the values you enter in consolidated cells will
be proportionally spread across the nested cells after you commit your data.

Note: Consolidated cells do not accept typed-in input in formulas-based reports, such as Custom Reports
or Dynamic Reports.

Procedure
1. On the IBM Planning Analytics tab, click Options .
2. In the navigation pane, click IBM Planning Analytics.
3. Under Application settings, select the Auto spread consolidated input check box.
4. Click OK.

Preserve user formulas
This setting preserves the user formulas in an Exploration View, list view, or Quick Report.

About this task
You can choose to preserve user formulas in an Exploration View, list view, or Quick Report.

Note: If this setting is not selected, any formulas that you add to an Exploration View, list view, or Quick
Report will be discarded when you commit data.

Procedure
1. On the IBM Planning Analytics tab, click Options .
2. In the navigation pane, click IBM Planning Analytics.
3. Under Application settings, select the Preserve user formulas check box.
4. Click OK.

Exploration or list settings

Show system and package information in exploration and list sheet
This setting is used to display the system and package information in newly created Exploration Views or
list views.

About this task
You can choose to display the system and package information in your Exploration Views and list views by
enabling this setting.

Note: This setting only applies to Exploration Views and list views created after the setting is enabled.
This setting will not have an effect on explorations already opened.

Procedure
1. On the IBM Planning Analytics tab, click Options .
2. In the navigation pane, click IBM Planning Analytics.
3. Under Exploration or list settings, select the Show system and package information in exploration

and list sheet check box.
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4. Click OK.

Results
Unselected

Selected

Assign exploration or list starting cell
This setting is used to enable a prompt, which defines the starting cell for a new Exploration View or lists
view.

About this task
You can choose to assign a starting cell when creating a new Exploration View or list view by enabling this
setting. After the setting is enabled, a prompt will appear for a starting cell when creating a new
exploration.
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Procedure
1. On the IBM Planning Analytics tab, click Options .
2. In the navigation pane, click IBM Planning Analytics.
3. Under Exploration or list settings, select the Assign exploration or list starting cell check box.
4. Click OK.

Results
A prompt will appear for a starting cell when creating a new exploration

Hide refresh confirmation for each worksheet and workbook
This setting is used to hide the confirmation dialog box, which appears whenever you refresh an
Exploration View or a Quick Report.

About this task
Right clicking a cell in your Exploration View or Quick Report and selecting IBM Planning Analytics will
show you options for refreshing your workbook or worksheet. If you decide to refresh your workbook or
worksheet from this menu, a confirmation dialog box will appear. Use this option to hide the confirmation
dialog box whenever you refresh your workbooks or worksheets.

Note: This setting does not apply to the Refresh or Refresh All Data buttons.

Procedure
1. On the IBM Planning Analytics tab, click Options .
2. In the navigation pane, click IBM Planning Analytics.
3. Under Exploration or list settings, select the Hide refresh confirmation for each workbook or

worksheet check box.
4. Click OK.
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Results
Left: Unselected

Right: Selected

Expand with double-click
This setting is enables consolidated cells to expand when double-clicked.

About this task
By enabling this setting, you will be able to expand a consolidated member by double-clicking on it.

Enabling this setting will also override the default double click action in BI formulas.

Procedure
1. On the IBM Planning Analytics tab, click Options .
2. In the navigation pane, click IBM Planning Analytics.
3. Under Exploration or list settings, select the Expand with double-click check box.
4. Click OK.

Results
You can now double-click a consolidated member to expand it.

Allow sum on context dropdown
This setting enables you to select a sum of items in the context dimension drop down of an Exploration
View.

About this task
You can add a Sum button to the context dimension drop down of an Exploration View. After enabling this
option, you can click on the drop down and click Sum to select the sum of the items.

Procedure
1. On the IBM Planning Analytics tab, click Options .
2. In the navigation pane, click IBM Planning Analytics.
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3. Under Exploration or list settings, select the Allow sum on context dropdown check box.
4. Click OK.

Results
A Sum button is added to the context dimension drop down.

Prompt for uncommitted changes
This setting enables a confirmation prompt, which appears when you refresh an Exploration View or list
view.

About this task
Refreshing a workbook with uncommitted changes may result in the changes being lost. This setting will
enable a confirmation prompt before a refresh is made. The prompt will only display if there are changes
to the workbook that are uncommitted and at risk of being lost after a refresh.

Procedure
1. On the IBM Planning Analytics tab, click Options .
2. In the navigation pane, click IBM Planning Analytics.
3. Under Application settings, select the Prompt for uncommitted changes check box.
4. Click OK.
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Results
Selected

Context member dropdown limit
This setting defines the number of members displayed in an Exploration View’s dimension drop down.

About this task
Use this option to define the number of members to display in the dimension area drop down.

Procedure
1. On the IBM Planning Analytics tab, click Options .
2. In the navigation pane, click IBM Planning Analytics.
3. Locate Context member dropdown limit under Exploration or list settings.
4. Define a number.
5. Click OK.
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Results
Left: Context member dropdown limit set to 3.

Right: Context member dropdown limit set to 10.

Data display row limit
This setting defines the number of rows that are displayed in an Exploration View or list view.

About this task
If you are pulling large quantities of data while working on your Exploration Views or list views, you may
find that there is a delay. Limiting the number of rows that are displayed in your Exploration Views or list
views can help mitigate this delay.

Under the last row of your Exploration View or list view, you can double-click More or All to see the
remaining rows of data.

Procedure
1. On the IBM Planning Analytics tab, click Options .
2. In the navigation pane, click IBM Planning Analytics.
3. Locate Data display row limit under Exploration or list settings.
4. Use the field to define a number.
5. Click OK.

Results

Expand member limit
This setting defines the maximum number of members to display when you expand a consolidated
member in your Exploration View. This setting affects only IBM® Cognos® Analytics Exploration Views.

About this task
Note: This option affects only IBM Cognos Analytics Exploration Views.

Set the maximum number of members to display when you expand a consolidated member in your
Exploration View.

Procedure
1. Click Options , from the IBM Planning Analytics tab.
2. Click IBM Planning Analytics, from the navigation pane.

58  IBM Planning Analytics: Planning Analytics for Microsoft Excel



3. Locate Expand member limit under Exploration or list settings.
4. Use the field to define a number.
5. Click OK.

Results

Grouping options
This setting defines the way in which cells are grouped when you nest dimensions.

About this task
You can nest multiple dimensions in a row or column. This setting will define how the dimensions appear
when nested.

Table 1. Grouping options

Options Description

Merge cells Repeating cells in the parent dimension are
merged.

Repeat labels Repeating cells in the parent dimension each have
labels.

Label top cell Only the top cell of the repeating cells in the parent
dimension has a label.

Left: Merge cells

Center: Repeat labels

Right: Label top cell

Procedure
1. On the IBM Planning Analytics tab, click Options .
2. In the navigation pane, click IBM Planning Analytics.
3. Locate Grouping options under Exploration or list settings.
4. Use the drop down menu to select an option.
5. Click OK.

Custom report settings

Set TM1RebuildOption when generating new formula content
This setting enables the TM1RebuildOption variable when you generate new formula content.

About this task
The TM1RebuildOption variable causes the worksheets in a book to be rebuilt upon opening. This
forces a recalculation to happen on each sheet in the book every time you open the book. The Set
TM1RebuildOption when generating new formula content setting enables the TM1RebuildOption
variable when you generate new formula content.
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Procedure
1. On the IBM Planning Analytics tab, click Options .
2. In the navigation pane, click IBM Planning Analytics.
3. Locate Set TM1RebuildOption when generating new formula content under Custom report

settings.
4. Select the check box.
5. Click OK.

Expand with double-click (applies to package based data sources only)
This setting overrides the default double-click action in IBM® Cognos® Analytics formulas and enables you
to expand with double-click on IBM® Cognos® Analytics formulas in package based data sources.

About this task
Override the default double-click action in IBM Cognos Analytics formulas.

Procedure
1. On the IBM Planning Analytics tab, click Options .
2. In the navigation pane, click IBM Planning Analytics.
3. Locate Expand with double-click (applies to package based data sources only) under Custom

report settings.
4. Select the check box.
5. Click OK.

Results

Refresh data on Excel recalculation Keys (F9, Shift F9)
This setting enables Custom Report refreshes by using Microsoft Excel recalculation keys.

About this task
Use this setting to enable Custom Report refreshes by using Microsoft Excel recalculation keys. When this
setting is enabled, you can use F9 to refresh the entire workbook or Shift + F9 to refresh the current
sheet.

Note: You need to restart Microsoft Excel after setting this option for it to take effect.

Procedure
1. On the IBM Planning Analytics tab, click Options .
2. In the navigation pane, click IBM Planning Analytics.
3. Locate Refresh data on Excel recalculation Keys (F9, Shift F9) under Custom report settings.
4. Select the check box.
5. Click OK.

Refresh data on writeback
This setting defines if and how you want to refresh your data on write back.

About this task
Use this setting to define if and how you want to refresh your data on write back.
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Table 2. Refresh data on write back options

Option Description

None Data does not refresh on write back.

Workbook The data refreshes in the workbook on write back.

Worksheet The data refreshes in the worksheet on write back.

Procedure
1. On the IBM Planning Analytics tab, click Options .
2. In the navigation pane, click IBM Planning Analytics.
3. Locate Refresh data on writeback under Custom report settings.
4. Select an option.
5. Click OK.

Quick report settings

Double-click option
This setting defines the action executed after double-clicking on dimensions or context areas of a Quick
Report.

About this task
You can use this setting to define the action that occurs after double-clicking on the dimension or context
areas of a Quick Report.

Table 3. Double-click options

Option Description

None No action occurs after double-click.

Replace Double-clicking a dimension or context member
opens up the set editor to allow a replacement of
the dimension / context member.

Toggle Expands and collapses consolidated members
when double-clicked on dimension areas.
Launches the set editor when double-clicked on
the context area.

Procedure
1. On the IBM Planning Analytics tab, click Options .
2. In the navigation pane, click IBM Planning Analytics.
3. Locate Double-click option under Quick report settings.
4. Select an option.
5. Click OK.

Results
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Use level based indents
This setting enables level based indents between parent-child members in a Quick Report.

About this task
Level based indentations allow you to easily identify parent-child relationships in rows within Quick
Reports. By enabling level based indents, child row members will be indented under the parent row
member.

Procedure
1. On the IBM Planning Analytics tab, click Options .
2. In the navigation pane, click IBM Planning Analytics.
3. Under Quick Report settings, select the Use level based indents check box.
4. Click OK.

Results

Use type-in refresh
This setting, if enabled, refreshes a Quick Report automatically when you update a context member by
typing it into the report.

About this task
update a context member

You can use this option to refresh a Quick Report automatically when you add a member by typing it into
the report.

Procedure
1. On the IBM Planning Analytics tab, click Options .
2. In the navigation pane, click IBM Planning Analytics.
3. Locate Use type-in refresh under Quick report settings.
4. Click the checkbox.
5. Click OK.

Results

Use server formatting
This setting removes custom formatting in a Quick Report and uses server formatting.

About this task
You can use this option to remove custom formatting in a Quick Report and use server formatting.

Procedure
1. On the IBM Planning Analytics tab, click Options .
2. In the navigation pane, click IBM Planning Analytics.
3. Locate Use server formatting under Quick report settings.
4. Click the checkbox.
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5. Click OK.

Results

Settings in the CognosOfficeReportingSettings.xml file
You can configure IBM Planning Analytics for Microsoft Excel by using the
CognosOfficeReportingSettings.xml file. This file is located in C:\Users\[User]\AppData
\Local\Cognos\Office Connection.

The following tables group the settings into categories:

• Settings that apply to all supported datasources
• Settings that apply only when you are using a IBM Cognos Analytics datasource
• Settings that apply only when you are using a TM1 datasource

Settings that apply to all supported datasources

Table 4. Settings that apply to all supported datasources

Name Description Allowed values Default value

CommitWithoutConfirmati
on

Commits valid data
without prompting you to
confirm the commit.

You can also turn this
feature on or off by using
the Hide commit
confirmation option in the
Options dialog box. Or you
can use the Hide commit
confirmation option in the
Commit Changes dialog
box.

True, False False

ContextMemberLimit Sets the number of
members to display in the
drop-down list for
dimensions in the context
area of Exploration Views.
Click More to see more
members.

Integer 15

ConvertDropDown Sets the default
conversion option
displayed on the
explorations toolbar (used
for converting to another
report type).

Quick Reports:
MapOnNewSheet,
MapOnThisSheet,
MapAtSpecifiedLocation

Formulas:
FormulasOnNewSheet,
FormulasOnThisSheet,
FormulasAtSpecifiedLocat
ion

None

MapOnNewSheet
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Table 4. Settings that apply to all supported datasources (continued)

Name Description Allowed values Default value

CustomStartingRange Prompts you for a starting
cell when you create
explorations.

You can also turn this
feature on or off by using
the Assign Exploration
View or list starting cell
option in the Options
dialog box.

True, False False

DataRowLimit Specifies the number of
rows to retrieve from the
server and display in
explorations, 0 = no limit.

You can also set this by
using the Data display
row limit option in the
Options dialog box.

Note: This is a global
setting for all explorations
in a workbook. You can
override this setting in the
Properties dialog box for
Exploration Views and
lists.

Integer 500

DefaultRefreshMode Sets the default refresh
button displayed on the
explorations toolbar.

For example, if you set
DefaultRefreshMode=
PreviewOnly, the Preview
with No Data button is
displayed on the
explorations toolbar.

None

RunAllData: Refresh data
and formatting

RunAllDataWithout
Formatting: Refresh data
only

PreviewOnly: Preview
without data

None

ExplorationOverride
DoubleClick

Overrides the double-click
action in explorations.

True, False True

ExplorationThresholdCont
extUnnamedSetSize

Defines the maximum
number of members in
unnamed and static sets
that will be shown when a
view is added to an
exploration.

Defines the size limit for
unnamed sets when a
view is added to an
Exploration.

Integer 1000
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Table 4. Settings that apply to all supported datasources (continued)

Name Description Allowed values Default value

GroupingOption Sets the way in which
cells are grouped when
you nest dimensions.

You can also set the
grouping option by using
the Grouping option in
the Options dialog box.

Note: This is a global
setting for all explorations
in a workbook. You can
override this setting in the
Properties dialog box for
Exploration Views and
lists.

None

Sparse: Labels the top cell
only

Normalized: Repeats
labels

Full: Merges cells

Full

InsertDetails Sets the default insert
mode displayed on the
explorations toolbar.

For example, if you set
InsertDetails=
InsertSingleMember, the
Insert Single Member
button is displayed on the
explorations toolbar.

None

InsertSingleMember

InsertMemberWithChildre
n

InsertMemberWithChildre
n Dynamic

InsertMemberWith
Descendants

InsertMemberWithInputs

InsertMemberWithAncest
ors

InsertSingle Member

MemberLimit Sets the maximum
number of child members
to show in the source tree.

You can also set this
option by using the
Member display count
limit option in the Options
dialog box.

Integer 1000

MruPackage Contains information
about the most recently
used datasource.

MruServer Contains information
about the most recently
used Cognos system.
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Table 4. Settings that apply to all supported datasources (continued)

Name Description Allowed values Default value

RefreshConfirmation Displays a confirmation
dialog box when you
refresh a workbook or
worksheet.

You can also turn this
feature on or off by using
the Hide refresh
confirmation for each
worksheet and
workbook option in the
Options dialog box.

True, False True

RefreshDropDown Stores the refresh mode
most recently used on the
explorations toolbar.

None

RunAllData: Refresh and
apply server formatting

RunAllDataWithout
Formatting: Refresh and
apply Excel formatting

PreviewOnly: Preview
without data

RunAllData

ShowServerInExploration Displays an information
area above explorations.
The information area
displays details such as
the server, row
dimensions, column
dimension, and so on.

You can also turn this
feature on or off by using
the Show system and
package information in
the Exploration View and
list sheet option in the
Options dialog box.

True, False True

UndoStackLimit Defines the limit on the
number of undo actions a
user can perform in an
Exploration View.

Integer 15

UseMruPackage Loads the most recently
used datasource at
startup.

You can also turn this
feature on or off by using
the Load most recently
used system and
package option in the
Options dialog box.

True, False False
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Settings that apply only to reports that use IBM Cognos Analytics datasources

Table 5. Settings that apply only to reports that use IBM Cognos Analytics datasources

Name Description Allowed values Default value

ChunkSize Sets the IBM Cognos
Analytics chunk size (row
count per request).

Integer 0

EnableBIToggle For explorations using
IBM Cognos Analytics
datasources, enables the
Toggle_set expression
instead of adding all child
members.

True, False False

ExpandMemberLimit Sets the maximum
number of members to
display when you expand
an item.

You can also set this
option by using the
Expand member limit
option in the Options
dialog box.

Integer 4000

FormulaDefaultNumeric For explorations, forces a
zero to be returned when
a value is empty in the
result set.

True, False False

FormulaResolution
Paused

Prevents formulas from
triggering a call to the
server.

True, False False

OverrideDoubleClick Overrides the default
double-click action in IBM
Cognos Analytics
formulas.

You can also set this
option by using the
Expand with double-
click option in the Options
dialog box.

True, False True

RequestFormat Specifies the format to
use when loading IBM
Cognos Analytics
explorations. You can also
set this option by using
the Request format
option in the Properties
dialog box for Exploration
Views.

CSV: Unformatted,
removes data formatting
from the model

rawXML: Formatted

rawXML
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Settings that apply only to reports that use IBM TM1 datasources

Table 6. Settings that apply only to reports that use IBM TM1 datasources

Name Description Allowed values Default value

ActionButtonBackupDir Sets the default directory
for backing up workbooks
when upgrading action
buttons.

Path C:\Users\<User>\Desktop

ActionButtonLogDir Sets the default directory
for saving the logs when
upgrading action buttons.

Path C:\Users\<User>\Desktop

AllowContextSum Enables you to select a
sum of items for context
dimensions in Exploration
Views.

In an Exploration View,
click the drop-down for a
dimension in the context
area and click Sum.

True, False True

AutoSpread
ConsolidatedInput

Converts values entered
in consolidated cells into
proportional spread
operations.

True, False True

BulkUploadAutoCommitV
alid

Commits values in valid
intersections of a Quick
Report automatically,
without validating the
values first.

You can also turn this
feature on or off by using
the Automatically
commit valid
intersections option in
the Error Report dialog
box.

True, False True

cellSetMaxSize Sets the upper bound limit
on the size of cellset
resolution attempts from
a client. Client operations
exceeding the limit during
processing are terminated
and a
DataLimitExceededEx
ception error level log is
produced.

Positive signed Int32 Zero (auto)
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Table 6. Settings that apply only to reports that use IBM TM1 datasources (continued)

Name Description Allowed values Default value

DefaultExpandDirection Sets the direction to
expand when you double-
click in an Exploration
View or list.

You can also change this
setting by using the
Expand Direction option
in the Properties dialog
box for Exploration Views
and lists.

EXPAND_ABOVE: Expands
child members above
their parent.

EXPAND_BELOW:
Expands child members
below their parent.

EXPAND_ABOVE

Expansions Defines macros for data
entry: k, m, q, or user-
defined. These macros are
applied to a value before it
is committed to the TM1
server.

A JSON expression {{"TM1": {"k":"1000",
"m":"1000000",
"q":".001"}}}}

FlexviewDefaultIndentOn Sets Quick Reports to
indent by default.

True, False True

FlexViewDoubleClickActio
n

Defines the double-click
action for Quick Reports.
You can also set this
option by using the
Double-click action
option in the Options
dialog box.

None: This allows the
normal Excel behavior to
occur, which is to edit the
cell.

ExpandAbove: Double
clicking a consolidated
member expands the
children above their
parent.

ExpandBelow: Double
clicking a consolidated
member expands the
children below their
parent.

Replace: Double clicking
any member displays the
set editor, which you can
use to replace the
member.

None

IncludeControlObjects Displays the control cubes
of a TM1 datasource in the
Select Package dialog
box. You can select a cube
and use it to create
reports.

True, False False

IncludeProcesses Shows the processes in
the metadata tree.

True, False False
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Table 6. Settings that apply only to reports that use IBM TM1 datasources (continued)

Name Description Allowed values Default value

MapAddedRowColumnSty
le

Sets the style to apply
when you extend a Quick
Report by adding rows or
columns.

NoStyle: No styles are
applied to the extended
values

ServerStyle Apply server
styles to the extended
values

LastRowColumnStyle:
Apply the style of the
previous row or column to
the extended cells

NoStyle

MapHotRefreshEnabled Enables the Use Type-in
Refresh option for Quick
Reports.

You can also turn this
feature on or off by using
the Use Type-in Refresh
option in the Properties
dialog box for Quick
Reports.

True, False False

MapUseMergeAreas Allows the user to use
merged cells along the
axes of Quick Reports.

True, False False

PreserveFormulas Preserves user formulas
in an exploration or Quick
Report when you commit
data.

Attention: If this
option is set to
False, any
formulas that you
add to an
Exploration View
or Quick Report
are discarded
when you commit
data.

You can also turn this
feature on or off by using
the Preserve user
formulas option in the
Options dialog box.

True, False True

PromptUncommitted
Changes

When you refresh,
prompts you to confirm
before uncommitted
changes are lost.

True, False True
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Table 6. Settings that apply only to reports that use IBM TM1 datasources (continued)

Name Description Allowed values Default value

RefreshOnExcelHotkeys Refreshes data on Excel
recalculation keys (F9,
Shift F9). User needs to
restart Excel after change.

True, False False

RefreshOnWriteBack Refreshes data on
writeback. The user can
define whether the data in
the workbook or
worksheet is refreshed.

None

Workbook: Refreshes data
in the workbook on
writeback.

Worksheet: Refreshes
data in the worksheet on
writeback.

None

SetEditorPreviewOn Shows set members in the
Selection pane (Hierarchy
mode) of the Subset
Editor instead of the set
definition (Definition
mode).

You can toggle the display
in the Selection pane
using the View Set
Contents and View Set
Definition buttons.

True, False True

SetRebuildOptionOnSlice Sets the
TM1RebuildOption
variable. This variable
causes the worksheets in
the book to be rebuilt on
opening (which forces a
recalculation to happen
on each sheet in the
book).

True, False False

UseGzipUpload Enables Gzip compression
for data uploaded to TM1.

True, False True
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Chapter 6. Work with data and reports
Learn about the different report types available to you and the ways you can work with them to analyze
your data.

You can make changes to your reports by retrieving data and overriding any previous changes, removing
data, or converting dynamic data to static data to prevent future updates from the servers. You can also
share your reports with other users.

When you work with data from the IBM TM1 server, you are also able to write back data to the TM1 cube.

Change the hierarchy
You can change the hierarchy that's being used in your report.

If your dimension contains multiple hierarchies, you can use the set editor or Cube Viewer to change the
hierarchy that's being used in your report. For example, if you're working with an Exploration View, you
can edit sets and use members from another hierarchy if the dimension that the Exploration View uses
contains alternate hierarchies.

You can change the hierarchy for all members of an Exploration View and for context members of a Quick
Report.

1. Open the set editor or Cube Viewer.
2. Click the hierarchy name to open the Select hierarchy menu.
3. Select the hierarchy which contains the set and members that you want to use in your report.

Note: You may notice that some hierarchies cannot be selected. Disabled selections indicate that the
hierarchy is currently in use in your active report. You can only change to a hierarchy that is not in use
in your report.

4. Click Apply and close.

After you click Apply and close, your report is automatically refreshed to reflect the change in
hierarchies.

Clearing data
You can clear data from the cells in an exploration, cell-based report, or in a Quick Report.

What does clearing data do?
When you clear data, the cleared cells remain as blank cells on the worksheet.

Formats, such as number formats, conditional formats, and borders are retained. Clearing the content
does not break the link to the datasource.

Why would I want to clear data?
You might want to clear the data before you share a report so that

• Report consumers are required to refresh data to obtain recent changes from the data source.
• Report consumers are authenticated before they are able to view report content.

Can I automate the clearing of data?
You can also automate this task by using the ClearAllData method. For more information, see https://
ibm.github.io/paxapi/#clearalldata .
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Can I restore the data that I have cleared?
To restore the data that you have cleared, you need to refresh the data. For more information, see
“Refresh data” on page 93.

Note: Some values may be visible in a published workbook, even if the values were cleared. This may
occur if the values were cleared and published from an older version of Microsoft Excel, and opened in a
newer version of Microsoft Excel. Cleared data is visible in this scenario because opening a workbook in a
newer version of Microsoft Excel triggers a recalculation, which includes a refresh of the IBM TM1 data.
The data is authenticated with the credentials of the user that opens the workbook.

Clearing all data from a workbook
You can clear all data in a specific workbook or in all workbooks in IBM Planning Analytics for Microsoft
Excel.

When you clear data, the cleared cells remain as blank cells on the worksheet. Formats, such as number
formats, conditional formats, and borders are retained. Clearing the content does not break the link to the
datasource.

You can clear data in a workbook either by using the IBM Planning Analytics ribbon or the right-click
menu.

Clear all data in a workbook from the IBM Planning Analytics ribbon
You can use the Clear All Data icon in the IBM Planning Analytics ribbon to clear all data in your workbook.

Procedure
1. Click the IBM Planning Analytics tab to open the IBM Planning Analytics ribbon.

2. Click the Clear icon .
3. Click Clear Book to clear all data from the single workbook.
4. Click Clear All Books to clear all data from all workbooks.

Clear all data in a workbook from the right-click menu
You can use the right-click menu in Planning Analytics for Microsoft Excel to clear all data in your
workbook.

Procedure
1. Right-click any cell on a worksheet.
2. Click IBM Planning Analytics.
3. Click Clear data.
4. Click Clear workbook.

Clearing all data in a worksheet
You can clear all data in a specific worksheet in IBM Planning Analytics for Microsoft Excel.

When you clear data, the cleared cells remain as blank cells on the worksheet. Formats, such as number
formats, conditional formats, and borders are retained. Clearing the content does not break the link to the
datasource.

You can clear data in a worksheet either by using the IBM Planning Analytics ribbon or the right-click
menu.
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Use the right-click menu to clear all data in a worksheet

About this task
You can use the right-click menu in Planning Analytics for Microsoft Excel to clear all data in your
worksheet.

Procedure
1. Right-click any cell in the worksheet you want to clear data from.
2. Click IBM Planning Analytics.
3. Click Clear data.
4. Click Clear worksheet.

Use the IBM Planning Analytics ribbon to clear all data in a worksheet

About this task
You can use the IBM Planning Analytics ribbon to clear all data in your worksheet.

Note: This method cannot be used for Dynamic Reports or Custom Reports.

Procedure
1. Click the IBM Planning Analytics tab.
2. Locate the Data ribbon group.
3. Click Clear.
4. Click Clear Sheet.

Results
The data in the worksheet is cleared.

Clearing all data from a cell-based report
You can clear all data from a specific cell-based report.

About this task
Use the right-click menu to clear all data from a specific cell-based report.

Note: The Clear Data command does not clear data from Dynamic Reports or Custom Reports.

Procedure
1. Right-click any cell in the worksheet containing the cell-based report that you want to clear data from.
2. Click IBM Planning Analytics.
3. Click Clear data.
4. Click Clear worksheet.

Clearing data from a specific cell
You can clear all data from a specific cell.

About this task
Use the right-click menu to clear data from a specific cell.
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Procedure
1. Right-click a cell or range of cells.
2. Click IBM Planning Analytics.
3. Click Clear Data.
4. Click Clear Selected Cells.

Common View Specification
You can use a Common View Specification to embed additional state information in your Exploration View
or Quick Report.

A Common View Specification (CVS) is a JSON that can be used to embed additional state information
when creating an Exploration View or Quick Report. A CVS is composed of two major parts; the MDX query
and a sidecar for additional state information. Data driven mechanisms, such as TurboIntegrator are only
concerned with the MDX query, however user interfaces will also consume the sidecar to ensure
presentation consistency. By using a CVS, you can generate highly customizable Exploration Views or
Quick Reports. For example, using a CVS, you can define aliases and subsets as per the CVS schema input.

To generate an Exploration View or Quick Report from a CVS, use the CreateFromCVS API method. For
more information, see CreateFromCVS (Exploration View) and CreateFromCVS (Quick Report).

The following is the schema for a Common View Specification.

/*!
 * Licensed Materials - Property of IBM
 * © IBM Corp. 2021. All Rights Reserved.
 * US Government Users Restricted Rights - Use, duplication or
 * disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
 */
{
    "$schema": "http://json-schema.org/draft-06/schema#",
    "title": "IBM Planning Analytics Universal View Specification",
    "type": "object",
    "required": ["MDX"],
    "additionalProperties": false,
    "properties": {
        "MDX": {
            "type": "string"
        },
        "Meta": {
            "type": "object",
            "additionalProperties": true,
            "properties": {
                "Aliases": {
                    "type": "object",
                    "additionalProperties": false,
                    "patternProperties": {
                        "^\\[.+\\]\\.\\[.+\\]$": {
                            "type": "string"
                        }
                    }
                },
                "ExpandAboves": {
                    "type": "object",
                    "additionalProperties": false,
                    "patternProperties": {
                        "^\\[.+\\]\\.\\[.+\\]$": {
                            "type": "boolean"
                        }
                    }
                },
                "ContextSets": {
                    "type": "object",
                    "additionalProperties": false,
                    "patternProperties": {
                        "^\\[.+\\]\\.\\[.+\\]$": {
                            "type": "object",
                            "additionalProperties": false,
                            "properties": {
                                "Expression": {
                                    "type": "string"
                                },
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                                "SubsetName": {
                                    "type": "string"
                                },
                                "IsPublic": {
                                    "type": "boolean"
                                }
                            },
                            "oneOf": [
                                {
                                    "required": ["Expression"]
                                },
                                {
                                    "required": ["SubsetName"]
                                }
                            ],
                            "dependencies": {
                                "IsPublic": "SubsetName"
                            }
                        }
                    }
                }
            }
        }
    }
}

Convert dynamic data to snapshots (static data)
If you modify a workbook, worksheet, or exploration that you do not want to update with changes from
the content store, you can convert the dynamic data items to snapshots (static data) by disconnecting
from the data source.

When you convert dynamic data to snapshots, any query-related information, such as calculations and
filters, is removed but the data values are preserved.

Convert all reports
To convert all reports in a workbook to a snapshot, on the toolbar, click Snapshot > Convert Book to
Snapshot.

Convert a worksheet
To convert a worksheet to static data, right-click a cell and click IBM Planning Analytics > Convert to
snapshot > Convert worksheet to Snapshot.

Convert a cell or range of cells
To convert a cell or range of cells to static data, right-click a cell or a range and click IBM Planning
Analytics > Convert to snapshot > Convert Selected Cells to Snapshot.

Convert data in reports
To convert data in reports, follow these steps:

• For an Exploration View or list, in the source tree, expand Current Explorations. Right-click the
Exploration View or list and click Convert to snapshot. Or, to convert all Exploration Views and lists,
right-click the Current Explorations folder and click Convert all to Snapshots.

• For a Quick Report, in the source tree, expand Quick Reports. Right-click the Quick Report and click
Convert to snapshot. Or, to convert all Quick Reports, right-click the Quick Reports folder and click
Convert to snapshot.

• For Custom Reports, Dynamic Reports, and cell-based reports, right-click any cell in the report, click
IBM Planning Analytics > Convert to snapshot > Convert worksheet to Snapshot.

Constrained Calculations
You can use Constrained Calculations to narrow the scope of the recalculations. For information on how to
enable Constrained Calculations, see Manually enabling features in the tm1features.json file(https://
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www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
r_pax_tm1features.html) .
Why does my data get recalculated?

Normally, when you refresh your worksheet, IBM Planning Analytics for Microsoft Excel will
recalculate all data that is flagged as "dirty" in your workbook. Planning Analytics for Microsoft Excel
recalculates this data in an attempt to ensure maximum data coherency.

Maximum data coherency
When you refresh a worksheet, Planning Analytics for Microsoft Excel will dirty the requested sheet,
and then recalculate any dirty data in your workbook. This is in an attempt to ensure maximum data
coherency at rest.
If you have other content in your workbook that is flagged as dirty, ensuring maximum data coherency
may have a performance cost, as any dirty content will have to be recalculated.
For more information on data coherency and dirty data, see “Data coherency” on page 86.

What does Constrained Calculations do?
You can use Constrained Calculations to limit the recalculations strictly to the specified worksheet.
Because Planning Analytics for Microsoft Excel is only recalculating the single worksheet, you may
notice improved performance when refreshing a single worksheet. Other content in your workbook
that is flagged as dirty will not be recalculated if you use Constrained Calculations.

Why do my cells show RECALC_###?
Cells with unfinished calculations may display RECALC_###. Complete the refresh of any worksheets
that contain RECALC_### to update those cells with data.
If your Calculation Options is set to Manual, then RECALC_### is the expected response for any
triggered formula-based report content until a refresh gesture is performed.
If your Calculation Options is set to Automatic and you use Constrained Calculations, RECALC_###
may occur if there are any other sheets invalidated beyond the sheet being refreshed. This can
happen due to formula references to that sheet.

Which gestures will prompt a calculation with Constrained Calculations enabled?
With Constrained Calculations enabled, gestures such as Refresh Sheet and Rebuild Sheet will
prompt a calculation. For a full list of gestures that will prompt a calculation with Constrained
Calculations enabled, see “Actions that prompt a Constrained Calculation” on page 78.

Usage Notes
If your Calculation Options is set to Manual, it is acceptable to have shared report drivers referenced
directly, since constrained manual calculation fully limits all costs.
If your Calculation Options is set to Automatic, it is suggested to use decoupled drivers, with Action
Buttons to propagate driver information across the workbook instead of direct references. This is
because under automatic recalculations, Microsoft Excel will still attempt to do the initial processing
of any dirty content. Constrained Calculation will not change Excel behavior.
As of Planning Analytics for Microsoft Excel version 2.0.41, the benefits of Constrained Calculations
will be most noticeable if your worksheet does not contain volatile functions or persistently dirty data.
If the worksheet that you are restricting the recalculation scope to contains volatile functions or
persistently dirty data, Planning Analytics for Microsoft Excel may need to recalculate any sheets that
it shares dependencies with.

Actions that prompt a Constrained Calculation
With Constrained Calculations enabled, there are a number of actions that you can use to prompt a
calculation. This topic outlines the different actions that you can use in IBM Planning Analytics for
Microsoft Excel.

IBM Planning Analytics ribbon
From the IBM Planning Analytics ribbon, you can prompt a calculation with Constrained Calculations
enabled with any of the following actions:
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• Refresh Sheet
• Rebuild Sheet
• Clear Sheet

IBM Planning Analytics context menu
You can access the context menu by right-clicking inside of your report, then clicking IBM Planning
Analytics. From the context menu, you can perform any of the following actions to prompt a calculation:

• Refresh > Refresh selected cells.
• Refresh > Refresh worksheet.
• Clear data > Clear selected cells (for Exploration Views, list views, and Quick Reports only).
• Clear data > Clear worksheet (for Exploration Views, list views, and Quick Reports only).

Data tree
From the Workbook tab in the Task Pane, you can prompt a calculation with Constrained Calculations
enabled with any of the following actions:

• Explorations > Right-click a sheet > Refresh data.
• Explorations > Right-click a sheet > Clear data.
• Quick Reports > Right-click a sheet > Refresh data.
• Quick Reports > Right-click a sheet > Clear data.
• Dynamic Reports > Right-click a sheet > Refresh.
• Dynamic Reports > Right-click a sheet > Rebuild.
• Dynamic Reports > Right-click a sheet > Recreate.

Hot keys
Using hot keys, you can refresh a sheet with Constrained Calculations enabled using any of the following
actions:

• Shift + ALT + 9: Refreshes the sheet and constrains the calculation.
• Shift + F9: Refreshes the sheet, but only constrains the calculation if you have the Refresh data on

Excel recalculation Keys (F9, Shift F9) setting enabled. For more information on this setting, see “IBM
Planning Analytics settings” on page 48.

Note: You can also create macros that are linked to a user-defined function that will perform a
constrained calculation.

Converting a report
You can convert an Exploration View to another report type in IBM Planning Analytics for Microsoft Excel.

When you convert a report from an Exploration View, you can decide whether or not your converted
reports use stylesheet formatting. In the Exploration ribbon group, select Use Excel Formats to convert
reports using stylesheet formatting. Select Use Server Formats to convert reports using the server
formats.

Converting to a Quick Report using TM1 data
Create a Quick Report from an IBM TM1 Exploration View when you finish your analysis and want to
present data by using more advanced cell-based features from Microsoft Excel.

When you convert Exploration Views to Quick Reports the application places the system information,
rows, and columns in named ranges.

Chapter 6. Work with data and reports  79



If you have views, explorations, or other Quick Reports available in the Task Pane, you can drag these to a
worksheet to create a Quick Report. For more information, see “Create a Quick Report” on page 119.

1. Open or create an Exploration View.
2. Click Convert to and select an option. For example, to create the Quick Report on a new worksheet,

select Convert to > Quick Report > On New Sheet.

After the report is converted, the Quick Report is listed in the Task Pane > Workbook tab in the Quick
Reports folder.

Note: Calculations created in an Exploration View need to be recreated in Microsoft Excel after converting
to a Quick Report.

Converting to a Custom Report using TM1 data
Convert a TM1 Exploration View to a Custom Report when you want to manipulate individual cells. You
can use data from multiple data sources in a Custom Report.

You can also create a Custom Report completely from scratch using the cell-based method.

• You cannot convert an Exploration View to a Custom Report if the Exploration View contains alternate
hierarchies.

• The Exploration View must also have at least one row or column dimension.
• Text values in formulas are limited to 255 characters. To create text values longer than 255 characters

in a formula, use the CONCATENATE function or the concatenation operator ( & ).

When you convert an Exploration View, you have the option of converting data on the current worksheet,
copying and moving the data to a new worksheet, or specifying the location for the converted data.

In the converted report, context members are defined by SUBNM formulas. Data cells are defined by
DBRW formulas. You can modify these formulas by double-clicking the cells.

1. Go to the worksheet that contains the Exploration View that you want to convert.
2. Click Convert to > Custom Report and select an option.

a. To convert the Exploration View to formulas and place the result on the current worksheet, select
On This Sheet.

b. To convert the Exploration View to formulas and place the result on a new worksheet, On New
Sheet. By placing the results on a new worksheet, you preserve the original Exploration View.

c. To convert the Exploration View to formulas and specify the location, which is a cell in an existing
spreadsheet, select At Specified Location.

After the report is converted, the drop zones disappear. The formatting remains the same, but the cells of
the Exploration View contain TM1 formulas, which link the individual cells to data in the cube. An
information area above the Custom Report shows the context members of the report.

You can continue to modify the worksheet by editing formulas and applying formatting.

Converting to a Custom Report using Cognos Analytics data
Convert an Exploration View to a Custom Report when you want to manipulate individual cells or place
columns or rows in between the imported data.

When you convert an Exploration View, you have the option of converting data on the current worksheet,
copying and moving the data to a new worksheet, or specifying the location for the converted data.

Before you convert an Exploration View to a Custom Report, note the following restrictions:

• You cannot convert data from relational sources to a cell-based analysis.
• Text values in formulas are limited to 255 characters. To create text values longer than 255 characters

in a formula, use the CONCATENATE function or the concatenation operator ( & ).
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It is also possible to convert your Custom Report to an Exploration View. Click a cell and then click IBM
Planning Analytics > Explore. Depending on how your columns and rows are set up and how many items
are in each, you may notice that certain objects are added to the context drop zone instead of being
placed in a row or column.

If the default measure is also on columns, you cannot convert an Exploration View to formulas. You must
first remove the default measure. For more information, see “Remove measures” on page 208.

1. Open the workbook with the Exploration View you want to convert.
2. In the IBM Planning Analytics tab, click Convert to.
3. Choose where to place the converted data:

a. To convert the Exploration View to formulas and place the result on the current worksheet, click On
This Sheet .

b. To convert the Exploration View to formulas and place the result on a new worksheet, from the
exploration bar, click Convert to Formulas > On New Sheet . By placing the results on a new
worksheet, you preserve the original Exploration View used to create the analysis and can use it
again to change parameters for another analysis.

c. To convert the Exploration View to formulas and specify the location, which is a cell in an existing
spreadsheet, from the exploration bar, click Convert to Formulas > At Specified Location .

After the report is converted, the drop zones disappear. The formatting remains the same, but the cells of
the report contain formulas, which link the individual cells to data items in the database.

You can continue to modify the worksheet by editing formulas and applying formatting. By default, data is
updated when you edit a formula. To edit formulas without data updates, right-click the worksheet and
select IBM Planning Analytics > Pause formula resolution. When you are ready to show data, right-click
the worksheet and select IBM Planning Analytics > Run formula resolution.

Copy and move worksheets
You can copy or move worksheets that contain reports based on IBM TM1 data. You can copy or move
worksheets within a workbook or between workbooks.

Before you begin
If you want to copy a worksheet that contains a Quick Report, start IBM Planning Analytics for Microsoft
Excel before you copy or move the worksheet.

You can only copy one Quick Report at a time. Copying multiple Quick Reports at a time may cause
unexpected behaviors.

Note: Exploration Views cannot be copied and moved.

Procedure
1. Go to the worksheet that you want to move or copy.
2. Right-click the worksheet tab and click Copy.
3. Copy the worksheet.

For more information, see the Microsoft Excel online help.

Creating customized report themes
IBM Planning Analytics for Microsoft Excel uses Excel styles to format reports. It's why you see a
consistent visual theme when you create your reports. With some modifications, you or your organization
can create and deliver unique and customized themes in your reports.
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Getting started
The Excel styles that are used by Planning Analytics for Microsoft Excel are generated and stored in an
external file. Get started by accessing the styles.

1. Navigate to your Planning Analytics styles directory: C:\Users\<User>\AppData\Local\Cognos
\Office Connection\Styles

2. Open Styles_CAFE.xlsx.

Note: Ensure that Planning Analytics for Microsoft Excel is not loaded.
3. Open Microsoft Excel.
4. From the Home tab, in the Styles section, click More.

The Microsoft Excel Styles window is opened and you are presented with all of the available styles.

Customizing a style
You can customize styles for your columns, rows, and measures.

1. Open the Microsoft Excel Styles window.
2. Right-click the style that you want to customize. For more information on which Excel styles to

customize, see “Microsoft Excel styles for Exploration Views, List views, and Quick Reports” on page
84

3. Click Modify....
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4. Click Format.

5. Click the Fill tab.
6. Click Fill Effects....
7. Define the colors and shading styles that you want for your columns, rows, or measures.
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8. Click OK on all of the opened dialog boxes.
9. Save your Styles_CAFE.xlxs file.

10. Restart Microsoft Excel.
11. Start Planning Analytics for Microsoft Excel.
12. Create a new Exploration View, List view, or Quick Report to view your custom style.

Microsoft Excel styles for Exploration Views, List views, and Quick Reports
Exploration Views, List views, and Quick Reports all share a common set of Excel styles. You can edit
these styles to customize the theme of your reports. This topic shows you how different Excel styles
impact your reports.

There are styles for everything from the design of a blank exploration to the shade for data values locked
by TM1. Below is a list of the styles that apply to these report types.
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The following image shows how styles are applied to an Exploration View.
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For more information on how you can use Excel styles to customize the theme of your reports, see
“Creating customized report themes” on page 81.

Data coherency
In IBM Planning Analytics for Microsoft Excel, data is considered coherent if the data in your workbook is
in sync with the data saved in the datasource. If you use partially scoped refresh gestures, you may have
situations where your workbook is not fully coherent. This topic will take you through some of the
scenarios where your workbook may or may not be coherent, as well as explain some of the terms related
to data coherency.
Total data coherency

There is total data coherency if the data in your workbook is in sync with the data saved in the
datasource. The goal of total data coherency is to ensure that the entire reporting content of the
workbook is consistent with the data in the datasource.

Partial data coherency

There is partial data coherency if some of the data in your workbook differs from the data saved in the
datasource. Your workbook can have partial data coherency if you are editing cells or modifying the
workbook and have not yet committed your changes to the datasource. Partial data coherency can
also occur if the data in the datasource changes and you have not refreshed your workbook to reflect
the changes, or have refreshed only a part of your workbook.

Partial data coherency is also likely to occur if you employ Constrained Calculations. For more
information on Constrained Calculations, see “Constrained Calculations” on page 77.
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"Dirty" data
Spreadsheet content is flagged as "dirty" by the Excel runtime whenever you make any changes, such
as editing cells or modifying the workbook. Data in a worksheet may also be flagged as dirty if it has
dependencies on calculations in another worksheet. If the calculations are changed or recalculated,
but the data in the worksheet is not recalculated, the data is flagged as dirty.

"Clean" data
The dirty flag is cleared by the Excel runtime when the relevant spreadsheet content if finally
calculated, and if there are no outstanding recalculations that need to be performed.

Calculation Options
If your Calculation Options in Microsoft Excel is set to Manual, you may observe a "CALCULATE"
message in the Microsoft Excel status bar. The "CALCULATE" message appears if there is any active
content that is still flagged as dirty.
If your Calculation Options in Microsoft Excel is set to Automatic, Microsoft Excel will attempt to
recalculate any dirty content whenever it is encountered.

Design Mode
Design Mode is a handy tool that can be used to enable or disable the refreshing of an Exploration View
upon every change. You can also use Design Mode to preserve or clear DBRW formulas when you are
copying and pasting values into cells.

How to enable or disable Design Mode

You can find the Design Mode  icon in the Data group of the IBM Planning Analytics ribbon.

Click the Design Mode icon to enable or disable Design Mode.

Use Design Mode to enable or disable the automatic refresh of an Exploration View
In an Exploration View, Design Mode prioritizes the structure of the Exploration View.

When Design Mode is on, you must manually refresh your Exploration View to populate the data
intersections.

When Design Mode is off, the Exploration View is refreshed automatically when it is changed.

Preserve or clear DBRW formulas when you are pasting values into cells
When Design Mode is on, you can copy and paste values into cells and clear any DBRW formulas in those
cells.

When Design Mode is off, you can preserve the DBRW formulas when you are copying and pasting into
cells that contain DBRW formulas.
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Find items in the source tree
The data source or package that you select might contain large amounts of data. You can use several
techniques to find the items in the source tree that you need.

You can do the following:

• Expand a dimension to see successive levels and details
• Specify a greater or lesser number of items to show in the source tree
• Search for items

By default, the source tree shows 50 items for any one dimension at a time. You can change this value to
increase or decrease the number of items displayed. Depending on the size of the data source, you might
want to set a smaller value to improve performance. For more information, see “Member display count
limit” on page 48.

If you are using a IBM Planning Analytics data source and the number of members in the dimension is
greater than the member display limit, a More icon is displayed. If you click More, more members are
displayed. For example, if the member limit is 25 and you click More, another 25 members are displayed.

If you are using a IBM Cognos Analytics package and there are more than the specified number of items in
the dimension, a Search icon is displayed. If you click Search, you can enter your search criteria to find
the items that interest you.

Search for members in an IBM Planning Analytics with Watson data source
When the source tree displays an IBM Planning Analytics with Watson data source, you can search for
members in the data source by name or by attribute values.

Procedure
1. In the source tree, select a hierarchy or member.

• To search all members in a hierarchy, select a hierarchy.
• To search a member and its descendants, select a member.

2. Right-click the hierarchy or a member, and click Search metadata.
3. Define the search criteria.

To add search criteria, click the plus sign at the end of the search criteria row. To delete a search
criteria, click the minus sign at the end of the row.

4. Click Apply.
The search results are displayed. You can drag members from the search results list to the work area.

5. After you finish your search, click OK.

Example

Suppose that you want to create an Exploration View that shows all Sedan car models that are also leaf
members. You want these members to be displayed in the rows of your Exploration View.

1. Open PriceCube on the SData server.

Note: SData is a sample TM1 Server Application folder that is provided with TM1. PriceCube is a
sample cube that contains a Model dimension.

2. Create a blank Exploration View.
3. In the source tree, expand the Model dimension.
4. Right-click the model hierarchy and select Search metadata.
5. Create the search criteria.

• Select Name, Contains, and type Sedan.
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• Click the plus sign to add another row.
• Select Level, =, and enter 0.

Name Contains Sedan
Level = 0

6. Click Apply. The results are displayed.
7. Select all the members that are returned by your search.
8. Drag the members to the Rows drop zone in the Exploration View.

The rows of your Exploration View now display Sedan car models that are leaf members in the Model
dimension.

Search for items in an IBM Cognos Analytics package
When the source tree displays a package, you can search for items in the package by name.

Searching is limited to the immediate details of the selected item. In DMR packages, you can search only
one level down. For example, if searching for Star Dome Tent, you must select Tents and not Products to
perform your search.

In packages based on a cube, you can search in all descendants.

For information about searching for members in a IBM Planning Analytics data source, see “Search for
members in an IBM Planning Analytics with Watson data source” on page 88.

Procedure
1. In the source tree, click a dimension, hierarchy, or level, and click Search metadata.
2. In the Words box, type the words or characters for which you want to search.
3. In the Options box, click the search parameter you want to use.
4. If you want to perform a case-sensitive search, select the Match case check box.

If the database does not support this feature, it is disabled.
5. In the Search In box, click the level in which you want to search.
6. Click Search.
7. After you finish your search, click Close.

Results
The search items appear in the Results box. If you do not see the results box, you might need to resize
the dialog box so that all the fields are visible.

Tip: To make it easier to find items, you can specify the number of items to show in the source tree for the
current session. For more information, see “Member display count limit” on page 48.

How level based indents are applied
IBM Planning Analytics for Microsoft Excel supports level based indentations in various report types.
Depending on the report type that you use, you may find that indentations are applied differently.

Level based indentations allow you to easily identify parent-child relationships in rows within your
reports. Indentations are applied differently, depending on the report type that you are using.

Exploration Views
Level based indentations in an Exploration View are applied based on your element's hierarchy level. If
you have asymmetric hierarchies or if you have elements that appear multiple times in a single hierarchy,
but at different levels, you will see level based indentations in your Exploration Views more
predominantly.
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Quick Reports
Like Exploration Views, level based indentations in a Quick Report are also applied based on the hierarchy
level. However, Quick Reports allow you to enable and disable level based indentations. For more
information on how to enable and disable level based indentations in a Quick Report, see “Use level
based indents” on page 62 (https://www.ibm.com/support/knowledgecenter/SSD29G_2.0.0/
com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/t_coi_gt_strtd_level_based_indents.html).

Dynamic Reports
Level based indentations in a Dynamic Report are based on your element's subset level.

Naming conventions
IBM Planning Analytics with Watson has the following naming conventions. Some of these conventions
are enforced.

Although some of these characters are not reserved, it is a good practice to avoid the use of these special
characters in most cases when you name objects and members. For more information, see “Member
names and MDX expressions” on page 91.

Table 7. Special characters to avoid in object and member names

Character Description

’ apostrophe

* asterisk

@ at sign - see “Object names in TM1 rules” on page 92.

\ back-slash

: colon

, comma

{ curly brace - see “The curly brace in object names” on page 91.

" double-quote

! exclamation mark - see “Object names in TM1 rules” on page 92.

> greater-than

< less-than

- minus sign - in member names. See “Member names and MDX expressions” on page
91.

| or ¦ pipe or broken pipe

+ plus sign - in member names. See “Member names and MDX expressions” on page
91.

? question-mark
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Table 7. Special characters to avoid in object and member names (continued)

Character Description

; semicolon

/ slash

~ tilde - see “Object names in TM1 rules” on page 92.

^ caret - see “Member names and MDX expressions” on page 91.

Reserved characters per component
The following characters are explicitly reserved for the following components and must never be used
when you name objects in these contexts:

• TM1 Architect reserves the following characters:

\ / : * ? " < > | } 

• TM1 Server reserves these characters in these objects: Cube, Dimension, Subset, View, Process,
Chores.

\ / : * ? " < > | ' ; ,

• For process variable names, the identifier cannot contain any special characters except for:

AllowableChars[] = ".$%_`";

The curly brace in object names
It is a good practice to avoid the use of the right curly brace (}) as the first character in any user-created
TM1 object name. TM1 control object names always begin with the right curly brace. If a user-created
object name begins with a right curly brace, the object becomes hidden if the Display Control Objects
parameter is turned off.

Member names and MDX expressions
Do not use + or - as the first character of a member name. Although only the first member in a set when
slicing to active form cannot use + or - as the first character in the element name, it is a good practice to
never use + or - as the first character of an member name.

Do not use a ^ in a member name. The ^ character can be used as the delimiter between the ancestor and
multi-parent member's name but when a member name that contains this character is referenced in an
MDX expression, it cannot be escaped.

Although all the other characters available for use in member names are technically not restricted, it is
good practice to avoid the special characters that are listed in the previous table when you name
members.

A member name can contain a right square bracket ( ] ) but when a member name that contains this
character is referenced in an MDX expression, the character needs to be escaped by doubling it. For
example, a member that is named Array[N] Elements, can be referred to in an MDX expression as
[Array[N]] Elements].
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Object names in TM1 rules
Although technically allowed, it is a good practice to avoid using these special characters in object names
because they may conflict when used in a rules expression. This guideline protects you if the objects or
members ever become part of a rule statement where those special characters are not permitted.

• For example, ) | ~ ; @ \ / : * ? " < > are all often found in rules statements and should not be used in
object names.

• The @ is technically not restricted, however it is a good practice to avoid using the @ character in object
names or member names because the @ character is also a string comparison operator in TM1 rules. If
you reference any object with a name that contains the @ character in rules, the object name must be
enclosed in single quotation marks. For example, a dimension named products@location must be
referenced as 'products@location' in rules. Escaping the name with quotation marks does not work in all
cases, so it is best to avoid the use of @ in all cases when naming objects.

• Escaping the special character using quotation marks does not work for ! or in certain rule expressions.
• The exclamation point ! character must not be used in object names because it is also used in rules

expressions. For example:

DB('MarketExchange',!market,!date)

Maximum string length for data directory and object names
The entire string that is represented by the combination of the TM1 Server data directory name and the
object name is limited to 128 bytes. For example, if your data directory is C:\Financial data\TM1\ (22
bytes), object names are limited to 106 bytes, inclusive of a file extension such as .cub or .rux.

Some TM1 objects, such as views, subsets, and applications, are stored in subdirectories of the TM1
Server data directory. In this case, the 128-byte limit is applied to the combination of the TM1 Server data
directory, the subdirectory, and the object name.

Case sensitivity
Object names are not case-sensitive. For example, the dimension name actvsbud is equivalent to
ActVsBud.

Spaces in object names
Spaces are allowed in all object names, but spaces are ignored by the TM1 Server. The TM1 Server
considers the dimension name Act Vs Bud to be equivalent to ActVsBud (or actvsbud).

User names
User names that include reserved characters cannot save private objects.

Preserve or clear DBRW formulas when pasting values into cells
When working with Custom Reports or Dynamic Reports, you can choose how values are copy and pasted
into cells.

When Design Mode is on, you can copy and paste values into cells and clear any DBRW formulas in those
cells.

When Design Mode is off, you can preserve the DBRW formulas when you are copying and pasting into
cells that contain DBRW formulas.

You can copy and paste formula cells in Custom Reports or Dynamic Reports. If Automatic Calculation
Mode is on, you can only paste formulas once. The recalculation that occurs in Automatic Calculation
Mode discards the original formula cell selection and only preserves the value of the cell. If you paste a
formula more than once, the subsequent pastes will only paste the value of the cell.

92  IBM Planning Analytics: Planning Analytics for Microsoft Excel



Tip: If you want to paste a formula multiple times, you need to either turn Automatic Calculation Mode
off, or paste the formulas as the full formula string in order to preserve them across multiple pastes.

Refresh data
If the data in a report is changed, you can refresh the data to ensure that you are working with the latest
data.

About this task
You can refresh your entire workbook, a worksheet, a report, or selected cells.

• To update the entire workbook, on the IBM Planning Analytics tab, click Refresh All Data.

If you choose the Refresh the data only option, the data is refreshed and any user applied formatting is
preserved.

If you choose the Refresh the data and report formatting option, the data is refreshed and the default
formatting is applied. Any user applied formatting is removed.

All worksheets, including Exploration Views, lists, and Custom Reports are updated with the most
recent data.

If you choose to also refresh report formatting, formats are updated.

– Refreshing the report formatting applies only to Exploration Views and lists, and temporarily
overrides the Run with Excel formats option on the Exploration or List toolbar.

– Quick Reports update their formatting based on a per-Quick Report flag to use server formats
(instead of the global flag for explorations) and update formats every time the data is pulled.

– Custom Reports have no dynamic formatting component and use standard Excel formatting.
• To refresh only the current worksheet, right-click any cell on the worksheet, click IBM Planning

Analytics > Refresh > Refresh worksheet.
• To refresh a specific report, follow these steps:

– In an Exploration View or list, click  and select an option.

– In a Quick Report, click .
– For a Dynamic Report, in the source tree, expand Dynamic Reports. Right-click the Dynamic Report

and click Refresh. For more information, see “Refresh, rebuild, or recreate” on page 127.
– For Custom Reports, right-click any cell in the report, click IBM Planning Analytics > Refresh >

Refresh worksheet.
• To refresh only specific cells, right-click a cell or range of cells, click IBM Planning Analytics > Refresh

> Refresh selected cells.

Design Mode
When Design Mode is on, you must manually refresh your Exploration View to populate the data
intersections.

For more information about Design Mode, see Design Mode(https://www.ibm.com/support/
knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.ug_cxr.2.0.0.doc/
c_pax_design_mode.html).

Run Cognos TM1 TurboIntegrator processes
You can run IBM Cognos TM1 TurboIntegrator processes from the IBM Planning Analytics for Microsoft
Excel task pane.

A TurboIntegrator process contains a script of TurboIntegrator functions and commands to
programmatically import data as well as create and modify TM1 objects, such as cubes and dimensions.
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An IBM TM1 administrator creates the TurboIntegrator process and saves the process on an IBM TM1
server. The administrator also assigns security privileges to the TurboIntegrator process. You must have
read access privileges to access the TurboIntegrator process from the task pane in IBM Planning
Analytics for Microsoft Excel. You cannot create a TurboIntegrator process from IBM Planning Analytics
for Microsoft Excel.

Run, monitor, cancel, or change TurboIntegrator process parameters

You can run, monitor, and cancel TurboIntegrator processes directly from the task pane. You can also
change TurboIntegrator process parameters when you run the TurboIntegrator process.

1. Click the Show and hide icon  in the task pane.
2. Ensure that Show processes is selected.
3. Expand Processes in the source tree to see a list of available processes.
4. Right-click a process and then click Run Process to run it.
5. If there are parameters defined for the process, a dialog box containing the parameters will open,

which will allow you to change the process parameters.

Note: A TurboIntegrator process that encounters a major error will roll back instead of committing any
changes. For example, errors such as the data source failing to open or attempting to write to a cube that
doesn't exist are major errors and trigger a rollback.

By default, when a process is running, there is no progress indicator. To monitor the execution of running
processes, right-click Processes, and then click Active Processes. In the Active Processes window you
can monitor process execution, and also cancel running processes.

You can also create an action button that runs a TurboIntegrator process. For more information, see “Run
a process” on page 247.

For more information about TurboIntegrator processes, see the IBM Cognos TM1 TurboIntegrator
documentation.

Share your analysis
Share your analysis to give colleagues an opportunity to view important information or contribute their
own pieces of data.

Several options exist for storing and distributing IBM Planning Analytics for Microsoft Excel-enabled
workbooks.

Publish a workbook to a TM1 Server Application folder
You can publish workbooks that contain TM1 reports to a TM1 Server Application folder. You can publish
lists, Exploration Views, Quick Reports, Dynamic Reports, and Custom Reports. Publish a workbook to
share it with other users.

This video demonstrates how to publish a workbook: https://youtu.be/L4Run7-rsb8

About this task
When you publish a workbook, it is saved under the TM1 Server Application folder. The workbook can
then be opened in TM1 Web and in IBM Planning Analytics Workspace.

By default, workbooks are published as private, unless you publish the workbook to a public folder or
change the workbook from private to public. Private workbooks are available only to you. Public
workbooks are available to users who have access permissions to the TM1 Server Application folder
where you published the workbook.

Note: Public workbooks can be viewed only by users with sufficient data access and security permissions.
If you are unable to view a public workbook or if another user is unable to view your public workbook,
have your administrator review the data access and security(https://www.ibm.com/support/
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knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.prfmdl_ug.2.0.0.doc/
c_prfmdl_data_access_and_security.html) permissions for their user groups.

Lists and Exploration Views are displayed as static websheets in TM1 Web and IBM Planning Analytics
Workspace. Data is not read from the TM1 Server Application folder and so doesn't change when the data
on the server changes.

Custom Reports, Quick Reports, and Dynamic Reports are displayed as live websheets. A live websheet
maintains its connection to the TM1 Server Application folder. If the data on the server changes, the live
websheet reflects the change.

You can use subfolders to organize workbooks. You can rename or delete folders and workbooks that you
created.

For example, you can publish a workbook that is called Budget Plan to a TM1 Server Application folder
called Planning Sample in a folder called Budget. In TM1 Web, you can open the budget plan report by
connecting to the Planning Sample server and browsing to Applications > Budget. The workbook is
displayed in TM1 Web as a static websheet.

Note: For information about publishing a worksheet to a IBM Cognos Analytics system, see “Publish an
exploration to IBM Cognos Connection” on page 96.

Procedure
1. On the IBM Planning Analytics tab, click Publish.
2. Select a TM1 connection.
3. Select a TM1 Server Application folder.
4. Select a folder or create a new folder.
5. Type a name for the workbook.
6. Optional: Enter a description.
7. Click Publish.

By default, newly saved workbooks are private. Right-click the workbook in the Publish dialog box and
click Make Public to make the workbook public.

Publish a workbook to IBM Cognos Connection
Publish your IBM Planning Analytics for Microsoft Excel-enabled workbooks to IBM Cognos Connection to
share them with other users in a secure and centrally managed way. Users can refresh the data based on
their user authentication privileges in IBM Cognos Analytics.

You can also automate this task by using the Publish method. For more information, see https://
ibm.github.io/paxapi/#publish .

If users do not have IBM Planning Analytics for Microsoft Excel installed, they can view the document and
its contents, but they cannot refresh the data or update the contents.

For information about publishing TM1 workbooks to a TM1 Server Application folder, see “Publish a
workbook to a TM1 Server Application folder” on page 94.

Procedure
1. Open the workbook.
2. Choose whether you want to save your workbook with recent data:

• To save the workbook with the most up-to-date data, on the IBM Planning Analytics tab, click

Refresh All Data .

• To save the workbook as a template without data, on the IBM Planning Analytics tab, click Clear ,
then choose the appropriate option.
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3. On the IBM Planning Analytics tab, click Publish .
4. If prompted, click your namespace and type your user name and password.
5. In the Look in box, click the IBM Cognos Analytics system where you want to publish the workbook.
6. Choose the type of folder in which you want to save the workbook:

• To save the workbook in a public folder, click Public Folders.
• To save the workbook in a private folder, click My Folders.

7. In the Name box, type the name of your workbook.
8. If you want, in the Description box, type a description for the workbook.
9. Click Open.

Results
The workbook is published to IBM Cognos Connection.

Publish an exploration to IBM Cognos Connection
Publish your Exploration View or list to IBM Cognos Connection to make it available to other users.

Only the exploration in the currently active worksheet is published to IBM Cognos Connection.

For information about publishing workbooks to a IBM Cognos Analytics server, see “Publish a workbook to
IBM Cognos Connection” on page 95.

Before you begin
Your system administrator must first give you the capability to publish reports to IBM Cognos Connection.

Procedure
1. Create and save your workbook.
2. Go to the tab that contains the exploration that you want to publish.

3. On the IBM Planning Analytics click Publish .

The Publish dialog box is displayed.
4. In the Connection box, click the system where you want to publish the exploration.
5. Choose the type of folder in which you want to save the exploration:

• To save the exploration in a public folder, click Public Folders.
• To save the exploration in a private folder, click My Folders.

6. In the Name box, type a name.

The default is the name of the saved workbook.
7. In Description box, type a description for this report.
8. Click Open.

Results
The exploration is saved to IBM Cognos Connection.

Work with dimensionally modeled relational (DMR) and OLAP data
For IBM Planning Analytics for Microsoft Excel, data items are organized hierarchically. Dimensional data
sources include OLAP data sources and dimensionally modeled relational (DMR) data sources. The source
tree provides a hierarchical-based view of the data.
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Note: The names of levels and members in a dimension come from the model. It is the responsibility of
the modeler to provide meaningful names.

1. Package

Packages are subsets of a model, containing items that you can insert in a report.
2. Dimension

Dimensions are broad groupings of descriptive data about a major aspect of a business, such as
products, dates, or markets. The Information dimension includes additional objects, such as System
Name and Package Name that you can also drag into the worksheet.

Tip: Ensure that all of the dimensions that you use in a report are from the same cube that was used to
create the report. Using dimensions from outside of this cube can cause object reference errors.

3. Level hierarchy

Level hierarchies are more specific groupings within a dimension. For example, for the Years
dimension, data can be organized into smaller groups, such as Years, Current Month, and All Dates.

4. Members folder

Members folders contain the available members for a hierarchy or level. For example, the Members
folder for the Years level hierarchy contains everything found in the Year, Quarter, and Month levels.

5. Level

Levels are positions within the dimensional hierarchy that contain information at the same order of
detail and have attributes in common. Multiple levels can exist within a level hierarchy, beginning with
a root level. For example, the Years level hierarchy has the following related levels.

Table 8. Example of related levels for the Years level hierarchy

Level Level name Description

Root Years The root level.

First Year Years in the Years root level. For
example, 2004, 2005, and
2006.

Second Quarter Quarters for each year in the
Year level. For example, 2004
Q1, 2004 Q2, and 2004 Q3.

Third Month Months for each quarter in the
Quarter level. For example, Jan,
Feb, and Mar.

Note: The Measures dimension, which is not shown in the table, contains the measures available in
the data source.
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Chapter 7. Explore TM1 data
Create, explore, and share views and reports using TM1 data. You can also use TM1 functions, sets, and
modify TM1 data for your reports.

Exploration Views and lists
Use Exploration Views and lists to quickly change how you view performance measures and to show
detailed information from your database in rows and columns.

To explore IBM TM1 data by using an Exploration View or list, select an IBM Planning Analytics data
source and choose items from that data source to place in the rows and columns of the Exploration View
or list.

Note: The Format as Table feature in Microsoft Excel should not be used with an Exploration View or list.
Formatting an Exploration View or list as a table will cause issues with the ability to refresh the data.

Before you can create an Exploration View or list, the administrator must create a TM1 data source and
publish it to a location to which you have access. The administrator must also configure your access
privileges.

Administrators can create data sources and assign access privileges in IBM Cognos TM1 Performance
Modeler or IBM Cognos TM1 Architect.

When you create or open an Exploration View or list, you'll notice that the IBM Planning Analytics with
Watson ribbon changes, and includes an Exploration group and a Overview bar.

The Overview bar is displayed when you are viewing an Exploration View or a list. Use the overview area
as a convenient place to quickly explore and change the contents of the Exploration View or list. For
Exploration Views, the overview area displays the Rows, Columns, and Context areas. You populate the
Exploration View with data by adding items from the data source to these areas. The items that you place
in the context area are used to filter the values. Each box in the rows, columns, and context area
represents a set of data in the data source.

Note: If you are opening an existing Exploration View, the data in the Context area is not automatically
updated and synced with its underlying TM1 model. To ensure that the Context data is updated with any
metadata changes in the TM1 model, perform a manual refresh of the Exploration View.

The Exploration group contains tools, which you can use to work with your Exploration View or list.

 Undo - Use the Undo tool to undo your last action.

© Copyright IBM Corp. 2009, 2021 99



Note: By default, you can undo up to 15 actions. Your undo limit can be changed in the Options
dialog.

 Redo - Use the Redo tool to redo your last action.

 Save View - Use the Save View tool to save an Exploration View or list.

 Reset - Use the Reset tool to reset an Exploration View or list. This action will clear your Exploration
View or list.

 Swap Rows and Columns - Use the Swap Rows and Columns tool to swap the rows and columns of
an Exploration View for a different view of your data. To learn more, see “Swap rows and columns” on
page 107.

 Suppression Type - Use the Suppression Type tool to suppress/hide zeros in the rows, columns,
rows and columns, or apply no suppression at all.

 MDX - Use the MDX tool to view or edit the MDX of the report.

 Use Server Formats - Use the Use Server Formats tool to use server formats
when you refresh an Exploration View or list. This tool will remove custom formatting on refresh.

 Convert To - Use the Convert To tool to convert an Exploration View to a Quick Report,
Dynamic Report, or Custom Report. To learn more, see “Converting a report” on page 79.

 Properties - Use the Properties tool to set properties for an Exploration View or a list
that are specific to a worksheet. To learn more, see “Set properties” on page 115.

 Overview - Use the Overview tool to show or hide the Overview bar.

Create a list
Use list explorations to show detailed information from your database, such as customer lists or product
lists.

A list exploration is a report that shows data in rows and columns. You can create a list, for example, to
look up the names of members in a dimension and then reference the members in another worksheet
where they can be used for setting parameters.

Related concepts
“Insert blank columns” on page 101
Insert a blank column into a list to create white space or to add cell-based calculations. You can use the
new column to insert any Microsoft Excel calculation, such as AVG, MIN, or MAX and you can reference
cells both inside and outside the list.
Related tasks
“Create a list” on page 101
“Insert members” on page 103
“Suppress empty cells” on page 101
“Create a calculated column or row from scratch” on page 116
“Nest rows or columns” on page 105
“Change the cube or datasource used by an exploration” on page 117
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You can change the cube or datasource that is used by an exploration.

Create a list
When you create list, you begin with a blank list and then drag items from the Task Pane onto the list.

Before you begin
Ensure that you have access to an IBM Planning Analytics data source. The administrator has configured
your access privileges.

Procedure
1. Log on to a TM1 system and select a data source.

For more information, see “Open a model or package ” on page 39.
The source tree in the Task Pane displays the cube and related items of the data source, such as views.

2. On the IBM Planning Analytics tab, click  List.
3. Add members to the list.

Drag dimensions, sets, or members from the Task Pane to the Columns drop zone.

Insert blank columns
Insert a blank column into a list to create white space or to add cell-based calculations. You can use the
new column to insert any Microsoft Excel calculation, such as AVG, MIN, or MAX and you can reference
cells both inside and outside the list.

Right-click a column header in the list where you want to insert a column, and click IBM Planning
Analytics > Insert user row/column.

A blank column is added next to the selected column.

Suppress empty cells
Sparse data can result in lists showing empty cells. To remove sparse data in a list, you can suppress
empty cells that contain a null or zero value.

Procedure

1. On the IBM Planning Analytics tab, click  Suppression type.
2. Click Suppress Rows Only.

Results
Suppressed items are hidden.

Note: To remove suppression, repeat step 1 and click No Suppression.

Create an Exploration View
You can explore IBM TM1 data with Exploration Views.

Use Exploration Views to quickly change how you view performance measures, such as revenue or
budgeted production costs.

You can compare and manipulate data so that you can better understand relationships between data and
the relative importance of individual data items. Whether you want to assess revenue growth or to identify
top performers, IBM Planning Analytics for Microsoft Excel provides the filtering and sorting support you
need for exploration and write back.
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If you are already comfortable with exploration fundamentals, you may want to refine your Exploration
View by using tasks such as manipulating the rows and columns, adding calculations, and sharing the
results. For more information, see “Nest rows or columns” on page 105, “Add calculated rows and
columns” on page 106, and “Publish a workbook to a TM1 Server Application folder” on page 94. You can
also edit data in Exploration Views. For more information, see “Edit data” on page 110.

Note: Worksheets containing an Exploration View can only contain the single Exploration View. Combining
other report types in a worksheet containing an Exploration View is not supported.

Create an Exploration View

Create an Exploration View by using a view
You can create an Exploration View from a view. Views are listed in the source tree in the Views folder.

This video demonstrates how to create an Exploration View by using a view: https://youtu.be/
F3wo_N97aVg

Before you begin
You have access to an IBM Planning Analytics data source. The data source includes views. The
administrator has configured your access privileges.

Procedure
1. Log on to a TM1 system and select a data source.

For more information, see “Open a model or package ” on page 39.
The source tree in the task pane displays the cube and related items of the data source, such as views.

2. Expand the Views folder.
3. Use one of the following methods to create an Exploration View.

• Drag a view onto a blank Exploration View.
• Right-click a view and click Exploration > On new sheet
• To replace an existing Exploration View, drag a view onto the Exploration View. Or, right-click a view

and click Replace Exploration.
• To convert a list to an Exploration View, drag a view onto the list.

4. Click Save to save your view. You can choose to save it as a private view, this is then available from a
folder called Private views, below the Views folder in the source tree.

Create an Exploration View from scratch
Creating an Exploration View allows you to fully customize how your report looks and what your report
analyzes. Creating an Exploration View from scratch is as easy as starting with a blank Exploration View
and dragging items from the source tree onto the Exploration View.

Before you begin
Ensure that you have access to an IBM Planning Analytics data source. Access privileges are configured by
your administrator. If you do not have access to a data source, speak with your administrator.

Watch this video to see how you can create an Exploration View.

About this task

Procedure
1. Log on to a TM1 system and select a data server.

For more information, see “Open a model or package ” on page 39.
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The source tree in the task pane displays the cube and related items of the data source, such as views.

2. On the IBM Planning Analytics tab, click Exploration .
An Exploration View is created on a new worksheet.

3. Add members to the rows and columns. For more information, see “Add objects to rows, columns, and
the context area” on page 104.

Tip: You can use a view to build an Exploration View. In the source tree, expand Views and drag a view
onto the Exploration View.

4. Optionally, add members to the context area.

Insert members
You can insert members from the source tree to the rows and columns in an Exploration View that uses
TM1 data. You can also insert members to a column in a list that uses TM1 data.

About this task
You can control how members are inserted by setting the insert option in the Task Pane . You can use the
following insert options.

• Insert single member, which inserts the selected member.
• Insert member with children, which inserts the selected member and its components to one level as a

dynamic set.
• Insert member with descendants, which inserts an item and all levels of its component items as a

dynamic set.
• Insert member with ancestors, which inserts an item along with all its related components as a

dynamic set.
• Insert member with inputs, which inserts an item and its input or leaf items as a dynamic set.

You can also simultaneously insert all the members of a level “Insert all the members of a level” on page
104. In an Exploration View, you can also insert members from different levels of the same dimension
“Insert members from multiple levels of a dimension” on page 103.

For groups of members that you use frequently, you can create a set to make selection of them easier. For
more information about sets, see “Create and edit sets” on page 137.

Procedure

1. In the Task Pane, click  and select the required option.
2. In the source tree, select the members that you want to insert.

3. Drag the members to the desired location in the exploration.

To add a member to the members that already exist in an Exploration View, hold down the Ctrl key
when dropping items into the drop zones. A highlighted bar indicates where you can drop the item.

You can use Shift+click or Ctrl+click to select multiple members in a dimension and then drag them to
the exploration. When selecting multiple members, the selected members are placed in the
Exploration View in the order that you click them. To avoid rearranging members after you drag them
into the Exploration View, click the members in the order of placement that you want.

Insert members from multiple levels of a dimension
For a mixed comparison, you can position members from different levels of a dimension adjacent to each
other in a TM1 Exploration View.
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About this task
You can select members from a single dimension in the source tree. You can select both contiguous and
noncontiguous members from different levels.

After you select members, you can drag the members to the Exploration View.

For groups of members that you use frequently, you can create a set to make selection of them easier. For
more information on sets, see “Create and edit sets” on page 137.

Procedure
1. In the source tree, expand the dimension to locate the members that you want to insert.
2. Use Shift+click or Ctrl+click to select multiple members in a dimension and then drag them to the

Exploration View.

Tip: When selecting multiple members, the selected members are placed in the Exploration View in
the order in which you click them. To avoid rearranging members after you drag them into the
Exploration View, click the members in the order of placement that you want.

Results
The members are displayed in the Exploration View.

Insert all the members of a level
You can simultaneously insert all the members of a level into a TM1 Exploration View. Levels define the
way data is grouped in dimensions.

About this task
Use this technique to insert members at the same level from multiple consolidated members.

For example, a Region dimension might contain levels for region, country, and city. You can click a single
country and instantly insert every country in the Region dimension into the Exploration View.

Procedure
1. In the source tree, expand a single member that contains the detail that you want in the Exploration

View.
2. From the Levels item, drag the level to the drop zone.

Results
The members are inserted into the Exploration View.

Note: You can also insert a level using the source tree. In the source tree, expand a dimension, expand
Levels, and then drag a level to the Exploration View.

Add objects to rows, columns, and the context area
Select the data that you want to appear in the TM1 Exploration View. You can insert dimensions,
members, and subsets.

Alternatively, you can use a view to populate the Exploration View.

Before you begin
You can add or remove dimensions, members, and subsets to the rows, columns, and context areas of an
Exploration View.
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The rows and columns areas are continuously expressive; when you add or remove a dimension, member,
or subset to the rows or columns areas, the sheet is updated to reflect your changes and calculations
from a calculated row or column are preserved.

The context area is not continuously expressive; if you move a calculated row or column to or from the
context area, the calculations are not preserved. For more information on calculated rows and columns,
see “Add calculated rows and columns” on page 106.

Procedure
1. Create an Exploration View using an IBM Planning Analytics with Watson.
2. To use a view to populate the Exploration View, in the source tree, expand Views and drag a view onto

the Exploration View.

Or, in the source tree, expand a cube, and then drag a dimension, member, or set to the drop zones.

Note: You cannot add a dimension, member, or set from the top level Dimensions node in the source
tree.

a. Drag a dimension, member, or set to the Rows drop zone.
b. Drag a dimension, member, or set to the Columns drop zone.
c. Drag dimensions, members, or sets to the context area. This step is optional. Use the context area

to filter the data in the Exploration View. For example, to filter the data by product, drag a member
of the Products dimension to the context area.

When you drag a member to a drop zone, the member and its children are inserted by default. For
more information about inserting members, see “Insert members” on page 103.

For example, to display a dimension called Retailers in the rows, click the Retailers dimension in the
source tree and drag the dimension to the Rows drop zone.

3. Save your workbook.

Results
Members are displayed in the rows and columns of the Exploration View.

Columns and rows

Nest rows or columns
You can nest rows and columns in an Exploration View to compare information from more than one
dimension in a column or row. For example, an Exploration View shows the sales by product line for the
past fiscal year. You can nest a row to further break down the sales by order method.

You can also nest columns in a list.

In the overview area, you can drag the boxes that represent the nested items to change the nesting order.

Procedure
1. In the source tree, click the item that you want to insert. You can select a dimension, a set, or one or

more members in a dimension.
2. Drag the item to the location in the Rows or Columns drop zone that you want. Or drag the item onto

the exploration in the location that you want.

A highlight bar indicates where you can drop the item.

Insert blank columns or rows
Insert a blank column or row into an Exploration View to create white space or to add cell-based
calculations. You can use the new row or column to insert any Microsoft Excel calculation, such as AVG,
MIN, or MAX.
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About this task
Depending on the type of data, such as relational or asymmetric you experience very different results.
Experiment with different approaches to see what makes sense in your environment.

After you insert a row or column into an Exploration View, the rows or columns are separated into two
distinct blocks of items before and after the inserted row or column. If you want to use the Expand level /
Collapse level feature, you must do so for each block separately.

Procedure
1. Right-click a column or row header in the Exploration View where you want to insert a column or row.

If the Exploration View area expands, make sure that it does not overwrite items.
2. Click IBM Planning Analytics > Insert user row/column.

A blank column or row appears next to or under the selected column or row.

Results
The blank row or column is added to the Exploration View.

You can leave the row or column blank. You can also populate the blank column or row with a Microsoft
Excel calculation. For more information, see “Create a calculated column or row from scratch” on page
116.

Add calculated rows and columns
Insert a calculation to make your Exploration View more meaningful by deriving additional information
from the data source. For example, you create an invoice, and you want to see the total sales amount for
each product ordered.

About this task
In addition to simple arithmetic calculations, you can perform the following calculations:

% Of
Calculates the value of a selected member as a percentage of another member, for example, fourth
quarter as a percentage of the whole year or actual as a percentage of target.

% Change
Calculates the change in value of a selected member as a percentage, for example, growth from year
to year or variance from target.

% Of Base
This calculation is available only if you select two members from different hierarchies, one on rows
and the other on columns, for example, each region's contribution (on rows) to a yearly total (on
columns).

% Of Parent
This calculation is available only for TM1 data. The % of Parent calculation is available only if you
select two members from different dimensions, one on rows and the other on columns. % Of Parent
calculates the value of a selected member as a percentage of its parent, for example, January sales as
a percentage of sales for the whole year.

After you insert a calculation into an Exploration View, the rows and columns are separated into two
distinct blocks of items before or after the inserted row or column. If you want to use the Expand level /
Collapse level feature, you must do so for each block separately.

When calculations in the rows and columns of an Exploration View intersect, calculations are performed
in the following order:

• Addition or subtraction
• Multiplication or division
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If both calculations have the same precedence, for example, if they are both functions, then the row
calculation takes precedence.

For information about adding Microsoft Excel calculations, see “Create a calculated column or row from
scratch” on page 116.

Procedure
1. Right-click the columns or row headers that you want to use in the calculation.
2. Click IBM Planning Analytics > Insert calculation and select the calculation that you want to

perform.

Note: Calculations that are not applicable to the items you selected are grayed out.

Results
The calculated row or columns appears in the Exploration View. You can rename the calculated column or
row. You can also move the calculated column or row.

Note: To remove a calculation, delete the row or column that contains the calculation from the
spreadsheet.

Swap rows and columns
You can swap rows and columns for a different view of your data. For example, the rows contain quarters
of the fiscal year and the columns contain products. To track trends over time more easily, you can swap
them so that the rows contain products and the columns contain quarters.

Note: When you swap rows and columns in a TM1 Exploration View, sorting and top or bottom filters are
removed.

Procedure

Click Swap Rows and Columns  on the toolbar.

Tip: You can also use the overview area to swap individual items on rows and columns by dragging the
items from one area to the other.

Sort rows by values
Sorting rows by values makes it easier for you to organize and analyze your data.

Procedure
1. Right-click the column header cell then click IBM Planning Analytics > Sort by values.
2. Select a sort option.

Results
In the overview area, a symbol appears in the columns box to indicate a sort is applied. To remove a sort,
right-click the header cell then click IBM Planning Analytics > Sort by values > Remove.

Note: When you swap rows and columns, a sort is removed.

Filter data using the context area
You can filter the data in a TM1 Exploration View using the context area. You can filter using dimensions,
members, and sets.

About this task
Changing context changes the values that appear. It does not limit or change the members in the rows or
columns.

Chapter 7. Explore TM1 data  107



For example, you have an Exploration View showing products in the rows and months in the columns. To
change the context to Asia, you drag Asia from the source tree to the Context drop zone in the overview
area. The Exploration View then shows only the values for Asia.

You can filter using multiple values in the context area. For example, you can drag Asia and Franchise
Stores to the context area. The Exploration View then shows only the values for franchise stores in Asia.

Procedure
1. Create an Exploration View using a TM1 data source.
2. In the source tree, select one or more items to filter on.

• To filter using a dimension, select the dimension. The default member of the dimension is used for
the filter.

• To filter using a set, expand the dimension, expand Subsets, and select a set. The default member of
the set is used for the filter.

• To filter using a member, expand the dimension, expand Members, and select the member.
3. Drag the item you selected to the Context drop zone.

Results
The values in the Exploration View are filtered using the items you selected.

Notice that each item has a down-arrow beside it. Click the down arrow to see options for deleting or
changing the context member. For example, if you filtered using a set, you can click the down-arrow to
select a different member of the set to use in the filter.

Limit members
You can limit the members that are displayed in a TM1 Exploration View using a variety of techniques.

You can use the following techniques.

• Use zero-suppression to hide rows or columns that contain only missing values. For more information,
see “Suppress empty cells” on page 212.

• From either rows or columns, select the members you want to show in the Exploration View, right-click
the cells and select IBM Planning Analytics > Keep.

• Use the Data Display Row Limit option to limit the number of rows displayed in the Exploration View.
On the IBM Planning Analytics tab, click  Properties. In the Properties dialog box, set the number
of rows to display. For more information, see “Set properties” on page 115.

• Create a set of members. For more information, see “Create and edit sets” on page 137.
• Apply a filter to display the top or bottom values only. For more information, see “Show top or bottom

results” on page 109.

Suppress empty cells
Sparse data can result in Exploration Views showing empty cells. For example, an Exploration View that
matches employees with products, results in many rows of empty values for the revenue measure if the
employee does not sell those products. To remove sparse data in an Exploration View, you can suppress
empty cells that contain a null or zero value.

When you are working with IBM Cognos Analytics data, totals-based suppression is applied. Totals-based
suppression removes rows or columns where the total results in a null or zero value throughout the
Exploration View. You cannot remove sparse data from individual rows or columns.

Procedure

1. On the IBM Planning Analytics tab, click  Suppression type.
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2. Choose where to apply the suppression:

• Suppress Rows Only
• Suppress Columns Only
• Suppress Rows and Columns

Results
Suppressed items are hidden.

Note: To remove suppression, repeat step 1 and click No Suppression.

Show top or bottom results
In an Exploration View that uses an IBM Planning Analytics with Watson data source, you can apply a filter
to values to display only the top or bottom results.

About this task
You can apply a top or bottom filter in the following ways.

• Show only the top results to quickly determine the highest values in your data. For example, you want to
know which sales representative contributed the greatest amount to yearly sales, so you apply a top
percent filter.

• Show only the bottom results to quickly determine the lowest values in your data. For example, you
want to know which employees spent the fewest dollars on travel, so you apply a bottom rows filter.

Procedure
1. Right-click a column header cell then click IBM Planning Analytics > Sort by values > Top/Bottom.
2. Select a sort option and enter a value.

• For Top rows and Bottom rows, the value represents the number of rows to display.
• For Top percent and Bottom percent, the value represents a percentage of the sum of all values. For

example, you can type 10 to display the customers who contribute to the top 10% of revenue.
• For Sum of top rows and Sum of bottom rows, the value represents the sum of the results you want

to display. For example, you can type 10000000 to display the customers who contribute to the first
10 million dollars of revenue.

Results
In the overview area, a symbol appears in the columns box to indicate a top or bottom filter is applied. To
remove the filter, right-click the header cell then click IBM Planning Analytics > Sort by values >
Remove.

Note: When you swap rows and columns, a top or bottom filter is removed.

Drill down and drill up
You can drill down and drill up to change the focus of your analysis by moving between levels of
information.

Drill down to see more detail. For example, you can drill down to the lowest-level member to examine the
impact of a single aspect of your business.

Drill up to compare results. For example, you can examine revenue for a single product and then drill up to
see revenue for the entire product line for comparison.
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Procedure
1. To drill down or up in a single row or column, right-click a cell and then click IBM Planning Analytics >

Drill Down or IBM Planning Analytics > Drill Up.
2. To drill down or up in both a row and column simultaneously, double-click the value at the intersection

of the row and the column.

Edit data
You can edit data in an Exploration View that uses an IBM Planning Analytics with Watson data source, if
you have Write access to the cells and the cells are editable.

Cell shading identifies the cells that you can edit.

• White: A consolidated cell.
• Gray: A derived or locked cell. You cannot edit the value.
• Green: A calculated cell.
• Dark gray: A cell with a hold applied. Place a hold on a cell to exclude it from data spreading. For more

information, see “Edit TM1 data by using data spreading” on page 153.

Planning Analytics for Microsoft Excel offers different ways to work with IBM TM1 data changes. You can
determine how your user group is designed to operate based on the options presented on the toolbar. For
example, if you have been granted Sandbox capability, you have access to the New Sandbox and Delete
Sandbox options. For more information, see “Writeback mode” on page 148 and “Virtual sandbox
dimensions” on page 150..

To edit a value in a cell, click the cell, type the new value, and then press Enter.

To save your changes, commit the data to the TM1 Server Application folder.

On the IBM Planning Analytics toolbar, click  Commit. A confirmation dialog box is displayed.

For more information, see “Commit data in a TM1 Exploration View ” on page 113.

Cell formatting indicates the state of data changes.

• Bold blue font: The value in the cell has changed but has not been committed to the TM1 server.
• Orange background: The value in the cell has been committed to your sandbox, but has not been

committed to Base.

After you commit the changes, the Exploration View displays the updated values in a normal font,
indicating that you have saved the changes.

Layouts
You can choose the most practical layout for your Exploration View.

The following layouts are available.

Basic
This layout contains one set of rows and one set of columns.

Figure 3. Example of basic sets
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Nested
This layout contains sets nested either along the rows, the columns, or both.

Figure 4. Example of nested sets

Stacked
This layout contains two or more sets arranged one before another on the rows, next to each other on the
columns, or both.

Figure 5. Example of stacked sets

Asymmetric
This layout contains both nested and stacked sets. Many combinations are possible.

To create asymmetrical nesting, nest the required sets. Right-click on an open space in the rows or
columns drop zone, then click Convert axis to asymmetric. To revert the axis to a symmetric set, click the

Convert axis to symmetric icon , located above the rows or columns drop zone icon. You can then
delete nested members from a parent without deleting the nested member from all parents. For example,
you can show an actual category under previous years and show only the forecast category under the
current year, because no actual is available.

Note: You can only convert an axis to asymmetric if the axis contains more than one dimension.
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Figure 6. Example of asymmetric sets

Clearing all data from an Exploration View or list view
You can clear all data from a specific Exploration View or list view.

MDX editor
Clearing an Exploration View or list view does not break the link to the datasource. When you clear data in
an Exploration View or list view, the button to open the MDX editor is temporarily disabled. This feature
prevents other users from viewing the worksheet's MDX expression, which may contain information about
the datasource.

The button to open the MDX editor is enabled again if the Exploration View or list view is refreshed by the
user that initially cleared the data. When the view is refreshed, the context dimensions will query for the
first available member for each subset and update the selections and the MDX expression is updated.

Set element selections
Clearing an Exploration View or list view discards any set element selections. After an Exploration View or
list view is cleared, set expressions are reevaluated and the set element selection is defaulted to the first
entry upon refresh.

Do not clear an Exploration View or list view if the set element selection state is intended to be preserved.
If the first entry is not desired as the default set element selection, structure the set in such a way that
the first entry is desirable as the default set element selection, for example, the first leaf entry vs the first
total.

Procedure
Use the Task Pane to clear all data (including from the rows, columns, and context drop zones), in a
specific Exploration View or list view.

1. In the Task Pane source tree, expand Current Explorations.
2. Right-click the Exploration View or list view that you want to clear all data from.
3. Click Clear Data.
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Commit data in a TM1 Exploration View
After you have entered values in an Exploration View, you can commit your changes to save the values to
the TM1 server.

On the IBM Planning Analytics toolbar, click Commit . A confirmation dialog box is displayed.

Note: If you have enabled Hide commit confirmation in the Options dialog box, the confirmation dialog
box is not displayed and the values are committed to the TM1 server. If any errors are found, the Error
Report dialog box is displayed.

To preview the changes, click Preview Changes. The Commit Preview dialog box displays the data
changes, along with any errors. Click OK.

To commit the changes, click Yes. If any errors are found, the Error Report dialog box is displayed.

Note: You cannot undo changes after you have committed them to the TM1 server.

For information about resolving errors, see “Resolve errors when committing data to a TM1 server” on
page 159.

Methods for saving an Exploration View
Planning Analytics for Microsoft Excel provides you with several different methods to save your
Exploration Views. You can choose the method that suits your needs the best.

There are three ways that you can save your Exploration Views or list views. The best method for your
view or report depends on where they will be opened, what type of data they need to store, and how they
will be viewed.

Table 9. Feature comparison of the save types.

Content Store MDX view TM1 Server view

Save location of the view Planning Analytics
Workspace Content
Store

TM1 Server TM1 Server

Can be referenced by
TurboIntegrator scripts

Can store alias information

Can store subset information for
slicer selection

Can define static, set based or
expression based set information by
axis

Can store calculations

Can store headers

Can define asymmetric axis

Compatibility with Planning
Analytics for Microsoft Excel

Can open and save
the view

Can open and save
the view

Can open and save
the view

Compatibility with Planning
Analytics Workspace

Can open and save
the view

Can only open the
view

Can only open the
view

Compatibility with TM1 Web Not compatible with
the view

Not compatible with
the view

Can open and save
the view
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MDX views

An MDX view is a named MDX expression that is stored inside of the TM1 Server. The MDX expression is
used to recreate the view. An MDX view is also a known and named object inside of the TM1 Server and
can be referenced by TurboIntegrator scripts. An MDX view can store calculations, headers, and other
virtual elements. An MDX view can be used to define asymmetric axes.

TM1 Server view

A TM1 Server view is a well defined structure that is stored inside of the TM1 Server. A TM1 Server view's
structure gives users the ability to define static, set based, or expression based set information by axis.
This includes subset and alias information for all axes. A TM1 Server view can only store information
about known elements; a TM1 Server view cannot store calculations or headers. A TM1 Server view
cannot be used to define asymmetric axes.

Planning Analytics Workspace Content Store

Saving your Exploration Views to the Planning Analytics Workspace Content Store allows you to save an
enhanced view, and share your views between IBM Planning Analytics Workspace and IBM Planning
Analytics for Microsoft Excel. When you save your Exploration View to the Planning Analytics Workspace
Content Store, the view is stored as an MDX expression. Just like in an MDX view, you can store
calculations, headers, virtual elements and define asymmetric axes when you save your Exploration
Views to the Planning Analytics Workspace Content Store. Since the Planning Analytics Workspace
Content Store is outside of the TM1 Server, it cannot be referenced by TurboIntegrator scripts.

Note: To use the Planning Analytics Workspace Content Store, you must:

• Be a Planning Analytics Workspace licensed user.
• Have Planning Analytics for Microsoft Excel version 2.0.44 or newer, and Planning Analytics Workspace

version 2.0.44 or newer.
• Have IBM Planning Analytics version 2.0.7 IF 3 or newer installed. It is recommended that you install

IBM Planning Analytics version 2.0.8 or newer.
• Be connected to a TM1OData connection. For more information on TM1OData connections, see Using

Planning Analytics for Microsoft Excel without Performance Manager Hub.
• To exchange an Exploration View with Planning Analytics Workspace Local, you must enable the
ENABLE_VIEW_EXCHANGE parameter. By enabling the ENABLE_VIEW_EXCHANGE parameter, you will
now be required to log into Planning Analytics Workspace before you can see your list of servers. For
more information on the ENABLE_VIEW_EXCHANGE parameter and how you can enable it, see Configure
Planning Analytics Workspace Local parameters(https://www.ibm.com/support/knowledgecenter/
SSD29G_2.0.0/com.ibm.swg.ba.cognos.tm1_inst.2.0.0.doc/c_paw_config_file.html).

This video shows you some of the features and capabilities of the Planning Analytics Workspace Content
Store: https://youtu.be/B3G3_kIkJ7Q

Save to the Planning Analytics Workspace Content Store
Save your Exploration View to the Planning Analytics Workspace Content Store to share your view
between Planning Analytics for Microsoft Excel and Planning Analytics Workspace.

About this task
This video will guide you through saving views to the Planning Analytics Workspace Content Store: https://
youtu.be/s796eMPgmrs

With your Exploration View open, follow these steps:

Procedure
1. Open the IBM Planning Analytics ribbon.
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2. Click the Save View icon, in the Exploration section.
3. Click Save to Content Store. A Save View dialog opens.
4. Give your view a name.
5. Define tags for your view (Optional).
6. Give your view a description (Optional).
7. Select the location where you want to save your view.

Permissions for the view are inherited from the folder that you choose to save it in.
8. Click Save.

Results
Your Exploration View is now saved to thePlanning Analytics Workspace Content Store and can be shared
between Planning Analytics for Microsoft Excel.

Open a view from the Planning Analytics Workspace Content Store
If you or a colleague has saved a view to the Planning Analytics Workspace Content Store, you can open it
from Planning Analytics for Microsoft Excel.

About this task
This video will guide you through opening views from the Planning Analytics Workspace Content Store:
https://youtu.be/Cnq8zjv-3iM

You can open a view that has been saved to the Planning Analytics Workspace Content Store.

Procedure
1. Open the IBM Planning Analytics ribbon.
2. Click the View icon, in the Add section. The Open View dialog opens.
3. Locate the view in the View pane.
4. Click the view that you want to open to highlight it.
5. Select the report type that you want the view to be opened as.
6. Click Select.

Results
The view is opened as the selected report type.

Set properties
You can set properties for an Exploration View or a list that are specific to a worksheet.

About this task
The settings in the Properties dialog box are specific to a worksheet. For information about setting global
options, see Chapter 5, “Settings,” on page 45.

In addition to changing settings, the Properties dialog box enables you to view information about the
worksheet including server and package information, and the date the worksheet was created.

Procedure

1. On the IBM Planning Analytics tab, click  Properties.

2. To change the starting location of your Exploration View or list, type a new row number in the Row
start box and a new column number in the Column start box.
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3. If you are working with a TM1 Exploration View, you can choose whether to process data in either CSV
or raw XML format.

• To choose CSV format for faster processing of large data sets, in the Request format drop-down box,
click Unformatted Values.

• To choose raw XML format, in the Request format drop-down box, click Formatted Values.
4. If you are working with a IBM Cognos Analytics List, you can choose whether to process data in either

CSV or raw XML format.

• To choose CSV format for faster processing of large data sets, in the Request format drop-down box,
click Unformatted Values.

• To choose raw XML format, in the Request format drop-down box, click Formatted Values.
5. To control how labels appear in nested cells, set the Default grouping option.

Note: The Default grouping option controls how the Group / Ungroup feature works. For Exploration
Views, this is the automatic setting for presentation of metadata in nested rows and columns. For lists,
this determines how the Group /Ungroup menu items and buttons work.These settings override the
settings in the Options dialog box and affect only the current worksheet. You can leave cells
ungrouped when you need to use Microsoft Excel lookup functions or you can group cells to provide for
greater readability. Changes to the Grouping option will be reflected in the worksheet immediately,
whereas changes in the Options dialog box will only be reflected when a new Exploration View is
created.

• To merge metadata into cells that span nested items and allow for full grouping, click Merge Cells.
• To repeat metadata in individual cells that span nested items, click Repeat Labels.

Use this option when you want to use other Microsoft Excel functions on the data.
• To limit cell metadata and merging to minimize labels, click Label Top Cell.
• To turn grouping off, click None.

6. To limit the number of rows displayed, set the Data Display Row Limit property.

7. After you are done setting options, click OK.

Calculated columns and rows
You can insert any Microsoft Excel calculation, such as AVG, MIN, or MAX into an Exploration View or list.
You can reference cells both inside and outside the exploration.

Create a calculated column or row from scratch
You can create a column or row, containing Microsoft Excel calculations, from scratch.

Procedure
1. Insert a blank column or row.
2. Create the calculation in the first cell that applies to the inserted column or row.

You must create the formula for the calculation in the cell closest to cell A1 (the upper left most cell) of
the inserted group.

3. After you have created the calculation for a single cell, from the toolbar, click Use Server formats to
remove custom formatting.

Results
The calculation is propagated to all the inserted cells.

Tip: You can apply conditional formatting to the calculated column or row. Select the column or row. Click
Home and then click Conditional formatting. Use the conditional formatting menu to choose the styles
for the cells.
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Insert a calculated column or row from existing columns or rows
You can use existing columns or rows in your Exploration View to create a calculated column or row.

About this task

Procedure
1. Create or open an Exploration View.
2. Select two or more column or row headers in the Exploration View.
3. Right-click any of the selected column or row headers to open the context menu.
4. Click IBM Planning Analytics.
5. Click Insert calculation.
6. Select any of the available calculations.

Results
A new column or row containing your selected calculation is created.

Rename a calculated column or row
You can rename any calculated columns or rows that you have created in an Exploration View.

About this task
By default, when you create a calculated column or row, the column or row is named after the calculation
that was used. You can rename your calculated column or row by editing the column or row header.

Procedure
1. Click the header of the calculated column or row that you want to rename.
2. Type a new name for your calculated column or row.
3. Refresh the sheet.

Results
Your calculated column or row is renamed.

Note: You must refresh the sheet every time you rename a calculated column or row, otherwise you will
not be able to commit your data.

Change the cube or datasource used by an exploration
You can change the cube or datasource that is used by an exploration.

Before you begin
The information area must be displayed above the Exploration View or list to complete this task. Show the
information area by enabling the Show system and package information in Exploration View or list

sheet setting in the Options. Then click Refresh  to see the information area.

Note: Changing the cube or datasource may cause your Exploration View to refresh.

Procedure
1. Open the worksheet that contains the exploration.

Chapter 7. Explore TM1 data  117



2. In the information area above the exploration, double-click the cell that displays the System or
Package information.

3. In the Select package dialog box, you can change the datasource by using the System drop-down to
select a new datasource.

4. In the Select package dialog box, you can change the cube by expanding one of the models in the
main pane and selecting a new cube.

5. Click OK.

Bulk update the datasource or TM1 instance for Exploration Views
You can bulk update the datasource or TM1 instance for multiple Exploration Views at the same time.

Before you begin
Ensure that you do not have IBM Planning Analytics for Microsoft Excel signed into any instances of IBM
Planning Analytics with Watson while you are running a bulk update.

About this task
To bulk update the datasource or package for your Exploration Views, you need to use the
BulkSerializeUtil command. The BulkSerializeUtil command consists of three parts:

• The path to the folder with the books that contain the Exploration Views that you want to change.
• The new datasource URI that you want your Exploration Views to get updated to.
• The TM1 model name in the new datasource URI that you want your Exploration Views to get updated

to.

Your BulkSerializeUtil command has the following syntax:

=bulkserializeutil(``<path to folder>``,``<new datasource URI>``,``<name of new TM1 model>``)

Note: This function uses straight double quotation marks. Do not use curly quotation marks.

Procedure
1. Move all of the books that contain the Exploration Views that you want to update into a single folder.
2. Close any instances of Planning Analytics for Microsoft Excel and Microsoft Excel.
3. Start Microsoft Excel and open a blank book.
4. Click the IBM Planning Analytics with Watson tab.
5. In a cell, enter the BulkSerializeUtil command.
6. Save the sheet to preserve the changes.
7. Refresh the sheet to see the changes applied.

Results
Your screen might flash as the command is being run. When the command is complete, a message is
returned in a cell, containing information about the results of the command. The results have the
following syntax:

<#> Results - Success: <#> Failed: <#> Unknown: <#>

• Success indicates that the Exploration View was successfully updated.
• Failed indicates that the Exploration View failed to update.
• Unknown indicates that there was an unknown issue.
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Quick Reports
You use Quick Reports to work with IBM TM1 data in Microsoft Excel in a more dynamic way.

You can combine data from multiple data sources in a Quick Report and then enhance the data by using
Microsoft Excel formulas, formats, and cell references. When you create or open a Quick Report, the
names of the dimensions used in the Quick Report are automatically displayed at the top of the report.

Create a Quick Report
You can create a Quick Report from an Exploration View or from an existing view in the Task Pane.

This video demonstrates how to create Quick Reports: https://youtu.be/dgqa0A-Ng94.

After you create a Quick Report, you can change or add members, format the cells, and create charts from
the data. For example, you can change members and data using options such as typing the name of a
different member in a cell.

You can combine multiple Quick Reports on the same worksheet. Each Quick Report can be based on a
different data source. You can provide unique perspectives by creating calculations that reference
multiple Quick Reports. Another useful option for multiple Quick Reports on the same worksheet is to use
cell references to apply the same filter to more than one Quick Report. For example, you create three
Quick Reports on a worksheet to show different views of financial performance by region. The region
name appears in cell B4 in the context region on the first Quick Report. In the second and third Quick
Reports, you change the region name cell to a cell reference to cell B4. After you create the cell
references, you update the first worksheet to show data for a different region, either by dragging a
different region to cell B4 or by typing a region name in cell B4. When you refresh the data, all Quick
Reports show data for the new region.

Sets are a useful tool for building explorations and Quick Reports with TM1 data. For more information
about creating sets, including dynamic sets that can automatically reflect changes in a dimension, see
“Create and edit sets” on page 137.

Quick Reports regions
Each Quick Report includes four regions: rows, columns, context, and data. Each region is a named range
in Microsoft Excel. For example, the defined name for the rows region of the first Quick Report you add to
a worksheet is tm1\\_0_R. You can use the names when you use Microsoft Excel features such as creating
formulas.

To highlight a region on the worksheet, from the Task Pane, right-click a Quick Report in the Quick
Reports folder and select a region from the Show Regions list.

Create a Quick Report
You use a view, Exploration View, or a Quick Report to create a new Quick Report.

A worksheet can contain more than one Quick Report. For information on converting an Exploration View
to a Quick Report, see “Converting a report” on page 79

Create a Quick Report from the source tree
You can create a Quick Report from a view in the source tree of the Task Pane.

1. Log on to a TM1 system and select a data source. For more information, see “Open a model or
package ” on page 39.

2. Click Task Pane to open the Task Pane. The source tree in the Task Pane displays the cube and related
items of the data source, such as views.

3. Expand the Views folder.
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4. Use one of the following methods to create a Quick Report.

• Drag a view onto a worksheet.

Note: You can also create a Quick Report by dragging an Exploration View from the Explorations
folder onto a worksheet or by dragging a Quick Report from the Quick Reports folder.

• Right-click a view, click Quick Report, and select where to place the Quick Report.

Quick Report formatting
By default, a Quick Report that is created from a view in the source tree will use Excel formatting. You can
apply server formatting to an existing Quick Report from the Task Pane.

1. Open the Task Pane.
2. Click the Workbook tab.
3. Right-click the Quick Report that you want to apply server formatting to.
4. Click Use server formats.

Alternative, if you want to use server formats for all future Quick Reports, you must enable Use server
formatting in the Quick Reports settings. For more information, see “Use server formatting” on page 62.

Clearing all data from a Quick Report
You can clear all data from a specific Quick Report.

About this task
Use the Task Pane to clear all data from a specific Quick Report.

Procedure
1. In the Task Pane source tree, expand Quick Reports.
2. Right-click the Quick Report that you want to clear all data from.
3. Click Clear Data.

Add members
You can add members to the rows and columns of a Quick Report. You can add a member from the same
dimension or a different dimension.

This video demonstrates how to add members to Quick Reports: https://youtu.be/gAXNHweN30o

To add a row, select the cell below the last row title member, type a member name, and then click
Refresh .

To add a column, select the cell to the right of the last column title member, type a member name, and
then click Refresh .

Note: If the Use Type-in Refresh option is enabled, the Quick Report refreshes automatically. You do not
need to click Refresh. To enable type-in refresh, in the Task Pane > Workbook tab, right-click the Quick
Report and select Properties > Use type-in refresh.

By default, no cell styles are applied to the added values. You can change this behavior by setting the
MapAddedRowColumnStyle parameter in the CognosOfficeReportingSettings.xml file. The
possible values for the parameter are as follows:

• NoStyle: Do not apply any cell styles to extended values
• ServerStyle: Apply server styles to extended values
• LastRowColumnStyle: Apply the styles from the last row or column to extended values

Example
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Suppose that you have a Quick Report with the following members in the rows and columns:

• Columns: Total Year, Jan, and Feb in cells B7, C7, and D7
• Rows: Existing Stores Revenue, Gross Margin %, and Returns and Allowances in cells A8, A9, and A10

Table 10. Example Quick Report

Total year Jan Feb

Existing Stores Revenue 123,072,189 10,197,973 12,597,973

Gross Margin % 36.66% 34.72 34.88

Returns and Allowances 1,815,532 600,295 109,794

To add March to the Quick Report, type the member name, Mar, in cell E7, to the right of Feb.

To add Volume Discount to the Quick Report, type the member name, Volume Discount, in cell A11, below
Returns and Allowances.

Click Refresh on the Quick Report toolbar. If the Use type-in refresh option is enabled, you do not need
to click Refresh.

The Quick Report refreshes to show values for March and for Volume Discount.

Table 11. Example Quick Report with March and Volume Discount added

Total year Jan Feb Mar

Existing Stores
Revenue

123,072,189 10,197,973 12,597,973 13074105

Gross Margin % 36.66% 34.72 34.88 41.5098

Returns and
Allowances

1,815,532 600,295 109,794 140759.6

Volume Discount 899712.4 74551.7 69551.7 95577.52

By default, the values in the new row and column are not formatted.

Replace members
Planning Analytics for Microsoft Excel includes several options for replacing members in a Quick Report.

About this task
To replace a member in a Quick Report, use one of the following options.

• To replace a member, drag an item from the Task Pane to a cell in the rows region, columns region, or
context region. You can replace a member with a member from the same dimension or a different
dimension.

For example, the context area shows that the Quick Report is filtered on Price. You drag a different
account, Units, to the Price cell to change the context.

• To change members from the same dimension, select a cell in the rows region, columns region, or
context region and from the context menu, select IBM Planning Analytics > Replace Members. Use the
Set Editor to choose members.

For example, the Quick Report shows data for the Europe region. You can use Replace Members to add
the Americas region. Europe and Americas are both part of the World dimension.

• To replace a member in the rows region, columns region, or context region, type the name of a different
member in the cell. You must type the name as it appears in the source tree. You can replace a member
with a member from the same dimension or a different dimension.
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For example, the Quick Report includes a column for the S Series 2.5L Sedan model. To show data for a
different model, you type S Series 3.0L Sedan in the column heading.

Procedure
1. Replace a member in the Quick Report and press Enter.

2. Click Refresh .

Note: If Use Type-in Refresh is enabled, you do not need to click Refresh.

Refresh
If the data in your Quick Report has changed, you can refresh the data to ensure that you are working with
the latest data. You can refresh data in several ways.

About this task
You can refresh your entire workbook, a worksheet, a report, or just selected cells.

• To update the entire workbook, on the IBM Planning Analytics tab, click Refresh All Data.

You can choose to Refresh the data only or Refresh the data and report formatting.

If you choose to also refresh report formatting, formats are updated.

– Quick Reports update their formatting based on a per-Quick Report flag to use server formats
(instead of the global flag for explorations) and update formats every time the data is pulled.

• To refresh only the current worksheet, right-click any cell on the worksheet, click IBM Planning
Analytics > Refresh > Refresh worksheet.

• To refresh a specific report, follow these steps:

– In a Quick Report, click .
• To refresh only specific cells, right-click a cell or range of cells, click IBM Planning Analytics > Refresh

> Refresh selected cells.
• To refresh a Quick Report automatically when a context member changes, edit the Cognos TM1Web
configuration parameters and set the RecalcOnDataValidationChange value to true.

For more information, see Modifying TM1 Web configuration parameters.
• To automatically refresh values in a table when a new value is entered, enable the use type-in refresh

option. You can enable use type-in refresh in the Options dialog. For more information, see “Use type-
in refresh” on page 62.

Note: The type-in refresh option works if an input is made directly to the meta data element. For
example, if the user has a formula in the header cell and then changes the driver, type-in refresh will not
automatically update the data. In this scenario, the user will need to do an explicit refresh to get the
refreshed values based on that change.

For more information, see “Refresh data” on page 93.

Publish, share, and open
You can share Quick Reports with other IBM TM1 users by publishing the workbook to a TM1 Server
Application folder.

When you open a Quick Report in IBM Planning Analytics Workspace or in TM1 Web, the Quick Report is
displayed as a live websheet. A live websheet maintains its connection to the TM1 server. If the data on
the server changes, a live websheet recalculates and reflects the changes. You can refresh or rebuild the
Quick Report or the workbook by using the buttons on the websheet toolbar.

Published Quick Reports can be used as part of a sheet built in IBM Planning Analytics Workspace.
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Note:

• If the data in your Quick Report is not recalculating, ensure that the Quick Report is connected to the
correct server and that the server is available.

• In order for context members in published Quick Reports to synchronize with other dimensions in IBM
Planning Analytics Workspace, SUBNM formulas must be used in defining the context members.

• Quick Report cells containing user formulas are unable to write data back to the TM1 server, once they
are opened in a TM1 Web application.

For more information, see “Publish a workbook to a TM1 Server Application folder” on page 94.

Delete
You can delete a Quick Report from a worksheet.

Procedure
1. In the Task Pane, Workbook tab, expand Quick Reports.
2. Locate the Quick Report you want to delete.

Tip: You can see where a Quick Report is located in a workbook. Right-click a Quick Report and select
Show Report.

3. Right-click the Quick Report you want to delete and select Convert to snapshot.
4. Click Yes.
5. Delete the rows and columns.

Edit
You can edit data in a Quick Report, if you have Write access to the cells and the cells are editable.

If you are using server formats in the Quick Report, cell shading identifies the cells that you can edit.

• Light blue: A consolidated cell. You cannot edit the value.
• Gray: A derived or locked cell. You cannot edit the value.
• White: An editable cell.
• Dark gray: A cell with a hold applied. Place a hold on a cell to exclude it from data spreading. For more

information, see “Edit TM1 data by using data spreading” on page 153.

Planning Analytics for Microsoft Excel offers different ways to work with IBM TM1 data changes. You can
determine how your user group is designed to operate based on the options presented on the toolbar. For
example, if you have been granted Sandbox capability, you have access to the New Sandbox and Delete
Sandbox options. For more information, see “Writeback mode” on page 148 and “Virtual sandbox
dimensions” on page 150.

To edit a value in a cell, click the cell, type the new value, and then press Enter.

To save your changes, you must commit the data to the IBM TM1 server. For more information, see
“Commit data in a Quick Report” on page 124.

If you are using server formats, the cell formatting indicates the state of data changes.

• Bold blue font: The value in the cell has changed but has not been committed to the TM1 server.
• Orange background: The value in the cell has been committed to your sandbox, but has not been

committed to Base.

After you commit the changes, the Quick Report displays the updated values in a normal font, indicating
that you have saved the changes.
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Commit data in a Quick Report
After you have entered values in a Quick Report, you can commit your changes to save the values to the
TM1 server.

On the Quick Report toolbar, click Commit . The Commit Changes dialog box is displayed.

Note: If you have enabled the Hide commit confirmation option, the Commit Changes dialog box is not
displayed and the values are committed to the TM1 server. If any errors are found, the Error Report dialog
box is displayed.

To preview the changes, click Preview changes. The Commit Preview dialog box displays the data
changes, along with any errors. To commit valid changes, click Commit valid. If any errors are found, the
Error Report dialog box is displayed.

To commit changes without previewing them, in the Commit Changes dialog box, choose one of the
following options:

• To validate and then commit only the changed data, click Commit changes.
• To commit all data in the Quick Report without validating the data first, click Commit all. If any invalid

vales are found, they are displayed. You then have the option to continue and just commit valid data, or
to cancel and fix the invalid values.

Note: You cannot undo changes after you have committed them to the TM1 server.

For information about resolving errors, see “Resolve errors when committing data to a TM1 server” on
page 159.

Change the cube and datasource used by a Quick Report
You can change the cube and datasource that is used by a Quick Report.

Procedure
1. Click the worksheet that contains the Quick Report.
2. In the Task Pane, Workbook tab, expand Quick Reports.
3. Right-click the Quick Report that you want to change, and click Properties.

The Properties dialog box is displayed.
4. Click Update....

The Select package dialog box is displayed.
5. In the Select package dialog box, you can change the datasource by using the System drop-down to

select a new datasource.
6. In the Select package dialog box, you can change the cube by expanding one of the models in the

main pane and selecting a new cube.
7. Click OK in the Select package dialog box.
8. Click OK in the Properties dialog box.

Show the information header in a Quick Report
You can show or hide the header information in a Quick Report.

About this task
By default, the header information in a Quick Report is hidden. The header information includes the host
URL, server name, and the cube name for the Quick Report.

For information on how to enable the information header, see “Manually enabling features in the
tm1features.json file” on page 30.
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Dynamic Reports
You can use Dynamic Reports to create complex reports that combine the functionality of IBM TM1 with
Microsoft Excel features.

Dynamic Reports are implemented through a series of worksheet functions that define the components of
a form, such as context members, row members, and display properties. When you convert an Exploration
View to a Dynamic Report, the functions are created for you.

Dynamic Reports support features available in explorations and Quick Reports, such as selectable context
members, stacked row and column dimensions, expandable/collapsible consolidations (rows only), zero
suppression (rows only), and inserting rows and columns (with some restrictions).

You can use a filter by adding the TM1RPTFILTER function, for more information, see “TM1RPTFILTER” on
page 184.

In addition, you can define dynamic formatting for the Dynamic Report by using standard Microsoft Excel
format options directly in the worksheet.

Column dimensions are static in Dynamic Reports. You cannot expand or collapse consolidated column
members in a Dynamic Report by clicking them. Although the column dimension members are set when
you create the Dynamic Report, you can manually edit column members. When you enter a valid member
name for a column member, the Dynamic Report returns values from the server.

The Dynamic ribbon group
You can use the Dynamic group in the IBM Planning Analytics with Watson ribbon to perform many
actions relating to a Dynamic Report.

When you create a Dynamic Report, the IBM Planning Analytics with Watson ribbon changes and includes
a Dynamic group.

The Dynamic group contains tools, which you can use to work with your Dynamic Report.

 Rebuild Sheet - Use the Rebuild Sheet tool to rebuild all Dynamic Reports in the current
sheet. To learn more about rebuilding in Dynamic Reports, see “Refresh, rebuild, or recreate” on page
127.

 Rebuild Book - Use the Rebuild Book tool to rebuild all Dynamic Reports in the current
book. To learn more about rebuilding in Dynamic Reports, see “Refresh, rebuild, or recreate” on page 127.

 Recreate Book - Use the Recreate Book tool to recreate all Dynamic Reports in the
current book. To learn more about recreating in Dynamic Reports, see “Refresh, rebuild, or recreate” on
page 127.
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 Show Format Areas - Use the Show Format Areas tool to show the format areas of
Dynamic Reports in the current sheet. To learn more about format areas in Dynamic Reports, see “Report
format” on page 131.

 Hide Format Areas - Use the Hide Format Areas tool to hide the format areas of
Dynamic Reports in the current sheet. To learn more about format areas in Dynamic Reports, see “Report
format” on page 131.

Create or add Dynamic Reports
You can create a Dynamic Report from a view or Exploration View that uses TM1 data.

Before you begin
• If you are creating a Dynamic Report from an Exploration View, ensure that your Exploration View does

not contain alternate hierarchies. You cannot convert an Exploration View to a Dynamic Report if the
Exploration View contains alternate hierarchies.

• Clearing a worksheet that contains a Dynamic Report will not delete the named ranges. Existing named
ranges in a worksheet will cause errors if you add a new Dynamic Report to the worksheet. You can
either add your Dynamic Report to a new worksheet, or ensure that the worksheet that you're adding
the Dynamic Report to does not contain any named ranges.

Procedure
1. To create a Dynamic Report from an Exploration View, on the IBM Planning Analytics tab, on a

worksheet that contains an Exploration View, click Convert To > Dynamic Report and then select a
location.

2. To create a Dynamic Report from a view, right-click a view in the source tree, click Dynamic Report,
and select an option.

Results
The Dynamic Report is created in a new worksheet.

Note: If you rename the sheet that the Dynamic Report is created on, ensure that the sheet name:

• Starts with a letter, number, or an underscore.
• Does not contain any spaces.
• Does not contain any special characters.
• Does not have the same name as an existing sheet in the workbook.
• Does not resemble a cell address (for example, A$35 or R2D2).

Add multiple Dynamic Reports
You can add multiple Dynamic Reports to your worksheet.

Before you begin
Adding multiple Dynamic Reports is a great way to view, analyze, and compare data. Before you add
multiple Dynamic Reports, it is important to be aware of the following limitations:

• Use a top to bottom design approach. Additional Dynamic Reports should only be added below an
existing Dynamic Report.

• Multiple Dynamic Reports cannot exist side by side and the rows of two Dynamic Reports can never
overlap.

• Additional Dynamic Reports cannot be added to the left of the first Dynamic Report.
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• Multiple Dynamic Reports on the same worksheet will share the same format range. To learn more
about formatting a Dynamic Report, see “Report format” on page 131.

Procedure
1. Select a cell below an existing Dynamic Report.
2. Right-click a view in the source tree, click Dynamic Report, and select At current location or At

specified location.

Results
An additional Dynamic Report is added to the worksheet.

Note: If the values of your Dynamic Reports seem incorrect after adding multiple Dynamic Reports,
ensure that no two Dynamic Reports have overlapping rows.

Insert a Dynamic Report section
You can insert additional sections to your Dynamic Reports.

About this task
Inserting a Dynamic Report section allows you to view, analyze, and compare multiple subsets that share
the same context on a sheet.

Procedure
1. Right-click on the Dynamic Report header row.
2. Click IBM Planning Analytics.
3. Click Insert Dynamic Report Section.
4. Select the subset(s) you want to insert as a Dynamic Report section.
5. In Number of Rows Below, define the number of rows below the Dynamic Report that you want the

Dynamic Report section to be added.
6. Click OK.

Results
The Dynamic Report section is added below the Dynamic Report. If you selected multiple subsets, then
multiple Dynamic Report sections are added below the Dynamic Report.

Note: The dimension that is in the control row definition determines the subsets that you can choose to
insert as a Dynamic Report section. If you would like to select subsets from a different dimension, you
need to update the TM1RPTROW formula of the Dynamic Report.

Refresh, rebuild, or recreate
You can refresh, rebuild, or recreate a Dynamic Report.
Refresh

You can refresh a cell, the worksheet, or the workbook. When you refresh a Dynamic Report, the
following actions occur:

• The existing query is run and the physical rows on-screen are refreshed. Transient states, such as
toggles, are preserved.

• The data is refreshed from the TM1 server.
• The headers are updated.
• If the number of rows in the data area has changed, or if a computed value in the ID column of the

report has changed, the formatting is updated.
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Changes that you have made, such as drilling down or changing function parameters, are preserved.

Rebuild

When you rebuild a Dynamic Report, the following actions occur:

• The row set computations from the TM1RPTROW functions are rebuilt.
• The physical rows on-screen are refreshed. Transient states, such as toggles, are not preserved.
• The data is refreshed from the TM1 server.
• The headers are updated.
• The formatting is updated.
• The state of the TM1RPTROW functions in the Dynamic Report is updated. For example, if you

change the TM1RPTROW functions to point to a different named set, rebuilding the Dynamic Report
drops the existing row set, reevaluates the TM1RPTROW function against the set, and updates the
Dynamic Report rows with the result.

Recreate

When you recreate a Dynamic Report, the following actions occur:

• All content across the physical row area is recreated.
• The row set computations from the TM1RPTROW functions are rebuilt.
• The physical rows on-screen are refreshed. Transient states, such as toggles, are not preserved.
• Any updates to the formatting area are fully reapplied.

You need to recreate a Dynamic Report, for example, if you change the format function of the Dynamic
Report.

Refresh, rebuild, or recreate from the source tree
You can refresh, rebuild, or recreate your Dynamic Reports from the source tree.

Procedure
1. In the source tree, Workbook tab, expand Dynamic Reports.
2. Do one of the following actions:

• To refresh the Dynamic Report, select the Dynamic Report, and then click Refresh.
• To rebuild the Dynamic Report, right-click the Dynamic Report in the tree, and then click Rebuild.

Tip: You can also rebuild all Dynamic Reports in a workbook by pressing ALT+F9.
• To recreate the Dynamic Report, right-click the Dynamic Report in the tree, and then click Recreate.

Tip: You can also recreate a Dynamic Report by deleting all rows except the first row, and then
rebuilding the form.

Refresh, rebuild, or recreate from the IBM Planning Analytics with Watson
ribbon
You can refresh, rebuild, or recreate your Dynamic Reports from the IBM Planning Analytics with Watson
ribbon.

Procedure
1. In the IBM Planning Analytics with Watson ribbon, Dynamic Reports section, do one of the following

actions:

• To rebuild the Dynamic Report, click Rebuild Book.
• To recreated the Dynamic Report, click Recreate Book.
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2. To refresh the Dynamic Report, click the Refresh icon in the IBM Planning Analytics with Watson
ribbon, Data section, and select one of the options.

Expand and collapse rows
You can expand a consolidated member in a row to view its children.

About this task
Consolidated members that are collapsed have a plus sign (+) to the left of the member name. To expand
the row to view the child members, double-click the member name.

Consolidated members that are expanded have a minus sign (-) to the left of the member name. To
collapse a consolidated member to hide the child members, double-click the name of the consolidated
member.

When you expand or collapse a member, all instances of that member are expanded or collapsed.

Suppress or display zeros
You can selectively suppress or display rows that contain only zero values in a Dynamic Report.

About this task
Zero suppression is controlled by the value of the ZeroSuppression argument to the TM1RPTVIEW
function. If this argument value is 1, zeros are suppressed in the Dynamic Report; if the argument value is
0, zeros are not suppressed in the Dynamic Report.

Procedure
1. Unhide the rows above the Dynamic Report until you see the cell that contains the TM1RPTVIEW

function.
2. To suppress zeros, change the second parameter to 1. To show zeros, change the second parameter to

0.

Edit the row set
You can use the Set Editor to modify the row set in a Dynamic Report.

About this task
The rows in a Dynamic Report are defined by a TM1RPTROW function, which is defined when the Dynamic
Report is created. When you modify the row set by using the Set Editor, the TM1RPTROW function is
updated to reflect your changes.

Procedure
1. Right-click the first (top) row member in the Dynamic Report.
2. Select IBM Planning Analytics > Edit Set.
3. Define a set by using the options available in the Set Editor. For more information, see “Create and edit

sets” on page 137.
4. Click Apply and close.
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Change context members
You can access a different view of cube data by changing a member in the context area.

Procedure
1. Double-click a member in the context area.

The Set Editor is displayed.
2. Select a member.
3. Click Apply and close.

Insert columns
You can insert columns in a Dynamic Report.

You can insert a column in any of the following locations.

• Directly within the Dynamic Report
• To the right of the Dynamic Report
• To the left of the Dynamic Report

Do not insert a column between two row dimensions in a Dynamic Report.

Inserted columns persist when you refresh or rebuild (ALT+F9) the Dynamic Report.

Insert rows
You can insert rows in a worksheet that contains a Dynamic Report.

You can insert a row in any of the following locations.

• Within the Dynamic Report, outside the data area
• Above the Dynamic Report
• Below the Dynamic Report

Do not insert a row between existing rows in the data area, because this disrupts the row set of the
Dynamic Report.

Inserted rows persist when you refresh or rebuild (ALT+F9) the Dynamic Report.

Display the data source or package of a formula
When working in Dynamic Reports and Custom Reports, you can use more than one data source or
package. You can synchronize the source tree when moving from cells of one data source or package to
another. Synchronizing the source tree enables you to see accurately the dimensional data used to
populate the cells.

Right-click a formula cell and click IBM Planning Analytics > Display Package. The Task Pane displays
the package or data source that was used to create the selected cell.

Change the model and cube used by a Dynamic Report
Update the cube and datasource of a Dynamic Report to switch from a test to a production environment,
for example, or to access information from a different set of financial data, such as a submission.

You need to update the formulas in the Dynamic Report to reference a new cube or datasource. If your
formulas reference cells to obtain the cube and datasource name, you will need to update the referenced
cells.

You need to modify the following formulas:

• TM1RPTVIEW
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• SUBNM formulas for context members
• TM1RPTROW for the first row title member
• DBRW formulas for the cells in the data area

Note: You may need to unhide the rows to reveal the format range.

The first parameter of the TM1RPTVIEW formula specifies the model and cube name to use in the
Dynamic Report. Make the TM1RPTVIEW formula visible by revealing the format range above the Dynamic
Report so that you see the server name and data source name. Edit the TM1RPTVIEW formula to use a
different server and data source. For more information on revealing the format range, see “Report format”
on page 131.

Context members are defined by SUBNM formulas. The first parameter of each SUBNM formula specifies
the model and cube name. Modify the SUBNM formulas to use the new model and cube.

Row title members are defined by a TM1RPTROW formula in the first row title. The second parameter of
the TM1RPTROW formula specifies the model and cube name. Modify the TM1RPTROW formula to use
the model and cube.

Cells in the data area are populated by DBRW formulas. The first parameter of a DBRW formula specifies
the model and cube name. Modify the formulas to use the new model and cube name. Or, if the DBRW
formulas reference a cell containing the model and cube name, update the referenced cell.

Tip: You can modify DBRW formulas in a range of cell by using the Function Editor. For more information,
see “Modify a range of DBR and DBRW functions” on page 191.

Alternatively, return to the Exploration View that you used to create the Dynamic Report, change the
model and cube name, and then convert the Exploration View to a Dynamic Report.

Report format
The formatting in a Dynamic Report is specified by format definitions within a format range. You can
change the formatting of a Dynamic Report by changing the cell formatting of format definitions and by
adding new format definitions.

You can also follow along by watching this video: https://youtu.be/qbG98VpYPhE

The format range is hidden by default. You must reveal the format range before you can modify the
default formatting or create new format definitions. To reveal the format range, press Ctrl-A. On the Home
tab, under Cells, click Format > Hide and Unhide > Unhide Columns. Click Format > Hide and Unhide >
Unhide Rows. Repeat and select Unhide Columns. Cell A1 will now be visible. For more information
about hiding and unhiding rows and columns, see the Microsoft Excel online help.

The format range can also be revealed and hidden by clicking Show Format Areas and Hide Format
Areas from the IBM Planning Analytics ribbon, in the Dynamic Reports section.

Row 1 contains the Begin Format Range label. The last row of the format range contains the End
Format Range label. All formatting for the Dynamic Report must be defined between these labels.

The rows between the Begin Format Range label and the End Format Range label contain the default
format definitions for the Dynamic Report.

The format label column (typically column A) in the format range contains the format definition labels for
each format definition. Format definition labels can be numbers, letters, or strings.

For each data row in the Dynamic Report, the format label column (typically column A) contains a format
definition label, which determines the format definition to apply to the row. When you first generate a
Dynamic Report, the format definition corresponding to the level of each row set member is applied. Leaf

Chapter 7. Explore TM1 data  131

https://youtu.be/qbG98VpYPhE


indicates a leaf level member, while Default indicates a consolidation level greater than the number of
level format definitions defined in the format range. For example, if you define format definitions for levels
0 - 5, Default defines the formatting for all other levels.

Example

For example, suppose that you have the following row set.

• World (Level 0)

– North America (Level 1)
– South America (Level 1)

- Argentina (Leaf)
- Brazil (Leaf)
- Uruguay (Leaf)

World is a level 0 member in the row set, so the 0 format definition is applied to the World row. South
America is a level 1 member, so the 1 format definition is applied. Uruguay is a leaf member of the row
set, so the Leaf format definition is applied.

Format definitions
The format definitions in a Dynamic Report are applied based on the return value of an IF function in the
format label column (typically column A) for each row in the Dynamic Report.

The IF function uses several worksheet functions. The basic logic of the IF function is as follows:

1. Determine whether the row member is a consolidation.
2. If the row member is a consolidation, determine whether the subset member level of the consolidation

is less than or equal to the last level format definition defined in the format range.

• If the subset member level of the consolidation is less than or equal to the defined format definitions
for levels, return the subset member level.

• If the subset member level of the consolidation is greater than the last format definition for levels,
return Default.

3. If the row member is not a consolidation, return Leaf.

The following is an example of the default IF function that is created when you convert an Exploration
View to a Dynamic Report. The function TM1RPTELISCONSOLIDATED determines if the member is
consolidated or not. The function TM1RPTELLEV returns the level of the member. If the level is 6 or
greater, the functions returns Default. If the member is not consolidated, the function returns Leaf.

=IF(TM1RPTELISCONSOLIDATED($B$22,$B22),IF(TM1RPTELLEV($B$22,$B22)<=5,
TM1RPTELLEV($B$22,$B22),"Default"),"Leaf")

You can change the IF function. The function must return a value that can be matched to an ID in the
defined format range area. After you modify the IF function, repair the Dynamic Report to apply the
formatting. For more information, see “Apply format definitions” on page 133.

Modify formatting
You can modify the formatting of a Dynamic Report by modifying the cell formatting of format definitions.

When you modify the formatting of a cell in the format range, all cells in the Dynamic Report that use the
corresponding format definition are updated when you rebuild or repair the form. You can use the
standard Microsoft Excel cell formatting options to change format definitions.

You can also follow along by watching this video: https://youtu.be/CuVL7yapNuM

For example, if you modify format definition 1 by applying an orange background to cell C3 and then
rebuild the Dynamic Report, all Dynamic Report rows that use format definition 1 display the orange
background color in column C.
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You can also modify the formatting of Dynamic Reports by modifying the named styles that are used in
Dynamic Reports. When you modify a named style, all cells in a workbook that use the named style are
updated. You do not need to refresh, rebuild, or repair the Dynamic Reports to apply the change.

For example, the named style that is applied by default to the first row of data in a Dynamic Report is AF
Data 0 - IBM Cognos. If you change the fill color of this style to green, the change is reflected in all of the
cells in your workbook that use the AF Data 0 - IBM Cognos style.

You can apply different formatting to each cell in a format definition. For example, you can apply a
different background to each cell for format definition 1. You can apply an orange background to cell C3, a
blue background to cell D3, and a green background to cell E3. When you rebuild the form, cells with
format definition 1 display an orange background in column C, a blue background in column D, and a
green background in column E.

Any text or numbers you enter in a format definition row, other than in the format label column (typically
column A), are ignored. You can safely enter notes or characters to make it easy to identify the format of
any cell in the format range. For example, you can add a note in cell C3 as a reminder that this cell
determines the formatting for row title members.

To modify format definitions, reveal the format range, and then apply cell formatting to the cells in the
format range.

Note: To reveal the format range, unhide all rows and columns in the worksheet.

To see your changes, rebuild or repair the Dynamic Report.

Create format definitions
You can create format definitions for a Dynamic Report.

About this task
Each format definition must be assigned a unique label, and all format definitions must be inserted
between the Begin Format Range and End Format Range labels.

Procedure
1. Right-click the End Format Range label and select Insert.
2. Click Entire Row and then click OK.

A new row is inserted in the format range, inheriting the formatting of the preceding row.
3. In the first column of the format range (typically column A), enter a label for the format definition.

The label must be unique within the format range.
4. Apply formatting to the cells in the new format definition row.

Tip: You can enter notes or characters in columns other than the label column (typically column A) to
make it easy to identify the format of cells in the format definition.

5. Apply the format definition to the Dynamic Report. For more information, see “Apply format
definitions” on page 133.

6. Rebuild the Dynamic Report by pressing ALT+F9.

Apply format definitions
You can apply format definitions to rows in a Dynamic Report. Apply format definitions if you have
changed the label of a format definition or if you have created new format definitions.

About this task
If your Dynamic Report uses more than one format definition, the format label column (typically column
A) of the first row in the Dynamic Report must contain a function that resolves to one of the format
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definition labels in the format range. The format label column is set in the TM1RPTVIEW function by using
a cell reference or a named range.

To maintain dynamic formatting, do not use hardcoded values when you specify format definition labels in
the format label formula.

Procedure
1. Click the cell at the intersection of column A and the first data row in the Dynamic Report.
2. Modify the IF function to resolve to the format definition labels set in the format range.
3. Repair the Dynamic Report and view the formatting.

For more information, see “Refresh, rebuild, or recreate” on page 127.

Note: If the function in column A resolves to a value that is not used as a format definition label, no
formatting is applied to the Dynamic Report row.

Publish
You can share Dynamic Reports with other IBM TM1 users by publishing the workbook to a TM1 Server
Application folder.

When you open a Dynamic Report in IBM Planning Analytics Workspace or in TM1 Web, the Dynamic
Report is displayed as a websheet. You can refresh or rebuild the Dynamic Report or the workbook by
using the buttons on the Websheet toolbar.

For more information, see “Publish a workbook to a TM1 Server Application folder” on page 94.

Usage notes
Be aware of conditions and limitations when you use Dynamic Reports.

• Worksheet names must not include the dash (-) character.

Do not use a dash in the name of the worksheet that contains the Exploration View that you use to
generate a Dynamic Report. Also, do not use a dash in a worksheet that contains a Dynamic Report.

• The Sort feature of Microsoft Excel is not supported for Dynamic Reports.
• Dynamic Reports require at least one row dimension.

The Exploration View or list view from which you generate a Dynamic Report must contain at least one
row dimension. If the Exploration View or list view does not contain a row dimension, the Convert to
Dynamic Report option is disabled.

Create a Custom Report
You can create reports by using TM1 worksheet functions to populate the cells of the report.

You can create a Custom Report by using the following methods:

• Converting an Exploration View to a Custom Report
• Converting a view in the source tree to a Custom Report
• Manually entering formulas to build a report

The context members of a Custom Report can be defined by using SUBNM formulas. The data cells can be
defined by using DBRW formulas.

If you want to combine TM1 worksheet functions with automatic formatting, consider using a Dynamic
Report. For more information, see “Dynamic Reports” on page 125.

Create Custom Reports by using a view
You can create a Custom Report from a view. Views are listed in the source tree in the Views folder.
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Before you begin
You have access to a TM1 data source. The data source includes views. The administrator has configured
your access privileges.

Procedure
1. Select a TM1 system.
2. Log on to a TM1 server.
3. Select a data source.

The source tree displays the cube and related items of the data source, such as views.
4. Expand the Views folder.
5. Right-click a view, click Custom Report and choose an option.

What to do next
You can also create Custom Reports from a view opened in the Cube Viewer. See “Create a report” on
page 240.

Create Custom Report manually
You can create a Custom Report by entering formulas in cells and by dragging members from the source
tree.

For example, you can drag members from the source tree for the rows and columns, and then use DBRW
formulas to get data from the cube. You can define context members by using SUBNM formulas, and then
reference the SUBNM cells in the DBRW formulas.

You can also copy formulas from other worksheets to build the report. For example, if the context
members you need are defined on another worksheet, you can copy the cells to the formula-based report,
modify the context members as needed, and reference them in the DBRW formulas.

Change the cube and datasource of Custom Reports
Update the cube or datasource that formulas reference to switch from a test to a production environment.
For example, you can update the cube or datasource to access information from a different set of financial
data, such as a submission.

Procedure
1. From the worksheet you want to update, log on to the datasource and select the datasource.
2. To update all formulas in the report, do one of the following steps.

• If you are working with a Custom Report that you created from an Exploration View, edit the Cube in
the information area above the report. Use the format server:cube. server represents the name
datasource containing the cube and cube is the name of the cube.

Note: You may need to unhide the rows to reveal the format range. For more information on
revealing the format range, see “Report format” on page 131.

• If you are working with a Custom Report that you created manually, modify the cells where you
defined the server name and the cube name.

3. To update specific formulas, locate the formulas and modify the server:name parameter.

Tip: Use the Microsoft Excel search and replace function to update embedded references in the text of
cell formulas.
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Using data cell formulas in non-formula based reports
You can use formulas in your Exploration Views and Quick Reports.

Exploration Views and Quick Reports support the use of formulas in data cells. Formulas can be used to
calculate the value of a cell and can write back to the datasource. Your formulas can also reference other
cells, including calculations.

Note: Your formulas will be cleared after you commit your data. If you do not want your formulas to be
cleared, ensure that the Preserve user formulas option is enabled. To learn more about the Preserve
user formulas option, see “Preserve user formulas” on page 52.

Sets
Create and edit sets of members in a dimension to limit the number of members that you see in a view.
You can also create sets from hierarchies.

This video shows you how to create a simple set.

https://youtu.be/SOf-n-aZaXU

Edit a set for quick analysis
You can edit a set in IBM Planning Analytics Workspace without saving for quick ad-hoc analysis.

Procedure

1. Open the set by clicking the dimension tile in the cube view, and clicking .

2. Display the members that you want to create the set from by selecting from the Select hierarchy
menu, and the Select members to view menu.
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3. If your changes are simple, select the members that you want to be in the set in the Available
Members pane, and click Replace and close. The set editor closes and you return to the view,
displaying the members that you selected.

Note: The Replace and close button is not available when you create a new set.

Create and edit sets
A set is a collection of members in a dimension that limits the number of members that are displayed in a
view.

Procedure

1. To open the set, click the dimension tile in the cube view, and click .

2. Display the members that you want to use in the set by selecting from the Select hierarchy menu, and
the Select members to view menu.
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3. Select the members in the Available members list, then choose one of the following options to add
the members to the Current set:

• Click  to insert the members into the current set.

• Click  to replace all of the members in the current set.
• To append the members in the Available members list to the members in the Current set, click

, and then click .

• Tip: To control the members that are inserted into the set, click the bullet icon  and select one
of these options.

– Member only
– Children
– Descendants
– Leaf nodes
– Ancestors

Work in the Current set
4. To change the members in the Current set, do the following steps.

Change the position of a member
Right-click the member, then click one of the Move options. You can only change the position of a
member if the set is static. See “Convert a dynamic set to static” on page 144.

Remove members
To remove all members from the Current set, click .

Keep only selected members
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5. You can display the Member ID or the Alias for a member instead of the Caption. An alias is an

alternative name for a member. Click  and select the display name type.
Apply and save your changes.
6. To save your changes as a new set that can be reused in other views, click Save, and give the new set a

name.
Select Share public to share the set with other users. Clear this option to keep the set private.

7. If you are editing an existing set, you can apply the changes to your view without saving the new set
configuration. Click Apply and close.

Filter the selection in the set editor
If you have large dimensions, you can make it easier to find what you are looking for in the set editor by
filtering the selection in the Available members pane.

You can filter the selection in the following ways:

Restrict the content in the set editor to the selected members and their descendants

Select the members in the Available members pane, right-click the selection, and select Keep.

A selection is created that replaces All members. You can search in this selection, and you can use
the selection to create a set.

Select one of the default sets
All roots

Contains the root members of the hierarchy. The leaf members are hidden but can be displayed by
clicking . When All roots is searched, all members, including the leaf members, are searched.

All leaves
Contains the leaf members of the hierarchy. When this set is searched, only the leaf members are
searched.

All members
Contains all members in the hierarchy, both consolidation and leaf members.

Drill down on one or more members
Select the members in the Available members pane, right-click, and select Drill down. This option
creates a selection that can be searched in, or used to create a set.
You can also double-click a member to drill down.
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Expand selected members and show their children
Select the members, right-click, and select Expand to descendants. You can also collapse one or
more expanded members by selecting the members, right-clicking and selecting Collapse.

Show all ancestors
Select the members, right-click, and select Show all ancestors. Shows just the selected member and
its ancestors. Other members are hidden. This option creates a selection.

Paste members into the set editor
You can paste both member names and aliases into the set editor, in any combination.

When you paste an alias, the associated member name is inserted into the current set, and the alias is
displayed only if aliases are enabled in the set editor.

You can paste only member names that exist in the parent dimension. If you try to paste any names that
are not members of the parent dimension, an error message displays a list of those names.

Procedure
1. Copy the member names to the clipboard (CTRL+C for Windows, CMD+C for the Apple Mac) from

Microsoft Excel, Planning Analytics for Microsoft Excel, a word processor, or email, or from the Current
Set area.

In a spreadsheet application, names can be aligned on a single row or column, or on a contiguous
rectangular range, but there can be no empty cells within the copied selection. Empty cells cause an
error when you paste into the set editor.

In other applications, such as a word processor or email, each member name must appear on a
separate line or be on a single line that is separated by tabs. You can also copy member names from a
table. However, there cannot be any empty strings (a line without a member, a table cell without a
member, a tab location without a member) within the copied selection.

2. Use CTRL+V (Windows) or CMD+V (Apple Mac) to paste the member names into the current set.

If you paste into an empty current set, the pasted names become the current set.

If you paste into an existing current set without selecting an existing member as an insertion point, the
pasted names are appended to the end of the existing current set.

If you select a member in an existing current set as an insertion point, and then paste into the set:

• The pasted names are inserted immediately following the selected member, provided the selected
member is a regular dimension member (leaf or consolidation).

• If the selected member is part of a group of members that are returned by a dynamic query (or MDX
statement), the pasted names are inserted after the last group member.

Search in sets
You can search in the set editor when the list of members is large, or you are unsure of an exact member
name. You can also search to include members in the set that match specific criteria.

You can filter on name, level, or attribute. For example, filter members by one or more attributes so that
you can choose what appears in your tables and charts based on their attributes. The following example
shows a set that is filtered on two attributes: Engine type and Engine Size.
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When you search for members and save a set that includes the search results, a dynamic set is created
which contains a query that is run every time that the set is opened. If the parent dimension for the set
contains a new member that matches the search, the new member will be included in the set the next
time that the set is used.

For example, using search operators (<, >, <=,=>, <>), you can create dynamic selections based on ranges
of levels in your organization, accounts, or other hierarchy.

This video shows you how to use some advanced search features of the set editor to edit a set.

https://youtu.be/Mp2KDEWQedo

Search for members in a set
You can search in the set editor when the list of members is large, or you are unsure of an exact member
name. You can also search to include members in the set that match specific criteria.

Procedure

1. Click the dimension tile and click  to open the set editor.
2. To search for members whose names contain a specific series of characters, type the characters in the

Search available members box, then click .
The Available Members list shows all members that match the search, and a member that is named
Search that indicates the search criteria. For example, if you search for the characters en in a set of
the Region dimension, you get something like this:

Chapter 7. Explore TM1 data  141

https://youtu.be/Mp2KDEWQedo


When you add the member Search - (Name Contains en) to your set, the set includes all current
members that contain en. Additionally, the set will include any future dimension members that contain
en, such as Greenland or Venezuela.

3. To search on other criteria, click .
4. Select the type of criteria you want to search for: Name, Level, or Attribute.
5. Select a search operator (Contains, =, <>, <, <=, >, >=, Starts with, or Ends with), then type or select

the keyword or value you want to search for.

Tip: If you are searching for a text type attribute and you selected the = or <> operators, you can select
from a list of attribute values from a list. You can also filter the list of values. If you leave the attribute
value blank, members with no attribute defined are shown.

6. If you want to add criteria, click Add filter, then specify the additional search parameters.
You can search on up to three distinct criteria.

7. Click Search.
The Available Members list shows all current members that satisfy the criteria that you used, and a
member named Search that identifies the search criteria.

Related topics:
“Convert a dynamic set to static” on page 144
You can convert a dynamic set to a static set. When you convert to a static set, the MDX expression that
generated the dynamic set is deleted and the set contains only the members that are present at the time
of conversion.

Reorder members in a set
Use the set editor to define the order of the members in a set. Only members in a static set can be
reordered.

Procedure
1. Open the set editor for the set that you want to reorder.
2. Click Members (Selection).
3. Click Convert to static set .
4. In the Current set pane, right-click the member that you want to reorder.
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5. Reorder the member in the set by selecting Move to top, Move up, Move down, Move to bottom.
6. Click Apply and close.

Create a dynamic set
A dynamic set uses Multidimensional Expression (MDX) code. When you create a set from the data tree, a
dynamic set is created by default.
Dynamic sets update automatically based on the evaluation of an MDX expression. The members in a
dynamic set can change when new members are added to (or removed from) the parent dimension of the
dynamic set.

This feature is for advanced users only.

You can differentiate between dynamic and static sets by looking at the icons in the data tree, dimension

tiles in a view, or the set editor: dynamic  and static  sets.

For more information, see MDX Function Support.

Work through this procedure to find car models that constitute the top 20% of sales in a particular region
with the SData database.

Procedure
1. Create a book.
2. Navigate to the SData database, SalesCube cube, and expand Views. Right-click the All view and

select Add view.

3. Click the model dimension tile, and then click .
4. Click MDX .
5. Replace the existing MDX expression with this code:

TOPPERCENT(TM1FILTERBYLEVEL(DESCENDANTS({[model].[model].[Total]}) , 0), 
20.000000 , [SalesCube].([actvsbud].[actvsbud].[Budget],[region].[region].
CURRENTMEMBER,[account1].[account1].[Units],[month].[month].[Year]))

6. Click OK, and then Apply and close to return to the view.
7. The following steps verify that the models that you see constitute at least 20% of sales.

a) Click the Model dimension tile, and then click .

b) Set the insertion option  to Member only.
c) Move the Total member in the Available Members pane over to the Current Set .
d) Right-click the Total member, then click Move to top.
e) Click Apply and close to return to the view.
f) Right-click and select Show cell value as > % column total.

The value of the leaf member should be 20% or higher.

Related topics:
“Convert a dynamic set to static” on page 144
You can convert a dynamic set to a static set. When you convert to a static set, the MDX expression that
generated the dynamic set is deleted and the set contains only the members that are present at the time
of conversion.
“MDX string expressions” on page 144
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If you are using MDX expressions to create a dynamic set, you must be aware of the parsing rules for
string literals. Special characters and escape characters must be handled carefully in MDX string
expressions.

MDX string expressions
If you are using MDX expressions to create a dynamic set, you must be aware of the parsing rules for
string literals. Special characters and escape characters must be handled carefully in MDX string
expressions.

You must use a syntax notation that works correctly for all cases when special characters are embedded
in the strings.

Note: Using single-quoted string literals is preferred. However, Planning Analytics also supports double-
quoted string literals. Using double-quoted string literals requires care when you use MDX because the
JSON parser that is used for TM1 REST API also uses the double quotation mark as a string delimiter.

Example with single quotation marks in a string

Consider the string literal O'Reilly.

• Using single-quoted string literals, O'Reilly must be represented as 'O''Reilly'

The string must use a single quotation mark to escape the single quotation mark.
• Using double-quoted string literals, O'Reilly must be represented as \"O'Reilly\"

The string must use a back-slash to escape the double quotation mark. The single quotation mark in
O'Reilly does not need escaping.

Example with double quotation marks in a string

Consider the string literal O"Reilly.

• Using single-quoted string literals, O"Reilly must be represented as 'O\"Reilly'

The double quotation mark in O"Reilly must be escaped to satisfy the JSON parser.
• Using double-quoted string literals, O"Reilly must be represented as \"O\"\"Reilly\"

The double quotation mark in O"Reilly must be double escaped; once for the JSON parser, and again
for the MDX parser.

As you can see in these examples, using single-quoted string literals is simpler and preferred.

Convert a dynamic set to static
You can convert a dynamic set to a static set. When you convert to a static set, the MDX expression that
generated the dynamic set is deleted and the set contains only the members that are present at the time
of conversion.

About this task
Converting a dynamic set to a static set is useful when you have added a calculation to a dynamic set, but
want to control the positioning of the calculation in the set. When you add a calculation to a dynamic set,
the position of the calculation in the set is determined by the MDX expression and the position cannot be
changed. When you convert to a static set, you can move the calculation to any location in the set.

Procedure
1. Open the dynamic set in the set editor.
2. Click Save to save the set as static.
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View properties and attributes in a set
You can view properties and attributes for members in the set editor.

You can view any defined attributes:
Weight

The weight property controls how a child member rolls up to its immediate parent, whether that child
is also a parent of another consolidation or a leaf member. Top level consolidations do not have a
weighting.

Level
Show the level of the member in the hierarchy.

Type
See whether a member is consolidated or simple (leaf).

Index
The display order of members in a dimension.

Name
The member ID.

Procedure

1. In the set editor, click .

2. Select the attributes  and properties  in the Available attributes and properties pane, and
move them across to the Selected attributes and properties pane.
You might need to scroll down to view all properties. The order in which the attributes and properties
are listed on the right pane determines the order in which they are displayed in the set editor. You can
change the order by using the arrows.
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Delete a set
You can delete sets that are not currently used in any views. If you are a TM1 administrator, you can
delete any public set or any private set that you own. If you are not an administrator, you can delete only
private sets that you own.

Procedure
1. In the navigation tree, locate the set you want to delete. The path to a set is <Database_Name> >

Dimensions > <Dimension_Name> > <Dimension_Name> > Sets > <Set_Name>.
2. Right-click the set, then click Delete Set.

Results
After you delete a set, the navigation tree contracts to the database level.
Related topics:
Understanding Administrative Groups and Authority

Use the keyboard to work in the set editor
You can work in the set editor with the keyboard instead of the mouse.

Navigation and selection overview
Move between enabled items in the set editor

Press the Tab key to move to the next item.
Press Shift+Tab to go to the previous item.

Open a menu
With the focus on the menu, press Enter or the Space bar.

Move through items in a menu and members
Press the up and down arrow keys. To move to a sub menu, press the right-facing arrow key.

Select an option
Press Enter.

Select consecutive members (multi-select)
Highlight the first member that you want to select, hold Shift, and then use the arrow keys to select
the next members.

Expand and collapse consolidated members
Press Enter, or the right arrow to expand consolidated members, and press Enter or the left arrow to
collapse.

Show a context menu
On a Windows keyboard, press Shift+F10. On an Apple Mac keyboard, press Shift+Fn+F10. Use the up
and down arrow keys to move through the items.

Work in attributes menus

Tab to  and press Enter. Press the up and down arrow keys to move through the menu, and
press Enter to select an attribute. Tab to OK and press Enter to close the menu.

Navigate in the MDX Editor
To move around the controls, press the Tab key to move to the next control and press Shift+Tab to go
back to the previous control.
When the focus is inside the rich text editor, on a Windows keyboard, press CTRL+F2 to move to the
next control, and Shift+CTRL+F2 to go to the previous control. On an Apple Mac keyboard, press CMD
+fn+F2 to move to the next control, and Shift+fn+CMD+F2 to go to the previous control.
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Navigate in the set editor by using the keyboard.
Press Tab to navigate through the items in the set editor. To move backwards through the items, hold Shift
and press Tab.

When an area of the screen has focus, it has a contrasting line around it. When you open the set editor, the
first highlighted item is the Available Members pane.

To open a menu for an item that has focus, press Enter. You can move through the items in the menu by
pressing the down and up arrow keys. When a menu item is selected, it has a blue background.

Select members in the Available Members pane by using the keyboard
Tab to the Available Members pane. A black line appears around the pane when it has focus.

To select members in the Available Members pane, press the down and up arrow keys until the member
has focus. A member with focus has a dark blue background.

Press Enter to expand a consolidated member, and press Enter again to close it.

To select consecutive members, highlight the first member that you want to select, hold Shift, and then
use the arrow keys to select the next members.

When you highlight members, they stay selected so you can select either insert  or replace 
to move the members to the Current Set.

Search with filters in the set editor by using the keyboard
To create filters to search for members in the All members pane with the keyboard, do the following
steps:

1. Press Tab until  has the focus.

Note: Depending on which item in the Set Editor has focus, it can be quicker to use Shift+Tab to move

to .

Then, press Enter to display the search filters.
2. To set a filter, with the focus on Name, press Enter, then press the down arrow key to move through the

Level and Attributes menu items. Press Enter to select a menu item.
3. If Attributes has a sub menu, press the right arrow key to move the focus to the sub menu. Use the up

and down arrow key to move through the items, and press Enter to select an item.
4. After you select either Name, Level, or Attribute, press Tab to move to the next filter. Focus on either

Contains , = or <> by using the down or up arrow keys, and press Enter. Then, tab to the next field and
type the keyword that you want to search on.

5. Tab to Add filter, then press Enter to add a filter and repeat the previous steps.
6. To begin the Search, press Tab to go to Search, then press Enter.
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Modify TM1 data
You can modify data in reports that use an IBM Planning Analytics with Watson data source.

For example, when your TM1 Server Application folder administrator distributes an enterprise-wide plan,
you can use IBM Planning Analytics for Microsoft Excel to create an exploration to review, analyze, and
update the portion of the plan that is assigned to you.

You can edit TM1 data using the following methods:

• You can edit data in the cells of Exploration Views and Quick Reports.
• You can use data spreading in Exploration Views and Quick Reports to distribute numeric values.
• You can add comments to cells

You can also write back data using TM1 worksheet functions, such as DBRW.

IBM Planning Analytics for Microsoft Excel offers different ways to work with IBM TM1 data changes. The
Writeback mode and the Sandbox settings determine how changes to the server data are managed.

Writeback mode
IBM Planning Analytics for Microsoft Excel offers different ways to work with IBM TM1 data changes. The
Writeback mode in combination with the Sandbox determines how changes to the server data are
managed. Options allow the administrator to mix and match a variety of capabilities so that every
installation and every user group can work in the way that is best for them. In IBM Planning Analytics for
Microsoft Excel you can hold changes in a private workspace so that you can decide when to write the
data changes back to the server and make your changes available to others. This private workspace is
called a sandbox. When you commit the data changes that were in your private workspace to the base
data, the changed values are written to the server.

If you prefer to work directly with the base data without a private workspace, you can choose a direct
writeback method. Another option your administrator can offer is the ability to name and store data
changes in a named sandbox.

When you work in a sandbox IBM Planning Analytics for Microsoft Excel uses a change in cell coloring to
remind you when your data is not yet merged with the base. Once you commit the sandbox, the cell color
is restored to black. For more information, see “Cell coloring for changed data values” on page 152.

Your administrator assigns the capabilities for each user group using the administration tools in IBM TM1.
Since you could be a member of more than one group, your workspace options can be different depending
on your login, the client you use, and the combination of settings. Only administrators have access to the
Capability Assignments.

Ask your administrator for details about how your system is designed to operate. To learn how to
determine your writeback mode and sandbox setting using the toolbar, see “Toolbar options” on page
149. For details about Capability Assignments, see the IBM Cognos TM1 Operation Guide.

Writeback mode settings
The Personal Workspace Writeback Mode capability determines how data is written back to the server.
Writeback mode is determined by whether a user has the Personal Workspace Writeback Mode capability
on or off.

To have the sandbox capability in IBM Planning Analytics for Microsoft Excel, an administrator must
assign you rights in IBM TM1.

Table 12. Personal workspace writeback mode capabilities

Description Capability

Changes are made directly to the base. Off
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Table 12. Personal workspace writeback mode capabilities (continued)

Description Capability

Changes are held in a temporary area and are manually written to the base
using the Commit button or option. Cell coloring changes when data is
changed but not yet committed.

On

The Sandbox capability determines if you can name sandboxes or if you have one default sandbox:

Table 13. Sandbox capabilities

Description Capability

You can name the sandbox and manage multiple sandboxes. On

Only one default sandbox is available. Off

The combination of these settings determines how your data changes are stored and processed.

For example, your user group might offer direct writeback with named sandboxes. This is the default work
design used by TM1. It means that you do not have a personal workspace (instead you have direct
writeback to the server), but you also have the option of naming a set of changes and manually submitting
them. With this setting, when you first open a view, you are in the base and any changes you make are
written directly to the base. But, if you decide to save your changes in a named sandbox, you can use the
Commit button when you are ready to manually send those changes to update the base.

Consider the case where you usually want to send the data directly to the server. Then you have a set of
changes that you want to gather in a group before you update the server. You can use the Create Sandbox
options to save the current data changes in a private sandbox called Best Case. When you are in the Best
Case sandbox, you use the Commit button to send the changes to the base and make the changes
available to others. After Best Case is committed, those changes merge with the base so that others can
see the changes and you are now in the newly updated base.

If you are working in a sandbox, it is important to remember that you must manually commit the sandbox
for others to see your changes. Be sure that you are ready to make those changes public and that those
changes should be merged into the base.

If you move back to the base, you are back to using direct writeback. This setting offers flexibility. Users
with this setting need to remember when they are updating the base and when the Commit button is
needed to make changes available to others.

Your administrator may decide that you would like the flexibility to work in a personal workspace
writeback mode, but you do not want the complexity of creating named sandboxes. In this case, your
administrator can grant you the Personal Workspace Writeback Mode capability but deny the Sandbox
capability.

Toolbar options
You can determine how your user group is designed to operate based on the options presented on the
toolbar. For example, if you have been granted Sandbox capability, you have access to the Sandbox part
of the toolbar. When you do not see a sandbox list, work with data in Microsoft Excel and then commit
changes directly to the IBM TM1 server.

Direct writeback and named sandboxes
By default, IBM TM1 is set to use a direct writeback with named sandboxes. Your administrator might
have set your work options to something different.
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Table 14. Personal workspace mode and sandbox options

You want to Personal Workspace
Mode

Sandbox

Have data changes update the server immediately. Occasionally,
you want to save a set of changes and name them before
committing them to the server.

Off On

The New icon indicates that you can create and delete sandboxes. Until you create a sandbox, you are
operating in the base.

Direct writeback without sandboxes
In direct writeback mode you do not have access to named sandboxes. You work with data in Microsoft
Excel and then click the Commit Changed Values icon to commit changes directly to the IBM TM1 server.

To use direct writeback across the entire installation, you can set DisableSandboxing=T in the TM1
server configuration file. When sandbox mode is disabled for a server, the Capability Assignments are
ignored.

The toolbar in this case does not have any of the sandbox icons, such as New Sandbox or Merge
Sandbox. You have no access to any kind of sandbox.

Virtual sandbox dimensions
With the virtual sandbox dimension feature, you can create your own personal workspace or sandbox
where you can enter and store data value changes separate from base data.

A sandbox is not a copy of the base data, but a separate overlay or layer of your own data values on top of
the base data. The distinction between base data and sandbox data is important to understand as you
make changes to your data.

• Base data is the data that all users can access. Any edits made to base data are written directly back to
the database.

• Sandbox data is the data in your own personal work area where you can edit the data values as many
times as you want and keep the changed data separate from the base data. Sandboxes are private to
each user and cannot be seen by other users. Your data values are viewable to others only when you
merge them back with the base data.

Sandboxes are not stored on the client. They consist of a separate and private area of the server. When
you make a change to data in the sandbox, it is as if the base model data value is temporarily blocked by
the value you entered in the sandbox. To make the base model take on the values in the sandbox, you
must merge the sandbox values with the base values. After the sandbox data values are committed, they
are merged with the base so that the changed values then update and become the base values.

Sandboxes include the following features:

• Private data changes

Sandboxes let you try out different changes to the data before making those changes public to other
users and before committing those changes to the base data.

• Cell coloring

Changes to cell values in a sandbox are identified by a change in cell content colors. The cells change
color to remind you that the change has not yet been committed to the base data. After data is
committed and processing is complete, the cell coloring turns to black again.

Cell coloring is also applied to any dependent cells, such as consolidated or rule calculated cells, that
your edits affect.

• Manual commit
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When working in a sandbox, the Merge button becomes available so you can decide when to commit
changes to the base. When you commit the data, your changes become available to other users.

• Discard changed values

In a sandbox, the Discard icon becomes available and lets you reset the values that you have changed
but not committed. When you discard changed values, the values you have not committed are reset to
the values in the base data.

• Named sandboxes let you create what-if scenarios

Depending on your configuration settings, you can name multiple sandboxes, such as Best Case or
Worst Case and then compare the impact of your edits by switching between them.

Remember: Your administrator might have disabled sandboxes for your environment or changed the
writeback mode for your user group.

To work in a sandbox, you must first open a view and then either create a new sandbox or select an
existing sandbox. When working in a sandbox, the selected sandbox applies to all the other views in your
current user session.

Sandbox limitations
The following are limitations of the sandbox feature in Planning Analytics for Microsoft Excel:

• You can add sandboxes as a dimension in the Cube Viewer. However, if you generate a report from the
Cube Viewer, the sandbox dimension will not be present in the generated report.

• Planning Analytics for Microsoft Excel does not fully support the Sandboxes dimension.

Data values for leaf and consolidated cells in a sandbox
The data values for leaf and consolidated cells in a sandbox are calculated.

Leaf cell values in a sandbox are a combination of the values in the base and sandbox cells. The user-
entered values in sandbox leaf cells override the values in the base. If the values are entered over a
consolidated cell, the data will be automatically spread and immediately recalculated. Any leaf cell that
has not been changed in a sandbox still shows the base data.

Consolidated cells in a sandbox contain values that are the sum of the leaf cells displayed in the sandbox.

Reset data values in a sandbox
Resetting a sandbox clears the data values that you have changed but not committed and resets them
back to the current values in the base data.

About this task
For example, suppose you enter values in two cells and commit the changes to the server. You then enter
a value in a third cell, but do not commit the change. When you click Discard Changed Values, the values
you entered in the first two cells are unchanged, but the third cell changes back to the value in the base
data.

Procedure
1. From the IBM Planning Analytics tab, click the Discard icon.
2. Click OK.

Results
The data values in the sandbox that you have changed but not committed are set to the current values in
the base data. Any cell coloring is cleared and set to black.
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Cell coloring for changed data values
When you enter a new value in a sandbox, a visual indicator is applied to the cell to remind you that the
new value is different from the base values. The color of the data changes to blue after you press the
Enter key. The number changes back to black when you commit changes. Any dependent cells, such as
consolidated or rule calculated cells, also change in appearance if your edits cause them to be
recalculated.

The following table summarizes the default cell coloring that is applied in Planning Analytics for Microsoft
Excel when you enter new data values in a sandbox. These color attributes can be changed.

Table 15. Cell coloring attributes

Cell or font color Description

Black font and orange background Committed sandbox data that differs from the base.

Blue bold font. Newly input data.

After you type the value and press the Enter key the font turns
bold and blue. Other cells that turn blue because of this are
formula cells that reference this cell and adopt this change in
color as well.

Edited cells, dependent or consolidated cells, recalculated cells

White cell background Leaf input cell

Blue cell background Consolidated input cell

Gray cell background Locked cell

Commit changed data from a sandbox to base
You can merge all of the committed data values in your sandbox to the base data. You cannot use the
undo command to undo a merge action.

When you have multiple sandboxes and commit one of them to base, the new base values are
automatically applied to all the unchanged cells in your other sandboxes. If you entered new data values
in any other sandbox, those data values remain and do not show the new values that were committed to
the base data.

Procedure
1. On the toolbar, click Sandbox and select the sandbox whose data you want to merge with the base

data.

2. Click Merge Sandbox with Base.

Results
• The changed data values in the current sandbox are saved to the base data.
• The cell coloring for any changed data in the current sandbox is cleared and set to black.
• The new base data values are applied to all the unchanged cells in your other sandboxes.

When you have multiple sandboxes, you can use the toolbar to create, delete and select the different
sandboxes available to you.
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Edit TM1 data in reports
In a report that is based on a TM1 data source, you can edit values directly in the cells.

You can edit TM1 data using the following methods:

• You can edit data in the cells of Exploration Views and Quick Reports.
• You can use data spreading in Exploration Views and Quick Reports to distribute numeric values.
• You can add comments to cells

You can also write back data using TM1 worksheet functions, such as DBRW.

Edit data by typing values in cells
You can edit data in the cells of an Exploration View or IBM Planning Analytics for Microsoft Excel, if you
have Write access to those cells. The Exploration View interface identifies the cells that are writable by
using a special cell format that is customizable.

Procedure
1. To edit a value in a cell, click the cell and type the new value.
2. After entering a new number, press Enter or click another cell.

The new number displays in bold and blue, which indicates that there is a new value in this cell. You
must commit the data changes to the IBM TM1 server for the change that you made to persist.

3. To save the changes to the TM1 server, click Commit .
After you click Commit, you have the option to preview information about the changes that will be
saved to the TM1 server. You cannot undo changes after saving to the TM1 server.

Results
After committing the changes, the report displays the updated values in a normal font, indicating that you
saved the changes.

Edit TM1 data by using data spreading
You can use data spreading to enter or edit numeric data using a predefined distribution method, called a
data spread method.

Data spreading is available when you are working with TM1 data. Your administrator must also give you
capability assignments on the TM1 server for data spreading. For more information about capability
assignments, see the IBM Cognos TM1 Operation Guide.

Use data spreading in Exploration Views and Quick Reports
You can use data spreading to enter or edit numeric data in an Exploration View or Quick Report by using
a predefined distribution method, called a data spread method. For example, you can evenly distribute a
value across a range of cells or increment all values in a range of cells by a percentage.

Procedure
1. Select a cell or range from which you want to initiate data spreading.

You can initiate spreading from a single cell or a single linear range of cells. You cannot initiate
spreading from a non-contiguous range of cells, nor can you spread data across multiple individually
selected cells or ranges in a worksheet.

2. Right-click the cell or range and click IBM Planning Analytics > Spread.

Note: If the Spread command is not available, data spreading might be restricted on the server. Ask
your administrator to check the capability assignments configured in the data model.

3. Select a data spreading method.
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The methods that are available in the Spreading dialog box depend on the cells that you selected for
data spreading. For example, some methods, such as Equal Across Leaves, are applicable to
consolidated cells only.

4. Select an Update action.
5. Specify the required values.

For example, if you selected the Growth % method, enter the growth percentage.
6. Click OK.

Note: You can also apply data spreading by typing data spreading syntax in a cell.

Exclude cells from data spreading
You can apply a hold to a cell, or a range of cells, to exclude cells from data spreading operations.

About this task
You can apply a hold to consolidation cells and leaf cells.

When a consolidation hold is applied, you can initiate data spreading from a single leaf cell. Based on the
data spreading value you apply to the selected leaf cell, the remaining leaf values are updated so that the
consolidation value remains unchanged.

For example, you apply a hold on the consolidated cell at the intersection of S Series 1.8L Sedan and 1
Quarter. This consolidation hold keeps the value in the cell constant at 1,000.

Figure 7. Example hold applied to a consolidation cell

If you initiate proportional data spreading from the cell at the intersection of S Series 1.8L Sedan and Mar
and specify a value of 700, the Jan and Feb leaf values are changed proportional to their existing values.
Jan has a value of 120 and Feb has a value of 180. The consolidation of the leaves remains 1,000.

Figure 8. View of unchanged consolidation value

You can apply a hold to both the consolidated cell and one or more leaf cells. Using the original values in
the example, you apply a hold to the consolidated cell and a single leaf cell, Jan. When you change Mar
from 500 to 700, proportional spreading affects only the Feb cell. The value for Feb changes to 100. The
consolidation of the leaves remains 1,000.

Procedure
Right-click a cell and click IBM Planning Analytics > Set Hold.
To apply a hold to a range of cells, you must set a hold for each cell in the range separately.

Results
The formatting of the cell changes to show a hold is applied. To change the formatting, modify the Hold
Values - IBM Cognos style.

To remove a hold, select a cell with a hold applied and click IBM Planning Analytics > Remove Hold.
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Data spreading methods
IBM Planning Analytics for Microsoft Excel provides a variety of data spreading methods that you can use
to distribute numeric data to cells in an exploration. For example, you can use data spreading to evenly
distribute a value across a range of cells or to increment all values in a range of cells by a desired
percentage.

The methods that are available in the Spreading dialog box depend on the cells that you select for data
spreading. For example, some methods, such as Equal Across Leaves, are applicable to consolidated cells
only.

Proportional
The proportional spread method distributes a specified value among cells proportional to existing cell
values.

For example, consider a view in which the values for Argentina in the months January, February, and
March are 10, 30, and 60, respectively.

The sum of these values is 100, with the value in January accounting for 10% of the sum, the value in
February accounting for 30%, and the value in March accounting for 60%.

When you proportionally spread the value 300 across these cells and select the Replace update action,
the result is as follows.

• January contains the value 30, which is 10% of 300
• February contains the value 90, which is 30% of 300
• March contains the value 180, which is 60% of 300

These values are proportionally equivalent to the cube values that existed before you apply data
spreading.

Repeat
The repeat method repeats a specified value across cells in a view.

The value you enter repeats across the range of cells that you selected. When you apply the repeat
spreading method to a single consolidated cell, the value being spread is distributed proportionally to all
leaves of the consolidated cell.

Repeat Across Leaves
The repeat leaves method copies a specified value to the leaves of a consolidation. When you apply this
method, you can copy the value to all leaves of the consolidation or only to those leaves that already
contain non-zero values.

For example, assume that there are several leaves of Year, Argentina with values.

If you use the repeat leaves method to copy the value 400 to the leaves of Year, Argentina currently
populated with non-zero values, the value 400 is copied to all leaves that contained non-zero values.

If you initiate the repeat leaves method from a cell identified by more than one consolidated member, the
specified value is copied to all leaves associated with the cell.

Table 16. Options for the repeat leaves data-spreading method

Option Description

Populated Leaf Cells The specified value is copied only to leaf cells currently containing
non-zero values.

All Leaf Cells The specified value is copied to all leaf cells regardless of current
values.
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You can apply the Repeat Across Leaves method only to consolidated cells.

Straight
The straight line method populates cube cells by linear interpolation between two specified endpoints. It
requires both a start value and an end value.

For example, with the start value of 100 and the end value of 200, the option populates the intervening
cells with values at equal intervals between the two endpoints.

You can apply straight line spreading only across single rows or columns, not across rectangular ranges.

% change
The percent change method multiplies the current cell values by a specified percentage. The product of
that multiplication can then replace, be added to, or be subtracted from the existing cell values.

When you apply the percent change method and specify a % Change value of 10, the system multiplies
each cell value by 10% (or .10). If you select the Add update action, the product of multiplication is added
to the existing cell values. The result is that each cell value is increased by 10%. The percentage change is
applied across the range of cells that you selected.

Equal
The equal spread method distributes a specified value equally across the cells in a view.

For example, consider a view where a range of 12 cells is selected.

When you equally spread the value 60 to these cells and select the Add update action, the value is
equally spread across the range and added to the existing cell values. The result is that each cell value is
increased by 5 (60/12=5).

The value you entered spreads equally across the range of cells that you selected. When you apply the
equal spread method to a single consolidated cell, the value being spread is distributed proportionally to
all leaves of the consolidated cell.

Equal Across Leaves
The equal spread across leaves method distributes a specified value equally across all leaves of a
consolidated cell. When you apply this method, you can choose to distribute the value to all leaves of the
consolidation or only to those leaves that already contain non-zero values.

If you initiate the equal spread across leaves method from a cell identified by more than one consolidated
member, the specified value is distributed to all leaves associated with the cell.

Table 17. Options for the equal spread leaves method

Value Description

Populated Leaf Cells The specified value is copied only to leaf cells currently containing
non-zero values.

All Leaf Cells The specified value is copied to all leaf cells regardless of current
values.

You can apply the Equal Across Leaves method only to consolidated cells.

Growth %
The growth % method accepts an initial value and a growth percentage. By using the initial value as a
starting point, this method sequentially increments all values in a range by the specified growth
percentage.

156  IBM Planning Analytics: Planning Analytics for Microsoft Excel



You can apply growth % spreading across single rows or columns, not across rectangular ranges.

Clear
The clear method clears values from cells in a view. You can apply this method to either leaf cells or
consolidated cells. When you apply the clear method to a consolidated cell, all leaves of the consolidation
are set to zero.

Data spreading and hold syntax
You can apply most data spreading and hold methods using a syntax that you enter directly in cells.

You must use the user interface to apply the repeat leaves and equal spread across leaves methods. You
must use the user interface to spread across a selected range of cells.

Each data spreading syntax expression consists of a method code, a data action (optional), and method
parameters.

For example: s+100

The method code is s, the data action is +, and the method parameter is 100.

The method code is a one- or two-character code for a data spreading method. For example, S is the
method code for the equal spread method. For more information, see “Data spreading and hold syntax
reference table” on page 157.

The data action indicates whether spread values will replace, be added to, or be subtracted from the
existing cell values.

Replace
If you do not specify an action, the existing cell values are replaced with the spread values.

Add
Plus sign (+) adds spread values to the existing cell values

Subtract
Tilde (~) subtracts spread values from the existing cell values.

The method parameters supply all parameters required to execute a given spreading method. Most
methods require only a parameter indicating the value to be spread. The required method parameters for
each spreading method are listed in “Data spreading and hold syntax reference table” on page 157.

Data spreading and hold syntax reference table
The following table describes the data spreading and hold methods that you can apply with the syntax.

Table 18. Data spreading and hold syntax

Method Code Required Method
Parameters

Data Action
(Optional) *

Example

Proportional
Spread

P Value to be spread +, ~ P<>100

Proportionally spreads the
value 100 to all leaf cells,
and replaces the existing
cell values.

Equal Spread S Value to be spread +, ~ S+200

Equally spreads the value
200 to all leaf cells, and
adds the product of
spreading to the existing
cell values.
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Table 18. Data spreading and hold syntax (continued)

Method Code Required Method
Parameters

Data Action
(Optional) *

Example

Repeat R Value to be spread +, ~ R~50

Subtracts the value 50
from all leaf cells.

Percent Change P% Percentage +, ~ P%+10

Applies a percent change
of 10% to all leaf values,
adds the product to the
existing cell values, and
increments all leaves by
10%.

Straight Line SL Start Value and End
Value

+, ~ SL100:200

Replaces all leaf values,
with a start value of 100
and an end value of 200.

Growth % GR Start Value and
Growth Percentage

+, ~ GR300:25

Applies a 25% growth
percentage to the starting
value of 300 and replaces
all leaf values below the
point of insertion.

Clear C N/A N/A C

Clears values from all
cells.

Leaf Hold H N/A N/A H

Holds all leaf cells.

Release Leaf Hold RH N/A N/A RH

Releases all leaf holds.

Consolidation Hold HC N/A N/A HC

Holds all consolidated
cells.

Release
Consolidation Hold

RC N/A N/A RC

Releases all holds of
consolidated cells.

Release All Holds RA N/A N/A RA

Releases all holds on the
cells.
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* The default data action is Replace. The spreading syntax uses a tilde (~) to denote the Subtract data
action, and a plus sign (+) to denote the Add data action.

Add and view comments in cells
You can add and view comments in TM1 Exploration Views and Quick Reports.

Before you begin
In Microsoft Excel 2013, click File > Options, and then click Advanced. Under Display, select how you
want comments to be displayed in workbooks.

About this task
Use comments to indicate the significance of the cell value. For example, state why the variance between
forecast revenue and actual revenue for a product is high. You can view all comments that were added to
a cell. Use the Annotations dialog box to create, view, update, or delete comments.

Hover over a cell with a comment marker to see the comment, the user who entered the comment, and a
time stamp.

Procedure
1. To work with comments, right-click a cell, click IBM Planning Analytics > Annotations.
2. Use the Annotations dialog box to add, view, update, or delete comments.

Resolve errors when committing data to a TM1 server
When you commit data to an IBM TM1 server, the Error Report dialog box displays any errors.

For each error, the Error Report dialog box displays an error description and the intersection of members
where the error is located. When you click a row of error information, the cursor moves to the related cell,
enabling you to correct the error.

Error messages include the following:

• Consolidated: The member is a consolidated member. The cell is read-only.
• Hold: A hold has been placed on the cell. The cell is read-only.
• Incorrect Type: The value you entered does not match the data type of the member. This error occurs,

for example, if you enter text in a cell that requires a numeric value.
• Locked: The cell is locked. The cell is read-only.
• Rule Derived: The cell contains a calculated value or a value derived from other cells. The cell is read-

only.

Set options for committing data
You can choose to skip the commit confirmation step when committing data. You can also choose to
commit valid intersections automatically.

You can hide the confirmation dialog box.

• If you are working with an Exploration View, click Options, and then click IBM Planning Analytics.
Select the Hide commit confirmation check box.

• If you are working with a Quick Report, in the Commit Changes dialog box, select Hide commit
confirmation. When you commit data, the Commit Changes dialog box is not displayed and valid values
are sent to the TM1 server. If any errors are found, the Error Report dialog box is displayed.
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To turn confirmation back on, click Options, and then click IBM Planning Analytics. Clear the Hide
commit confirmation check box. You can also turn confirmation on or off using the
CommitWithoutConfirmation setting in the CognosOfficeReportingSettings.xml file:

<setting name="CommitWithoutConfirmation">False</setting>

You can choose to commit valid values automatically. In the Error Report dialog box, select Automatically
Commit Valid Intersections.

To turn this feature off, change the BulkUploadAutoCommitValid setting to False in the
CognosOfficeReportingSettings.xml file:

<setting name="BulkUploadAutoCommitValid">False</setting>

On Windows 7, the CognosOfficeReportingSettings.xml configuration file is installed in c:\Users
\[user_name]\AppData\Local\Cognos\Office Connection.

IBM TM1 functions
You can add formulas that use IBM TM1 functions to reports. You can also convert Exploration Views that
use TM1 data to formulas. For advanced analysis, you can create reports that use formulas to populate
the cells of a worksheet.

For information about formulas in IBM Cognos Analytics reports, see “Create a Custom Report” on page
226.

TM1 worksheet functions in IBM Planning Analytics for Microsoft Excel
You can use TM1 worksheet functions in IBM Planning Analytics for Microsoft Excel.

You can work with TM1 worksheet functions in the following ways:

• Create an Exploration View and convert it to a Dynamic Report or a Custom Report
• Open a workbook that was created from a slice in TM1 Perspectives.
• Open a workbook that was created using the Slice to Excel export option in TM1 Web Cube Viewer.
• Manually add the TM1 worksheet functions to a worksheet.

Things to consider:

• The IBM Cognos Office Reporting TM1 add-in is required to provide access to the TM1 worksheet
functions. The add-in is enabled by default when you install IBM Planning Analytics for Microsoft Excel.

• When refreshing a report, you need to be connected to a TM1 server. If you are not connected to a TM1
server, your TM1 worksheet functions will return a #N/A value upon refresh.

• A worksheet can contain only TM1 worksheet functions, or you can add TM1 worksheet functions to a
worksheet that contains other explorations or Quick Reports.

• Parameter values are case sensitive, unlike in TM1 Perspectives. If a parameter value is not found, the
function returns RECALC_0_0.

• If a worksheet function references an object on a remote server, you must prefix the object with the
server name and a colon. For example, to refer to the SalesCube cube on the SData server, use
SData:SalesCube. To refer to the Region dimension on the SData server, use SData:Region. You
must be connected to the server referenced by the function to receive accurate values in your
worksheet. If you are not connected to the server, TM1 worksheet functions return *KEY_ERR.

• Nesting certain functions is supported if you want to nest more than one function inside of a formula or
inside of another function.

Note: If you nest functions, you will not be able to perform data intersection specific actions, such as
drill throughs or spreading.
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Modify functions by using the Function Editor
You can modify the members that are used in a function by using the Function Editor. You can also modify
functions directly, but the Function Editor can be easier to use.

Before you begin
You must be connected to the data source referenced in the server:cube parameter.

Tip: To open the data source, right-click the cell and selectIBM Planning Analytics > Display Package.
The source tree displays the data source.

Procedure
1. Click a cell that contains a function and click the Microsoft Excel function button.

The Function Editor is displayed. The Arguments list shows the parameter values currently used by
the function. The Formula Result field will display RECALC_#_# as the formula result may change
when recalculated.

2. Modify the members that are used in the parameters by using any of the following techniques:

• To specify a value directly, type a member name into the field. For example, to change the member
for the first dimension in the cube, type a member name into the first field.

• To use a cell reference, click . Click a cell and then click OK.
• To use the set editor, right-click the dimension, select IBM Planning Analytics > Edit set. Use the

set editor to select a member, and then click Apply and close.

Note: You might need to scroll down in the Function Editor to see all of the parameters.
3. Click OK.

The function is updated in the worksheet.

Enable and configure TM1 functions

Enable the add-in required to work with TM1 worksheet functions
To work with TM1 worksheet functions in IBM Planning Analytics for Microsoft Excel, the IBM Cognos
Office Reporting TM1 add-in must be enabled. The add-in is enabled by default when you install IBM
Planning Analytics for Microsoft Excel. If the add-in is disabled, however, you can enable it.

The IBM Cognos Office Reporting TM1 add-in is installed in [installation_location]\IBM for
Microsoft Office. The file name is CognosOfficeTM1.xll.

You can also follow along by watching this video: https://youtu.be/k8bgqwjK5Yw

For information about enabling add-ins, see the Microsoft Excel Help.

Before you begin
If installed, disable the IBM TM1 Perspectives add-in. The IBM TM1 Perspectives add-in and the IBM
Cognos Office Reporting TM1 add-in cannot be active at the same time.

Configuration settings for working with TM1 worksheet functions
You can configure server connection information and specify the sandbox to use when working with TM1
worksheet functions.

If IBM Planning Analytics for Microsoft Excel does not recognize the TM1 server required by TM1
worksheet functions, you are prompted to select the host and server. The server connection information is
saved to the CognosOfficeXLLSettings.xml file. On Windows 7, this configuration file is installed to
Users\[user name]\AppData\Local\Cognos\Office Connection.
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When you create a connection to a TM1 server to support working with TM1 worksheet functions, the
default connection information does not identify a sandbox. To specify a sandbox, you must edit the
connection information in the CognosOfficeXLLSettings.xml file to change the default sandbox
setting from null to the sandbox name. The following is an example of a connection string showing the
default sandbox setting.

<userSettings>
<setting name="ServerMap">{"Servers":[{"Name":"SData","RESTuri":null,
     "Sandbox":null}]}
</setting>
</userSettings>

Troubleshoot TM1 worksheet functions
Use the information in this topic to help troubleshoot TM1 worksheet functions.
#NAME!

Check that the IBM Cognos Office Reporting TM1 add-in is enabled. For more information, see
“Enable the add-in required to work with TM1 worksheet functions” on page 161.

#VALUE!
The formula could not be solved. Check the syntax. Make sure that you have specified a valid value for
all required parameters and in the required order.

#N/A
Check that you are connected and logged in to the TM1 server referenced in the formula.

RECALC_0_0
The calculation is in progress. If the calculation option in Microsoft Excel is set to Manual, a refresh of
the sheet or the book is required to complete the calculation.

Note: RECALC_0_0 may appear if the calculation was interrupted or canceled.

Blank cell or 0 when a value is expected
One or more objects could not be found.

Check that the objects you specified in the formula are available.

• If the formula references a dimension, verify that the dimension is available on the TM1 Server
Application folder.

• If the formula references a member, make sure that the member exists in the dimension you
specified.

• If the formula references an attribute, make sure that the attribute exists for the member you
specified.

• If the function has an index argument, verify that the value you are using is in range. For example,
DIMNM returns a blank cell if the index parameter is 0 or if the index value is greater than the
number of members in the dimension.

For example, if a DBRA formula returns an empty cell, perform the following checks:

• Check that the dimension is available on the TM1 Server Application folder.
• Check that the member exists in the dimension.
• Check that the attribute exists for the member.
• Check that the names you are using in the formula match the names on the TM1 Server Application

folder and cube exactly.

Tip: To see the attributes of a member, right-click the member in the tree and select Search
Metadata. The Name list contains the available attributes for the member.

Supported IBM TM1 worksheet functions
IBM Planning Analytics for Microsoft Excel supports most TM1 worksheet functions.
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DBR
DBR retrieves a value from a specified TM1 cube.

In IBM Planning Analytics for Microsoft Excel, the DBR function is equivalent to the DBRW function. Both
functions are optimized to reduce network traffic and improve performance on wide area networks.

When all member arguments (m1, m2, etc.) to the function are leaf members, you can use the DBR
function to write values to the specified cube, provided that you have the appropriate access privileges to
the relevant cube, dimensions, members, and/or cells.

You can modify the members used in a DBR or DBRW function using the DBR Function Editor. For more
information, see “Modify functions by using the Function Editor” on page 161.

Syntax
DBR(server:cube, m1, m2,[...mn])

Argument Description Required/Optional

server:cube The name of a TM1 Server Application folder and
the name of a cube that is available on the server.

Required

m1,...mn Dimension member names that define the
intersection of the cube containing the value to be
retrieved.

Arguments m1 through mn are sequence-sensitive.
m1 must be a member from the first dimension of
the cube, m2 must be a member from the second
dimension, and so on. These arguments can also
be the names of aliases for dimension members.

Numeric member names must be enclosed in
double quotation marks.

Required

Example

In this example, the TM1 Server Application folder name is GO_New_Stores and the cube name is Base
Sales Forecast. The function returns the value at the intersection of Americas, Department Store, Freight,
Corporate Store, Budget version 1, and Jan.

DBR("GO_New_Stores:Base Sales Forecast", "Americas", "Department Store", 
"Freight", "Corporate Store", "Budget version 1", "Jan")

DBRA
DBRA retrieves the value of a specified member attribute.

The value returned can be either a string or numeric value, depending on the attribute type.

Syntax
DBRA(server:dimension, element, attribute)

Argument Description Required/Optional

server:dimension The name of the TM1 Server Application folder and
the name of a dimension.

Required

element A member of the dimension. Required
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Argument Description Required/Optional

attribute The attribute for which you want to retrieve a value.
This argument must be an attribute of the member.

Required

Example

In this example, the TM1 Server Application folder name is GO_New_Stores and the dimension name is
Month. The function retrieves the value of the startdate attribute for Jan.

DBRA("GO_New_Stores:Month", "Jan", "startdate")

Example

In this example, the TM1 Server Application folder name is SData and the dimension name is Model. The
function returns the value of the Engine Size attribute of the L Series 1.6 L Sedan member.

DBRA("SData:Model", "L Series 1.6 L Sedan", "Engine Size")

DBRW
DBRW retrieves a value from a specified TM1 cube.

In IBM Planning Analytics for Microsoft Excel, the DBRW function is equivalent to the DBR function. Both
functions are optimized to reduce network traffic and improve performance on wide area networks. For
more information, see “DBR” on page 163.

Example

In this example, the TM1 server name is GO_New_Stores and the cube name is Base Sales Forecast. The
function returns the value at the intersection of Americas, Department Store, Freight, Corporate Store,
Budget version 1, and Jan.

DBRW("GO_New_Stores:Base Sales Forecast", "Americas", 
"Department Store", "Freight", "Corporate Store", "Budget version 1", "Jan")

DBS
DBS sends a numeric value to a TM1 cube.

This function cannot send a string to a cube. To send strings, use the DBSS function.

In IBM Planning Analytics for Microsoft Excel, the DBS function is equivalent to the DBSW function. Both
functions are optimized to reduce network traffic and improve performance on wide area networks.

Syntax
DBS(value, server:cube, m1, m2[,...mn])

Argument Description Required/Optional

value The value being sent. Required

server:cube The name of the TM1 server and the cube to which
the value is sent.

Required
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Argument Description Required/Optional

m1, ...mn The names of members defining the intersection in
the cube to which the value is sent.

Arguments m1 through mn are sequence-sensitive.
m1 must be a member from the first dimension of
the cube, m2 must be a member from the second
dimension of the cube, and so on. These
arguments can also be the names of aliases for
dimension members.

Numeric member names must be enclosed in
double quotation marks.

Required

Example

In this example, the TM1 server name is GO_New_Stores and the cube name is Base Sales Forecast. The
function writes the value 5342 to the intersection of Americas, Department Store, Freight, Corporate
Store, Budget version 1, and Feb.

DBS(5342,"GO_New_Stores:Base Sales Forecast","Americas",
"Department Store","Freight","Corporate Store","Budget version 1","Feb")

DBSA
DBSA sends a value to a specified member attribute.

The value sent can be either a string or numeric value, depending on the attribute type.

Syntax
DBSA(att_value, server:dimension, member, att_name)

Argument Description Required/Optional

att_value The value you want to send. To send the value as a
string, use double quotation marks. For example
"1.8" is sent as a string value while 1.8 is sent as a
numeric value.

Required

server:dimension The name of the TM1 server and a dimension
name.

Required

member A member of the dimension. Required

att_name The attribute to which you want to send a value.
att_name must be an attribute of the member
specified by the member argument.

Required

Example

In this example, the TM1 server name is Planning Sample. The function writes Jane Smithers to the
Manager attribute of the UK member of the business_unit dimension.

DBSA("1.8", "SData:Model", "L Series 1.8 L Sedan", "Engine Size")

Example
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In this example, the TM1 server name is SData. The function writes 1.8 to the Engine Size attribute of the
L Series 1.8 L Sedan member of the Model dimension. The value, 1.8, is in double quotation marks
because the Engine Size attribute is a text attribute. If the data type of the Engine Size parameter was
Numeric, the function would be:

DBSA(1.8, "SData:model", "L Series 1.8 L Sedan", "Engine Size")

DBSS
DBSS sends a string to a cube of any number of dimensions.

This function cannot send a numeric value to a cube. Use the DBS function to send numeric values.

Syntax
DBSS(string, server:cube, m1, m2,...mn)

Argument Description Required/Optional

string The string being sent. Required

server:cube The name of the TM1 server and the cube to which
the string is sent.

Required

m1, ...mn The names of members defining the intersection in
the cube to which the string is sent.

Arguments m1 through mn are sequence-sensitive.
m1 must be a member from the first dimension of
the cube, m2 must be a member from the second
dimension of the cube, and so on. These
arguments can also be the names of aliases for
dimension members.

Numeric member names must be enclosed in
double quotation marks.

Required

Example

In this example, the TM1 server name is GO_New_Stores and the cube name is New Store Plan. The
function writes the value Department Store to the intersection of Americas, 1 (a member in the ID number
dimension), Budget version 1, and Retailer Type.

DBSS("Department Store", "GO_New_Stores:New Store Plan",
"Americas","1","Budget version 1","Retailer Type")

DBSW
DBSW sends a numeric value to a TM1 cube.

This function cannot send a string to a cube. To send strings, use the DBSS function.

In IBM Planning Analytics for Microsoft Excel, the DBSW function is equivalent to the DBS function. Both
functions are optimized to reduce network traffic and improve performance on wide area networks. For
more information, see “DBS” on page 164.

Example
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In this example, the TM1 server name is GO_New_Stores and the cube name is Base Sales Forecast. The
function writes the value 6342 to the intersection of Americas, Department Store, Freight, Corporate
Store, Budget version 1, and Feb.

DBSW(6342,"GO_New_Stores:Base Sales Forecast","Americas",
"Department Store","Freight","Corporate Store","Budget version 1","Feb")

DFRST
DFRST returns the first member of a specified dimension. The first member in a dimension is the member
with an index number of 1.

The member with an index number of 1 might not be listed first in the tree. Index numbers are assigned to
members when they are added to a dimension. For example, if members were added and then reordered,
the first member listed in the tree might not have an index of 1.

To determine the index number of a member use the “DIMIX” on page 167 function.

Syntax
DFRST(server:dimension)

Argument Description Required/Optional

server:dimension The name of the TM1 server and a dimension
name.

Required

Example

In this example, the TM1 server name is GO_New_Stores. The function returns the first member in the
Retailers dimension, All Retailers. The function returns All Retailers because this member has an index
number of 1 in the Retailers dimension.

DFRST("GO_New_Stores:Retailers")

DIMIX
DIMIX returns the index number of a member within a dimension.

Syntax
DIMIX(server:dimension, element)

Argument Description Required/Optional

server:dimension The name of the TM1 server and a dimension
name.

Required

element The name of a member within the dimension.

If the member is not a member of the dimension
specified, the function returns 0.

This argument can also be the name of an alias for
a dimension member.

Required

Example
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In this example, the TM1 server name is GO_New_Stores. The function returns the index number of the
Tents member in the Products dimension. If Tents has an index number of 7, for example, the function
returns 7.

DIMIX("GO_New_Stores:Products","Tents")

DIMNM
DIMNM returns the member of a dimension that corresponds to the index argument.

Syntax
DIMNM(server:dimension, index, [Alias])

Argument Description Required/Optional

server:dimension The name of the TM1 server and a dimension
name.

Required

index A value less than or equal to the number of
members in the dimension.

The functions returns a blank cell if you enter 0 or if
you enter a value greater than the number of
members in the dimension.

Required

Example

In this example, the TM1 server name is GO_New_Stores. The function returns the name of the member
with an index of 7 in the Products dimension. If the Tents member has an index number of 7, for example,
the function returns Tents.

DIMNM("GO_New_Stores:Products",7)

DIMSIZ
DIMSIZ returns the number of members within a specified dimension.

Syntax
DIMSIZ(server:dimension)

Argument Description Required/Optional

server:dimension The name of the TM1 server and a dimension
name.

Required

Example

In this example, the TM1 server name is GO_New_Stores. The function returns the number of members in
the Budget version dimension. For example, if the Budget version dimension contains two members, the
function returns 2.

DIMSIZ("GO_New_Stores:Budget version")

DNEXT
DNEXT returns the member name that follows the member specified as an argument to the function.
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Syntax
DNEXT(server:dimension, element)

Argument Description Required/Optional

server:dimension The name of the TM1 server and a dimension
name.

Required

element The name of a member within the dimension. This
argument can also be the name of an alias for a
dimension member.

Required

Example

In this example, the TM1 server name is GO_New_Stores. The function returns the name of the member
after Cooking Gear in the Products dimension.

DNEXT("GO_New_Stores:Products","Cooking Gear")

DNLEV
DNLEV returns the number of hierarchy levels in a dimension.

Syntax
DNLEV(server:dimension)

Argument Description Required/Optional

server:dimension The name of the TM1 server and a dimension
name.

Required

Example

This example uses the TM1 server SData and a dimension called Region. In the Region dimension, the
various nations (Level 0) add up to regions (Level 1). The regions then add up to super-regions (Level 2),
which in turn add up to the world (Level 3).

DNLEV("SData:Region")

The region dimension has four hierarchy levels (0, 1, 2, and 3). Therefore, in this example the function
returns 4.

DTYPE
DTYPE returns information about the specified member. The function returns "C" if the member is a
consolidated member, "N" if the member is a numeric member, and "S" if the member is a string member.
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Syntax
DTYPE(server:dimension, element)

Argument Description Required/Optional

server:dimension The name of the TM1 server and a dimension
name.

Required

element The name of a member within the dimension. This
argument can also be the name of an alias for a
dimension member.

Required

Example

In this example, the TM1 server name is SData. The member Europe in the dimension Region is a
consolidated member, so the example returns "C".

DTYPE("SData:Region","Europe")

In this example, the TM1 server name is GO_New_Stores. If the Tents member contains numeric data,
such as product numbers, the function returns N. If the Tents member contains text, such as model
names, the function returns S.

DTYPE("GO_New_Stores:Products","Tents")

ELCOMP
ELCOMP returns the name of a child of a consolidated member in a specified dimension.

Syntax
ELCOMP(server:dimension, element, index)

Argument Description Required/Optional

server:dimension The name of the TM1 server and a dimension
name.

Required

element The name of a consolidated member within the
dimension. This argument can also be the name of
an alias for a dimension member.

If the member is not a consolidated member, the
function returns 0.

Required

index A positive value less than or equal to the total
number of children in the specified member.

If you enter a value greater than the number of
children in the member or if you enter 0, the
function returns a blank cell.

Required

Example

In this example, the TM1 server name is GO_New_Stores. The function returns the second child member
under Europe. If Europe is a consolidated member with the children Central Europe, Northern Europe, and
Southern Europe, the function returns Northern Europe.
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• Europe

– Central Europe
– Northern Europe
– Southern Europe

ELCOMP("GO_New_Stores:Country and Region","Europe",2)

ELCOMPN
ELCOMPN returns the number of children of a specified member.

Syntax
ELCOMPN(server:dimension, element)

Argument Description Required/Optional

server:dimension The name of the TM1 server and a dimension
name.

Required

element The name of a consolidated member within the
dimension. This argument can also be the name of
an alias for a dimension member.

If the member is not a consolidated member, the
function returns 0.

Required

Example

In this example, the TM1 server name is GO_New_Stores. The function returns the number of child
members under Europe.

If Europe is a consolidated member with the children Central Europe, Northern Europe, and Southern
Europe, the function returns 3.

ELCOMPN("GO_New_Stores:Country and Region","Europe")

Canada is not a consolidated member in the Country and Region dimension, so the function returns 0.

ELCOMPN("GO_New_Stores:Country and Region","Canada")

ELISCOMP
ELISCOMP determines whether element1 is an immediate child of element2 in the specified dimension.

The function returns TRUE if element1 is an immediate child of element2, otherwise the function returns
FALSE.

Syntax
ELISCOMP(server:dimension, element1, element2)

Argument Description Required/Optional

server:dimension The name of the TM1 server and a dimension
name.

Required
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Argument Description Required/Optional

element1 The name of a member within the dimension. This
argument can also be the name of an alias for a
dimension member.

Required

element2 The name of a member within the dimension. This
argument can also be the name of an alias for a
dimension member.

Required

Example

The following examples use the GO_New_Stores TM1 server and a dimension called Products with the
following structure:

• Total Products

– Camping Equipment

- Tents
- Lanterns

– Golfing Equipment

- Putters
- Golf Accessories

ELISCOMP("GO_New_Stores:Products","Tents","Golf Equipment")

In this example, the function returns FALSE because Tents is not a child of the Golf Equipment member in
the Products dimension.

ELISCOMP("GO_New_Stores:Products","Tents","Camping Equipment")

In this example, the function returns TRUE because Tents is a child of the Camping Equipment member.

Note that the ELISCOMP function returns TRUE only for immediate children. In the above example, Tents
is a child of Camping Equipment. Further, Camping Equipment is a child of Total Products. However,
because the function returns TRUE only for immediate children, the following example returns FALSE:

ELISCOMP("GO_New_Stores:Products","Tents","Total Products")

ELISPAR
ELISPAR determines whether member1 is an immediate parent of member2 in the specified dimension.

The function returns TRUE if member1 is an immediate parent of member2, otherwise the function
returns FALSE.

Syntax
ELISPAR(server:dimension, member1, member2)

Argument Description Required/Optional

server:dimension The name of the TM1 server and a dimension
name.

Required
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Argument Description Required/Optional

member1 The name of a member within the dimension. This
argument can also be the name of an alias for a
dimension member.

Required

member2 The name of a member within the dimension. This
argument can also be the name of an alias for a
dimension member.

Required

Example

The following examples use the GO_New_Stores TM1 server and a dimension called Products with the
following structure:

• Total Products

– Camping Equipment

- Tents
- Lanterns

– Golfing Equipment

- Putters
- Golf Accessories

– Mountaineering Equipment

- Rope

ELISPAR("GO_New_Stores:Products","Mountaineering Equipment", "Tents")

In this example, the function returns FALSE because Mountaineering Equipment is not a parent member
of Tents in the Products dimension.

ELISPAR("GO_New_Stores:Products","Camping Equipment","Tents")

In this example, the function returns TRUE because Camping Equipment is a parent member of Tents in
the Products dimension.

Note that the ELISPAR function returns TRUE only for immediate parents. In the above example, Total
Products is a parent of Camping Equipment. Further, Camping Equipment is a parent of Tents. However,
because Total Products is not an immediate parent of Tents, the following example returns FALSE:

ELISPAR("GO_New_Stores:Products","Total Products","Tents")

ELLEV
ELLEV returns the level of a member within a dimension.

Syntax
ELLEV(server:dimension, element)

Argument Description Required/Optional

server:dimension The name of the TM1 server and a dimension
name.

Required
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Argument Description Required/Optional

element The name of a member within the dimension. This
argument can also be the name of an alias for a
dimension member.

Required

Example
These examples use the TM1 server SData and a dimension called Region. In the Region dimension,
individual nations (Level 0) add up to regions (Level 1). The regions then add up to super-regions (Level 2),
which in turn add up to the world (Level 3).

ELLEV("SData:region","Norway")

In this example, the function returns 0 because Norway is a leaf level member of the Region dimension.

ELLEV("SData:region ","Scandinavia")

In this example, the function returns 1 because Scandinavia is a Level 1 member of the Region dimension.

ELLEV("SData:Region","Europe")

In this example, the function returns 2 because Europe is a Level 2 member of the Region dimension.

ELPAR
ELPAR returns the parent of a member in a specified dimension

Syntax
ELPAR(server:dimension, element, index)

Argument Description Required/Optional

server:dimension The name of the TM1 server and a dimension
name.

Required

element The name of a member within the dimension. This
argument can also be the name of an alias for a
dimension member.

Required

index A positive value less than or equal to the total
number of unique consolidated members (parents)
that use the member argument as a child.

Tip: You can use the ELPARN function to find out
how many unique parents a member has.

Required
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Example

The following examples use the SData TM1 server and a dimension called model with the following
structure:

• L Series 2WD

– L Series 4WD
– L Series

- L Series Sedan
- L Series Wagon

• S Series 2WD
• Total

– L Series

- L Series Sedan
- L Series Wagon

– S Series
– T Series

ELPAR("SData:model","L Series 4WD",1)

In this example, the function returns L Series 2WD, the parent of L Series 4WD.

ELPAR("SData:model","L Series",2)

In this example, the function returns Total. L Series is a child of two unique parents: L Series 2WD and
Total. In the structure of the model dimension, Total appears second, so this is the member returned by
the function.

ELPAR("SData:model","L Series Wagon",2)

In this example, the function returns a blank cell. L Series Wagon appears twice, but in both cases the
parent is L Series. Since L Series Wagon does not have a second unique parent, the function returns a
blank cell.

ELPARN
ELPARN returns the number of unique parents of a member in a specified dimension.

Syntax
ELPARN(server:dimension, element)

Argument Description Required/Optional

server:dimension The name of the TM1 server and a dimension
name.

Required

element The name of a member within the dimension. This
argument can also be the name of an alias for a
dimension member.

Required

Example

The following examples use the SData TM1 server and a dimension called model with the following
structure:
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• L Series 2WD

– L Series 4WD
– L Series

- L Series Sedan
- L Series Wagon

• S Series 2WD
• Total

– L Series

- L Series Sedan
- L Series Wagon

– S Series
– T Series

ELPARN("SData:model","L Series")

In this example, the function returns 2. In the model dimension, L Series has two unique parents: L Series
2WD and Total.

ELPARN("SData:model","L Series Wagon")

In this example, the function returns 1. In the model dimension, L Series Wagon has one unique parent, L
Series.

ELSLEN
ELSLEN returns the length of a member name within a dimension, if the member name is a string.

If the member specified is not a member of the dimension specified, or is not a string member, the
function returns 0.

If you use an alias in the member argument, the function returns the length of the member name
corresponding to the alias.

Syntax
ELSLEN(server:dimension, element)

Argument Description Required/Optional

server:dimension The name of the TM1 server and a dimension
name.

Required

element The name of a string member within the
dimension. This argument can also be the name of
an alias for a dimension member.

Required

Example

In this example, the TM1 server name is GO_New_Stores. The function returns 6. The member Europe is a
string with a length of six characters.

ELSLEN("GO_New_Stores:Country and Region","Europe")

In this example, the function returns 15. Nordeuropa is an alias of the Northern Europe member. The
Northern Europe member is a string with a length of 15 characters.
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ELSLEN("GO_New_Stores:Country and Region","Nordeuropa")

ELWEIGHT
ELWEIGHT returns the weight of a child in a consolidated member.

Syntax
ELWEIGHT(server:dimension, element1, element2)

Argument Description Required/Optional

server:dimension The name of the TM1 server and a dimension
name.

Required

element1 The name of a consolidated member within the
dimension. This argument can also be the name of
an alias for a dimension member.

If member1 is not a consolidated member, the
function returns 0.

Required

element2 The name of a child of the consolidated member.
This argument can also be the name of an alias for
a dimension member.

If member1 is not a parent of member2, the
function returns 0.

Required

Example

The following examples use the SData TM1 server and a member called Gross Margin with two child
members.

ELWEIGHT("SData:Account1","Gross Margin","Sales")

In this example, the function returns 1. The member Sales, which is a child of Gross Margin, has a weight
of 1.

ELWEIGHT("SData:Account1","Gross Margin","Variable Costs")

In this example, the function returns -1. The member Variable Costs, which is a child of Gross Margin, has
a weight of -1.

SUBNM
SUBNM returns the member of a set corresponding to the IndexOrName argument.

If you include the optional alias parameter to this function, the function returns the alias for the selected
member.

When you double-click a cell containing a SUBNM function and the data source that contains the SUBNM
function dimension is selected, the Set Editor opens.
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When you click a cell containing a SUBNM function that references a set, a drop-down arrow is displayed.
Click the down arrow to select a different member from the set. This feature is available when you are
logged on to a data source that contains the dimension.

Syntax
SUBNM(server:dimension, set, IndexOrName, [alias])

Argument Description Required/Optional

server:dimension The name of the TM1 server and a dimension
name.

Required

set The name of a set in the dimension. If the value of
the set argument is an empty string, the value is
considered subset all.

Required

IndexOrName An index into the set or the name of a member in
the set.

If an index, a positive integer less than or equal to
the total number of members in the specified set.
If a name, a string representing the name of a
member of the set. You can also use the alias of a
member.

Required

alias The name of an alias that exists for the set. If it is
used, the specified alias is applied when the Set
Editor opens and the function returns the alias for
the selected member.

Optional

Example

The following examples use the GO_New_Stores TM1 server, a dimension called Country and Region, and
a set called Countries Only.

• Countries Only

– Americas
– Central Europe
– Northern Europe
– Southern Europe
– Asia-Pacific

SUBNM("GO_New_Stores:Country and Region", "Countries Only",
"Americas")

In this example, the function returns Americas.

SUBNM("GO_New_Stores:Country and Region", "Countries Only",2)

In this example, the function returns Central Europe, which is the second member in the Countries Only
set of the Country and Region dimension.

The following examples use the Planning Sample TM1 server, a dimension called plan_department, and a
set called All Departments. The members in this dimension are named with department ID numbers. The
Department alias contains the department names.
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The following table lists the members in the All Departments set. The first column lists the member
names. The second column shows the Department alias of each member.

member name Department

1000 Total Organization

100 Sales

200 Marketing

300 Engineering

SUBNM("Planning Sample:plan_department","All Departments",
"300","Department")

In this example, the function returns Engineering. The third argument is the member name, 300, and the
fourth argument, Department, is the name of the alias to retrieve. The Department alias for 300 is
Engineering.

SUBNM("Planning Sample:plan_department","All Departments",
"100","Department_Spanish")

Suppose another alias, Department_Spanish, contains department names in Spanish. In this example, the
function returns Ventas. The third argument is the member name, 100, and the fourth argument,
Department_Spanish, is the name of the alias to retrieve. The Department_Spanish alias for 100 is
Ventas.

When you double-click the cell containing this example, the Set Editor opens. The Available Members list
displays the Spanish aliases for the plan_department dimension and its members.

SUBSIZ
SUBSIZ returns the number of members in a dimension set.

Syntax
SUBSIZ(server:dimension, set)

Argument Description Required/Optional

server:dimension The name of the TM1 server and a dimension
name.

Required

set The name of a set in the dimension. If the value of
the set argument is an empty string, the value is
considered subset all.

Required

Example

In this example, the TM1 server name is GO_New_Stores. The function returns the number of members in
the Countries Only set of the Country and Region dimension. If the set contains six members, for example,
the function returns 6.

SUBSIZ("GO_New_Stores:Country and Region", "Countries Only")

TABDIM
TABDIM returns the dimension name that corresponds to a given index argument.
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Syntax
TABDIM(server:cube, index)

Argument Description Required/Optional

server:cube The name of the TM1 server and a cube name. Required

index A positive value less than or equal to the total
number of dimensions in the cube.

The functions returns a blank cell if you enter 0 or if
you enter a value greater than the number of
dimensions in the cube.

Required

Example

In this example, the TM1 server name is GO_New_Stores and the cube name is Base Sales Forecast. The
Base Sales Forecast cube has the following dimensions: Country and Region, Retailers, Existing Stores
Revenue, Store Type, Budget version, and Month. The function returns Store Type, the fourth dimension in
the Base Sales Forecast cube with an index number of 4.

TABDIM("GO_New_Stores:Base Sales Forecast",4)

TM1ELLIST
TM1ELLIST returns a downwards array vector of values. It is useful because you can get a set of element
values from a TM1 model by using a single formula.

Note:

• TM1ELLIST does not overwrite or insert into any non-formula space like a Dynamic Report. It is up the
workbook designer to consume the plural value response correctly.

• TM1ELLIST returns an array of values, however, only the first element is displayed if the function is
placed into a singular value store.

This worksheet function is valid in worksheets only.

Syntax
TM1ELLIST(ServerDimension, [SetName], [ElementList],
[AliasOverride], [ExpandAbove], [MDXOverride], [IndentRate], [IndentCharacter])

Argument Description Required/Optional

ServerDimension A dimension, specified using the format
server:dimension.

Required

SetName A named set. If this argument is empty, all
elements of the dimension are used.

Optional

Elementlist An array of values that specifies a list of elements
to constitute a set. For example, ElementList can
reference a cell range.

When this argument is supplied, the named set
specified by the SetName argument is ignored.

If this argument is empty, the elements from the
set specified by the SetName argument are used.

Optional
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Argument Description Required/Optional

AliasOverride A string that defines the alias used for the set.

When this argument is supplied, it overrides the
default alias property defined by the subset
specified by the SetName argument.

If this argument is empty, the alias from the set
specified by the SubsetName argument is used.

Optional

ExpandAbove A Boolean flag to turn on or off the set Expand
Above property.

When this argument is supplied, it overrides the
default Expand Above property defined by the
subset specified by the Set argument.

If the argument value is 1, consolidated members
expand upward when drilling.

If the argument value is 0, consolidated members
expand downward when drilling.If this argument is
empty, the Expand Above property from the subset
specified by the Subset argument is used.

Optional

MDXOverride An MDX statement that applies to the subset
specified by the SubsetName/ElementList
argument.

When this argument is supplied, it overrides the
default MDX filter defined by the subset specified
by the SetName argument.

If this argument is empty or omitted, the members
from the set specified by the SetName argument
are used.

Optional

IndentRate An integer value to indicate how many indentations
are applied to each level when drilling down on a
consolidated member.

If the argument value is 0, no auto-indentation is
performed. IndentRate is relative to the set level of
the set elements.

If this argument is empty or omitted, one
indentation is applied to each level as you drill
down on a consolidated member.

Optional

IndentCharacter IndentChar sets the symbol used to provide in-
string indentation, the default is the en-space
character (the normal space symbol).

Optional

Example

TM1ELLIST("PlanSamp:plan_currency","All currencies")

TM1ELLIST returns an array of elements based on given arguments.

To retrieve all the returned values, a named range can be created in Excel, referring to the formula. To do
this, create a named range and enter the TM1ELLIST formula in the Refers To column.
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Select desired number of cells (based on the return array size) in Excel, type =[namedrange], and hit
CTRL+Shift+Enter.

The Excel INDEX function can then be used to extract a single element for the range.

TM1GLOBALSANDBOX
TM1GLOBALSANDBOX returns the current global active sandbox for the user.

Note: This function is valid only in Planning Analytics for Microsoft Excel and in Planning Analytics
websheets. It is not supported in IBM TM1 Perspectives.

Syntax
TM1GLOBALSANDBOX(SERVER)

Argument Description Required/Optional

Server The name of the TM1 server. Required

Example

TM1GLOBALSANDBOX("Planning Sample")
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TM1INFO
TM1INFO returns information about the current TM1 version and client.

Note: This function is valid only in Planning Analytics for Microsoft Excel and in Planning Analytics
websheets. It is not supported in IBM TM1 Perspectives.

Syntax
TM1INFO("Property Name")

Argument Description Required/Optional

Property Name The property name can be one of the following:
clientversion

Returns the full client version number. For
example, 10.2.10000

clientversionmajor
Returns the major client version number.

clientversionminor
Returns the minor client version number.

clientversionpatch
Returns fix pack and hotfix number.

client
Returns the name of the client. For example,
cor or websheet.

Required

Example

TM1INFO("clientversion")

TM1PRIMARYDBNAME
TM1PRIMARYDBNAME returns the primary TM1 server name that the user is authenticated through, even
if the user is implicitly logged into multiple TM1 servers. This function doesn't accept any arguments.

Note: This function is valid only in Planning Analytics for Microsoft Excel and in Planning Analytics
websheets. It is not supported in IBM TM1 Perspectives.

Syntax
TM1PRIMARYDBNAME()

TM1RPTELISCONSOLIDATED
TM1RPTELISCONSOLIDATED returns a Boolean value to indicate whether a member in a Dynamic Report
is consolidated.

Syntax
TM1RPTELISCONSOLIDATED(RptRowFormula, RowHeaderCell)

Argument Description Required/Optional

RptRowFormula An absolute reference to a cell that contains a
TM1RPTROW formula.

Required
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Argument Description Required/Optional

RowHeaderCell A relative reference to a cell that contains a
member from the TM1RPTROW formula.

Required

Example

TM1RPTELISCONSOLIDATED($B$25,$B25)

TM1RPTELLSEXPANDED
TM1RPTELLSEXPANDED returns a Boolean value to indicate whether or not a member is expanded in a
Dynamic Report row set.

Syntax
TM1RptElIsExpanded(RptRowFormula, RowHeaderCell)

Argument Description Required/Optional

RptRowFormula An absolute reference to a cell that contains a
TM1RPTROW formula.

Required

RowHeaderCell A relative reference to a cell that contains a
member from the TM1RPTROW formula.

Required

Example

TM1RPTELLSEXPANDED($B$25,$B25)

TM1RPTELLEV
TM1RPTELLEV returns an integer value representing a member level within a hierarchy. This function is
used in Dynamic Reports.

Syntax
TM1RPTELLEV(RptRowFormula, RowHeaderCell)

Argument Description Required/Optional

RptRowFormula An absolute reference to a cell that contains a
TM1RPTROW formula.

Required

RowHeaderCell A relative reference to a cell that contains a
member from the TM1RPTROW formula.

Required

Note: In the current release, TM1RPTELLEV and ELLEV are equivalent. Both functions return the level of a
member based on the dimension.

Example

TM1RPTELLEV($B$25,$B25)

TM1RPTFILTER
TM1RPTFILTER defines the filter applied to a Dynamic Report column dimension.
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Syntax
TM1RPTFILTER(ReportView, Tuple, FilterFunction, FilterValue, SortOrder)

Argument Description Required/Optional

ReportView A cell reference to a cell that contains a
TM1RPTVIEW formula. The filter applies to the
view specified by the TM1RPTVIEW formula.

Required

Tuple A tuple string specifying the member in the column
dimension to which the filter applies. For example,
[month].[Feb].

Required

FilterFunction One of the following filter function names:

• TOPCOUNT
• BOTTOMCOUNT
• TOPPERCENT
• BOTTOMPERCENT
• TOPSUM
• BOTTOMSUM

Required

FilterValue A filter value. Required

SortOrder One of the following sort orders:

• asc: Ascending
• desc: Descending
• nbasc: Ascending without breaking the hierarchy
• nbdesc: Descending without breaking the

hierarchy

Required

Example
TM1RPTFILTER($B$4,"[month].[Jan]","TOPCOUNT",5,"asc")

TM1RPTROW
TM1RPTROW sets the Dynamic Report control row definition. The control row definition governs the
behavior of all rows in the Dynamic Report.

Syntax
TM1RPTROW(SAFID, ServerDimension, [SetName], [ElementList],
[AliasOverride], [ExpandAbove], [MDXOverride], [IndentRate], [AllowDrilling])

Argument Description Required/Optional

SAFID A reference to a cell that contains a TM1RPTVIEW
formula.

Required

ServerDimension A dimension, specified using the format
server:dimension.

Required
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Argument Description Required/Optional

SetName A named set. If this argument is empty, all
elements of the dimension are used.

Optional

ElementList An array of values that specifies a list of members
to constitute a set. For example, ElementList can
reference a cell range.

When this argument is supplied, the named set
specified by the SetName is ignored.

If this argument is empty, the members from the
set specified by the SetName are used.

Optional

AliasOverride A string that defines the alias used for the set.

When this argument is supplied, it overrides the
default alias property defined by the set specified
by the Set argument.

If this argument is empty, the alias from the set
specified by the set argument is used.

Optional

ExpandAbove A Boolean flag to turn on or off the subset Expand
Above property. When this argument is supplied, it
overrides the default ExpandAbove property
defined by the subset specified by the Subset
argument.

If the argument value is 1, consolidated members
expand upward when drilling.

If the argument value is 0, consolidated members
expand downward when drilling.

If this argument is empty or omitted, the Expand
Above property from the subset specified by the
Subset argument is used.

Optional

MDXOverride An MDX statement that applies to the set specified
by the Set/SetMembers argument.

When this argument is supplied, it overrides the
default MDX filter defined by the set specified by
the set argument.

If this argument is empty or omitted, the members
from the set specified by the set argument are
used.

Optional

IndentRate An integer value to indicate how many indentations
are applied to each level when drilling down on a
consolidated member. If the argument value is 0,
no auto-indentation is performed.

If this argument is empty or omitted, one
indentation is applied to each level as you drill
down on a consolidated member.

Optional
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Argument Description Required/Optional

AllowDrilling A Boolean flag to turn on or off drilling on
consolidated members.

When this argument value is 1, you can drill down
on consolidated members in the Dynamic Report.

When this argument value is 0, you cannot drill
down on consolidated members in the Dynamic
Report.

If this argument is empty or omitted, the default
behavior is to allow drilling on consolidated
members.

Optional

Example
TM1RPTROW($B$9,"SData:region",,"$B$17:$B$18",,1,"",5, 0)

TM1RPTROW($B$16,"GO_New_Stores:Retailers",,,,,B$15)

TM1RPTTITLE
TM1RPTTITLE defines a Dynamic Report title dimension.

Syntax
TM1RPTTITLE(server:dimension,Element)

Argument Description Required/Optional

server:dimension A dimension, specified using the format
server:dimension.

Required

Element A cell reference to a cell that contains a SUBNM
function that returns a member name.

Required

Example
TM1RPTTITLE("SData:model",$C$7)

TM1RPTVIEW
TM1RPTVIEW defines the view displayed in a Dynamic Report.

Syntax
TM1RPTVIEW(ViewID,ZeroSuppression,TM1RPTTITLE,...) 

Argument Description Required/Optional

ViewID A name for the view using the format
server:cube:unique_id.

Required
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Argument Description Required/Optional

ZeroSuppression A Boolean flag to turn on or off the zero
suppression property for the view. 1 = on, 0 = off

Required

TM1RPTTITLE For each title dimension in the Dynamic Report,
include a reference to a TM1RPTTITLE function as
an argument to TM1RPTVIEW.

Required

FormatRange The formatting range for the Dynamic Report. You
can use a cell reference or a named range for this
parameter.

When you create a Dynamic Report, a named range
called TM1RPTFMTRNG is created to include all
formatting range cells. You can use this named
range as an argument.

Required

IDColumn The column in the Dynamic Report that contains
format IDs. You can use a cell reference or a
named range for this parameter.

When you create a Dynamic Report, a named range
called TM1RPTFMTIDCOL is created to include all
formatting range cells. You can use this named
range as an argument.

Required

Example
TM1RPTVIEW("SData:SalesCube:6", 0, TM1RPTTITLE("SData:actvsbud",$C$6), 
TM1RPTTITLE("SData:model",$C$7), TM1RPTTITLE("SData:account1",$C$8), 
TM1RPTFMTRNG,TM1RPTFMTIDCOL)

TM1USER
TM1USER returns the user name of the user currently logged in to TM1 and using the TM1USER function.

If the current user is not connected to a TM1 server, or if the specified server is not running, TM1USER
returns an empty string.

Note: If you run TM1USER against a TM1 server that is configured to use Cognos security, the function
returns the user name, not the internal user name/CAMID. (In TM1 Perspectives, this function returns the
internal user name/CAMID.)

Syntax
TM1USER("server")

Argument Description Required/Optional

server The name of a TM1 server. Required

Example

If a user named BrianT is logged in to the GO_New_Stores server, and BrianT runs the TM1USER function,
this example returns BrianT.

TM1USER("GO_New_Stores")
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VIEW
VIEW is primarily used for compatibility with IBM TM1 Perspectives worksheets. For example, when you
create a slice from a TM1 Perspectives worksheet and open it in IBM Planning Analytics for Microsoft
Excel, you might see a VIEW function. The VIEW function defines a view of the cube specified by the
server:cube argument.

DBR and DBRW formulas can refer to a VIEW function.

A workbook can contain multiple VIEW functions.

Syntax
VIEW(server:cube, m1,m2[,...mn])

Argument Description Required/Optional

server:cube The name of the TM1 server and the name of the
cube from which to retrieve data.

Required

m1,...mn Either specific members in the slice to be used as
titles, or the string "!".

The string "!" indicates that the corresponding
dimension is a row or column in the view.

Arguments m1 through mn are sequence-sensitive.
m1 must be a member from the first dimension of
the cube, m2 must be a member from the second
dimension, and so on. These arguments can also
be the names of aliases for dimension members.

Required

Example

The following examples use the GO_New_Stores TM1 server. The dimensions in this cube are:

• Retailers
• Countries_currency
• Products
• Month
• Budget version
• Store Sales Plan

VIEW("GO_New_Stores:Store Sales Plan")

In this example, the function defines a view for the Store Sales Plan cube. The cell containing the VIEW
function displays GO_New_Stores:Store Sales Plan.

VIEW("GO_New_Stores:Store Sales Plan","Department Store",
"Americas","!", "!", "Budget version 1","Quantity")

In this example, the function defines a view as follows:

• Title members: Department Store, Americas, Budget version 1, Quantity
• Rows: Products
• Columns: Month

The cell containing the VIEW function displays GO_New_Stores:Store Sales Plan.

You can also use cell references in a VIEW function:
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VIEW("GO_New_Stores:Store Sales Plan",$B$20,"$B$21","!", "!",
$B$23,$B$24)

Suppose that cell B5 contains the VIEW function shown above. You can display data from the view by
using a DBR or DBRW function that references the view.

DBR(B5,"Department Store","Americas","Tents","Total Year",
"Budget version 1","Quantity")

In this example, the DBR function returns the value at the intersection of Department Store, Americas,
Tents, Total Year, Budget version 1, and Quantity in the view that is defined in cell B5.

You can also use cell references for some or all of the arguments:

DBR(B5,D55,D56,D57,D58,D59,”Quantity”)

Display the data source or package of a formula
When working in Dynamic Reports and Custom Reports, you can use more than one data source or
package. You can synchronize the source tree when moving from cells of one data source or package to
another. Synchronizing the source tree enables you to see accurately the dimensional data used to
populate the cells.

Right-click a formula cell and click IBM Planning Analytics > Display Package. The Task Pane displays
the package or data source that was used to create the selected cell.

DBR and DBRW formulas
DBRW formulas are created, for example, when you create a Dynamic Report by converting an Exploration
View or Quick Report and when you convert an Exploration View to a Custom Report. DBRW formulas
define the data cells. You can also create your own DBR and DBRW formulas.

You can use several techniques to modify DBR and DBRW formulas.

You can modify the members that are used as arguments in DBR and DBRW formulas by using the
following methods:

• Drag a member from the source tree onto a cell that contains a DBR or DBRW formula
• Use the Function Editor to modify the members that are used by a formula in a cell.
• Use the Function Editor to modify the members that are used by the formulas in a range of cells.

Modify DBR and DBRW formulas by dragging members from the source tree
You can change the members that are used in a DBR or DBRW formula by dragging members from the
source tree.

Before you begin
You can drag members from the source to modify a DBR or DBRW formula when the following conditions
are met:

• The DBR or DBRW formula includes a value for the server:cube parameter.
• You are connected to the data source referenced in the server:cube parameter.

Tip: To open the data source, right-click the cell and select IBM Planning Analytics > Display Package.
The source tree displays the data source.

Procedure
1. In the source tree, expand a dimension and locate the member that you want to use in the formula.
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2. Click and drag the member onto the cell that contains the DBR or DBRW formula that you want to
modify.

Results
The formula is updated in the worksheet.

Modify a range of DBR and DBRW functions
You can modify the DBR or DBRW functions that are used in a range of cells by using the DBR Function
Editor.

Before you begin
The DBR Function Editor is available when the following conditions are met:

• The first cell in the range contain a DBR or DBRW function.
• All DBR or DBRW functions in the range have the same value for the server:cube parameter.
• You are connected to the data source referenced in the server:cube parameter.

Tip: To open the data source, right-click the cell and select IBM Planning Analytics > Display Package.
The source tree displays the data source.

About this task
You can select a range of cells that contain DBRW functions and change one or more members that are
used by all of the DBRW functions in the range. Dimensions that have multiple members within the range
are not available for editing.

For example, if all DBRW functions in a column use Jan for the Month dimension and Europe for the
Region dimension, you can change Jan to Feb and Europe to France. If the member used for the Account
dimension varies within the column, the Account field is disabled in the DBR Function Editor. When you
click OK, the DBRW functions in the column are updated with Feb and France. All other members that are
used by the DBRW functions remain unchanged.

Procedure
1. Select a range of cells.
2. Select the range and select the Insert Function button.

The Excel Function Editor is displayed. The Arguments list shows the parameter values that are used
by the functions. The members that are common to all of the cells in the range are available for editing.

3. Modify the members that are used in the parameters by using any of the following techniques:

• To specify a value directly, type a member name into the field. For example, to change the member
for the first dimension in the cube, type a member name into the first field.

• To use a cell reference, click . Click a cell and then click OK.

Note: You might need to scroll down in the Function Editor to see all of the parameters.
4. Click OK.

The functions are updated in the worksheet.

SUBNM formulas
SUBNM formulas are created, for example, when you create a Dynamic Report by converting an
Exploration View or Quick Report and when you convert an Exploration View to a formula-based report.
SUBNM formulas define the context members.

You can modify SUBNM formulas by using the set editor or by editing the formula.

You can also create your own SUBNM formulas.

Chapter 7. Explore TM1 data  191



To modify a SUBNM formula, double-click the cell. The set editor opens. Use the set editor to select
members, and then click OK. The formula is updated.

You can also edit SUBNM formulas manually.

MDX Function Support
All TM1 supported Microsoft-defined and TM1 specific functions are listed in this section.

Support for Microsoft-defined MDX Expressions and Functions
TM1 supports Microsoft-defined MDX expressions and functions. The TM1 implementation of these
functions and expressions is based on the definitions in the Microsoft MSDN library, which is available at
the Microsoft MSDN website.

Supported Member Expressions
The following MDX member expressions are supported.

• <dimension>.CURRENTMEMBER
• <member>.FIRSTCHILD
• <member>.FIRSTSIBLING
• <member>.LAG
• <member>.LASTCHILD
• <member>.LASTSIBLING
• <member>.LEAD
• <member>.NEXTMEMBER
• <member>.PARENT
• <member>.PREVMEMBER

Supported Member Functions
The following MDX member functions are supported.

• ANCESTOR(...)
• COUSIN(...)
• OPENINGPERIOD(...)
• PARALLELPERIOD(...)

Supported Numeric Functions
The following MDX numeric functions are supported.

• AGGREGATE(...)
• AVG(...)
• CORRELATION(...)
• COUNT(...)
• COVARIANCE(...)
• LINREGINTERCEPT(...)
• LINREGPOINT(...)
• LINREGR2(...)
• LINREGSLOPE(...)
• LINREGVARIANCE(...)
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• MAX(...)
• MEDIAN(...)
• MIN(...)
• RANK(...)
• STDDEV(...)
• SUM(...)
• VAR(...)

Supported Set Expressions
The following MDX set expressions are supported.

• <dimension>.MEMBERS
• <level>.MEMBERS
• <member>. CHILDREN
• <member>.SIBLINGS

Supported Set Functions
The following MDX set functions are supported.

• ADDCALCULATEDMEMBERS(...)
• BOTTOMCOUNT(...)
• BOTTOMPERCENT(...)
• BOTTOMSUM(...)
• CROSSJOIN(...)
• DESCENDANTS(...)
• DISTINCT(...)
• DRILLDOWNLEVEL(...)
• DRILLDOWNLEVELBOTTOM(...)
• DRILLDOWNLEVELTOP(...)
• DRILLDOWNMEMBER(...)
• DRILLDOWNMEMBERBOTTOM(...)
• DRILLDOWNMEMBERTOP(...)
• DRILLUPMEMBER(...)
• DRILLUPLEVEL(...)
• EXCEPT(...)
• EXTRACT(...)
• FILTER(...)
• GENERATE(...)
• HEAD(...)
• HIERARCHIZE(...)
• INTERSECT(...)
• LASTPERIODS(...)
• ORDER(...)
• PERIODSTODATE(...)
• TOPCOUNT(...)
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• TOGGLEDRILLSTATE(...)
• TOPPERCENT(...)
• TOPSUM(...)
• SUBSET(...)
• UNION(...)

Supported Tuple Expressions
The following MDX tuple expressions are supported.

• <set>.CURRENTMEMBER
• <set>[.ITEM](...)

TM1 specific MDX functions
TM1 supports several TM1 specific MDX expressions. You can apply these expressions while developing
MDX applications to run against the server or when creating/editing dynamic subsets in the Expression
Window of the Subset Editor.

TM1FILTERBYPATTERN( <set>, <pattern_str> )
This TM1 specific MDX function returns all the members in <set> with names matching the pattern
<pattern_str>.

Syntax
The syntax of <pattern_str> is the same used for the Select By Regular Expression option on the Subset
Editor.

TM1FILTERBYLEVEL( <set>, <level_number>)
This TM1 specific MDX function returns all the members in <set> of the specified <level_number>.

Syntax
<level_number> is a number specifying the TM1 level number not an MDX level number.

TM1DRILLDOWNMEMBER( <set1>, <set2>|ALL [,RECURSIVE] )
This TM1 specific MDX function is similar to the DRILLDOWNMEMBER function from Microsoft , but it has
been adjusted to match the functionality of the Expand button {bmct expand_button.bmp} on the Subset
Editor.

Syntax
ALL means drilldown all the members in <set1>.

RECURSIVE means that when one member from <set1> is being drilled down upon, every consolidated
member resulting from that expansion will also be recursively drilled down until level 0 (TM1 level 0 ) is
reached.

TM1Member
This function returns a member from a specified tuple.

A null member reference is returned when any of the following conditions are encountered:

• A null Tuple parameter
• An out-of-range numeric Index parameter
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• A dimension or hierarchy parameter not found in the passed tuple.

Syntax
TM1Member(Tuple, MemberSpecifier);

Argument Description

Tuple An expression that resolves to a tuple.

MemberSpecifier This parameter can be either a 0-based numeric
index into the tuple or the name of a dimension/
hierarchy associated with the tuple. See below for
examples showing both parameter types.

Example

TM1Member ( [model].Members.Item(23) ,0 ) ] 

This example uses a numeric index into the tuple as the MemberSpecifier argument.

TM1Member( [model].Members.Item(23), [Model] ) ] 

This example uses the name of a dimension associated with the tuple as the MemberSpecifier argument.

TM1SORT( <set>, ASC|DESC )
This TM1 specific MDX function sorts <set> alphabetically.

Syntax
ASC sorts A-Z

DESC sorts Z-A

TM1SORTBYINDEX( <set>, ASC|DESC )
This TM1 specific MDX function sorts <set> by the index value of the members.

Syntax
ASC sorts by ascending index value.

DESC sorts by descending index value.

TM1SUBSETALL([<dimname>])
This TM1 specific MDX function returns the TM1 subset All of <dimname>.

Syntax
TM1SubsetAll([<dimname>]);
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TM1SubsetToSet
This function returns the members of a TM1 subset. TM1SubsetToSet is equivalent to the
<dimension>.<subsetname> expression, but does not require string literals. Instead, TM1SubsetToSet
lets you use expressions that resolve to the appropriate dimension and subset.

If a private and a public subset have identical names, enter the scope parameter to specify the scope of
the search as "private" or "public".

Syntax
TM1SubsetToSet(Dimension_exp, Subset_exp, Scope);

Argument Description

Dimension_exp An expression that resolves to a valid TM1
dimension name.

Use [dimension] or [dimension].[hierarchy] to
specify a dimension.

Subset_exp An expression that resolves to a valid subset of the
dimension returned by Dimension_exp.

When resolving an expression for a subset, the
server searches first in the private subset list and
then in the public list.

Scope (optional) The subset list to search, which is specified as
private or public.

Specify public to search the public list only.

If this parameter is not specified and a private and
a public subset have the same name, the private
subset is returned.

Example

MDX sample code with dimension name [Corp Planning Hry] in the last line:

{INTERSECT(EXCEPT(DESCENDANTS([Corp Planning Hry].[Fixed Assets]),
TM1FILTERBYLEVEL(DESCENDANTS([Corp Planning Hry].[Fixed Assets]),0)),{
TM1SubsetToSet([Corp Planning Hry],"elist")}),[Corp Planning Hry].[FixedAssets]}

MDX sample code with fully qualified dimension name [Corp Planning Hry].[Corp Planning
Hry] and [Corp Planning Hry].[FixedAssets] in the last line:

{INTERSECT(EXCEPT(DESCENDANTS([Corp Planning Hry].[Fixed Assets]),
TM1FILTERBYLEVEL(DESCENDANTS([Corp Planning Hry].[Fixed Assets]),0)),{
TM1SubsetToSet([Corp Planning Hry].[Corp Planning Hry],"elist")}),
[Corp Planning Hry].[FixedAssets]}

Example

MDX sample code with two subsets, one private, one public, both named 'MySub' under a Markets
dimension. The following queries on columns from [QB] return the content of the private subset:

select TM1SubsetToSet( [QBMarkets].[QBMarkets], 'MySub' )
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Or:

select TM1SubsetToSet( [QBMarkets].[QBMarkets], 'MySub', 'private' )

The following query on columns from [QB] returns the content of the public subset:

select TM1SubsetToSet( [QBMarkets].[QBMarkets], 'MySub', 'public' )

TM1TupleSize
This function returns the number of members in a tuple.

Syntax
TM1TupleSize(Tuple);

Argument Description

Tuple An expression that resolves to a tuple.

The function returns 0 if the Tuple argument does
not resolve to a valid tuple, or of the tuple is null or
empty.

TM1 specific MDX expressions
TM1 supports several TM1 specific MDX expressions. You can apply these expressions while developing
MDX applications to run against the server or when creating/editing dynamic subsets in the Expression
Window of the Subset Editor.

<dimension>.<subsetname>
This TM1 specific MDX expression returns members of <subsetname> in <dimension>.

Syntax
Since the same syntax ( <dimension>.IDENTIFIER ) is used for members and levels, a subset with the
same name of a member or a level will never be instantiated.

When searching for a subset, the server searches first in the private subset list and then in the public list.

<member>.ANCESTORS
This TM1 specific MDX expression returns the ancestors of <member>.

Syntax
For example, assuming the following hierarchy of the Month dimension:

• Year

– 1 Quarter
– Jan
– Feb
– Mar

The following expression:

month.jan.ANCESTORS
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returns the set

{ 1Quarter, Year }.

If the member has more than one immediate parent, the expression returns the set containing the first
parent in the default hierarchy. Consider a hierarchy of a Region dimension, where the member Belgium
has more than one immediate parent, being Benelux and Europe.

The following expression:

region.belgium.ANCESTORS

returns the set

{ Benelux, Europe }.

<member>.WEIGHT
This TM1 specific MDX expression returns the weight of <member>.

Syntax
The weighting property controls how a child member rolls up to its immediate parent, whether that child
is also a parent of another consolidation or just a leaf member. Top level consolidations do not have
weight.

Drill through to detailed data
A TM1 modeler can define drill processes and drill assignment rules for a data source. If the TM1 cube,
view, or relational table that you are working on contains drill processes or drill assignment rules, you can
drill through certain cells to detailed data.

About this task
Watch this video to see how you can perform a drill through in Planning Analytics for Microsoft Excel:

https://youtu.be/h_nu4wOPTiw

If your TM1 modeler has defined drill processes or drill assignment rules for a TM1 cube, view, or
relational table that you're working with, you can drill through on certain cells in your report. Drilling
through on a cell provides detailed data on the cell, and shows you information from the data source. You
can drill through on cells in Exploration Views, Custom Reports, Quick Reports, and Dynamic Reports.

Note: Non-admin users require the installation of IBM Planning Analytics with Watson version 2.0.3 IF4
or later to use the drill-through feature.

Depending on the data source, you can perform either a cube drill through or a relational drill through.

A cube drill through is a drill through on a TM1 cube or TM1 view data source. The Drill Through Viewer
opens when you drill through a cube or view. The Drill Through Viewer is interactive.
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Figure 9. Cube drill through

A relational drill through is a drill through on a relational table, such as an ODBC or flat file data source. A
table viewer opens when you drill through a relational table. The table viewer is non-interactive.

Figure 10. Relational drill through

Procedure
1. Highlight a cell and check to see whether the cell can be drilled on. In the IBM Planning Analytics with

Watson ribbon, in the data section, there is an icon for Drill Through.
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If the Drill Through icon is enabled, you can drill through on the highlighted cell.

2. Click the Drill Through icon .
3. Click the data source that you want to view the detailed data for.

Results
A drill through view of the data source for the selected cell appears.

Cascading drill through
If your TM1 modeler defined multiple levels of drill processes or drill assignment rules for a TM1 cube,
view, or relational table that you're working with, you can successively drill through multiple levels in your
report.

About this task
You can successively drill through multiple levels from the Drill Through Viewer or the Cube Viewer.

Procedure
1. Open the Drill Through Viewer or the Cube Viewer.
2. Right-click a drill through capable cell.

Figure 11. Drill through menu
3. Click Drill through.

Note: If the Drill through option is disabled, the cell that you right-clicked on does not have drill
processes or drill assignment rules set for it.

4. Click the drill process that you want to use.
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Figure 12. Drill through process

Results
An additional Drill Through Viewer appears. 

Figure 13. Multiple Drill Through Viewers

What to do next
If your TM1 modeler has more levels defined, you can repeat these steps in new Drill Through Viewers to
continue drilling. You can also generate reports from any of the Drill Through Viewers.

Save a drill through
You can save data in a relational drill through as a CSV file.

Procedure
1. Open the drill through table viewer.
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2.
Click the Download CSV button.

3.
A prompt appears, asking if you want to open or save the file. Click Save.

Results
The data in your relational drill through is saved as a CSV file.
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Chapter 8. Explore IBM Cognos Analytics data
Make effective business decisions by exploring data with explorations, views, and reports using IBM
Cognos Analytics data.

You can use IBM Cognos Framework Manager packages to create Exploration Views, list views, and
custom reports.

Note: IBM Cognos Analytics data modules are not supported in IBM Planning Analytics for Microsoft
Excel.

Exploration Views and lists
Use Exploration Views and lists to quickly change how you view performance measures and to show
detailed information from your database in rows and columns.

Note: The Format as Table feature in Microsoft Excel should not be used with an Exploration View or list.
Formatting an Exploration View or list as a table will cause issues with the ability to refresh the data.

Create an exploration
Create explorations of IBM Cognos Analytics data to help you make more effective business decisions by
exploring significant company data. To explore IBM Cognos Analytics data, select a package and choose
items from that package to place in the rows and columns of the Microsoft Excel worksheet.

Before you begin
Before you can create an Exploration View or list view, the administrator must create a package and
publish it to a location to which you have access.

The administrator must create a package in Framework Manager and publish it to a location in the IBM
Cognos Connection portal to which you have access. For full access to IBM Planning Analytics for
Microsoft Excel, you should be a member of the Express® Authors or Report Administrators role in IBM
Cognos Analytics. An administrator must configure these privileges using IBM Cognos Administration.

Procedure
1. Specify the package.
2. Add data items to rows and columns.
3. Add a measure.
4. Optionally, nest and filter data. For more information, see “Nest rows or columns” on page 211 and

“Creating custom filters” on page 220.

Results
To format cells in your Exploration View or list view, you can use the IBM Cognos custom styles, such as
Measure - IBM Cognos or Calculated Column - IBM Cognos, in addition to the pre-built Microsoft Excel
styles.

You can access the IBM Cognos styles by clicking Home > Cell Styles. The IBM Cognos styles are listed
along with the pre-built Excel styles. You can modify attributes, such as font and alignment, and then save
the changes to a template for re-use.

In Microsoft Excel 2010, a background color that is set using the Format Cells command overrides the
background color that is set for the cell styles.
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To preserve formatting you applied to the exploration, from the IBM Planning Analytics tab, click the Use
Server formats dropdown and select Use Excel formats. If you select Use Server formats, all custom
formatting is removed.

Note: Worksheets containing an Exploration View can only contain the single Exploration View. Combining
other report types in a worksheet containing an Exploration View is not supported.

Create a list
Use list explorations to show detailed information from your database, such as customer lists or product
lists.

Work with items in a list
Use lists to show detailed information from your database, such as customer lists or product lists.

A list is a report that shows data in rows and columns. Each column shows all the values for a data item in
the database or a calculation based on data items in the database. Lists are useful for very large reports
that require minimal filtering.

Lists and relational sources
Use lists for relational sources.

Lists and dimensional sources
Avoid using lists with dimensional sources. It is preferable to use Exploration Views with dimensional
sources whenever possible, because it will provide much richer filtering capability. However, lists are
useful against dimensional sources if there is no measure in the report. Such a report cannot be created
as an Exploration View and can only be created as a list.

Work with lists that use IBM Cognos Analytics data
You can explore IBM Cognos Analytics data with lists.

Use list explorations to show detailed information from your database, such as customer lists or product
lists. Data sources can be relational, OLAP, or dimensionally modeled relational (DMR).

A list exploration is a report that shows data in rows and columns. Each column shows all the values for a
data item in the database or a calculation based on data items in the database. You can create a list to
look up the value of an item from the database. It can then supply the value to another worksheet where
it can be used for setting a parameter. For more information, see the section on use cases and examples.

Related concepts
“Insert blank columns” on page 101
Insert a blank column into a list to create white space or to add cell-based calculations. You can use the
new column to insert any Microsoft Excel calculation, such as AVG, MIN, or MAX and you can reference
cells both inside and outside the list.
Related tasks
“Create an exploration” on page 203
“Insert items” on page 215
“Suppress empty cells” on page 101
“Create a calculated column or row from scratch” on page 116
“Add calculated columns in a list” on page 205
“Nest rows or columns” on page 211
“Sort a column by names in a list” on page 205
“Change the cube or datasource used by an exploration” on page 117
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You can change the cube or datasource that is used by an exploration.

Sort a column by names in a list
Sorting a column by names makes it easier for you to organize data.

Procedure
1. In the overview area, click the down-arrow of a column box.
2. Click Sort by names and select a sort option.

Results
In the overview area, a symbol appears in the column box to indicate a sort is applied. To remove a sort,
click the down-arrow and select Sort by names > Remove.

Insert blank columns
Insert a blank column into a list to create white space or to add cell-based calculations. You can use the
new column to insert any Microsoft Excel calculation, such as AVG, MIN, or MAX and you can reference
cells both inside and outside the list.

Right-click a column header in the list where you want to insert a column, and click IBM Planning
Analytics > Insert user row/column.

A blank column is added next to the selected column.

Add calculated columns in a list
Insert a calculation to make your list more meaningful by deriving additional information from the data
source. You can insert calculations in lists that use IBM Cognos Analytics data.

About this task
The list must include a measure. For example, the first column displays Products and the second column
displays Revenue.

In addition to simple arithmetic calculations, you can perform the following calculations.

% Of
Calculates the value of a selected member as a percentage of another member, for example, fourth
quarter as a percentage of the whole year or actual as a percentage of target.

% Change
Calculates the change in value of a selected member as a percentage, for example, growth from year
to year or variance from target.

For information about adding Microsoft Excel calculations, see “Create a calculated column or row from
scratch” on page 116.

Procedure
1. Select the headers of the measure columns that you want to use in the calculation.
2. On the list toolbar, click Insert Calculation and select the calculation that you want to perform.

Note: Calculations that are not applicable to the items you selected are grayed out.

Results
The calculated column is displayed in the list. You can rename the calculated column. You can also move
the calculated column.

Note: To delete a calculation, right-click the calculated column, click IBM Planning Analytics > Delete.
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Suppress empty cells
Sparse data can result in lists showing empty cells. To remove sparse data in a list, you can suppress
empty cells that contain a null or zero value.

Procedure

1. On the IBM Planning Analytics tab, click  Suppression type.
2. Click Suppress Rows Only.

Results
Suppressed items are hidden.

Note: To remove suppression, repeat step 1 and click No Suppression.

Clearing all data from an Exploration View or list view
You can clear all data from a specific Exploration View or list view.

About this task
Use the Task Pane to clear all data (including from the rows, columns, and context drop zones), in a
specific Exploration View or list view.

Note:

• Clearing an Exploration View or list view does not break the link to the datasource. When you clear data
in an Exploration View or list view, the button to open the MDX editor is temporarily disabled. This
feature prevents other users from viewing the worksheet's MDX expression, which may contain
information about the datasource.

• The button to open the MDX editor is enabled again if the Exploration View or list view is refreshed by
the user that initially cleared the data. When the view is refreshed, the context dimensions will query for
the first available member for each subset and update the selections and the MDX expression is
updated.

• Clearing an Exploration View or list view discards any set element selections.
• After an Exploration View or list view is cleared, set expressions are reevaluated and the set element

selection is defaulted to the first entry upon refresh. Do not clear an Exploration View or list view if the
set element selection state is intended to be preserved.

• Ensure that the first entry is desired as the default set element selection. If not, structure the set in
such a way that the first entry is desirable as the default set element selection, for example, the first
leaf entry vs the first total.

Procedure
1. In the Task Pane source tree, expand Current Explorations.
2. Right-click the Exploration View or list view that you want to clear all data from.
3. Click Clear Data.

Create an Exploration View
Use Exploration Views to quickly change how you view performance measures, such as revenue or
budgeted production costs.
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Work with IBM Cognos Analytics data
You can explore IBM Cognos Analytics data with Exploration Views.

Use Exploration Views to quickly change how you view performance measures, such as revenue or
budgeted production costs.

OLAP (online analytical processing) exploration uses the term slicing and dicing to describe the ease with
which you can change context and view details. For example, you look at revenue for the years 2012 to
2015 by sales region. You notice a dip in the revenue for 2014. By clicking 2014, you can drill down to
show revenue results by quarter for 2014. You can easily change the view from quarters for 2014 to sales
personnel by replacing quarters with sales personnel.

You can compare and manipulate data so that you can better understand relationships between data and
the relative importance of individual data items. Whether you want to assess revenue growth or to identify
top performers, IBM Planning Analytics for Microsoft Excel provides the filtering and sorting support you
need for exploration.

To extend the example of reviewing revenue by sales region and sales personnel, you can add sales
targets and then calculate the percentage difference between the sales target and actual revenue for each
salesperson. The result indicates who achieved their sales quota as well as who is eligible for a bonus.

For an example about creating a basic Exploration View, see “Example - evaluate revenue from specific
order methods” on page 272.

If you are already comfortable with exploration fundamentals, you may want to refine your Exploration
View by using tasks such as filtering data, nesting rows and columns, and inserting calculations.

Work with relational Exploration Views
Relational data in Exploration Views has limitations and differences from dimensional data. One such
instance is replacing measures on columns. Measures derived from relational data are stacked blocks.
Replacement of the entire stacked block on the grid is not permitted. You would need to do this on the
summary bar. This behavior is consistent with query items that are not measures. You may also notice
that expand, collapse and totals do not work with relational data sources.

Work with items in an Exploration View
You can manipulate the way rows and columns appear in an Exploration View for more effective
comparison.

You can do this by

• nesting rows or columns “Nest rows or columns” on page 211
• swapping rows and columns “Swap rows and columns” on page 107
• showing or hiding rows or columns “Limit items” on page 216

Exploration is a process in which you explore the relationships between items to help understand your
business. The Exploration View helps you discover whether the value of one item is associated with that
of another.

Comparisons are key elements of nearly every exploration. The following table shows examples of
different types of comparisons.

Table 19. Examples of comparisons

Comparison Example

Simple comparison Tents versus sleeping bags

Multiple comparison Tents versus golf clubs, tees, and golf balls

Multidimensional comparison Products versus territories, this year-to-date
versus last year-to-date
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Table 19. Examples of comparisons (continued)

Comparison Example

Mixed comparison Tents versus similar camping products, this year
versus last year, and the last quarter versus last
year

Summaries of measures at different levels Tents as a share of camping products, as a share of
European sales

Explorations and relational sources
Explorations can be used to transform relational sources into an Exploration View that allows dimensional
style layout. Filters for relational explorations are, however, detail filters as opposed to dimensional. If
dimensional style layout and filtering are common requirements, we recommend that you create a DMR
model for this data source to simplify report creation.

Explorations and dimensional sources
We recommend that you use explorations for dimensional sources. Even if the report has a simple layout
with no nesting and measures as columns, the query supports precise filtering if created as an Exploration
View.

Select measures
Each Exploration View based on DMR or OLAP packages must contain at least one measure. Only one
measure can be dragged to the measure drop zone. If you select more than one measure by placing a
measure in a row or column, the measure that is in the measure drop zone becomes the default measure.

Tip: To drag more than one measure to a row or column, you can use Shift+click or Ctrl+click.

Sometimes, when you add measures to columns or rows, you may notice that other items get re-ordered.
This is a query framework behavior. Unlike an OLAP data source, DMR data is not returned in a specified
order. If a specified order is required, you must edit the specifications in Framework Manager.

Procedure
1. In the source tree, select and drag a measure to the Measure drop zone.

Unlike the Rows or Columns drop zone, the Measure drop zone is available only on the grid and not in
the header area. The selected measure appears.

2. Save your workbook.

Results
After you save your workbook, you can publish it to IBM Cognos Connection.

Remove measures
To remove measures from an Exploration View that uses IBM Cognos Analytics data, you must have an
active worksheet. After removing a measure from the Measure drop zone, you are able to add back a
measure. In addition to the Measure drop zone, which can contain only a single measure, you can add
multiple measures to other drop zones.

To replace a measure, you can drag a new measure to any of the drop zones where the measure has been
placed. This includes the measure drop zone.
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Procedure
To remove a measure from an Exploration View, right-click the cell that displays the measure name, click
IBM Planning Analytics, and then click Hide.

Results
The measures are removed from the measure drop zone in the Exploration View. You can now add one or
more measures to the Exploration View.

Insert a hierarchy
You can use a dynamic expression to insert a hierarchy in an Exploration View based on the structure of
the metadata tree.

You do this by selecting an insert member option that creates a dynamic expression, such as the Insert
Member With Children option, and then dragging a node item to either the rows or columns drop zone.

Alternate hierarchies of the same dimension can only be stacked in the same Exploration View. They
cannot be nested or used on opposite axes. Alternate hierarchies of the same dimension, for example,
Retailers by Geography and Retailers by Type, do not produce logical results when combined on the
same Exploration View as nested items or on opposite dimensions. To combine two alternate views of the
same hierarchy, you must model them as separate dimensions. If they are available as separate
dimensions, they can be combined on the same Exploration View. For example, it would be possible to
place Retailers by Type on rows with Retailers by Geography on columns, and Retailers by Type on
rows with Retailers by Geography nested on rows.

Procedure

1. In the task pane, click  and select Insert member with children .
2. In the source tree, drag the hierarchy that you want to insert to the Rows or Columns drop zone.

Results
Note: If by using one of the multiple selection techniques, you dragged an item and one of its children to
Rows or Columns, you may notice that it appears twice. If this was accidental, you can delete the
repeated item. To remove an item, in the work area, right-click the item and then click Delete.

The items appear in the Exploration View in their expanded format.

Add calculated rows and columns
Insert a calculation to make your Exploration View more meaningful by deriving additional information
from the data source. For example, you create an invoice, and you want to see the total sales amount for
each product ordered. Create a calculated column that multiplies the product price by the quantity
ordered.

About this task
In addition to simple arithmetic calculations, you can perform the following calculations:

% Of
Calculates the value of a selected member as a percentage of another member, for example, fourth
quarter as a percentage of the whole year or actual as a percentage of target.

% Change
Calculates the change in value of a selected member as a percentage, for example, growth from year
to year or variance from target.
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% Of Base
This calculation is available only if you select two members from different hierarchies, one on rows
and the other on columns, for example, each region's contribution (on rows) to a yearly total (on
columns).

% Of Parent
This calculation is available only for TM1 data. The % of Parent calculation is available only if you
select two members from different dimensions, one on rows and the other on columns. % Of Parent
calculates the value of a selected member as a percentage of its parent, for example, January sales as
a percentage of sales for the whole year.

After you insert a calculation into an Exploration View, the rows or columns are separated into two distinct
blocks of items before or after the inserted row or column. If you want to use the Expand level / Collapse
level feature, you must do so for each block separately.

When calculations in the rows and columns of an Exploration View intersect, calculations are performed
in the following order:

• Addition or subtraction
• Multiplication or division

If both calculations have the same precedence, for example, if they are both functions, then the row
calculation takes precedence.

For information about adding Microsoft Excel calculations, see “Create a calculated column or row from
scratch” on page 116.

Procedure
1. Right-click the columns or row headers that you want to use in the calculation.
2. Click IBM Planning Analytics > Insert calculation and select the calculation that you want to

perform.

Note: Calculations that are not applicable to the items you selected are grayed out.

Results
The calculated row or columns appears in the Exploration View. You can rename the calculated column or
row. You can also move the calculated column or row.

Note: To remove a calculation, right-click the calculated row or column header, click IBM Planning
Analytics > Remove.

Filtering values using context
You can use one or more items to quickly focus your Exploration View on a particular view of the data.
This technique is known as filtering using context.

For example, you have an Exploration View showing products in the rows and revenue for different
quarters in the columns. To change the context to Asia, you drag Asia from the source tree to the Context
section of the overview area. The Exploration View then shows only the values for Asia.

Changing context changes the values that appear. It does not limit or change the items in the rows or
columns.

You can filter using multiple values in the context area, however, multiple filters are lost when you convert
the Exploration View to formulas and start to use cell-based methods. Some context filters cannot be
converted to formulas, such as multiple filters from the same dimension and filters from dimensions that
are already displayed in the Exploration View.

Procedure
1. In the source tree, select or search for one or more items to filter on.
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2. Drag the item that you want to filter on into the Context section of the overview area.

A drop-down list box appears under Context.
3. Click the item that you want.

The Exploration View shows the results only for the selected item.

Tip: To change context, select a new item from the drop-down list under Context.
4. If you want to use a custom set as a filter, drag the custom set from the Source Tree to the Context

section of the overview area.

Insert blank columns or rows
Insert a blank column or row into an Exploration View to create white space or to add cell-based
calculations. You can use the new row or column to insert any Microsoft Excel calculation, such as AVG,
MIN, or MAX.

About this task
Depending on the type of data, such as relational or asymmetric you experience very different results.
Experiment with different approaches to see what makes sense in your environment.

After you insert a row or column into an Exploration View, the rows or columns are separated into two
distinct blocks of items before and after the inserted row or column. If you want to use the Expand level /
Collapse level feature, you must do so for each block separately.

Procedure
1. Right-click a column or row header in the Exploration View where you want to insert a column or row.

If the Exploration View area expands, make sure that it does not overwrite items.
2. Click IBM Planning Analytics > Insert user row/column.

A blank column or row appears next to or under the selected column or row.

Results
The blank row or column is added to the Exploration View.

You can leave the row or column blank. You can also populate the blank column or row with a Microsoft
Excel calculation. For more information, see “Create a calculated column or row from scratch” on page
116.

Nest rows or columns
You can nest items in an Exploration View to compare information by using more than one item in a
column or row. For example, an Exploration View shows the sales by product line for the past fiscal year.
You can add an item to further break down the sales by order method. You can also nest rows in a list.

When nesting columns in an Exploration View, there are four distinct drop zones where you can insert a
new data item. The drop zone you choose defines the relationship between the data item and the column.

The following relationships are created when you insert a data item as a row:

• Inserting a data item before or after a column creates a parent-child relationship between the data
items.

When you insert a data item before a column, the data item becomes a parent to the row. When you
insert a data item after a column, the data item becomes a child of the row.

• Inserting a data item before or after a column creates a union relationship between the data items.

The following relationships are created when you insert a data item as a column:
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• Inserting a data item before or after a column creates a union relationship between the data item and
the column.

• Inserting a data item before or after a row creates a parent-child relationship between the data items.

When you insert a data item before a column, the data item becomes a parent to the column. When you
insert a data item after a column, the data item becomes a child of the column.

For example, you have an Exploration View with Product line as rows and Quantity and Revenue as nested
rows. For columns, you have Order method with Country or Region as a nested column.

• Product line is a parent to Quantity and Revenue.
• Quantity and Revenue are peers.
• Order method is a parent to Country or Region.

In the overview area, you can drag the boxes that represent the nested items to quickly change the
nesting order.

If you nest a row or column, the context menu for Expand, Drill, and Explore does not appear for the
outer item when you convert to formulas and use cell-based methods.

Procedure
1. In the source tree, click the item that you want to insert.

Tip: When selecting multiple items, the selected items are placed in the exploration in the order that
you click them. To avoid rearranging items after you drag and drop them into the exploration, click the
items in the order of placement that you want.

2. Drag the item to the location that you want in the rows or columns.

A highlight bar indicates where you can drop the item.
3. If you are working with a list, to merge cells with the same data, right-click items in the column you

want to group, and then click IBM Planning Analytics > Group/Ungroup.

Tip: If you add more than one measure to an Exploration View to the same axis, you must add them as
a set. Ctrl+click the items or, to add a measure to another measure already in the Exploration View,
press the Ctrl key while dragging the item to the other measure.

Rearrange nested items
You can rearrange nested items by dragging one item next to another item in a drop zone.

For example, if Products and Regions are nested, you can move Regions to the outside edge.

Procedure
1. Drag an item next to another item within a drop zone or next to a different drop zone.

A highlight bar indicates where you can drop the item.
2. If you are creating a list, to merge cells with the same data, Right-click items in the column you want to

group, and then select IBM Planning Analytics > Group/Ungroup .

Results
Nested items appear next to each other with nested items replicated for each of the preceding items.

Suppress empty cells
Sparse data can result in Exploration Views showing empty cells. For example, an Exploration View that
matches employees with products, results in many rows of empty values for the revenue measure if the
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employee does not sell those products. To remove sparse data in an Exploration View, you can suppress
empty cells that contain a null or zero value.

When you are working with IBM Cognos Analytics data, totals-based suppression is applied. Totals-based
suppression removes rows or columns where the total results in a null or zero value throughout the
Exploration View. You cannot remove sparse data from individual rows or columns.

Procedure

1. On the IBM Planning Analytics tab, click  Suppression type.
2. Choose where to apply the suppression:

• Suppress Rows Only
• Suppress Columns Only
• Suppress Rows and Columns

Results
Suppressed items are hidden.

Note: To remove suppression, repeat step 1 and click No Suppression.

Best practices
Exploration Views provide many automatic features so that you can focus on your main purpose, which is
to analyze and explore your company data.

This topic applies to Exploration Views that use IBM Cognos Analytics data.

Any charts, cells, or cell-formatting that you introduce onto the worksheet might be overwritten when
refreshed data changes the size or the content of the Exploration View. Create headings and charts where
expanding data in the cells of the Exploration View do not overwrite items.

In general, use Exploration Views for dimensional data sources. For more information, see “Work with
items in an Exploration View” on page 207.

If you are pulling large quantities of data while you are working on the layout of your Exploration View, you
may find that there is a delay. The following techniques help you to eliminate or at least mitigate
performance delays.

• On the IBM Planning Analytics toolbar, click  and select Preview with No Data. Refresh the data
after you have finished designing your worksheet.

• If you are working with dimensional data in an Exploration View, select a measure first. This limits the
amount of data and gives you much faster results.

• Lower the maximum number of rows or columns to pull into an Exploration View or list by using the
Data Display Row Limit option. When you finish the layout, you can set the Data Display Row Limit
number higher or double-click More or All to see the remaining rows or columns of data.

Sets
Sets are the basic building blocks of IBM Planning Analytics for Microsoft Excel. A set identifies a group of
items from a single hierarchy. You can manipulate the individual sets in the Exploration View.

Sets may be

• nested or stacked in the Exploration View
• used as filters

The following list describes the different kinds of sets you can use.
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Simple
A single member and its direct dependents one level down.

Selection-based set
A collection of individual items that you have explicitly selected. The items or members may be
selected from one or more levels from the same hierarchy and are not aggregated.

Combination set
A set consisting of more than one simple or selection-based set.

Set properties
You can set properties for an Exploration View or a list that are specific to a worksheet.

About this task
The settings in the Properties dialog box are specific to a worksheet. For information about setting global
options, see Chapter 5, “Settings,” on page 45.

In addition to changing settings, the Properties dialog box enables you to view information about the
worksheet including server and package information, and the date the worksheet was created.

Procedure

1. On the IBM Planning Analytics tab, click  Properties.

2. To change the starting location of your Exploration View or list, type a new row number in the Row
start box and a new column number in the Column start box.

3. If you are working with a TM1 Exploration View, you can choose whether to process data in either CSV
or raw XML format.

• To choose CSV format for faster processing of large data sets, in the Request format drop-down box,
click Unformatted Values.

• To choose raw XML format, in the Request format drop-down box, click Formatted Values.
4. If you are working with a IBM Cognos Analytics List, you can choose whether to process data in either

CSV or raw XML format.

• To choose CSV format for faster processing of large data sets, in the Request format drop-down box,
click Unformatted Values.

• To choose raw XML format, in the Request format drop-down box, click Formatted Values.
5. To control how labels appear in nested cells, set the Default grouping option.

Note: The Default grouping option controls how the Group / Ungroup feature works. For Exploration
Views, this is the automatic setting for presentation of metadata in nested rows and columns. For lists,
this determines how the Group /Ungroup menu items and buttons work.These settings override the
settings in the Options dialog box and affect only the current worksheet. You can leave cells
ungrouped when you need to use Microsoft Excel lookup functions or you can group cells to provide for
greater readability. Changes to the Grouping option will be reflected in the worksheet immediately,
whereas changes in the Options dialog box will only be reflected when a new Exploration View is
created.

• To merge metadata into cells that span nested items and allow for full grouping, click Merge Cells.
• To repeat metadata in individual cells that span nested items, click Repeat Labels.

Use this option when you want to use other Microsoft Excel functions on the data.
• To limit cell metadata and merging to minimize labels, click Label Top Cell.
• To turn grouping off, click None.

6. To limit the number of rows displayed, set the Data Display Row Limit property.

7. After you are done setting options, click OK.
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Insert items
You insert items from the source tree as rows and columns in an Exploration View or list to create sets for
exploration. A set is a collection of like data. For example, you can have a set of data named years that
includes quarters as details.

You can control how items are inserted by setting the insert option on the exploration bar. For an IBM
Cognos Analytics data source, you can use the following insert options.

• Insert Single Member, which inserts the selected member.
• Insert Member With Children, which inserts the selected member and its components to one level as a

static set.
• Insert Member With Dynamic Children, which inserts the selected member and its components to one

level as a dynamic set.

In addition to items from the source tree, you can insert items retrieved in a search.

Note: The default measure specifies the measure to use for an Exploration View if the measure is not set
by one of the existing axes. For example, you create an Exploration View with Products in the rows and
Quantity Sold in the columns. You add Revenue to the Measure drop zone to make it the default
measure, but the values in the rows do not change because they refer to the measure Quantity Sold in
the column axis. However, if you replace the measure Quantity Sold with the non-measure Order
Method, the values now refer to Revenue as the default measure.

You can also simultaneously insert all the items of a level “Insert all the items of a level” on page 216,
insert some items from a level, or insert items from different levels of the same dimension “Insert items
from multiple levels of a dimension” on page 215.

Procedure
1. Select the insert option you want to use.
2. In the source tree, select the items that you want to insert.

3. Drag the items to the desired location in the Exploration View or list.

To add an item to items that already exist in the Exploration View or list, hold down the Ctrl key when
dropping items into the drop zones.

A highlighted bar indicates where you can drop the item.

Note: Sometimes, when you add measures to columns or rows, you may notice that other items get re-
ordered. This is a query framework behavior. Unlike an OLAP data source, DMR data is not returned in
a specified order. If a specified order is required, you must edit the specifications in Framework
Manager.

A detail-based set appears in the Exploration View or list.

You can insert items as a selection-based set by pressing Shift+click or Ctrl+click to select multiple
items in a dimension and then dragging them to the Exploration View or list. When selecting multiple
items, the selected items are placed in the Exploration View in the order that you click them. To avoid
rearranging items after you drag and drop them into the Exploration View, click the items in the desired
order of placement.

Insert items from multiple levels of a dimension
For a mixed comparison, use selection-based sets to position items adjacent to each other in an
Exploration View.

For example, you can select items from a single dimension in the source tree. You can select both
contiguous and noncontiguous items from different levels.

After you select items, you can drag the items to the Exploration View.
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For groups of items that you use frequently, you can create a custom set to make selection of them easier.
For more information, see “Create and edit sets” on page 137.

Procedure
1. In the source tree, expand the dimension to locate the items that you want to insert.
2. Press Shift+click or Ctrl+click to select multiple items in a dimension and then drag them to the

Exploration View.

Tip: When selecting multiple items, the selected items are placed in the Exploration View in the order
that you click them. To avoid rearranging items after you drag and drop them into the Exploration View,
click the items in the desired order of placement.

Results
A selection-based set appears in the Exploration View.

Insert all the items of a level
You can simultaneously insert all the items of a level into an IBM Cognos Analytics exploration. Levels
define the way data is grouped in dimensions.

For example, a geographical dimension in a source tree might contain levels for region, country or region,
and city. You can click a single region and instantly insert every country or region that belongs to that
region into the Exploration View. By expanding the region item, you can display all of the countries or
regions within that region. Use this technique to insert members of a single node item.

You can also choose to display all of the countries or regions across regions by inserting a special Level
item. Use this technique to insert members at the same level from multiple node items.

Procedure
1. In the source tree, click a single item that contains the detail that you want in the exploration.
2. Optionally, insert members from a single node item.

• Drag the item to the drop zone in the overview area, such as the Rows drop zone.
• Expand the item.

Tip: To expand or collapse items, right-click the item, click IBM Planning Analytics, and then click
Expand / Collapse or Expand Level / Collapse Level. Expand Level expands items from the highest
level member.

3. Optionally, insert members at the same level from multiple node items

• In the source tree, click a single item that contains the detail that you want in the Exploration View.
• From the command area, drag the Level item to the drop zone or work area.

Limit items
You can limit the items in an Exploration View or list using a variety of techniques.

You can use the following options with Exploration Views:

• Use zero-suppression to hide rows or columns that contain only missing values.
• From either rows or columns, select the items you want to show in the Exploration View, right-click the

cells and select IBM Planning Analytics > Keep. The Keep option is also available in the set editor.
• Use the Data Display Row Limit option to limit the number of rows displayed in the Exploration View.

On the IBM Planning Analytics toolbar, click Options. Set the number of rows to display in the Data
display row limit field.

You can use zero-suppression to hide rows that contain only missing values in Lists.
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Drill down and drill up
You can drill down and drill up to change the focus of your analysis by moving between levels of
information.

Drill down to see more detail. For example, you can drill down to the lowest-level item to examine the
impact of a single aspect of your business.

Drill up to compare results. For example, you can examine revenue for a single product and then drill up to
see revenue for the entire product line for comparison.

Note: When you drill back up after drilling down, you may lose filters that are applied. For example, you
create a filter to include the data for sales regions of the USA and Canada. You drill down on Florida. When
you drill up again, the analysis no longer includes Canada in its scope.

Procedure
1. To drill down or up in a single row or column, right-click a cell and then click IBM Planning Analytics >

Drill Down or IBM Planning Analytics > Drill Up.
2. To drill down or up in both a row and column simultaneously, double-click the value at the intersection

of the row and the column.

Rows and columns
You can choose the data that you want to appear in the rows and columns of your Exploration Views.

Add objects to rows and columns
Select the data items that you want to appear in the Exploration View or list view. When selecting multiple
items, the selected items are placed in the exploration in the order that you click them. To avoid
rearranging items after you drag and drop them into the Exploration View, click the items in the desired
order of placement. To add an item to a multiple set, hold down the Ctrl key while dragging the item. This
appends the new item to the items already in the Exploration View.

You may frequently use items from different query subjects or dimensions in the same reports. Ask your
modeler to organize these items into a folder or model query subject and then to republish the relevant
package. For example, if you use the product code item in sales reports, the modeler can create a folder
that contains the product code item and the sales items you need.

Procedure
1. In the IBM Planning Analytics toolbar, click Exploration or list.
2. If the Select Start Location dialog box appears, type a cell address, such as $L$20 and click OK.

You can also click a cell to populate the Start Address. For example, you can change the start location
to accommodate graphs or other worksheet items.

3. In the source tree, drag each data item to the location in the work area where you want it to appear.

For an Exploration View, drag objects to the Rows and Columns drop zones, which are located in the
header area of the worksheet. Use the Context area, to further refine or filter your report.

For a list, drag objects to the Columns drop zone, which is located in the header area of the worksheet.

Note:

• To drag more than one item, you can use Shift+click or Ctrl+click to select multiple items.
• To add an item to items that are already on Columns, hold down the Ctrl key and drop the item onto

the existing items.
4. Save your workbook.
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Results
Selected items appear in the rows and columns of the report.

After you edit your workbook, you can publish it to IBM Cognos Connection.

Sort rows by values or names
Sorting rows by values or names makes it easier for you to organize and analyze your data.

Sort options differ depending on the type of data source and the type of exploration. For example, in an
Exploration View that uses a multidimensional data source, you can sort rows by row name.

Procedure
1. Select a sort option.

a) To sort rows based on the values in a column, right-click the column header cell then click IBM
Planning Analytics > Sort by values.

b) To sort rows by row name, right-click a row header cell then click IBM Planning Analytics > Sort by
names.

You can also sort rows by name using the context-menu from a row or column box in the overview
area.

2. Select a sort option.

Results
In the overview area, a symbol appears in the rows or columns box to indicate a sort is applied. To remove
a sort, right-click the header cell then click IBM Planning Analytics > Sort by values or Sort by names >
Remove.

Swap rows and columns
You can swap rows and columns for a different view of your data. For example, the rows contain quarters
of the fiscal year and the columns contain products. To track trends over time more easily, you can swap
them so that the rows contain products and the columns contain quarters.

Note: When you swap rows and columns in a TM1 Exploration View, sorting and top or bottom filters are
removed.

Procedure

Click Swap Rows and Columns  on the toolbar.

Tip: You can also use the overview area to swap individual items on rows and columns by dragging the
items from one area to the other.

Change the system and data source used by an exploration
You can change the IBM Cognos system that is used by an exploration. You can also change the data
source that is used by an exploration.

Before you begin
The information area must be displayed above the Exploration View or list to complete this task. The
information area is displayed when Show system and package information in Exploration View or list

sheet in the Options dialog box is enabled. Then click Refresh .
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Procedure
1. Click the worksheet that contains the exploration.
2. In the information area above the exploration, double-click the cell that displays the System.

Or, if you want to change only the data source or package, double-click the cell that displays the
Package.

3. In the Select Package dialog box, select a system.
4. Select a data source, and then click OK.

Custom filters
For IBM Cognos Analytics data sources, you can filter data so that only the data you require appears in the
analysis. Add a filter expression to focus a report and minimize processing time by excluding unwanted
data. For example, you can filter data to show customers who placed purchase orders that were valued at
over one thousand dollars during the past year. When you run the report, you see only the filtered data.
Depending on your data, you can specify a filter by using measures, attributes, fields, and calculations and
using comparison and logical operators to compare them with a constant, a measure, an attribute, a field,
or a cell reference, including a date.

When you define a filter rule by using a label or an attribute, the text is case sensitive. These detail filters,
which are applied to the data source, are Boolean expressions used to exclude items based on values.

Use cell references
Cell references can be used anywhere a constant could be used. Cells are read at the time the query is
initiated. You can use a text box for typing values or you can use cell ranges, such as J7, $K$9 for cells or
H3:H20, $J$5:$M$15 for ranges. Cells can be on another sheet, for example, Sheet2!:B4, Sheet3!
D2R2, or even a named range, such as Sheet1!RangeName. Blank cells are ignored and invalid numeric
values are converted to zero (0). You can create Exploration Views and lists on one worksheet to be used
as part of a filter expression in another worksheet. A cell reference used in a numeric or date comparison
that does contain a valid value will result in the use of 0 and the current date respectively.

Match data types
If you create a filter for a particular data type, such as a numeric data type, but enter criteria for another
data type, such as a string, you receive an error. In general, you must enter values that are consistent with
the data type of the item for which you are creating criteria. For example, if you create a filter for a
monetary amount, which is numeric, but enter a string value, such as "Yen" you receive the following
error:

Error 901: QE-DEF-0260 Parsing error before or near position: position of:
"filter(MUN)"

The following operators are an exception to the data type rule: IS NULL, IS NOT NULL, LAST N DAYS, and
IS IN. In the case of these operators, the target, or second, argument is not a type match with the field, or
first argument. In the first two, IS NULL and IS NOT NULL, there are no target arguments. None of these
operators can use a database reference as a target argument.

OLAP and DMR data sources
For OLAP and DMR data sources in a list report, criteria are limited to the items that you add to the list
itself. To enhance filter capabilities, use lists for relational data sources and use Exploration Views for
dimensional sources. Be cautious when mixing context dimensions with filters because they may not yield
the result you expect.

In nested explorations using OLAP or DMR data sources, you must apply the filter to the dimension on
rows or columns that defined the measure value in the Exploration View. For example, you might have an
Exploration View with products and order method on rows, years on columns and quantity sold on
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measures. Because order method is the inside edge of the nested rows (it appears after products in the
Rows drop zone), you must create the filter using order method.

Focus relational data
You can limit the data in your report with filters or query parameters. The method you choose should
depend on the capabilities of the data source, the performance requirements, the persistence of the
dataset, and how complex you want the report to be. In IBM Planning Analytics for Microsoft Excel, you
must use detail filters for list reports in the relational reporting style. These filters remove rows and
columns from your reports.

Before aggregation
For relational data sources, you may also have the option of applying filters before aggregation. Select the
Before aggregation check box if the field is a measure, however this check box is disabled for non-
measures or if the condition is at or below a logical OR operator. In that case, the default is enforced
where non-measures are automatically before aggregation and all others are after aggregation.

Combine filters
You can combine filters to create custom AND and OR conditions. When you filter your data based on a
number of criteria, there may be filter rules that are optional and filter rules that are required. You use
AND to group rules that are mandatory. You use OR to group filter rules that are optional. For example,
customers filtered by Revenue > 1000000 AND Discount >.15 gives different results from Customers
filtered by Revenue > 1000000 OR Discount > .15. A more complex scenario might require combining
both mandatory and optional filter rules.

Filters and calculations
Filters cannot use calculations that reference the set being filtered because this creates a circular
reference. Depending on how ranking functions (such as rank or quartile) or percentage functions (such as
percent of total) are customized, they may not be available when defining a filter.

IS IN operator
Based on the SQL IN operator, the IS IN operator reduces the need for multiple OR clauses. Use the IS IN
operator for numeric and text fields. For numeric fields it would normally be non-measures, such as Year.
You can use a text box for typing values or you can use cell ranges, such as J7, $K$9 for cells or H3:H20,
$J$5:$M$15 for ranges. Cells can be on another sheet, for example, Sheet2!:B4, Sheet3!D2R2, or
even a named range, such as Sheet1!RangeName. Blank cells are ignored and invalid numeric values are
converted to zero (0). You can create Exploration Views and lists to be used as part of a filter expression in
another worksheet. For more information, see the topics on use cases.

Promote filters to a studio
When you promote an Exploration View or a list to a studio, such as Report Studio, the custom filter that
used a dimensional data source is recognized as a set expression. Set expressions are calculated sets of
members. For example, children ([2015]) is a set expression that displays the child members of 2015. To
edit the custom filter in a studio, you must edit it as a set expression using the Query Calculation editor.
For more information about set expressions, see the user guide for the studio.

Creating custom filters
In IBM Cognos Analysis for Microsoft Excel you can filter data so that only the data you require appears in
the analysis. Specifically, you can add a filter expression using measures, attributes, fields, and
calculations and using comparison and logical operators to compare them with a constant, a measure, an
attribute, a field, or a cell reference, including a date.
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If you are working with a dimensional data source, you can also use context filters. For more information,
see “Filtering values using context” on page 210.

Procedure
1. In the drop zone, click the drop-down box of the item you want to filter and then click Filter >

Edit/Add Filter.

The Filter window appears. Based on your selection you are able to select or enter items for Item,
Operator, or Value. Criteria for filters are not limited to the items shown on the report.

2. Edit the filter expression and click OK.
3. After you have created all the criteria for the custom filter, click OK.

Results
After you close the filter window, all cells used in references are selected. This is useful if you want to
format these cells to indicate their importance. The filter is applied to the applicable item. If you are
working with the Preview with No Data option selected, the effects of the filter show when you run the
data. The filter tag is displayed next to the item. In the drop-down box, on the Filter menu, Apply filter is
selected.

Tip: To remove a filter, click the drop-down box of the filtered item, and then click Filter > Apply Filter to
clear the check mark.

Adding a filter line
In the Filter window, add filter lines to create criteria for your filter. Each line represents a unique criterion
or filter expression.

Before you begin
You must create your filter and be in the Filter window to add a filter line.

Procedure
1. Click the Add a Filter Line icon.

The Edit Filter window appears.
2. Edit the expression.

Click a data item, then click a Boolean operator, and then enter a constant or enter the cell reference
that contains the value you want to use in this expression.

3. Click OK.

Applying filter criteria before aggregation
If you use a relational data source, to apply the filter criteria before items are summed, you can select the
Before Aggregation check box in the Edit Filter window.

Before you begin
You must create or edit a filter line from a relational data source.

Procedure
1. From the Filter window, click the filter line, or if you are creating a new filter, click the Add a Filter Line

icon.
2. Select the Before aggregation check box.
3. Click OK.
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Grouping filter criteria
To combine filter criteria, group the filter lines. This enables you to create complex filter expressions that
rely on multiple data items and values. You can use complex criteria to display ranges of items based on
minimum and maximum values that you set in the Filter editor or in the cells of the Microsoft Excel
worksheet.

Procedure
1. Ctrl+click the items you want to group.
2. Click the Group Selected Filter Lines icon.

Deleting filter criteria
To remove criteria from your filter, you must delete the filter line or group that has that expression in the
Filter window. If more than one criterion has been grouped, you can delete the entire group.

Procedure
1. To open the Filter window, from the toolbar or drop zone, click the Filter icon and then click Edit/Add

Filter.
The Filter window appears.

2. Click the line or group you want to remove.
3. Click the Delete Selected Filter Line icon.

This deletes the highlighted line or group.

Ungrouping filter criteria
Ungroup filter criteria if you want to change the order of the criteria, change the Boolean operators, or if
you want to delete specific lines from a complex filter.

Procedure
1. To open the Filter window, from the toolbar or drop zone, click the Filter icon and then click Edit/Add

Filter.
The Filter window appears.

2. Click the grouped items.
To select multiple items, Ctrl-click each item.

3. Click the Remove the Group Containing Selected Filter Lines icon.

Create and edit sets
A set is a collection of members in a dimension that limits the number of members that are displayed in a
view.

Procedure

1. To open the set, click the dimension tile in the cube view, and click .
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2. Display the members that you want to use in the set by selecting from the Select hierarchy menu, and
the Select members to view menu.

3. Select the members in the Available members list, then choose one of the following options to add
the members to the Current set:

• Click  to insert the members into the current set.

• Click  to replace all of the members in the current set.
• To append the members in the Available members list to the members in the Current set, click

, and then click .

• Tip: To control the members that are inserted into the set, click the bullet icon  and select one
of these options.

– Member only
– Children
– Descendants
– Leaf nodes
– Ancestors

Work in the Current set
4. To change the members in the Current set, do the following steps.

Change the position of a member
Right-click the member, then click one of the Move options. You can only change the position of a
member if the set is static. See “Convert a dynamic set to static” on page 144.

Remove members
To remove all members from the Current set, click .

Keep only selected members
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5. You can display the Member ID or the Alias for a member instead of the Caption. An alias is an

alternative name for a member. Click  and select the display name type.
Apply and save your changes.
6. To save your changes as a new set that can be reused in other views, click Save, and give the new set a

name.
Select Share public to share the set with other users. Clear this option to keep the set private.

7. If you are editing an existing set, you can apply the changes to your view without saving the new set
configuration. Click Apply and close.

Creating a custom set by using items in a drop zone
You can specify a name and description for a custom set of data that you may want to reuse later. You can
create a custom set using items in a drop zone. Multiple custom sets may be available in a single saved
exploration.

You can save custom sets. IBM Planning Analytics for Microsoft Excel creates a folder in your personal
folder, My Folders, in the IBM Cognos Connections portal with the same name as the package and saves
the custom set information in that folder. The custom set information is not shared among different users,
even when they are using the same package. You only have access to your own custom sets.

Custom sets can be used in an Exploration View using dimensionally modeled relational packages or
OLAP data sources. They are not available for relational packages. Levels cannot be saved as a custom
set.

Procedure
1. When creating a new exploration, select items from a dimension or node in the source tree.

Note: Order of selection is the order in which the items appear in the drop zone and in the custom set.
2. Drag the items to a drop zone.

For an Exploration View, the drop zones are Columns, Rows, or Context. For a list, the drop zone is
Columns.

3. From the drop zone, click the item drop-down box and then click Edit Set.

The Selection window is displayed.

To edit custom sets, use the dialog box to move items to or from the Available Members pane to the
Selection pane. To limit items in the Available Members pane, click , type a string in the box, and
click . To reorder items in the Selection pane, right-click an item to access move options.

4. To save the custom set, click the Save or Save as icon.
The Save window appears.

5. In the Name box, type a name for the custom set and click Save.

Results
The custom set is saved and is displayed in the source tree in the Custom Sets node item. It is saved as
part of your workspace and is not available to other users.

Creating a custom set using items in the source tree
You can specify a name and description for a custom set of data that you may want to reuse later. You can
create a custom set using items in the source tree. Multiple custom sets may be available in a single saved
exploration.

You can save custom sets. IBM Planning Analytics for Microsoft Excel creates a folder in your personal
folder, My Folders, in the IBM Cognos Connections portal with the same name as the package and saves
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the custom set information in that folder. The custom set information is not shared among different users,
even when they are using the same package. You only have access to your own custom sets.

Custom sets can be used in an Exploration View using dimensionally modeled relational packages or
OLAP data sources. They are not available for relational packages. Levels cannot be saved as a custom
set.

Procedure
1. When creating a new Exploration View or list, Ctrl+click items from a dimension or node in the source

tree.

Note: Order of selection is the order that the items appear in the drop zone and in the custom set.
2. Right-click a selected item and then click New Set.

The Selection dialog box appears.

To edit custom sets, use the dialog box to move items to or from the Available Members pane to the
Selection pane. To limit items in the Available Members pane, click , type a string in the box, and
click . To reorder items in the Selection pane, right-click an item to access move options.

3. To save the custom set, click the Save or Save as icon.
The Save window appears.

4. In the Name box, type a name for the custom set and click Save.

Results
The custom set is saved and is displayed in the source tree in the Custom Sets node item. It is saved as
part of your workspace and is not available to other users.

Insert Microsoft Excel calculations
You can insert any Microsoft Excel calculation, such as AVG, MIN, or MAX into an Exploration View or list.
You can reference cells both inside and outside the exploration.

Procedure
1. Insert a blank column or row.
2. Create the calculation in the first cell that applies to the inserted column or row.

You must create the formula for the calculation in the cell closest to cell A1 (the upper left most cell) of
the inserted group.

3. After you have created the calculation for a single cell, from the toolbar, click Use Server formats to
remove custom formatting.

Results
The calculation is propagated to all the inserted cells.

Tip: You can apply conditional formatting to the calculated column or row. Select the column or row. Click
Home and then click Conditional formatting. Use the conditional formatting menu to choose the styles
for the cells.

Chapter 8. Explore IBM Cognos Analytics data  225



Create a Custom Report
To take full advantage of the features that Microsoft Excel offers when you work with IBM Cognos
Analytics data, you can convert an Exploration View to a Custom Report or drag items directly to the cells
of a worksheet.

Using Custom Reports
When you use the cells of the worksheet to create a new analysis, you drag labels and items to adjoining
cells, either in rows or columns to create a Custom Report. Like Exploration Views, the intersecting cells
are used for measures, which will be populated with the actual data.

Note: Cell-based analysis is available for dimensionally modeled relational (DMR) and OLAP data sources
only. It does not work with relational data sources and cannot be generated from a list even when using
DMR or OLAP packages.

You can also convert an Exploration View to a Custom Report. You can create an Exploration View by using
the exploration toolbar and the drop zones and then convert it to formulas. For an example using both
methods, see “Example - evaluate revenue from specific order methods” on page 272.

Formulas
With IBM Cognos Analytics packages, when you drag items from the source tree directly to the cells of a
worksheet you create a COGNAME or COGVAL formula. The formula references the item in the database.
Because IBM Planning Analytics for Microsoft Excel uses COGNAME and COGVAL as part of its internal
processing, do not use either of these strings to name any part of a worksheet or in any part of a cell
formula.

COGNAME formulas
COGNAME formulas are used to supply the server, package, and member names to the cells of a
worksheet. The COGNAME formula takes three objects: server, package, and member unique name (MUN).

Depending on your server version and type of cube, in addition to the system and package, you may have
other information, such as the date of the last cube update available to you.

The syntax for the COGNAME formula is as follows:

=COGNAME("server", "package", "MUN")

The arguments in the formula are described as follows.

server
The server object can reference a cell, such as B4, use a named range, or use a literal value with the
full path to a gateway, such as http://sampleserver/ibmcognos/cgi-bin/cognos.cgi. It can also
reference a COGNAME formula that contains the server information.

package
The package object is derived from the package search path, which you can find in IBM Cognos
Connection. Because this argument is a literal string, you can embed this information. Or, you can put
this information in a cell and reference that cell in the argument. This enables you to switch over from
a test system to a production system or to change your package easily. It can also reference a
COGNAME formula that contains the package information you want to use.

member unique name
The member unique name supplies information about a particular name you want to display in your
workbook, such as Years. You can obtain this information from IBM Cognos Report Studio by right-
clicking an object and recording the string, which includes schema.

The following is a sample COGNAME formula from the IBM Cognos sample database

=COGNAME("http://sampleserver/ibmcognos/cgi-bin/cognos.cgi", "/content/
package[@name='Great Outdoors Company']", "[great_outdoors_company].[Years].
[Years].[Years]->:[PC].[@MEMBER].[Years]")
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COGVAL formulas
COGVAL formulas are used to supply data to the cells of a worksheet. The COGVAL formula takes three
objects: server, package, and member unique names of members or measures (MUNs(X)).

The syntax for the COGVAL formula is as follows:

=COGNAME("server", "package", MUN1,MUN2,MUN3,MUNx)

The arguments in the COGVAL formula are the same as in the COGNAME formulas.

The following is a sample COGVAL formula from the IBM Cognos sample database

=COGVAL("http://sampleserver/ibmcognos/cgi-bin/cognos.cgi", "/content/
package[@name='Great Outdoors Company']", $A2, C$1, $A$1 )

In this example, the cell references supply Products, Revenue, and 2004.

The COGVAL formula does not allow members from the same dimension to be supplied more than once.

Create from scratch
You can create a Custom Report without using an Exploration View. This advanced technique is referred to
as cell-based mode. In cell-based mode you drag metadata from the source tree to the cells of the
worksheet.

Because there are no drop zones, you must drag objects in such a way that they appear horizontally or
vertically to form the rows and columns of the worksheet. In general you must start by building the rows
and columns by dragging and dropping headings and then individual or groups of items along the vertical
(for example, in the diagram, cells numbered 1.1, 1.2, 1.3, and 1.4) or horizontal (in the diagram, cells
numbered 2.1 and 2.2) axis. After you have created this framework, you can drag a measure to the
intersecting cell where the row heading and column heading meet (in the diagram, the cell numbered 3).

Figure 14. Drop zones for cell-based analysis

You can continue to modify the worksheet by editing formulas and applying formatting. By default, data is
updated when you edit a formula. To edit formulas without data updates, right-click the worksheet and
select IBM Planning Analytics > Pause formula resolution. Placeholder symbols (~ ~) appear in data
cells when Pause formula resolution is selected. When you are ready to show data, right-click the
worksheet and select √ > Run formula resolution.

Some of the techniques that you need to remember when working in cell-based mode include the
following:

• Leaving blank rows or columns when you create a cell-based analysis disconnects one part of the
exploration from another. This leaves cells without data. Only insert a blank row or column after you
have created your analysis and initially populated the cells with data. You are then able to insert a single
blank row or column for calculations or formatting purposes. Inserting more than one blank row or
column disconnects cells when expanding items.
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• To change the orientation of items, from vertical to horizontal, while dragging the items, hold down the
Ctrl key while dropping items into cells.

Before you can create a cell-based analysis, the administrator must have created a package in IBM
Cognos Framework Manager and published it to a location in the IBM Cognos Connection portal to which
you have access. For full access to IBM Planning Analytics for Microsoft Excel, you should be a member of
the Express Authors or Report Administrators role in IBM Cognos Analytics. An administrator must
configure these privileges using IBM Cognos Administration.

For more information on using cell-based mode, see “Example - using cell-based analysis to create an
Exploration View of order method revenue” on page 228.

Example - using cell-based analysis to create an Exploration View of order
method revenue
You are a business analyst at the Sample Outdoors Company, which sells sporting equipment. You are
asked to analyze the consequences of discontinuing the fax and mail order methods, which are expensive
to process.

First you get the items you need and insert them into an Exploration View for further exploration.

Before you can try this example, you must set up the sample packages that come with IBM Cognos
Analytics. For more information, see the IBM Cognos Analytics Administration and Security Guide.

Procedure
1. Start Planning Analytics for Microsoft Excel
2. In the IBM Planning Analytics, click Open .
3. Select the Great Outdoors Company package and click OK.

Data from the Great Outdoors Company package appears in the source tree.
4. Expand the Retailer level.
5. From the list of retailers, click Department Store and then Shift+click Warehouse Store.
6. In a new worksheet, drag the highlighted items to cell D5.

While dragging the items hold down the Ctrl key to reorient the list of items horizontally.
7. Drag the Order Method item to cell C6.
8. Right-click cell C6, click IBM Planning Analytics > Expand > Expand up.

The Order Method total item shifts down to cell C13. The cells before Order Method populate with
the components that make up Order Method in the hierarchy.

9. Drag Revenue from the Measures folder to cell C5.

The worksheet is populated with the revenue data.
10. Apply Excel formats to the cells to reflect column and row headings, total fields, and revenue

numbers.
11. Click File and Save.
12. In the Name box, type Order Methods Revenue.
13. Save the workbook.

Expand items
Expand items to add component members to the Custom Report from hierarchical items that have been
placed in the cells of the worksheet.

For an example of using this feature, see “Example - using cell-based analysis to create an Exploration
View of order method revenue” on page 228.
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Procedure
1. Right-click the heading cell that contains the item you want to expand, and click IBM Planning

Analytics > Expand.
2. Choose whether to expand before or after.

• To expand items before a row, which puts the node item after the expanded items, click Expand Up.
• To expand items after a row, which puts the node item before the expanded items, click Expand

Down.
• To expand items before a column, which puts the node item after the expanded items, click Expand

Left.
• To expand items after a column, which puts the node item before the expanded items, click Expand

Right.

Results
Expanded items appear in the rows or columns of the worksheet. Cells are automatically shifted to
accommodate the component values.

Drill down
Use the drill down feature to analyze details in a separate drill window.

Procedure
1. Right-click a data cell and click IBM Planning Analytics > Drill Down.

The result of the drill appears in a separate drill down window.
2. Click OK.

Tip: Alternatively, you can create a new Exploration View that displays the drill results. In the Custom
Report, right-click a data cell and click IBM Planning Analytics > Explore.

Display the data source or package of a formula
When working in Dynamic Reports and Custom Reports, you can use more than one data source or
package. You can synchronize the source tree when moving from cells of one data source or package to
another. Synchronizing the source tree enables you to see accurately the dimensional data used to
populate the cells.

Right-click a formula cell and click IBM Planning Analytics > Display Package. The Task Pane displays
the package or data source that was used to create the selected cell.

Change the server and package used by a Custom Report
Update the server and package designation in a worksheet to switch from a test to a production
environment or to access information from a different set of financial data, such as a submission. You can
update information in cell references and in embedded text.

Procedure
1. From the worksheet you want to update, open the new server and package.
2. From the Information folder, drag the updated server and package metadata to the server or package

cell.
3. Optionally, use the Microsoft Excel search and replace function to update embedded references in the

text of cell formulas.
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Troubleshoot
A problem with Custom Reports occurs when you have one or more COGVALs or COGNAMEs that do not
return a result (usually because of a bad reference to a COGNAME with a MUN that does not exist). This
can cause not only the incorrect item to fail, but also items that were retrieved in the same batch.

To resolve COGVAL and COGNAME errors, from the IBM Planning Analytics tab on the ribbon, click
Refresh Sheet. The MUN that is causing any errors becomes a text cell and any cells that use that MUN in
a calculation display #ERROR. Use the Microsoft Excel trace feature to locate the bad MUN. Then you can
correct the MUN by dragging a new item from the source tree to the cell.

Best practices
The main benefit of working in IBM Planning Analytics for Microsoft Excel in cell-based mode is that the
features of Microsoft Excel become more readily available to you during your analysis. You are able to use
features, such as formatting, sorting, and creating formulas using individual cells. This section describes
some of the ways that IBM Planning Analytics for Microsoft Excel interacts with frequently-used Microsoft
Excel features and functions.

Creating a chart
Charts update with new data as long as the data is after the current first cell and before the current last
cell.

Cutting and pasting
Copy and paste from the cell, so that other cells that refer to it are updated to point to the new location.

Copying
To copy the exact formula without changing its cell references, copy from the formula bar, not the cell.

Creating formulas
Consider labeling measure and dimension cells so that you can refer to them by name rather than cell
location.

If you are building a multisheet report with shared filters, such as date, consider creating a single page
with the filters and referring to those shared filters from each sheet.

Prompted metadata in IBM Cognos Analytics packages
Prompts help you to find the information that you need. It is a way for you to define the scope and limit
large amounts of data. You can change the behavior of prompts in IBM Planning Analytics for Microsoft
Excel by modifying the definition of dimensions or query subjects in the model or other data source.

IBM Planning Analytics for Microsoft Excel uses prompts that are saved in the model or other data source.
Prompting is useful for query items, such as ProductTypeCode, whose values are not shown in a report
but can be used for filtering data. For these variables, use IBM Cognos Framework Manager to define
type-in prompts. The Prompt Info properties in Framework Manager give you the ability to control default
filtering and prompting. The properties are used by IBM Planning Analytics for Microsoft Excel to create a
filter expression and set the use and display items in a prompt and prompt query.

If you expand an item in the source tree that contains a prompt, input for that item is requested before
the item can be added to the work area. Depending on the type of prompt, you generally need to provide a
response. If it is a prompt with a default, you must accept the default before dragging the item into the
Exploration View, list, or cells of the workbook. Prompt values persist in the report and are saved as part
of the query for future use.
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Note: IBM Planning Analytics for Microsoft Excel does not support prompt info settings from Framework
Manager.

Set options for IBM Cognos Analytics data

System optimization with large data sets
For lists based on IBM Cognos Analytics packages, Planning Analytics for Microsoft Excel can retrieve
large data sets in CSV format. This enables Planning Analytics for Microsoft Excel to retrieve these data
sets much faster than the standard fully formatted XML results. The CSV request format removes data
formatting from the model.

Control data compression for data
Automatic data compression is one way that Planning Analytics for Microsoft Excel decreases processing
time for large data transfers from the IBM Cognos Analytics server.

Data compression should be turned on under normal circumstances.

Although compression is turned on by default, you can turn it off by setting the UseGzipCompression
property to false in the CommManagerSettings.xml file. By default, the file is located in the Office
Connection directory, C:\Documents and Settings\[user name]\Local Settings
\Application Data\Cognos\Office Connection or C:\Users\[user name]\AppData\Local
\Cognos\Office Connection.

Turn compression off if you need to run tests or perform troubleshooting. To turn compression off, set the
following attribute:

<setting name="UseGzipCompression">False</setting>

To turn compression on, set the following attribute:

<setting name="UseGzipCompression">True</setting>

Compression is turned on automatically when you change from RawXML format to CSV format for lists.
The global property is not changed, which means that if you turned compression off, that setting is
retained for other types of data transfer.

For example, if you have compression turned off and you create a new exploration after making a CSV list
request, then your exploration data is still uncompressed.
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Chapter 9. Cube Viewer
You can work with data using the Cube Viewer rather than the Microsoft Excel grid. You can compare
multiple cube views alongside reports.

You can also generate reports from a cube view. See “Create a report” on page 240 for more information.

You can also follow along by watching this video: https://youtu.be/3NB3qacenN4

Procedure
1. Log on to a TM1 system and select a data source.

For more information, see “Open a model or package ” on page 39.
The source tree in the task pane displays the cube and related items of the data source, such as views.

2. In the source tree, navigate to the cube that you want to view, and expand Views.
3. Right-click a view and select Open in viewer.

A separate Cube Viewer opens. You can position it where you want in the window so that you can view
it along side other objects.

Data entry
You can enter data by typing in editable cells.

Cells that are grayed out and have data in italics in them, are read only. Cells can be read-only if you are a
viewer, or if the version that you are looking at is locked.

To enter dates, tap in a date cell and select the date.

Some cells have picklists that you can select from. The following image shows a picklist where you can
select a performance rating of Good, Average, or Poor.
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Aggregated data is shown in bold. If you type data into an aggregated cell, the data is spread to the cells
that make up the aggregated cells.

Calculated cells at detail level are colored green. You can't directly update calculated cells by typing data
in them.

Note: If all of the descendent detail cells are calculated, then you can't type data into the aggregated cell.

The following describes the areas that are referenced in the previous image:

1. Data can be entered in the Division row and in the 2016 column.
2. Aggregate data is bold. You can type data here.
3. Calculated cells are shaded green. You can't type data into calculated cells.

Symbols in cells, such as currency and percentages
In cells that expect numbers, you cannot enter a symbol. For example, in a cell that expects currency in
dollars, you enter the dollar amount in numbers, for example, for $10, enter 10.

If a cell is formatted as a percent %, the value is displayed as a proportion of 1. To enter 5%, you can
either type 5% or type 0.05. Both display as 0.05.

Preventing data from changing when data is spread
You can place a hold on a cell if you want to keep the value from changing when data is spread. Right-click
the cell, then select Hold and Release > Hold. You can still edit the cell directly. Two vertical bars indicate
that a hold is active on a cell.

When you place a hold on an aggregated cell, the aggregated value remains constant when you change
any of the children. When a hold is in place and you change the value of a child, proportional spreading is
automatically applied to the remaining children so that the consolidated value remains unchanged.

To remove holds, right-click any cell, then select Hold and release > Release all holds. You can also
right-click a cell with an active hold, then select Hold and release > Release hold to release a specific
hold.

Zeroing data
You can replace data in a book view with zeros by going to a detail cell in the upper right corner and typing
0>|. This copies 0 across rows (>) and columns (|).
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Change the font size
You can change the font size in the Cube Viewer to see more data.

If you're working with large dimensions or sets, you can change the font size of the Cube Viewer to display
more data. Use the Zoom in and Zoom out buttons in the toolbar of the Cube Viewer to change the font
size.

Data display
You can change the position of dimensions in the Cube Viewer.

Dimensions can appear in several positions: on the row axis, on the column axis, or as context.

Procedure
1. To swap the position of dimensions in a cube, drop one dimension directly on top of another

dimension.

2. To swap the position of the row and column dimensions, click  .
3. To have two or more dimensions on a row, column, or the context area, drop one dimension next to

another dimension.
4. Dimensions that are used as context can be visible in the view or can be placed on the bench to save

space and to simplify the appearance of the view.

Sort rows and columns
You can sort labels or values in ascending or descending order. You can choose to sort by hierarchy, or to
sort breaking the hierarchy.
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Procedure

1. To sort by label, right-click either the row selector , or the column

selector , and select the sort option.
2. To sort by value, right-click in the row or column and select the sort option.
3. To sort values within a hierarchy, right-click on the hierarchy label, select Sort hierarchical, then

choose your option.

Show and hide totals
You can show and hide totals in a view, and choose whether totals are leading or trailing.

Procedure

Right-click either the row  selector, or the column  selector, and
select one of the Show totals options.

Suppress zeros
You can hide rows and columns in a view that contain only zeros.

Procedure

Click  and choose either rows or columns.

Expand levels
You can expand levels in a hierarchy to a specific depth.

You can expand levels manually by tapping , or by selecting a specific level from the menu.

Procedure
1. To select a specific level to expand from the menu, right-click the member in the row or column that

you want to expand.
A member that can be expanded has this icon: .

2. Select Expand to level, then select the level.

Display cell values as percentages
You can change the way values are displayed so that values are displayed as percentages of the total.

Procedure
1. Right-click in a cell, and select Show cell value as.
2. Select the appropriate option from one of the following:
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% row total

Displays all the values in each row as a percentage of the total for the row.

% column total

Displays all the values in each column as a percentage of the total for the column.

% grand total

Displays values as a percentage of the total of all the values or data points in the report.

Advanced - % parent row total
Displays the values in each row as a percentage of the parent.

Advanced - % parent column total
Displays the values in each column as a percentage of the parent

The cells that display a percentage are shaded. This shading indicates that the values in these cells are
calculated.

3. To return to the actual cell values, in the Show cell value window, select As-is.

Drill up or down on members
You can drill down on a consolidated member in a view to view the members of the consolidation and to
hide other members by double-clicking on the member.

Procedure
1. To drill up to next level, right-click and select Drill up.
2. To remove the drills, right-click and select View all.

Hide rows and columns
You can hide rows and columns that are not needed in a view.

Procedure
1. Right-click the columns or rows that you want to hide and select Hide.

2. Instead of hiding a member, you can select and right-click rows or columns that you want to keep, and
select Keep. All other rows or columns are hidden.

3. To unhide columns or rows that are hidden, right-click and select Unhide all.

Add a calculation to a view
Member calculations apply to one or more members on either the row or column axis of a view.

About this task
You can create the following calculations with one member selected:

• Rank: ranks the value of the cell, with rank 1 being the highest. This applies to visible numeric values
only.

• Absolute value: the non-negative value of the cell.
• Percentage (%) of total: the value as a percentage of the total.
• Percentage (%) of parent: the value as a percentage of the immediate parent.
• Selected member + (plus), -(minus), / (divided by) or * multiplied by a numeric value (or the reverse)

You can calculate the following calculations with two or more members selected,
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• Average
• Minimum
• Maximum
• Median

With just two members selected, you can create the following calculations:

• Member 1 * member 2
• Member 1 + member 2
• Member 1 - member 2
• Member 1 / member 2
• Member 1 % change member 2
• Member 1 % of member 2

You can reverse the members in calculations by tapping 

Procedure
1. Right-click the row or column label of the member for which you want to create a calculation.

To create a calculation on multiple members, use CTRL+click or SHIFT+click to select the member
labels, and then right-click on one of the selected member labels.

2. Click Calculations, then Create.
3. Optionally, enter a name for the calculation. This is the name that will appear as a row or column label

in your view. If you don't enter a name, a name is assigned.
4. Click the calculation you want to create.
5. If you are creating an arithmetic calculation on a single member, enter the required numeric value.
6. Click OK.

Sandboxes
Sandboxes let you try out different changes to the data before making those changes public to other users
and before committing those changes to the base data. Sandboxes are visible only to you.

Procedure

1. To create a sandbox, click  and tap Create sandbox.
2. Name the sandbox.
3. Choose whether you want to create a sandbox from the base data or to create a copy of an existing

sandbox, and then click OK.

You can now work in the sandbox. You can move between different sandboxes by selecting them from

the drop-down list. 

4. When you are satisfied with the data in a sandbox, and you want to commit it to the base, click 
Commit data.

5. To delete a sandbox, follow these steps.

a) Click .
b) Select Delete sandbox, select the sandbox that you want to remove, and tap Delete.
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Copy and paste
You can paste values from external applications, or from such as Microsoft Excel.

User interface
Support for the right-click user interface varies by browser. Some browsers display cut, copy, and paste
options when you right-click a cell or range of cells; others do not. However, all browsers support
keyboard shortcuts:

• CTRL+x - cut
• CTRL+c - copy
• CTRL+v - paste

Paste behavior
When you paste to a single cell, the contents of the clipboard are pasted with the selected cell as the
initial insertion point, and the paste operation expands to other cells as required.

When you paste to a selected range of cells, and that range is smaller than contents of the clipboard, you
are notified that the paste operation will modify cells beyond the selected range. You have the option of
accepting or canceling the paste operation.

There is a 60,000 cell limit for pasting into the Cube Viewer. If you try to paste more than 60,000 cells an
error will be displayed.

Data spreading
You can use data spreading options to detail cells to distribute numbers in cells in a grid. For example, you
can evenly distribute a value across a range of cells.

You can use data spreading options with copy and paste shortcuts and data entry commands. To find out
more, see “Copy and paste” on page 239 and “Quick data entry commands” on page 241.

By default, the spreading options replace data, but you can specify + or ~ to add or subtract data instead.

Proportionally spread a value
P
Example: P<>100
Proportionally spreads the value 100 to all detail cells on the row of insertion and replaces the
existing cell values.

Equally spread a value
S
Example: S+|^200
Equally spreads the value 200 to all detail cells on the column of insertion, and adds the product of
spreading to the existing cell values

Repeat a value
R
Example: R~<50
Subtracts the value 50 from all detail cells to the left of the insertion point.

Apply a percent change
P%
Example: P%+<>10
Takes 10 percent of the cell values and adds it to the existing cell values across the row.

Populate cells by specifying a start and end value (Straight-line)
SL
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You specify a start and end value, choose the direction of the spread, and the update action.
Example: SL>100:200
Replaces all detail cell values to the right of insertion with a start value of 100 and an end value of
200. Across 5 detail cells, the values would be:
100, 125, 150, 175, 200.

Apply a linear growth percentage
GR
You specify a start value and a growth percentage.
Example: GR |300:25
Applies a 25 % growth percentage to the starting value of 300 and replaces all detail values below the
point of insertion.

Create a report
You can create an Exploration View, Dynamic Report, Quick Report and a Custom Report from a View in
the cube view.

Procedure

1. Open the cube view, and click .
2. Select the kind of report you want to create: Exploration View, Dynamic Report, Quick Report, or

Custom Report.
The report is created in an Excel worksheet.

Multiple hierarchies
IBM TM1 dimensions can include one or more hierarchies. Currently, multiple hierarchies can be
implemented by using TurboIntegrator or Planning Analytics Workspace.

Exploration Views and Quick Reports can display more than one hierarchy in a dimension.

If you are working in an IBM Planning Analytics with Watson data source where multiple hierarchies are
enabled, and are in use, you can do the following tasks in the Cube viewer.

• Remove hierarchies
• Hide a hierarchy control from view and add to the bench.
• Add a new related hierarchy from the same parent dimension to the view
• Replace a hierarchy with a different hierarchy.
• Change the hierarchy in use. For more information on changing hierarchies, see “Change the hierarchy”

on page 73.

Note: Do not create Dynamic Reports, or Custom Reports containing multiple hierarchies, as you will get
errors.

Procedure
1. In the source tree, navigate to the cube that you want to view, and expand Views.
2. Right-click a view and select Open in viewer.
3. In the overview, right-click the dimension member, and select one of these options:

Remove this hierarchy
Remove this hierarchy from the view.

Hide from view
Hide this hierarchy control from the view and add to the bench.
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Add related hierarchy
Adds a new related hierarchy from the same parent dimension to the view. Select the hierarchy
and click Insert.

Replace this hierarchy
Replace this hierarchy with a different hierarchy. Choose the hierarchy that you want to replace it
with.

Quick data entry commands
You can type a data entry command into a cell in a grid.

You can combine most of these commands with the copy and paste commands and with data spreading
techniques. To find out more, see “Copy and paste” on page 239, and “Data spreading” on page 239.

Enter the value in thousands
K
Example: 5K
Enters 5,000

Enter the value in millions
M
Example: 10M
Enters 10,000,000.

Add a number to a cell value
Add, +
Example: Add50
Adds 50 to the cell value.

Subtract a number from the cell value
Subtract, Sub, ~

Important: A minus sign (-) can't be used for subtract because it indicates a negative number.

Example: sub8
Subtracts 8 from the cell value.

Multiply the cell value by a percentage
Percent, Per
Example: per5
Gives 5% of the original cell value

Increase the cell value by a percentage
Increase, Inc
Example: inc10
Increases the cell value by 10%

Decrease the cell value by a percentage
Decrease, Dec
Example: Dec6
Decreases the cell value by 6%

Grow cells by a percentage
Gr
Example:Gr>150:10
Increase the value by 10 percent starting with a value of 150.

Hold the cell value from breakback calculations
Hold, Hol, H, Hc
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Hc holds aggregated cells.
Release held cells

Release, Rel, Rh, Rc
Rc releases aggregated cells.

Release all held cells
RA

Set data refresh options for a view
You can set data refresh options for a view directly from the Cube Viewer. These options determine which
actions in a view will trigger a data refresh.

About this task
Use the following procedure to a set data refresh behavior for a view:

Procedure
1. Open the Cube Viewer.

2. Click the Refresh data icon .
3. Set the data refresh option that you want to apply to the view.

Select After each context change to refresh data after actions that change the structure of the view.
This includes actions such as:

• swapping rows and columns,
• moving hierarchies between rows, columns, context, and the bench, or
• expanding or collapsing members in the rows or columns.

If you clear this option, you must manually refresh data after modifying the structure of a view.

Defer on leaf data change controls whether direct edits in leaf cells trigger a data refresh. When the
option is selected, data is updated when the view is refreshed (either explicitly or by an action that
triggers a refresh), and not when data is changed in leaf cells. Clear this option to refresh view data
whenever a leaf cell is modified. This option is off by default when you create a new view in a book.

Data is always refreshed immediately in a view with any of the following actions:

• data is entered in consolidated cells,
• data is spread in leaf cells,
• data is spread from the Spreading dialog, or
• cells are updated from a date picker.

Save a view from the Cube Viewer
You can use the Cube Viewer to save a view as part of the cube.

About this task
By saving your view as part of the cube, you can open your view in TM1 Web and in IBM Planning Analytics
Workspace.

Procedure
1. Open the Cube Viewer.
2. Make your changes.
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3. Click the Save icon.
4. Provide your view with a name.
5. Optional: Select the Save as private view check box if you want your view to be hidden from other

users.
6. Click OK.
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Chapter 10. Action buttons
You can create action buttons to run processes, navigate between worksheets, and recalculate
worksheets.

Users can access these buttons when working in IBM Planning Analytics for Microsoft Excel or with
websheets in TM1 Web.

You can use an action button to perform any of the following tasks:

• Run a TurboIntegrator process.
• Navigate to another worksheet.
• Run a TurboIntegrator process and then navigate to another worksheet.
• Recalculate a worksheet or rebuild a TM1 Dynamic Report in a worksheet.

For example, suppose that you have a workbook containing many worksheets. The workbook is large and
you want to make it easier to use and to maintain.

You can place action buttons on the first sheet to enable users to navigate quickly to the worksheets
within the book. You can also configure the action buttons to navigate to a worksheet and then recalculate
it.

You can also create a worksheet with action buttons to run the TurboIntegrator processes you use to
maintain the reports in the workbook, for example.

You can also use an action button on a worksheet with a Dynamic Report to rebuild the report.

What action buttons do
When you click an action button, the steps that are performed depend on how the action button was
configured.

When an action button runs a TurboIntegrator process only, IBM Planning Analytics for Microsoft Excel
performs the following steps:

1. If you selected a calculation operation on the Calculate tab, the calculation operation is performed.
2. The TurboIntegrator process is run.
3. The calculation operation that you selected in the Options dialog box for the process is performed.
4. The status message is evaluated and presented.

When an action button navigates to a worksheet only, IBM Planning Analytics for Microsoft Excel performs
the following steps:

1. If you selected a calculation operation on the Calculate tab, the calculation operation is performed.
2. The navigation action begins.
3. Context transfers are set into the target workbook. If you specified mappings in the Advanced Options

dialog box, the mappings are applied.
4. The target sheet is navigated to.
5. The calculation operation that you selected on the Worksheet tab of the Action Button Properties

dialog box is performed on the target worksheet.

When an action button runs a TurboIntegrator process and then navigates to a worksheet, IBM Planning
Analytics for Microsoft Excel performs the following steps:

1. If you selected a calculation operation on the Calculate tab, the calculation operation is performed.
2. The TurboIntegrator process is run.
3. The calculation operation that you selected in the Options dialog box for the process is performed.
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4. The status message is evaluated and presented.
5. The navigation action begins. The target workbook is opened.
6. Context transfers are set into the target workbook. If you specified mappings in the Advanced Options

dialog box, the mappings are applied.
7. The calculation operation that you selected in the Worksheet tab of the Action Button Properties dialog

box is performed on the target worksheet.

When an action button recalculates a worksheet or rebuilds a Dynamic Report only, IBM Planning
Analytics for Microsoft Excel performs the following steps:

1. The calculation operation that you selected in the Calculate tab of the Action Button Properties dialog
box is performed on the worksheet.

Add to a worksheet
You can insert an action button into a worksheet.

Before you begin
You must enable the following Microsoft Excel setting: Trust access to the VBA project object model. This
setting is found in Options, Trust Center Settings, Macro Settings.

About this task
When you insert an action button, you configure the action button and set its appearance properties.

The action buttons that you create are listed in the source tree under Action Buttons.

You can modify an action button. In the source tree, expand Action Buttons. Right-click an action button
and select Edit.

Procedure
1. Go to the worksheet where you want to add the action button.

2. On the IBM Planning Analytics toolbar, click the Action Button .
The Action Button Properties dialog box is displayed.

3. Select the TM1 Server Application folder where your data is located and connect to the server.
a) Select the TM1 Server.

For example, if you want to run a TurboIntegrator process that is stored on a different TM1 server,
select the server.

You can use a cell reference or a named range to retrieve the TM1 server name dynamically. Click
the Use Reference check box and then enter a cell or named-range reference.

To select a cell reference, click  and then specify the cell where the server name is located.

To retrieve the server name by referencing a named range, use the following format:

=NameOfRange 

The named range must point to a single cell that contains text for the server name.
b) If you are not connected to the server that you want to use, click Connect and log in.

4. Click the action that you want the action button to perform.
5. Configure the action button.

For more information, see the following topics:

• “Run a process” on page 247
• “Navigate to another worksheet” on page 248
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• “Run a process and navigate to a worksheet” on page 251
• “Recalculate or rebuild a worksheet” on page 251

6. Set the appearance of the action button. For more information, see “Set the appearance” on page 251.
7. Click OK.

What to do next
Action buttons can be saved in a workbook. If the saved workbook has Protected View enabled, the user
opening the workbook must select the Enable all macros option under File > Options > Trust Center >
Trust Center Settings... > Macro Settings.

Run a process
You can use an action button to run a TurboIntegrator process.

Procedure
1. Create an action button. For more information, see “Add to a worksheet” on page 246.
2. In the Action Button Properties dialog box, click Run a TurboIntegrator Process.

The Process tab is displayed.
3. Select the process that you want to run.

a) To select a process from the server that is displayed in the TM1 Server list, click the Process list
and select a process.

b) To select a process from the current workbook, click the Process list and select Get Process info

from Worksheet. In the Process Name box, enter the process name or click  and specify a
cell reference or a named range.

4. Specify parameters, if any, for the process. The Parameters table shows the available parameters for
the process you selected.

To specify a value for a parameter directly, enter the value in the Value cell and then press Enter.

To use a cell reference or a named range, click the Value cell and then click . Specify the cell
reference or a named range, and then click OK.

5. Click Options. The Options dialog box is displayed.
6. Select the calculation operation that you want to occur after the process runs.

• Automatically Recalculate Sheet - Refreshes the data in the current worksheet.
• Rebuild Sheet - Equivalent to Automatically Recalculate Sheet. Rebuilds the TM1 Dynamic

Report to its original report definition configuration.
• None - Do not recalculation or rebuild the worksheet.

7. Select and type the messages that you want the action button to display.

• Show Success Message - Displays a message after the process runs successfully.
• Show Failure Message - Displays a message if the process does not run successfully.
• Show Confirmation - Displays a confirmation message before the process is run. The user can click

Yes or No.
8. Click OK. The Action Button Properties dialog box is displayed.
9. If you want to recalculate or rebuild the worksheet before the TurboIntegrator process runs, click the

Calculate tab and select an option.
10. Set the appearance of the action button. For more information, see “Set the appearance” on page

251.
11. Click OK.
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Navigate to another worksheet
You can use an action button to navigate to another worksheet in the same workbook, or to a worksheet in
another workbook.

Procedure
1. Create an action button. For more information, see “Add to a worksheet” on page 246.
2. In the Action Button Properties dialog box, click Go to another Worksheet.

The Worksheet tab is displayed.
3. Specify the target workbook.

• To select a workbook on a TM1 server, click TM1 Applications. Click Browse and select the
workbook.

Or, to use a cell reference or a named range for the workbook name, click . The referenced cell
or named range must contain the path to the workbook. Start with the first folder name under
Applications and use a back-slash \ character to separate folders. Do not include the Applications
folder in the path. For example: Planning Sample\Bottom Up Input\Budget Input.

• To select a workbook that is stored on your computer or on the network, click Files. Click Browse
and select the workbook.

Note: If you plan to share your workbook with TM1 Web or IBM Planning Analytics Workspace
users, place the target workbook in a shared network location. The location that you specify must
be accessible by the server where TM1 Web or IBM Planning Analytics Workspace is running.

4. Specify the target worksheet.
You can use any of the following techniques.

• Click the Sheet list and select a worksheet.
• Enter the worksheet name in the Sheet field. Use the following format: =SheetName!Cell

• Use a cell reference or a named range, click . Specify the cell reference or a named range, and
then click OK.

5. Set the following options.

• Match Title Elements - Automatically matches and sets the text of the title dimensions in the
target worksheet when a user clicks the action button. For more information, see “Match Title
Elements option” on page 250.

• Replace Current Workbook - Determines whether the target worksheet opens in a new window or
in the same window, replacing the source worksheet. For more information, see “Replace Current
Workbook option” on page 250.

6. Select the calculation operation that you want performed on the target worksheet.

• Automatically Recalculate Sheet - Refreshes the data in the current worksheet.
• Rebuild Sheet - Equivalent to Automatically Recalculate Sheet. Rebuilds the TM1 Dynamic

Report to its original report definition configuration.
• None - Do not recalculation or rebuild the worksheet.

7. To map items, click Advanced Options.
For more information, see “Map fields” on page 249.

8. If you want to recalculate or rebuild the worksheet before navigating to the target worksheet, click
the Calculate tab and select an option.

9. Set the appearance of the action button. For more information, see “Set the appearance” on page
251.

10. Click OK.
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Map fields
When you create an action button that navigates to another worksheet, you can manually map fields
between the source worksheet and the target worksheet. You can map dimensions, cells, and values from
the source worksheet to the target worksheet.

Note: Manual mapping is applied after any automatic mapping has been applied by the Match Title
Elements option.

To map fields, click Advanced Options on the Worksheet tab in the Action Button Properties dialog box.

The Advanced Options dialog box includes a grid where you define the mapping of fields between the
source and target worksheets. Use the Add and Delete buttons to manage the rows in the grid.

You map the source worksheet to the target worksheet by setting values for the source type, source
object, target type, and target object in the Advanced Mapping grid.

Use the following steps to configure advanced mapping:

1. Indicate the type of object to map by setting the Source Type.
2. Determine the value for the type of object you are using by setting the Source Object.
3. Indicate the type of cell to map by setting the Target Type.
4. Indicate where to insert the value from the source object by setting the Target Object.
5. Repeat these steps to create more mapping configurations.

Source Type
The Source Type field represents the type of object for the value you want to map.

• SUBNM - Indicates that you are mapping from a cell that contains a title dimension in the source
worksheet.

• Selected DBRW - Indicates that you are mapping from a cell that contains a DBRW formula in the
source worksheet.

• Value - Indicates that you will enter a string or numeric value to send to the target worksheet.

Source Object
The Source Object field takes a value, or a Microsoft Excel expression that evaluates to a value,
depending on what you selected in the Source Type field.

• If Source Type is set to SUBNM, specify the name of the title dimension that exists in the source
worksheet.

• If Source Type is set to Selected DBRW, specify the name of a row or column title dimension that
exists in the source worksheet.

• If Source Type is set to Value, enter a string or numeric value to send to the target worksheet.

Note: You can also retrieve these values from the source worksheet by using a cell reference or a
named range.

Target Type
The Target Type field specifies the type of cell in the target worksheet where the value from the
Source Object field will be inserted.

• SUBNM - Indicates that the target is a title dimension in the target worksheet.
• Named Range - Indicates that the target is a named range in the target worksheet.
• Range - Indicates that the target location is a cell in the target worksheet.

Note: If you set Target Type to either Named Range or Range, any pre-existing data or formula in the
target cell will be overwritten when you click the action button. If the target cell contains a DBRW
function, then the function will be lost and the cell will not be able to connect to, read from, or write to
the IBM TM1 server.
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Target Object
The Target Object specifies the location in the target worksheet where the value from the source
object will be inserted. This location can be the name of a title dimension, a specific cell location, or a
named range in the target worksheet, depending on what you selected for Target Type.

• If Target Type is set to SUBNM, specify the name of the title dimension in the target worksheet.
When Target Type is set to SUBNM, you must also enter a value for the Subset and Alias fields.

• If Target Type is set to Named Range, specify the name of the range in the target worksheet.
• If Target Type is set to Range, specify the cell location in the target worksheet.

You can enter a value for the target object by entering the location value directly. Or, you can use a cell
reference or a named range to retrieve the location.

• Entering a value directly: To identify a location in the target worksheet, enter the value directly into
the Target Object field without the equal sign =. For example, enter C3 to identify the location of the
target object as the cell C3 of the target worksheet.

• Using a cell reference or a named range: To reference a cell in the source worksheet that contains a
location for the target object, include the equal sign =. For example, the cell A1 in the source
worksheet might contain the value C3 to represent the cell location for the target object in the target
worksheet.

Match Title Elements option
The Match Title Elements option automatically matches and sets the text of the title dimensions in the
target worksheet when a user clicks an action button to navigate to the target worksheet.

The Match Title Elements option is displayed on the Worksheet tab of the Action Button Properties dialog
box.

When the Match Title Elements option is enabled, the dimensions in the source and target worksheets
are automatically matched by the SUBNM and DBRW functions as follows:

• TM1 automatically matches title dimensions in the source and target worksheets based on the SUBNM
formula in a cell.

For example, when the same dimension exists in both the source and target worksheets, the member
selected in the source worksheet is set for the same dimension in the target worksheet. When a column
is selected in the source worksheet, it matches to the column with the same title dimensions in the
target worksheet.

• TM1 automatically matches the row and column dimensions of the currently selected DBRW cell in the
source worksheet to the matching title dimensions in the target worksheet, if they exist.

For example, if Operating Expense and Feb-2015 are the row and column dimension members for the
currently selected member in the source worksheet, when navigating, these dimension members are
matched to the title dimensions in the target worksheet. If the row Operating Expense and the column
Feb-2015 are both selected in the source worksheet, the DBRW cell is the cell that exists in both the
Operating Expense row and the Feb-2015 column. The row and column dimensions of the DBRW cell
are matched to title dimensions in the target worksheet.

Replace Current Workbook option
The Replace Current Workbook option determines whether the target worksheet is opened in a new
window or in the same window, replacing the source worksheet.

The Replace Current Workbook option is displayed on the Worksheet tab of the Action Button Properties
dialog box.

For example:

• If Replace Current Workbook is not selected (default) and you are working in TM1 Web, then the
source worksheet remains open and the target worksheet opens in a new tab.
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• If Replace Current Workbook is selected and you are working in TM1 Web, then the source worksheet
is replaced by the target worksheet on the same tab and a new tab does not open.

Important: If you enable the Replace Current Workbook option, remember to save your workbook
before you test the new button. You could lose your changes if you click the button and cause the current
workbook to close.

Run a process and navigate to a worksheet
You can configure an action button to run a TurboIntegrator process and then navigate to another
worksheet.

Procedure
1. Create an action button. For more information, see “Add to a worksheet” on page 246.
2. In the Action Button Properties dialog box, click Run a Process, then go to another Worksheet.

The Process tab is displayed.
3. Select the process that the action button will run. See “Run a process” on page 247.
4. Select the worksheet to which the action button will navigate. See “Navigate to another worksheet” on

page 248.
5. Set the appearance of the action button. For more information, see “Set the appearance” on page 251.
6. Click OK.

Recalculate or rebuild a worksheet
You can use an action button to recalculate or rebuild a worksheet, without running a TurboIntegrator
process or navigating to a new worksheet. You can also use the Calculate tab to select the calculation
operation that you want the action button to perform before running a TurboIntegrator process or
navigating to another worksheet.

Procedure
1. Create an action button. For more information, see “Add to a worksheet” on page 246.
2. In the Action Button Properties dialog box, click Calculate/Rebuild Only.

The Calculate tab is displayed.
3. Select the calculation option that you want to use.

• Automatically Recalculate Sheet - Refreshes the data in the current worksheet.

Note: The Automatically Recalculate Sheet option does not refreshExploration Views or Quick
Reports.

• Rebuild Sheet - Equivalent to Automatically Recalculate Sheet and also rebuilds the TM1 Dynamic
Report to its original report definition configuration.

• None - Do not recalculate or rebuild the worksheet.
4. Set the appearance of the action button. For more information, see “Set the appearance” on page 251.
5. Click OK.

Set the appearance
You can set the appearance of action buttons. You can set the caption, background picture, and other
visual features for the action button.

In the Action Button Properties dialog box, click the Appearance tab to adjust the appearance of the
button.

The Appearance tab has the following options:

• Caption - Sets the caption text that displays on the button.
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Tip: Use a single space character if you want to have a blank caption. Leaving the caption empty may
result in the action button caption appearing as "Run" when opened in other applications.

• Resize Button to Caption – Adjusts the size of the button to fit the caption.
• Font - Displays a font dialog box where you can change the font type and size of the button caption.
• Show Background Image - Use this option to select a background image for the button. Click Browse

to select an image file (bmp, gif, or jpg format). The image will be stretched to fit the size of the button.
• Display as Hyperlink - When enabled, this option displays the button as a hyperlink with blue,

underlined text instead of as a standard button. This option is not available if Show Background Image
is selected.

• Preview - This area shows an example of what the button will look like.
• Colors - Use these options to set text and background colors for the button. Click the color sample to

display a Color dialog box where you can select a standard color or define a custom color. If you select
Display as Hyperlink, the color options do not apply.

Edit, copy, rename, or delete
You can modify, copy, rename, or delete an action button.

Modifying, copying, or deleting an action button is easy and can be performed from the task pane. Start by
showing your available action buttons.

1. Ensure that the task pane is open.
2. Click the Workbook tab.
3. Expand Action buttons.

Modify
To modify an action button, right-click the action button in the source tree and select Edit.

Copy
To copy an action button, drag and drop the action button from the source tree onto the worksheet.

Note: Action buttons cannot be copied to another workbook. Copying an action button will not copy
the visual formatting of the action button.

Rename
To rename an action button, right-click the action button and type the new name. To refresh the name
in the Action buttons list, right-click Action buttons and then click Refresh list.

Delete
To delete an action button, right-click the action button in the source tree and select Delete.

Locate
To see where an action button is located in a workbook, right-click the action button and select
Select. If you do not see your action button in the source tree, right-click Action buttons and then
click Refresh list.
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Chapter 11. IBM Planning Analytics for Microsoft
Excel API

Using an application programming interface (API), you can automate the refreshing or publishing of
content.

You can use the API to create a scheduled batch program to refresh content on a daily, weekly, or monthly
basis so that, as your period data changes, the affected files are kept up-to-date.

You can call the API within Microsoft Excel workbooks using VBA or using VBS and a command line
interface. For these types of automation to work, you must register one or more macros within the
workbook.

If you have IBM Cognos Office installed, you can also use the API in Microsoft Word and Microsoft
PowerPoint.

When using sample macros and script files as part of your own processing functions, remember that the
API is accessible only as user defined functions (UDFs). UDFs are functions created in Visual Basic for
Applications (VBA). In this case, however, the UDFs are created within the IBM Cognos solution and are
called from VBA.

To help you understand what is possible using this API, several samples are provided. You can use the
samples to help you create your own solutions.

• Creating VBA macros
• Passing parameters, leveraging VBS and the command line interface

In addition to these capabilities, you can schedule scripts, either ones that you create or the samples, to
run as a batch process at a set time.

To use automation, you must set your macro security to an appropriate level in your Microsoft application.
You can set the macro security level using one of the following options depending on your version of
Microsoft Office.

• Change the security level of your Microsoft application to medium or low.
• Change the trusted publishers setting of your Microsoft application so that installed add-ins or

templates are trusted.

Planning Analytics for Microsoft Excel API documentation
Visit https://ibm.github.io/paxapi/ to see the documentation for the Planning Analytics for Microsoft
Excel API.

Report issues
Any issues or errors related to the Planning Analytics for Microsoft Excel API documentation can be
reported in GitHub (https://github.com/IBM/paxapi/issues).
To report any issues or errors related to Planning Analytics for Microsoft Excel API features or
functionality, use the IBM Planning Analytics Community (https://community.ibm.com/community/
user/businessanalytics/communities/community-home?CommunityKey=8fde0600-e22b-4178-acf5-
bf4eda43146b).
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Chapter 12. Tutorials, examples and exercises
Improve your IBM Planning Analytics for Microsoft Excel skills and knowledge with tutorials, examples,
and exercises.

Tutorials
Getting started in Planning Analytics for Microsoft Excel is easy. Going through these tutorials will help
you make sense of the features that are offered in Planning Analytics for Microsoft Excel and how you
might use them in your work.

In this tutorial, you are a new hire and you're just starting your job as a business analyst at an automotive
company. Your position requires you to analyze existing data, edit reports and create new reports by using
Planning Analytics for Microsoft Excel. You are familiar with Microsoft Excel, but you never used Planning
Analytics for Microsoft Excel before and have little data modeling knowledge. This series of tutorials will
guide you through the basics of Planning Analytics for Microsoft Excel and help to on your way to
becoming a star business analyst.

Get started
You sit down at your desk with your morning coffee. You're the new business analyst. Excited to make a
good first impression, you immediately turn on your computer and open Microsoft Excel; the emails from
Mom can wait. The user interface is familiar but there's a new tab. Let's get started.

Procedure
1. Open Microsoft Excel.
2. Click the IBM Planning Analytics tab.

The Planning Analytics for Microsoft Excel ribbon displays commands for starting Planning Analytics
for Microsoft Excel, logging on to IBM TM1 systems, setting options, opening reports that are
published to an IBM TM1 server, and so on. Report-specific sections might appear here as well when
you're working in them.

What to do next
It is difficult to analyze data and create reports when you have no data to analyze. Continue by adding a
system with data sources to connect to.
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Add a system
To get started with Planning Analytics for Microsoft Excel, you need to add a system and connect to a data
source. The data source is where the data you'll be importing to analyze will come from.

Procedure
1. Click Connect.

2. Click New Connection .

Unless a data source was already configured by your administrator, you need to add a data source
before you can connect to one.

3. Define the Datasource type , the Connection URL, and a Friendly name to help you easily remember
what your data sources are for.

If you're not sure of the Datasource type and Connection URL, ask your administrator.
4. Click Test connection .

This step ensures that the connection to the data source is accurate and live.
5. Click Save .

Connect to a data source
Now that you have your connection set up, it's time to connect to a data source.

Procedure
1. Click Connect.

2. Hover your cursor over the connection.
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3. Click SDataHierarchies.

4. Log in to the data source by using your credentials.

Results
You are now connected to a data source and the IBM task pane is opened on the right of the screen.

The IBM task pane opens when you connect to a data source in Planning Analytics for Microsoft Excel.
You can change the position of the IBM task pane by clicking near the top of the task pane and dragging it
to another area on the screen.
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The IBM task pane is where your workbooks are organized and where you can find a tree for all of your
views, cubes, dimensions, measures, and members. If you're unfamiliar with these terms, watch this
video on the basics to modeling and modeling concepts: https://youtu.be/5GOjioIcs8g

First assignment: Create and customize an Exploration View

You receive an email from your manager. It's your first assignment!
Hi,
Welcome to the team! As you know, this company sells vehicles world-wide. We are currently 
reviewing our sales for 2014. 
Please send a report that shows the following:
- Only sales for convertibles and sedans
- Only sales in Europe
- Only the actuals
- The quarters in the columns
- Data from 2014
You can find the data you need in the SDataHierarchies data source.
Regards,
Your manager

Now that you have your assignment, it's time to get to work.

Views

Check for existing views
You have your first assignment. Your manager asked you to check for a report that analyzes sales in 2014.
Start by checking whether such a view already exists.

Procedure
1. The top of the IBM task pane contains two tabs; SDataHierarchies and Workbook. Click the

Workbook tab.
The Workbook tab shows all of the Dynamic reports, Action buttons, Explorations, and Quick reports
that you have in your workbook. As you can see, no reports are currently in your workbook. No
problem, you can create one yourself.

2. Click the SDataHierarchies tab.

That's a lot of content. The cube icon  indicates that the item is a cube, and the dimension icon 
indicates that the item is a dimension. Notice that there's a cube that is named "WorldSales". That
looks like it might have what you need.
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What to do next
Impress your manager by creating an Exploration View from the 2014F view.

Create a new view

Procedure
1. Expand WorldSales.

Notice that there's a new type of icon. This icon is the views icon . This item contains views that are
in this particular cube. You want to see whether there's already an existing view that has the report
you're looking for.

2. Expand Views.

Another new type of icon! This is the icon for individual views . If you expand an individual view, you
can see the content inside of the view. The 2014F view looks like it's just what you need. Now how do
you create a report from it?

3. Drag 2014F and drop it into the workspace area.
Dragging a view into the workspace area creates a list view.

Results
Congratulations on creating your first list view. List views are good for showing data with little formatting.
List views are good for simple analyzes with simple data. But you didn't get hired for simple reports. And
you sure aren't going to show a list view to your manager as your first report! You're going to re-create this
report as an Exploration View.

Create an Exploration View from an existing view
Exploration views are great for exploring data in a pivot table style format. They're easy to manipulate and
can be changed dynamically.

In the last tutorial, you created a list view. But you want something more powerful. Something that more
closely resembles a pivot table. The Exploration View is perfect for that.

Procedure
1. Under the SDataHierarchies tab, expand WorldSales > Views.

2. Right-click 2014F.
3. Hover your cursor over Exploration view.
4. Click On new sheet.
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Results
An Exploration View is created from the 2014F view.

What to do next
Your Exploration View is great, but it does not meet the requirements from your manager. Next, you will
customize the Exploration View to meet your manager's needs.

Customize Exploration Views
Exploration Views are flexible reports. Exploration Views allow for exploring data in a pivot style format.
Perfect for quickly customizing your Exploration View for the manager.

Have a look at the Exploration View you created from the 2014F view. It is huge. Scroll down the report
and you see that the report contains a number of things that your manager did not ask for: sales for
wagons, the budget, sales for Canada, and so on. A summary of the report's content is presented in the
overview bar below the ribbon:

The rows drop zone  contains sets that are found in the rows of the Exploration View. The columns drop
zone  contains sets that are found in the columns of the Exploration View. The context drop zone 
contains sets that make up the context of the report. From the overview bar, you can edit the sets that are
contained in the Exploration View.

Insert and replace members into a set
Your Exploration Views looks great, but it shows all model types instead of just convertibles and sedans.
Change that now by inserting and replacing members in the model set.

Procedure
1. Right-click the model set in the rows drop zone.
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2. Click Edit Set.

The set editor opens for the model set. You use the set editor to customize which members are
displayed in your Exploration View.

Note: Your manager wants to see data for convertibles and sedans.
3. Input convertible in the search bar and then press enter.

The search results now contains only members with the word convertible in their names.

4. Click Search - (Name Contains convertible)
This member contains every search result member and dynamically updates if the set changes.

5. Click the replace set icon .
The replace set icon replaces the entire current set with the member that you selected from the
available members section.

6. Input sedan in the search bar and then press enter.

The search results now contains only members with the word sedan in their names.
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7. Click Search - (Name Contains sedan)

8. Click the insert icon 
The insert icon inserts the selected members into the current set.

9. Click Apply and close.

Results
Your Exploration View contains only data for convertibles and sedans.

What to do next
Your Exploration View contains data for the actuals and the budget. Your manager wants to see data for
the actuals. In the next tutorial, you will be removing a member from the set editor.

Remove members from a set
Your manager wants to see just the data for the actuals, but your Exploration Views contains both the
actuals and the budget. You need to remove the budget member from the Version set in the set editor.

Procedure
1. Right-click the Version set in the rows drop zone.
2. Click Edit Set.
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3. Right-click Budget under Current Set

4. Click Remove.
5. Click Apply and close.

Results
Your Exploration View contains only data for the actuals.

What to do next
Your Exploration Views looks good, but you still need to show only Europe. In the next tutorial, you will be
expanding a set to show specific levels in a set.

Expand levels in a set
Your Exploration Views contains both the actuals and the budget. Remove the budget member from the
Version set in the set editor.

Procedure
1. Right-click the regions set in the rows drop zone.
2. Click Edit Set.

3. Expand the World member under Available Members.
4. Click Europe.

5. Click the replace set icon .
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6. Click Apply and close .
7. Right-click any Europe cells in the workspace.
8. Click IBM Planning Analytics .

9. Click Expand / Collapse .

Results
Your Exploration View shows data for only the Europe member with the member expanded.

What to do next
Your Exploration Views is almost complete. Next, add quarters to the columns.

Use the drop zones
Your Exploration Views is almost complete. Add the quarters for 2014 to the columns.

Procedure
1. Drag the Time set from the context drop zone into the columns drop zone.
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2. Right-click the Time set.
3. Click Edit Set.
4. Expand 2014 from the Available Members section.
5. Select 2014 - Q1, 2014 - Q2, 2014 - Q3, 2014 - Q4.

6. Click the replace set icon .

7. Click Apply and close .

Results
Your Exploration View contains the quarters for 2014 in the columns.

What to do next
Your Exploration View is complete. Time to share it with your manager.

Share your work

About this task
Now that you have your first report created, it is time to share it with your manager. You can either save
the workbook as an Excel file and send that, or you can publish it to the server you are connected to.

Share your report by publishing it to the server

About this task
Publishing your reports to a server is easy and is a great way to share your analysis with colleagues!

Procedure
1. Click Publish.
2. Select a TM1 connection.
3. Select a TM1 Server Application folder.
4. Select a folder.
5. Type a name for the workbook.
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6. Select Make public
7. Click Publish.

Results
Your workbook is ready to be viewed by your manager and colleagues. They can view the workbook and
contribute to it as well.

Automate your work by using the IBM Planning Analytics for Microsoft Excel
API

You're a few weeks into your new job, using Planning Analytics for Microsoft Excel and you're noticing that
you're creating countless reports and repeating the same multi-step tasks over and over. Fortunately,
Planning Analytics for Microsoft Excel features an IBM Cognos automation API, which helps users
automate many of their tasks.

You log onto you computer and notice an email from your boss:
Hello,
Good work on the 2014 sales report! I now need you to create some reports for me.
Every year we send out a report to the sales, marketing, and engineering departments.
Can you create a report based on the Goal Input view for each of these departments?
You can find the Goal Input view in the plan_BudgetPlan cube, located inside of the Planning 
Sample server.
Thanks,
Your manager.

This is the perfect time to use the IBM Cognos automation API. Let's get started.

Setting up for the API
Before you can use the IBM Cognos automation API, you need to add a reference, which connects to IBM
Cognos automation. You need to open the Visual Basic Editor, add a reference to IBM Cognos
automation, and then access the IBM Cognos automation API.

About this task
https://youtu.be/IiGv_1tnIn4

Adjusting the Trust Center settings
Some settings in the Microsoft Excel Trust Center may need to be adjusted in order to use the IBM
Cognos automation API.

Procedure
1. Open a new Microsoft Excel workbook.
2. Click File > Options > Trust Center > Trust Center Settings... > Macro Settings.
3. Select Enable all macros and enable Trust access to the VBA project object model.
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4. Click OK

Results
Your Trust Center settings are now optimized for the IBM Cognos automation API.

Note: Remain on the Options dialog as you'll need it for the next step.

Opening the Visual Basic Editor
IBM Cognos automation and the IBM Cognos automation API functions are called by using macros in VBA.
The following steps show you how you can open the Visual Basic Editor and start by using VBA macros.

Procedure
1. From the Options dialog box, click Customize Ribbon.
2. If it is not already, select the check box for the Developer tab, in the Main Tabs pane.
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3. Click OK.
A new tab titled DEVELOPER is shown in the Microsoft Excel ribbon.

4. Click DEVELOPER > Visual Basics.

Results
The Visual Basic Editor opens.

Adding a reference to IBM Cognos automation and accessing the IBM Cognos
automation API
Now that you have the Visual Basic Editor open, you can establish a reference to IBM Cognos automation
and access the IBM Cognos automation API.

Procedure
1. Right-click VBAProject and then click Import File....

268  IBM Planning Analytics: Planning Analytics for Microsoft Excel



2. Browse to the IBM Planning Analytics for Microsoft Excel installation directory.
3. Browse to the /Automation folder.
4. Highlight CognosOfficeAutomationExample.bas and click Open.

5. Repeat steps 1-3.
6. Highlight CognosOfficeMessageSuppressor.cls and click Open.
7. Close the Visual Basic Editor.
8. Save the workbook as an Excel Macro-Enabled Template.

What to do next
Add IBM Cognos automation API functions to automate your tasks.
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Add and execute IBM Cognos automation API functions
Now that you have set up your environment for the IBM Cognos automation API, it's time to add and
execute some API functions.

About this task
https://youtu.be/wYELTlAEqts

Double-check the references to the IBM Cognos automation API
You might run into some trouble if you're missing some references to the IBM Cognos automation API.
Let's double check those first.

Procedure
1. Open the template file that you created in the last tutorial.
2. Log into the Planning Sample server. This is the server/datasource which contains the view that you'll

be creating multiple Exploration Views from.
3. Click the DEVELOPER tab.
4. Click Visual Basic.
5. Double-click CognosOfficeAutomationExample.bas in the Project pane to open it.
6. Check for the following:

a) m_oCOAutomation is defined as an object.
b) m_oCAFE is defined as an object.
c) There is a Property Get statement for CognosOfficeAutomationObject().
d) There is a Property Get statement for Reporting().

7. If you have all of the above in your CognosOfficeAutomationExample.bas, you can start adding your
own API functions. If you're missing one or more items, head over to https://ibm.github.io/paxapi/
#necessary-ibm-cognos-automation-api-references and supplement the file with what you're missing.
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Add your own API functions
You will choose different API functions depending on the tasks that you need to automate. Fortunately,
there are plenty to choose from.

Procedure
1. Right-click inside of the Project pane, click Insert > Module. This new module is where you will be

adding your own API functions.
2. Go to Chapter 11, “IBM Planning Analytics for Microsoft Excel API,” on page 253. This is where you can

find IBM Cognos automation API functions.
3. Click Exploration API functions.
4. Click Create. This Create API function allows you to generate Exploration Views from a combination

of host system URL, server name, cube name, and view name.
5. Copy the example that is in this topic.
6. Paste the example into the new module. You may have to adjust the formatting.
7. Replace the example host system URL with the one that you are using.
8. Replace Goal Input with Budget Input Total.

9. Save the template.

Results
You have just added your first API function! Next you'll be executing this API function.

Execute your API functions
Now that you have your API function added, it's time to execute them.

Procedure
1. Click the DEVELOPER tab.
2. Click Macros.
3. Click Create.
4. Click Run.
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Results
Congratulations! You have just automated creating an Exploration View from a view. Create two more
Exploration Views for a total of three. In each Exploration View, change the department to sales,
marketing, or engineering. Once you have one of each, go ahead and send those reports out to your
manager. Task accomplished (and mostly automated).

Examples and use cases
Using IBM Planning Analytics for Microsoft Excel you can create an Exploration View. Use Exploration
Views to show information in a more compact form than in a grouped list. For example, create an
Exploration View to show total sales by product line generated by each sales representative.

Like list reports, Exploration Views are reports that show data in rows and columns. However, the values
at the intersection points of rows and columns show summarized information rather than detailed
information.

You can also create list reports from relational data sources.

Example - evaluate revenue from specific order methods
You are a business analyst at the Sample Outdoors Company, which sells sporting equipment. You are
asked to analyze the consequences of discontinuing the fax and mail order methods, which are expensive
to process.

First you get the items you need and insert them into an Exploration View for further exploration.

Before you can try this example, you must have access to the sample packages that come with IBM
Cognos Analytics. For more information, see the IBM Cognos Analytics Administration and Security Guide.

Procedure
1. In Microsoft Excel, click the IBM Planning Analytics tab.
2. To connect to the IBM Cognos Analytics system to access the sample package, click Connect and

select the server.
3. Select the Sales and Marketing package and click OK.
4. Expand the Order Method folder.
5. Press Ctrl and click Fax and Mail.
6. With Fax and Mail selected, right-click Mail and click New Set.
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7. In the Selection on Dimension dialog box, click Save  and save the set using the default name,
Order method.

8. On the IBM Planning Analytics tab, click Exploration.
9. Expand the Custom Sets folder and drag the Order method set to the Rows area in the Exploration

View.
10. Expand the Sales measures folder and drag Revenue to the Measure area in the Exploration View.
11. Drag Retailers to the Columns area in the Exploration View.
12. Expand the Time folder and drag Time beside the order methods to nest years in the rows.

Results
You now have the data required to analyze if revenues for the fax and mail order methods are growing or
declining over time.

Figure 15. Exploration View

Example - create a list report
In this topic, you will use the GO Data Warehouse model. It contains data about human resources, sales
and marketing, and finance, grouped into business areas.

You will learn how to

• create a list report

The report shows revenue for each product for the last quarter of the current year.
• group items in the list report

You group data items in a list report to remove duplicate values. For example, you have a report that
shows products purchased. For each product, the product type is also shown. You group the Product
type column to show only one instance of each product type in the list.
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Procedure
1. Open the GO Data Warehouse (query) package.
2. On the IBM Planning Analytics, click List.
3. Expand Sales and Marketing (query), Sales (query) and then drag items to the worksheet to create

the report.

You can also add an item to the report by selecting the item, opening the item's context menu, and
selecting Add to columns.

• Expand Products and drag Product type to the drop zone.
• Expand Time dimension, and drag Quarter beside Product type.
• Expand Sales orders, and drag Order number beside Quarter.
• Expand Product, and drag Product name beside Order number.
• Expand Sales fact, and drag Quantity beside Product name.
• From Sales fact, drag Unit cost beside Quantity.

4. Create the calculation Quantity * Unit price.
5. Rename the calculation to Revenue.
6. Group the Product type column and then group the Quarter column.

Results
Your report will look like the following:

Figure 16. List report

If you need more help, see the following:

• “Exploration Views and lists” on page 99
• Nest rows or columns
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Try it yourself exercises
If you have some experience with IBM Planning Analytics for Microsoft Excel and want to improve your
skills in creating workbooks, this chapter is for you. Each topic gives you some guidelines on how to create
each sample worksheet. If you need help, links to more detailed instructions are available. Answers can
be found in the sample workbooks.

Before you can try these exercises, the sample packages must be set up on the IBM Cognos Analytics and
IBM TM1 systems. You access the sample workbooks from installation location of the IBM Cognos
Analytics samples. Sample workbooks are available from [samples_installation_location]
\webcontent\samples\datasources\ workbooks\performance_management
\business_intelligence.

Contact your administrator for the location of the samples installation.

Create an Exploration View that uses an indirect filter to update data and
charts

When you are working with a time dimension, you can use a cell reference to control a series of reports for
a specific year. In this topic, you learn how to create a dynamic report that retrieves year-to-date revenue
for each product line.

It should take 15-20 minutes to complete this topic. To view the completed report, download the
IndirectFilter.xls sample workbook.

Procedure
1. Begin by creating an Exploration View that uses the sample package named Great Outdoor Sales

(cube).
2. Add the following data items to the Exploration View:

• Products level (in Products) to the Rows drop zone
• Revenue, Gross Profit, Quantity sold, Unit cost, and Profit margin% (in Measures) to the Columns

drop zone
• Americas (in Sales Regions) and 2012 (in Years) to the Context drop zone

3. On the IBM Planning Analytics tab, click Convert to > Custom Report > On New Sheet .
4. From the original Exploration View, change the retailer by dropping a different retailer in the Context

drop zone and then convert it to formulas on a new sheet.

Complete this step for each retailer.
5. Using your knowledge of Microsoft Excel, chart Revenue, Gross profit, and Quantity for each of the

newly created worksheets.
6. To create an indirect filter, on a separate worksheet, drag 2012 (in Years) to a cell.

Tip: In an adjacent cell, label the cell with Select the Date Here.
7. For each of the worksheets you created, change the year in the Context cell to reference the filter cell

you created in step 6.

For example, for a worksheet named Filters with the filter in cell C3, type =Filters!C3.
8. From the source tree, drag 2013 (in Years) to the cell where you placed 2012.

Notice that the cell references are updated throughout the workbook and the charts reflect the 2013
data.
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Analyze data in an Exploration View
In IBM Planning Analytics for Microsoft Excel, you can manipulate items in your data interactively so that
you can identify and understand the problems and issues in your business.

In this topic, you learn how to create an Exploration View and use Excel's Moving Average analysis tool for
charting and reviewing the IBM Cognos data to help you spot trends and patterns that may warrant
further attention. To use this feature, you must have the Excel Analysis Toolpak installed on your
computer.

For this exercise, you are a business analyst for the Sample Outdoors Company. You want to further
analyze the historical return levels to predict future demand for the eye wear product line, enabling you to
better plan quality controls.

It should take 10 to 15 minutes to complete this topic. To view the completed report, download the
MovingAverage.xls sample workbook.

Procedure
1. To create the report, create a new Exploration View that uses the Sales and Marketing (cube)

package.
2. Insert data in the Exploration View:

• In Measures, drag Returns to the Measure drop zone.
• In Products, Personal Accessories, drag Eyewear to the Rows drop zone.
• In Time, drag Time to the Columns drop zone.

You have now created the report. You must now create an analysis.
3. To create the analysis, from the Tools menu, click Data Analysis.
4. In the Data Analysis dialog box, click Moving Average, and then click OK.
5. In the Input Range box, enter the single row for the Inferno brand eyewear.
6. In the Interval box, enter 2 as the number of data points used to calculate the moving average.

The smaller the interval, the more the moving average is affected by individual data point
fluctuations.

7. In the Output Range box, enter the cell address so that the results start outside the cell range of the
Exploration View.

8. Select the Chart Output check box to see a graph comparing the actual and forecasted return levels,
and then click OK.

9. Set the chart options as follows:

• Add text to the y-axis to show Returns.
• Add text to the x-axis to show Years.
• Change the chart title to indicate that this is a moving average for the Inferno line in eyewear.
• Ensure that the legend keys are shown to the side of the chart.
• Add value labels to the chart.

10. Set the value for the Z-axis scale to 25 as the major unit.

Results
The chart now shows your forecasted return levels and identifies each year's ending returns.

If you need more help, see Creating a New Exploration.

Balance sheet reports
In this topic, you will create a Balance Sheet report that shows assets, liabilities, and equity for the
Sample Outdoors Company in 2013.
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To create this report, you will use a package that was published from MSAS cubes containing financial
data. Use the GO Finance Fact cube derived from the GOSALESDW database. This cube contains year-to-
date and monthly financial data for all accounts. The data is in actual US dollars submissions for 2010,
2011, 2012, or 2013 (7 months actual data only).

You will use a Microsoft Office accounting template, available for download from the Microsoft Web site,
to create the balance sheet. For this exercise, the Balance Sheet with Ratios and Working Capital template
is used.

You will also apply cell-based analysis to populate your balance sheet with IBM Cognos data for Current
Assets, Other Assets, Current Liabilities, and Other Liabilities. In Excel, you will leverage the power of
formatting by applying background color, font styles and characteristics, and cell formatting for a
professional presentation of your report.

It should take 20 to 30 minutes to complete this exercise.

Create the balance sheet
You will create a Balance Sheet report that shows assets, liabilities, and equity for the Sample Outdoors
Company in 2013. You must first create the balance sheet.

To view the completed report, download the BalanceSheet template.xls sample workbook.

Procedure
1. Download the Balance Sheet with Ratios and Working Capital template from the Microsoft Web site:

http://office.microsoft.com/en-us/templates/CT101445641033.aspx (opens in new window)
2. Clear the content in the template, except for the calculated cells and balance sheet categories, such as

Current Assets and Other Liabilities.
3. Insert a line under each balance sheet category.

The line is used to build the rows and columns necessary for dragging and dropping headings and
groups of items along the vertical or horizontal axis.

4. Continue with populating current assets.

Populate current assets
You are creating a Balance Sheet report that shows assets, liabilities, and equity for the Sample Outdoors
Company in 2013. You must now populate current assets.

Procedure
1. Open the GOFinanceFact_EN_MSAS2011 package.
2. From the source tree, expand Accounts, Balance sheet (total), Assets (total).
3. Drag Current assets (total) to the cell after the Current assets category.
4. Right-click Current assets (total), click IBM Planning Analytics, Expand, Expand up.

The cells before Current Assets (total) fill in with the components that make up Current assets (total)
in the hierarchy.

5. From the source tree, expand Time, and then drag 2013 to the column area of the cell-based
framework.

6. From the source tree, expand Measures, and then drag Stmt Year to the measures area where the row
heading and column heading adjoin.

7. Convert the dynamic data to static data.
8. Continue with populating other assets.

Chapter 12. Tutorials, examples and exercises  277

http://office.microsoft.com/en-us/templates/CT101445641033.aspx


Populate other assets
You are creating a Balance Sheet report that shows assets, liabilities, and equity for the Sample Outdoors
Company in 2013. You must now populate other assets.

Procedure
1. From the Source tree, expand Accounts, Balance sheet (total), Assets (total).
2. Drag Other assets (total) to the cell after the Other assets category.
3. Right-click Other assets (total), click IBM Cognos Analysis, Expand, Expand up.

The cells before Other assets (total) populate with the components that make up Other assets (total)
in the hierarchy.

4. From the source tree, expand Time, and then drag 2013 to the column area within your cell-based
framework.

5. From the source tree, expand Measures, and then drag Stmt Year to the measures area where the row
heading and column heading adjoin.

6. Convert the dynamic data to static data.
7. Continue with populating current liabilities.

Populate current liabilities
You are creating a Balance Sheet report that shows assets, liabilities, and equity for the Sample Outdoors
Company in 2013. You must now populate current liabilities.

Procedure
1. From the Source tree, expand Accounts, Balance sheet (total), Liabilities & equities (total),

Liabilities (total).
2. Drag Current Liabilities (total) to the cell after the Current liabilities category.
3. Right-click Current liabilities (total), click IBM Cognos Analysis, Expand, Expand up.

The cells before Current liabilities (total) populate with the components that make up Current
liabilities (total) in the hierarchy.

4. From the source tree, expand Time, and then drag 2013 to the column area within your cell-based
framework.

5. From the source tree, expand Measures, and then drag Stmt Year to the measures area where the row
heading and column heading adjoin.

6. Convert the dynamic data to static data.
7. Continue with populating other liabilities.

Populate other liabilities
You are creating a Balance Sheet report that shows assets, liabilities, and equity for the Sample Outdoors
Company in 2013. You must now populate other liabilities.

Procedure
1. From the Source tree, expand Accounts, Balance sheet (total), Liabilities & equities (total),

Liabilities (total).
2. Drag Long-term and other liabilities (total) to the cell after the Other liabilities category.
3. Right-click Long-term and other liabilities (total), click IBM Cognos Analysis, Expand, Expand up.

The cells before Long-term and other liabilities (total) populate with the components that make up
Long-term and other liabilities (total) in the hierarchy.
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4. From the source tree, expand Time, and then drag 2013 to the column area within your cell-based
framework.

5. From the source tree, expand Measures, and then drag Stmt Year to the measure area where the row
heading and column heading adjoin.

6. Convert the dynamic data to static data.
7. Continue with cleaning up the balance sheet.

Clean up the balance sheet
You have created Balance Sheet report that shows assets, liabilities, and equity for the Sample Outdoors
Company in 2013. Finally, you must now clean it up.

Procedure
1. Under each balance sheet category, remove the row that contains the labels for the dimensions that

were used in the cell-based analysis.
2. Ensure that empty rows are deleted so that the balance sheet maintains its form.
3. After converting the data to static data, the summary items, such as Other assets (total) and Current

liabilities (total), are static values. Remove these rows so that the balance sheet template formulas
calculate the data accurately.

4. In a cell where you would like the heading of the balance sheet, type Great Outdoor Company
Balance Sheet and 2013.

Results
You have used your Excel knowledge to augment IBM Cognos data. If you need more help, see “Create
from scratch” on page 227.

Explorations using filters
When working with dimensional data, you can use context filters to quickly focus your report on a
particular view of the data. You can also use custom filters to refine your view.

In this topic, you will learn how to

• create context filters by dropping members or sets in the context filter area
• create a custom filter by creating an expression that you use to retrieve a specific subset of records

It should take 10-25 minutes to complete this topic. To view the completed report, download the
CustomFilter.xls sample workbook.

The Exploration View contains product lines in the rows, years in the columns, and returns as the
measure. The values are filtered to show returns for only Web orders from the Americas. We use a custom
filter to narrow the focus of this report to show only those product lines that have generated over 5000
returns in 2013.

Create context filters
In this topic, you will learn how to create context filters by dropping members or sets in the context filter
area.

It should take 15 to 20 minutes to complete this topic. To view the completed report, download the
CustomFilter.xls sample workbook.

Procedure
1. Create a new Exploration View that uses the Sales and Marketing (cube) package.
2. Insert data in the Exploration View:

• In Measures, drag Returns to the Measure drop zone.
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• Drag Products to the Rows drop zone.
• In Time, drag Time to the Columns drop zone.

3. Change the label in the Time column to Total.
4. Show all the members in the levels.
5. In Retailers, drag Americas to the Context drop zone.
6. In Order method, drag Web to the Context drop zone.

You see the returns only for the Web in the Americas territory for all the product brands over a four-
year span. The total number of returns is visible in the Total column.

7. Continue with creating custom filters.

Create custom filters
In this topic, you will learn how to create a custom filter by creating an expression that you use to retrieve
a specific subset of records.

Procedure
1. In the Rows drop zone, for Products, click the drop-down menu to select the Filter, Edit/Add filter

option.
2. In the Filter window, create an expression that will show only the product lines that generated more

than 5000 returns in 2013.

Results
If you need more help, see the following:

• Creating a New Exploration View
• Insert and Display All the Items of a Level
• Filter Values Using Context
• Create a Custom Set

Creating a custom filter from a list exploration
Create filters to limit the number of items that display in your exploration sheet.You can reference cells
from your Microsoft Excel workbook as part of your filter expressions.

By following the steps in this tutorial you learn how to:

• Create filters
• Combine filter lines
• Use cell values as part of your filter

This tutorial uses the sample package GO Sales (query).

Use sample relational data to create a complex list exploration with a
calculated column
Create a list exploration with several columns of data and then add a calculated column.

By following the steps in this portion of the tutorial you learn how to:

• Load a specific data package
• Create a complex list exploration
• Add a calculated column to use as part of your analysis
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Start IBM Planning Analytics for Microsoft Excel and open the sample package
To access data, you must start IBM Planning Analytics for Microsoft Excel and then select a data package.
Depending on how your server and data have been set up, you might have to expand several node items
to access the sample data set.

Procedure
1. Start IBM Planning Analytics for Microsoft Excel.
2. From the IBM Planning Analytics tab, click Connect and select the server that has the IBM Cognos

Analytics sample data.
3. From the list of packages, click GO Sales (query) and then click OK.

Create a list exploration with several columns of data from the GO Sales (query)
package
As part of your analysis, you must create a list exploration with product data from the sample sales cube.

Procedure
1. To create a list exploration, on the IBM Planning Analytics tab, click List.
2. In the source tree, expand the Sales (query) folder.
3. Expand the Product item.
4. To create columns, drag the following items to the exploration: Product name, Introduction date,

Unit price, and Unit cost.

Add a calculated column
Create a calculated column to use as part of your analysis.

Procedure
1. Select the Unit price and Unit cost columns.
2. From the exploration bar, click the Insert Calculation icon, and then click Unit price - Unit cost.

The calculated column, Unit price - Unit cost, appears after the Unit cost column.

Add values to the worksheet and create filter expressions
You can use values from the Microsoft Excel worksheet or workbook as part of the filter expression.

In the tutorial, these values are static. In your scenarios, they can be calculated values from other IBM
Planning Analytics for Microsoft Excel exploration sheets or the results of Microsoft Excel cell
calculations.

Add values to the Microsoft Excel worksheet to use in filter calculation
Create minimum and maximum values in the cells of the exploration sheet to use in the filter expression.

Procedure
1. Click cell I4 and type Minimum.

This cell serves as the label for the minimum value you use in the filter calculation.
2. Click cell I5 and type Maximum.

This cell serves as the label for the maximum value you use in the filter calculation.
3. Click cell J4 and type 10.

This cell serves as the minimum value you use in the filter calculation.
4. Click cell J5 and type 15.

This cell serves as the maximum value you use in the filter calculation.
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Create a filter expression based on minimum and maximum values
Create minimum and maximum values in the cells of the exploration sheet to use in the filter expression.

Procedure
1. From the exploration bar, click Filter and then click Edit/Add filter.

The Filter window appears.
2. Click Edit/Add filter.

The Edit Filter window appears.
3. Click Enter a cell reference.
4. In the GO Sales (query) pane, click Unit price - Unit cost.
5. In the operator box, click > (Greater Than).
6. In the cell reference box, which appears after the operator, type J4, and then click OK.

The Edit Filter window closes.
7. Click the Add a Filter Line icon.

The Edit Filter window appears.
8. Click Enter a cell reference.
9. In the GO Sales (query) pane, click Unit price - Unit cost.

10. In the operator box, click <(Less Than).
11. In the cell reference box, which appears after the operator, type J5, and then click OK.

The Edit Filter window closes.
12. Click OK.

Results
You observe that the results of the list exploration change because of the filter expressions you create.
You limit items in the list exploration because of the minimum and maximum values that you control as
static values in the cells of the exploration sheet.

By limiting the data in your exploration, you are better able to focus on key performance indicators. You
can add filter expressions to limit data to specific dates by adding filter lines that use the Introduction
date.

Create an Exploration View using a custom set of members
In this topic, you learn how to create an Exploration View that includes a custom set that you design.

You use custom sets to group members for specific reporting requirements. For example, you want to
focus the results from sales visits in a set of countries from the Asia Pacific region. You create a custom
set that includes the required countries and then add the custom set to a report.

It should take 15 to 20 minutes to complete this topic. To view the completed report, download the
CustomSet.xls sample workbook. The sample workbook has formatting applied in Microsoft Excel and
will not exactly match the worksheet you create.

Before you begin
The sample package must be set up on the IBM Cognos Analytics system. You access the sample
workbooks from the installation location of the IBM Cognos Analytics samples. Contact your administrator
for the URL required to connect to the IBM Cognos Analytics system and the location of the sample
workbooks.

Procedure
1. Connect to the IBM Cognos Analytics system and open the Sales and Marketing (cube) package.
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The default location for the sample package is Public Folders>Samples_Office>Cubes.
2. Create an Exploration View.
3. Ensure that the Insert Member with Children option is enabled.
4. Add the following data items to the report:

• Products to the Rows drop zone
• Time to the Columns drop zone
• Revenue to the Measures drop zone

5. Expand Order Method, and then drag Sales Visit to the Context area.
6. Create a custom set from the Asia Pacific dimension.

Select Japan, Korea, China, and Singapore. Right-click a selected member and click New Set. Save
the set as East Asia.

7. From the Custom Sets folder, drag East Asia to the rows area after Products.

Note that the Exploration View reflects only the retailers in East Asia. That means Australia, which was
an original member of the Asia Pacific dimension, is not a member of the East Asia custom set.

Results
A custom set is associated with the user that creates the custom set. The next time you open the Sales
and Marketing package, the custom set will be available for use in other reports. The custom set is not
available when a different user opens the package.

To edit a custom set, right-click the custom set and click Edit Set. If you edit a custom set, or if there are
changes to the members used in the custom set, the change is not applied to a report when you refresh
data. To update a report, delete the original custom set from the report and then add the changed custom
set.

If you need more help, see the following topics:

• “Create an exploration” on page 203
• “Create and edit sets” on page 137

Create sets in Exploration Views and Quick Reports
Use the set editor to create dynamic expressions that allow you to refresh reports to show the latest data.

The learning objectives for this tutorial are:

• Learn the features of the set editor
• Learn how to create dynamic expressions
• Learn how to use the set editor with Quick Reports

This tutorial uses the sample package plan_BudgetPlan.

Create an Exploration View
Create an Exploration View as part of your budget analysis. Use Exploration Views to show information in
a compact form where intersecting rows and columns show summarized information.

The Exploration View that you create contains data from the Planning Sample model, which contains
budget information. You learn how to create an Exploration View from a chart of accounts with net
operating income.
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Start IBM Planning Analytics for Microsoft Excel and load the sample budget plan
Load the IBM TM1 budget plan so that you can work with it during the tutorial.

Procedure
1. Start IBM Planning Analytics for Microsoft Excel.
2. From the IBM Planning Analytics tab, click Connect and select the server that has the IBM TM1

sample data.
3. From the list of packages, click Planning Sample, and then click OK.

Create a budget Exploration View
Create an Exploration View from the sample budget plan.

Procedure
1. From the IBM Planning Analytics tab, click Exploration.
2. Drag the following items to the Context drop zone from the source tree:

a) Click plan_version > plan_version > Members and then drag the FY 2004 Budget member to the
Context area.

b) Click plan_business_unit > plan_business_unit > Members > 10000 > 10100 and then drag the
10110 member to the Context area.

c) Click plan_department > plan_department > Members > 1000 > 100 and then drag the 105
member to the Context area.

d) Click plan_exchange_rates > plan_exchange_rates > Members and then drag the local member
to the Context area.

e) Click plan_source > plan_source > Members > budget and then drag the input member to the
Context area.

3. Add the year 2004 to the Columns drop zone.
Click plan_time > plan_time > Members and then drag the 2004 member to the Columns drip zone.

4. Add net operating income to the Rows drop zone.
Click plan_chart_of_accounts > plan_chart_of_accounts > Members and then drag the Net
Operating Income member to the Rows drop zone.

Work in the set editor
After you create a basic Exploration View, use the set editor to create a more complex Exploration View by
using more advanced features of the set editor.

Insert the 2004 members dynamically from the set editor
The first example is to make the year, 2004, dynamic and bring in its children.

Procedure
1. From the Columns drop zone, click the drop-down menu that is associated with the 2004 member,

and then click Edit Set.
The set editor opens.

2. In the Selection pane, right-click 2004, and click Insert Options > Insert Member With Children.

3. To inspect the dynamic expression that you created, from the set editor toolbar, click  Show MDX.
The Edit MDX window opens and you can see that the expression displays: {{[plan_time].
[2004],[plan_time].[2004].CHILDREN}}

4. To save the MDX expression and close the Edit MDX window, click OK.
5. To save your work in the set editor and close the set editor window, click OK.
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Replace the Net Operating Income item with its component items from the set editor
window
Work with the plan_chart_of_accounts dimension on the rows axis. Work with the Net Operating Income
item in the set editor.

Procedure
1. From the Rows drop zone, click the drop-down menu that is associated with the Net Operating

Income item, and then click Edit Set.
The subset editor window opens.

2. In the Selection pane, click the Net Operating Income item, and then press the Delete key.
3. In the Available Members pane, expand plan_chart_of_accounts and then expand Net Operating

Income.
You see the three component items, Revenue, COS, and Operating Expense.

4. From the toolbar, click the Insert Type icon, and then click Insert Single Member.
5. Select Revenue, COS, and Operating Expense, and then click the add arrow.

The selected items display in the Selection pane. To select multiple items, press Shift and click the
items.

6. To make the COS item dynamic, right-click the COS item, click Insert Options, and then click Insert
Member With Children.

7. To save your work in the subset editor and close the subset editor window, click OK.
Notice that the item names after the COS item display as account IDs. Use the subset editor again to
change the appearance.

8. From the Rows drop zone, click the drop-down menu that is associated with the Net Operating
Income item, click Set Alias, and then click AccountName.
Notice that the item names after the COS item display as account names instead of account IDs.

Create Quick Reports
Convert the Exploration View to a Quick Report. A Quick Report is useful when you present data or send
workbooks to other team members who do not have IBM Planning Analytics for Microsoft Excel.

You can work with the set editor to add items to a Quick Report.

Convert the Exploration View to a Quick Report
Use the subset editor with Quick Reports to add or remove items on the column or row axis.

You can also use it to create a data validation cell on a context member. While in a Quick Report, you can
add items by typing item names into the cells within the named range or by using the subset editor. To
remove items, you can delete columns or rows by using Microsoft Excel commands or by using the subset
editor. When you use the subset editor with a Quick Report, you can interact with it the same way as with
explorations. The only exception is that any dynamic members are converted to static members after you
exit the editor and apply it to a Quick Report.

Procedure

1. On the Exploration toolbar, click  and click Convert to Quick Report > On New Sheet.
2. Right-click Q1-2010, click IBM Cognos Analysis, and then click Replace Members.

The subset editor opens.
3. From the toolbar, click the Filter icon.

The filter controls and filter box display after the toolbar.
4. In the filter box, type Q1 and press the Enter key.

All the items in the plan_time dimension that contain Q1 display.
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5. In the Search Results pane, click Q1-2011 and then click the Add icon to add these items to the
Selection pane.

6. Click the Insert Type icon and then click Insert Member With Children.
7. Click OK.

After Q1-2010, the Q1-2011 component items display.
8. In cell A3, right-click the 10110 item, click IBM Cognos Analysis, and then click Replace Members.

The subset editor window opens.
9. From the Available Members pane, expand plan_business_unit and then expand the 10000 item.

10. Select 10100, 10200, 10300, and 10400 and then click the add icon to add these members to the
Selection pane.

11. Click OK.
Cell A3 is now a selector.
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Chapter 13. Troubleshoot
Use troubleshooting information as a resource to help you solve specific problems you may encounter
during or after the installation of IBM Planning Analytics for Microsoft Excel.

For more information, see “What are some common errors when installing Planning Analytics for
Microsoft Excel?” on page 291

Troubleshoot a problem
Troubleshooting is a systematic approach to solving a problem. The goal of troubleshooting is to
determine why something does not work as expected and how to resolve the problem.

The first step in the troubleshooting process is to describe the problem completely. Problem descriptions
help you and the IBM technical-support representative know where to start to find the cause of the
problem. This step includes asking yourself basic questions:

• What are the symptoms of the problem?
• Where does the problem occur?
• When does the problem occur?
• Under which conditions does the problem occur?
• Can the problem be reproduced?

The answers to these questions typically lead to a good description of the problem, which can then lead
to a resolution of the problem.

What are the symptoms of the problem?
When starting to describe a problem, the most obvious question is "What is the problem?" This question
might seem straightforward; however, you can break it down into several focused questions that create a
more descriptive picture of the problem. These questions can include:

• Who, or what, is reporting the problem?
• What are the error codes and messages?
• How does the system fail? For example, is the problem a loop, hang, crash, performance degradation, or

incorrect result?

Where does the problem occur?
Determining where the problem originates is not always easy, but it is one of the most important steps in
resolving a problem. Many layers of technology can exist between the reporting and failing components.
Networks, disks, and drivers are only a few of the components to consider when you are investigating
problems.

The following questions help you to isolate the problem layer:

• Is the problem specific to one platform or operating system, or is it common across multiple platforms
or operating systems?

• Is the current environment and configuration supported?

If one layer reports the problem, the problem does not necessarily originate in that layer. Part of
identifying where a problem originates is understanding the environment in which it exists. Take some
time to completely describe the problem environment, including the operating system and version, all
corresponding software and versions, and the hardware. Confirm that you are running within an
environment that is supported; many problems can be traced back to incompatible levels of software that
are not intended to run together or have not been fully tested together.
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When does the problem occur?
Develop a detailed timeline of events leading up to a failure, especially for cases that are one-time
occurrences. You can most easily develop a timeline by working backward: Start at the time an error was
reported (as precisely as possible, even down to the millisecond), and work backward through the
available logs and information. Typically, you need to look only as far as the first suspicious event that you
find in a diagnostic log.

To develop a detailed timeline of events, answer these questions:

• Does the problem happen only at a certain time of day or night?
• How often does the problem happen?
• What sequence of events leads up to the time that the problem is reported?
• Does the problem happen after an environment change, such as an upgrade or an installation of

software or hardware?

Under which conditions does the problem occur?
Knowing which systems and applications are running at the time that a problem occurs is an important
part of troubleshooting. These questions about your environment can help you to identify the cause of the
problem:

• Does the problem always occur when the same task is being performed?
• Does a certain sequence of events need to occur for the problem to occur?
• Do any other applications fail at the same time?

Answering these types of questions can help you explain the environment in which the problem occurs
and correlate any dependencies. Remember that just because multiple problems might have occurred
around the same time, the problems are not necessarily related.

Can the problem be reproduced?
Problems that you can reproduce are often easier to solve. However, problems that you can reproduce can
have a disadvantage. If the problem as a significant business impact, you do not want it to recur. If
possible, re-create the problem in a test or development environment, which typically offers you more
flexibility and control during your investigation. Answer the following questions:

• Can the problem be re-created on a test system?
• Are multiple users or applications encountering the same type of problem?
• Can the problem be re-created by running a single command, a set of commands, or a particular

application?

Get fixes
A product fix might be available to resolve your problem.

Procedure
To find and install fixes:
1. Determine which fix you need by using Fix Central (opens in new window) (http://www.ibm.com/

support/fixcentral/)
2. Download the fix. Open the download document and follow the link in the "Download package"

section.
3. Apply the fix by following the instructions in the "Installation Instructions" section of the download

document.
4. Subscribe to receive weekly email notifications about fixes and other IBM Support information.
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Contact IBM Support
IBM Support provides access to a variety of IBM resources for help with software questions.

Before you begin
After trying to find your answer or solution by using other self-help options such as technotes, you can
contact IBM Support. Before contacting IBM Support, your company must have an active IBM
maintenance contract, and you must be authorized to submit problems to IBM. You should also have the
following information at hand:

• Your customer identification number
• Your service request number, if it is an ongoing service request
• The phone number where you can be reached
• The version of the software you use
• The version of the operating environment you use
• A description of what you were doing when the problem occurred
• The exact wording of any error messages that display
• Any steps you took to attempt to solve the problem

For information about the types of available support, see the Support portfolio topic in the Software
Support Handbook (opens in new window).

Procedure
Complete the following steps to contact IBM Support with a problem:
1. Define the problem, gather background information, and determine the severity of the problem. For

more information, see the Getting IBM support (opens in new window) topic in the Software Support
Handbook.

2. Gather diagnostic information.
3. Submit the problem to IBM Support in one of the following ways:

• Using IBM Support Assistant (ISA): Use this feature to open, update, and view an Electronic Service
Request with IBM. Any data that has been collected can be attached to the service request. This
expedites the analysis and reduces the time to resolution.

• Online through the IBM Support (opens in new window): You can open, update, and view all your
Service Requests from the Service Request portlet on the Service Request page.

• By phone: For the phone number to call, see the Directory of worldwide contacts (opens in new
window) web page.

Results
If the problem that you submit is for a software defect or for missing or inaccurate documentation, IBM
Support creates an Authorized Program Analysis Report (APAR). The APAR describes the problem in
detail. Whenever possible, IBM Support provides a workaround that you can implement until the APAR is
resolved and a fix is delivered. IBM publishes resolved APARs on the IBM Support Web site daily, so that
other users who experience the same problem can benefit from the same resolution.

Exchange information with IBM
To diagnose or identify a problem, you might need to provide IBM Support with data and information from
your system.

In other cases, IBM Support might provide you with tools or utilities to use for problem determination.
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Send information to IBM Support
To reduce the time that it takes to resolve your problem, you can send trace and diagnostic information to
IBM Support.

Procedure
To submit diagnostic information to IBM Support:
1. Open a case. You can use the IBM Support site (opens in new window) to open a new case.
2. Collect the diagnostic data that you need. Diagnostic data helps reduce the time that it takes to resolve

your PMR. You can collect the diagnostic data manually or automatically.
3. Compress the files by using the TRSMAIN or AMATERSE program. Download the free utility from the

IBM web site to the IBM Cognos system and then install the utility using the TSO RECEIVE command.
4. Transfer the files to IBM. You can use one of the following methods to transfer the files to IBM:

• Standard data upload methods: FTP, HTTP
• Secure data upload methods: FTPS, SFTP, HTTPS
• Email

If you are using an IBM Cognos product and you use ServiceLink / IBMLink to submit PMRs, you can
send diagnostic data to IBM Support in an email or by using FTP.

All of these data exchange methods are explained on the IBM Support site (opens in new window).

Receive information from IBM Support
Occasionally an IBM technical-support representative might ask you to download diagnostic tools or
other files. You can use FTP to download these files.

Before you begin
Ensure that your IBM technical-support representative provided you with the preferred server to use for
downloading the files and the exact directory and file names to access.

Procedure
To download files from IBM Support:
1. Use FTP to connect to the site that your IBM technical-support representative provided and log in as
anonymous. Use your email address as the password.

2. Change to the appropriate directory:
a) Change to the /fromibm directory.

cd fromibm

b) Change to the directory that your IBM technical-support representative provided.

cd nameofdirectory

3. Enable binary mode for your session.

binary

4. Use the get command to download the file that your IBM technical-support representative specified.

get filename.extension

5. End your FTP session.

quit
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Subscribe to Support updates
Stay informed about IBM products that you use by subscribing to updates.

About this task
By subscribing to receive updates, you can receive important technical information and updates for
specific Support tools and resources. You can subscribe to updates by using one of two approaches:

My Notifications
With My Notifications, you can subscribe to Support updates for any IBM product. You can specify that
you want to receive daily or weekly email announcements. You can specify what type of information
you want to receive, such as publications, hints and tips, product flashes (also known as alerts),
downloads, and drivers. My Notifications enables you to customize and categorize the products that
you want to be informed about and the delivery methods that best suit your needs.

RSS feed
After you subscribe to a product's notifications, you can view links to the product's RSS/Atom feed.

Procedure
To subscribe to Support updates:
1. Open the IBM Support.
2. Click Go to My Notifications.
3. Find the product that you want to subscribe to in the Product lookup: search box.
4. In the drop down, click Subscribe.
5. Select the document types that you want to receive notifications for.
6. Click Submit.
7. For links to the RSS/Atom feed, click Links .

Results
You're now subscribed to support updates for your product. Until you modify your RSS feeds and My
Notifications preferences, you will continue to receive notifications. You can modify your preferences
when needed (for example, if you stop using one product and begin using another product) from the My
Notifications page.

What are some common errors when installing Planning Analytics
for Microsoft Excel?

This section lists the most common errors that you might encounter.

Configuration Issues
These issues are related to configuration and setup.

Convert to Formulas does not show value
You can create an Exploration View without experiencing an error, but when you convert that exploration
sheet to formulas, cells no longer display values properly. In one of the cells that has no value, you click
the cell and it shows the COGVAL formula, such as =COGVAL($C$1, $C$2, $B10, C$8, $B$8). Attempting
to do this on another workstation you find that values are displayed correctly. If a user with administrative
rights to the workstation attempts to convert to formulas, the values are displayed correctly in the cells of
the worksheet.

The user did not use Microsoft Excel before IBM Planning Analytics for Microsoft Excel was installed and
did not get registered properly. There are two ways to resolve this problem. You can give the affected user
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local administration rights to the workstation or you can run the file Register Cognos XLL.vbs, which will
add the proper registry entries for the new user.

For the Register Cognos XLL.vbs file process to work (both during the installation of the software or when
run separately to add a new user) the Microsoft Excel registry entries must have been created by
Microsoft Excel itself. You must ensure that the user run Microsoft Excel first, before attempting to add
registry entries for IBM Planning Analytics for Microsoft Excel. You can examine the ntuser.dat that the
script writes to check whether the user has been properly added.

Update server and package designations to make a server available
After changing the gateway alias or switching from a test to a production environment you receive the
following error message advising you that the server is not available and that the Cognos gateway is
unable to connect to the IBM Cognos Analytics server.

SERVER_NOT_AVAILABLE: The Cognos gateway is unable to connect to the Cognos Analytics server. The
server may be unavailable or the gateway may not be correctly configured.

This is probably caused by a change in the gateway URI.

Update the server and package designation in a workbook to switch from a test to a production
environment or to access information from a different set of financial data, such as a submission.

Procedure
1. Optionally, you can update information in cell references.

• From the worksheet you want to update, open the new server and package.
• From the Information folder, drag the updated server and package metadata to the server or

package cell.
2. Optionally, you can update information in embedded text.

• Use the Microsoft Excel search and replace function to update embedded references in the text of
cell formulas.

The Cognos Office interface fails to initialize in Microsoft Office
IBM Cognos Office may not initialize when the Microsoft .NET Framework is not installed or the version is
not correct. The required Microsoft .NET Framework version is 4.6.1 or later. Another possible reason for
this condition is that the add-in is either not installed or not registered.

If you are running the wrong version of Microsoft .NET Framework, uninstall it and then reinstall
Microsoft .NET Framework.

To install the IBM Cognos add-in, run the installation program.

Before you attempt to install Microsoft .NET Programmability Support, you must have installed
Microsoft .NET Framework.

Cognos for Microsoft Office Fails to Initialize
If you use Internet Explorer to browse IBM Cognos Analytics and open a workbook, document, or
presentation published by IBM Cognos for Microsoft Office, the document launches in Microsoft Office,
but without full functionality.

To configure Internet Explorer to open Microsoft Office files in Microsoft Office instead of in Internet
Explorer, you must use the Folder Options tool to update browse options. It is also possible to do this in
Windows Registry.

Procedure
1. Open My Computer.
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2. From the Tools menu, click Folder Options.
3. On the File Types tab, under Registered file types, click Microsoft Excel Worksheet, and then click

Advanced.

The Edit File Type dialog box appears.
4. Clear the Browse in same window check box and click OK.
5. Complete the same steps for Microsoft Office PowerPoint presentations and Microsoft Office Word

documents.

Microsoft Office does not open a Microsoft Office document published from
Cognos Office
If you observe Microsoft Office trying to open a published document twice when you double-click the
workbook, document, or presentation from Microsoft Windows Explorer, the file association is either
corrupted or not installed properly.

There are two options to resolve this issue. You can start the Microsoft Office application first, and then
open the document using the Open command from the File menu, or you can reregister the file type.

Re-register file types with a Microsoft Office program
When you are not able to open a Microsoft Office document even though it is associated with the correct
file type, you must re-register the file type with the appropriate Microsoft Office program, such as Excel,
Word, or PowerPoint.

About this task
In these steps, program.exe is a placeholder for the executable file for the Microsoft Office program that
you want to re-register. If you installed Microsoft Office to another location, use the path that is correct for
that location.

Note: If you are using the command line on version 7 of Microsoft Windows operating system, you must
elevate the rights of the command line to perform certain tasks, such as re-registering file types. To open
an elevated command prompt, or a command prompt in Administrator mode, right-click the command
prompt shortcut, and select Run as Administrator.

Procedure
1. From the Start menu, click Run.
2. To disassociate the program version, in the Open box, type the following command, and then click OK:

program.exe/regserver
3. To specify the default version, from the Start menu, click Run.
4. In the Open box, type the following command, and then click OK:

program.exe/regserver

Unable to Open Published Microsoft Office Documents from Cognos
Connection
If the browser does not prompt you to open or save the workbook, document, or presentation, it may
mean that the option to prompt before opening was cleared. Reset this option.

You must enable the File Download and Automatic prompting for file downloads in Internet Explorer.

Confirm opening of documents
The procedure to confirm opening of documents is as follows.

Procedure
1. Start the Windows Control Panel.
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2. Double-click Folder Options.
3. From the File Types tab, in the Registered file types list, click Microsoft Excel Worksheet, and then

click Advanced.
4. Ensure that the Confirm open after download check box is selected and click OK.
5. Repeat steps 3 and 4 for other Microsoft Office documents that are supported in IBM Cognos Office,

such as Microsoft Office Excel Template, Microsoft PowerPoint Presentation, Microsoft Office
PowerPoint Template, Microsoft Word Document, and Microsoft Office Word Template.

6. Click Close.

Reset internet security options
The procedure to reset internet security options is as follows.

Procedure
1. Start Internet Explorer.
2. From the Tools menu, click Internet Options.
3. From the Security tab, click the Web content zone for which you are updating these options, and then

click Custom Level.
4. Scroll down to the Downloads section and click Enable for the File download and Automatic

prompting for file downloads options.
5. Click OK twice.

.NET Messages are not in the installed .NET Framework language
When you install a non-English version of .NET Framework in a non-English operating system, you will
notice that the error messages, .NET shortcut, and .NET Console are in English.

To solve this issue, you must apply the .NET Framework Language Pack for your language.

The subkey numbers relate to the language. For example, English, French, German, and Japanese are
listed here: 1033=en-en, 1036=fr-fr, 1031=de-de, and 1041=ja. Refer to the Microsoft Support Site to
obtain subkey numbers for other languages.

If you are missing the language pack subkeys, you must install the .NET language pack, which is available
from the Microsoft support Web site.

Workbook closes unexpectedly
If you install the COM add-in and your Microsoft Excel workbook name contains a square bracket, Excel
stops responding or closes unexpectedly after opening.

To resolve this problem, rename the workbook so that it does not contain square brackets.

Reports unavailable in Cognos Connection jobs after using Save As command
in Cognos Report Studio
After opening a report in IBM Cognos Report Studio and saving a copy using the Save As command, you
may find that if the report is included in a job, it is not available in the IBM Cognos Connection portal.

Do not use the Save As command in IBM Cognos Report Studio to save changes when a report is included
in a job. Instead, make a copy of the report, make changes to the copy, and then copy the updated report
to the IBM Cognos Connection portal. Use this method to overwrite the report in the job without breaking
the report links.
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The content of the Custom Report shows #NAME?
When building a Custom Report, the content of the cells shows #NAME?

When you drag items from the source tree directly to a cell of a worksheet, you are creating a COGNAME
or COGVAL formula that references the item in the database. This functionality is available only when the
CognosOfficeUDF.Connect automation add-in is loaded.

If #NAME? appears in the contents of the cell, it means that the add-in was not loaded and the
CognosOfficeUDF.Connect check box in the Add-in dialog box (Tools, Add-Ins) is not selected.

To resolve this issue and ensure that the add-in is always properly loaded, you must verify that the value
of the OPEN registry key is set to /A "CognosOfficeUDF.Connect". If you use version 7 of Microsoft
Windows operating system, you must use Run in XP from the command prompt to reregister file types.

Procedure
1. From the Windows Start menu, click Run.
2. In the Open box, type Regedit, and then click OK.
3. In the Registry Editor, go to the Registry branch:

HKEY_CURRENT_USER\SOFTWARE\Microsoft\Office\version\Excel\Options
4. In the topic area, right-click the OPEN entry, and then click Modify.
5. In the Value Data box, type

/A "CognosOfficeUDF.Connect"
6. Click OK, and then close the Registry Editor.

Processing issues
The following issues are related to processing and rendering reports.

Improve performance for TM1 data
If you experience unacceptable performance when you work with TM1 data, the administrator of the TM1
system might be able to change cube or system settings to improve performance. To help the TM1
administrator evaluate the performance issue, provide the administrator with the details of the data you
are using and a description of actions that result in unacceptable performance.

The following are examples of TM1 settings that affect performance.

VMM (}CubeProperties)
For each cube, this property determines the amount of RAM reserved on the server for the storage of
stargate views. The more memory made available for stargate views, the better performance will be.
Sufficient memory must be available for the TM1 server to load all cubes.

VMT (}CubeProperties)
If the time required to calculate a cube view surpasses the specified threshold, TM1 attempts to store
a stargate view. If there is not enough memory available to store the stargate view, TM1 purges the
oldest stargate view that is not currently in use, and continues to purge views in this manner until
sufficient memory is made available.

The IBM Cognos TM1 Operation documentation includes more information about the CubeProperties and
other tuning options.

DPR-ERR-2079 Firewall Security Rejection
If you run a report after your session has expired and then try to navigate away from the first page of the
report, you encounter an error.

DPR-ERR-2079 Firewall Security Rejection. Your request was rejected by the security firewall. CAF
rejection details are available in the log. Please contact your administrator.
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When the DPR-ERR-2079 error occurs after an expired session, you must log on again to resolve the
problem.

Procedure
1. In the report list, right-click the node item, which appears before other items.
2. Click Log On.
3. Provide your authentication credentials as prompted and click OK.

Item cannot be expanded
Microsoft Excel has reached the maximum number of rows or columns for this worksheet. The number of
rows and columns is limited in Microsoft Excel. Expanding the current item is not possible because it
would shift rows or columns beyond this worksheet limit. Microsoft Excel cannot shift nonblank cells off
the worksheet.

Manually move items so that the row or column item can expand without reaching the limit, or move your
Exploration View, list, or report to another worksheet. Or, you can move the data to a new location and try
again.

Results have exceeded the Excel row or column limit
Microsoft Excel has reached the maximum number of rows or columns for this worksheet. The number of
rows and columns is limited in Microsoft Excel. Items are truncated.

Filter items so that the row or column items can be displayed without reaching the limit. Consider creating
additional Exploration Views, lists, or reports to spread the data over more than one worksheet. Consider
using a new version of Microsoft Excel that has larger limits for rows and columns.

Error: Exception from HRESULT:<location>
If you import a data item where the path to the data item exceeds 256 characters it results in the error:
Exception from HRESULT.

You must create names and unique data identifiers that keep to the 256-character limit inside Microsoft
Excel.

Error refreshing exploration saved in earlier version of Microsoft Excel
This workbook may have been created with an older version of Microsoft Excel that has a set maximum
number of rows or columns. Rows or columns that go beyond the maximum limits are truncated.

Although you are no longer using that version, the application is working within the limits of the older
version of Excel. You might encounter this situation when you are expanding items or when you are
refreshing items that have grown in size since the workbook was created.

To correct the problem, you must save the workbook with the .xlsx extension. Opening the workbook that
contains the exploration in a more recent version of Excel does not convert it to the new format. Saving
the workbook with the .xlsx extension converts the workbook to the new format.

Security Issues
The following issues are related to security setup.
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Cognos Office Unable to Create Trust Relationship
If you are using HTTPS to Report Data Service and you receive an error in IBM Cognos Office about being
unable to trust the relationship, the Certificate Authority (CA) certificate that was issued by the Web
server is not trusted on the client workstation.

To resolve this problem, you must ensure that the Certificate Authority (CA) that issued the Web server
certificate is also trusted on the client workstation. If the certificate is not from an authority that is already
trusted on the client, such as Verisign, you must install the CA certificate in the trust store on the client.

Procedure
1. Retrieve the CA certificate from the issuing authority.

The file has a .cer extension. This is not the same certificate as the one used by the Web server. It is
the certificate for the issuing authority itself.

2. Double-click the .cer file, click Install Certificate, and then click Next.
3. Click Place all certificates in the following store.
4. Click Browse, click Trusted Root Certification Authorities, and then click Next.
5. Click Finish.

Requirements for using custom SSL certificates
There are a few requirements for using Planning Analytics for Microsoft Excel with a Planning Analytics
Workspace environment that is set up with a custom SSL or security certificate.

To use Planning Analytics for Microsoft Excel with a Planning Analytics Workspace environment that is set
up with a custom SSL or security certificate, ensure that:

• The version of Planning Analytics Workspace is 2.0.41 or newer.
• The SSL or security certificate is properly configured. For more information about configuring your
certificates, see Configuring TLS for Planning Analytics Workspace Local(https://www.ibm.com/support/
knowledgecenter/SSD29G_2.0.0/com.ibm.swg.ba.cognos.tm1_inst.2.0.0.doc/t_paw_enable_ssl.html).

If your environment does not meet the requirements, you may see the following serialization error:

System.Runtime.Serialization.SerializationException: Type 
'Cognos.Office.Tm1.Connections.Tm1WebException' in Assembly 'TM1.Common, Version=11.0.40.11, 
Culture=neutral, PublicKeyToken=d6e6d7d808b7e5b7' is not marked as serializable.

Unable to View Reports After Clicking View Report
IBM Cognos for Microsoft Office is functioning normally, but you cannot use the View Report option to
view reports. The client machine, running IBM Cognos for Microsoft Office, cannot connect to the gateway
URL as configured in IBM Cognos Analytics. This may be because it is behind a firewall, the
hostname/DNS is not known to this client machine, or the client machine has proxy issues.

To resolve the connectivity issues, work with your system administrator.

Cognos Office Numbered Error Messages
The following error messages may appear in a dialog box and are recorded in the IBM Cognos Office log.

COI-ERR-2002 Block type is not valid
An internal processing error occurred. The block object was not able to be processed.

Contact IBM Cognos Resource Center. Be ready to supply all relevant logs and details related to this error.
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COI-ERR-2003 Unexpected type: stacked block
An internal processing error occurred. The data object was not of the expected type and could not be
processed.

Contact IBM Cognos Resource Center. Be ready to supply all relevant logs and details related to this error.

COI-ERR-2005 This version of Microsoft Office is not supported
IBM Cognos Office supports only specific versions of Microsoft Office applications.

Load the report content into one of the supported applications and environments.

To review an up-to-date list of environments supported by IBM Cognos Office products, including
operating systems, patches, browsers, web servers, directory servers, database servers, and application
servers, go to the IBM Support Portal for IBM Cognos Analysis for Microsoft Excel or the IBM Support
Portal for IBM Cognos for Microsoft Office.

COI-ERR-2006 This Microsoft Office product is not supported
IBM Cognos Office supports only specific Microsoft Office applications, such as Microsoft Excel, Microsoft
Word, and Microsoft PowerPoint. You cannot load IBM Cognos Office content to another Microsoft Office
application, such as Microsoft Access even when there is an add-in that enables these applications to
interoperate.

Load the report content into one of the supported applications and environments.

To review an up-to-date list of environments supported by IBM Cognos Office products, including
operating systems, patches, browsers, web servers, directory servers, database servers, and application
servers, go to the IBM Support Portal for IBM Cognos Analysis for Microsoft Excel or the IBM Support
Portal for IBM Cognos for Microsoft Office.

COI-ERR-2008 Unable to Retrieve from Resources. Tried '{0}'
An internal processing error occurred.

Contact IBM Cognos Resource Center. Be ready to supply all relevant logs and details related to this error.

COI-ERR-2009 Unable to Perform This Operation Because Microsoft Excel is
in Edit Mode
Report content cannot be refreshed while one of the cells of the workbook is being edited.

Click outside the active cell to return it to a non-edit mode and try again.

COI-ERR-2010 The name {0} is not valid. A name must not contain both a
quote (") character and an apostrophe (') character
When you create a folder, rename a folder, or publish a document, the name can contain an apostrophe or
a quote, but not both.

To resolve this problem, rename the folder or document. Exclude the apostrophe or quote character from
the name.

COI-ERR-2011 The server did not return the expected response. Check that
the gateway is valid.
This error message is displayed if the value entered in the System Gateway URI box of the Options dialog
box is not a valid IBM Cognos Analytics server.

To resolve this problem, reenter the System Gateway URI with the gateway address for a valid IBM
Cognos Analytics server.
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COI-ERR-2013 Unable to load metadata
You may be unable to load metadata because you do not have security rights to all of the items in the
worksheet or because the items were removed or changed on the server.

Ensure that you have security rights to all of the items that you are trying to view. If this does not fix the
problem, ensure that the server and package information are correct and that any items that have been
removed from the source database are also removed from the worksheet.

COI-ERR-2015 There was a problem parsing the MIME encoded server
response. Tried to find the boundary [{0}] but found the boundary [{1}]
instead
While using GZip compression, an option for compressing data that is retrieved from the server, an error
occurred. The codes to decompress the data are missing or unrecognized by IBM Cognos Office.

Turn compression off. Although compression is turned on by default, it can be turned off by setting the
UseGzipCompression property to false in the CommManagerSettings.xml file, which, by default, is located
in the Office Connection directory, such as C:\Documents and Settings\user name\Local Settings
\Application Data\Cognos\Office Connection or C:\Users\user name\AppData\Local\Cognos\Office
Connection.

Turn compression off if you need to run tests or perform troubleshooting.

To turn gzip compression off set the following attribute:

<setting name="UseGzipCompression">False</setting>

COI-ERR-2016 Worksheet protected, IBM Cognos styles cannot be populated
If the worksheet is protected, the IBM Cognos styles cannot be applied.

You must unprotect the worksheet for the styles to be applied during a refresh of the data.

COI-ERR-2019 Connection failed
In Planning Analytics for Microsoft Excel, when you try to connect to a IBM Planning Analytics with
Watson server, the following error message appears:

COI-ERR-2019 Connection failed. Connection returned an error. Verify that the connection string,
including the server name and port number, is correct.

To resolve this issue, you must configure your antivirus software to allow connections from both
Microsoft .NET Runtime and Microsoft Excel.

COI-ERR-2305 Unable to perform this operation because Microsoft Excel is in
edit mode
Report content cannot be refreshed while one of the cells of the workbook is being edited.

Click outside the active cell to return it to a non-edit mode and try again.

COI-ERR-2307 Login failed
Your user name and password are not correct.

Ensure that you typed a valid user name and password.

IBM Planning Analytics for Microsoft Excel numbered error messages
The following error messages may appear in a dialog box and are recorded in the IBM Cognos Office log.
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COR-ERR-2004 Axis specification is not valid
The workbook specification is not capable of being generated because of an anomaly.

To fix the problem, you may attempt to do any of the following:

• Click Undo.
• Click Clear All Data.
• Close the workbook and open it again.

The workbook should now accept data from the source tree.

COR-ERR-2007 Error retrieving from resources. Tried '{0}'
The exploration sheet experienced a bad state.

Contact IBM Cognos Resource Center.

COR-ERR-2009 Name formula is not valid
The COGNAME formula did not parse correctly. It may have been altered manually and may have a
missing argument.

Check the COGNAME formula in the active cell and ensure that it is in the correct format, or optionally,
insert the member from the source tree.

COR-ERR-2010 Formula is not valid
If an argument to a COGNAME or COGVAL formula references a cell and that cell does not contain the
expected string formula you receive this error.

Check the cell and its dependents. Look for #REF or #VALUE in the cell. The contents of the cell may have
accidentally been deleted.

COR-ERR-2011 Invalid range: Please enter a valid range for crosstab or list
The range is not valid or is outside of the range of the data type.

To avoid this limitation, limit your data selections.

COR-ERR-2013 Exploration cannot be converted to formula based because at
least one context item contains a selection
With more than one item in the Context drop zone there is no way for the multiple items to be rendered
into the cells of the worksheet.

Remove one dimension from the Context drop zone. You must have one item per dimension to convert to
a formula-based analysis.

COR-ERR-2014 Due to Excel worksheet limitations the results may be
truncated
If the data that you receive back exceeds the row or column limits of Microsoft Excel, the result is
truncated. You receive this message to make you aware of the truncation.

To avoid this limitation, limit your data selections.

COR-ERR-2015 The current exploration cannot be rendered at this location on
the worksheet
The exploration cannot write data outside the limits of the current worksheet. Either the exploration is too
large for Microsoft Excel or you have designated a starting location too close to the limit.
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Try to move your start location. If that fails to fix the problem, try creating an Exploration View with fewer
rows or columns.

COR-ERR-2016 Unable to retrieve package <Name>
After you selected a package using the Open Package dialog box, an error occurred when trying to
download the package from the server.

This is an internal error.

Contact IBM Cognos Resource Center.

ValueNotInPickList (243)
The value you are trying to commit is not an available option in the picklist.

When entering a value into a report cell, ensure that the value is an available option in the picklist.

Microsoft Excel limits
There are specifications and limits in Microsoft Excel 2013-2016 that may affect the performance of
Planning Analytics for Microsoft Excel.

The following tables group the specifications and limits into categories:

• Worksheet and workbook
• Calculation

Table 20. Specifications and limits that apply to worksheets and workbooks

Specification Maximum limit / restrictions Notes

Column width 255 characters If the data that you enter or receive
exceeds the column limits of
Microsoft Excel, the result is
truncated.

Row height 409 points If the data that you enter or receive
exceeds the row limits of Microsoft
Excel, the result is truncated.

Total number of characters that a
cell can contain

32,767 characters If the data that you enter or receive
exceeds the cell character limits of
Microsoft Excel, the result is
truncated.

Maximum limits of memory storage
and file size for Data Model
workbooks

32-bit environment is subject to 2
gigabytes (GB) of virtual address
space, shared by Excel, the
workbook, and add-ins that run in
the same process. A data model’s
share of the address space might
run up to 500 – 700 megabytes
(MB), but could be less if other data
models and add-ins are loaded.

64-bit environment imposes no
hard limits on file size. Workbook
size is limited only by available
memory and system resources.

Due to the limitations with add-ins,
users can only copy and paste once
on top of a DBRW formula.

Adding tables to the Data Model
increases the file size. If you don’t
plan to create complex Data Model
relationships using many data
sources and data types in your
workbook, uncheck the Add this
data to the Data Model box when
you import or create tables, pivot
tables, or data connections.
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Table 21. Specifications and limits that apply to calculations

Specification Maximum limit / restrictions Notes

Length of formula contents 8,192 characters If the formula that you enter
exceeds the formula content limit
of Microsoft Excel, the result is
truncated.

Internal length of formula 16,384 bytes If the formula that you enter
exceeds the internal length of
formula limit of Microsoft Excel, the
result is truncated.
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Appendix A. Sample reports and packages
The IBM Cognos for Microsoft Office products include sample reports and packages that are based on the
sample company, The Sample Outdoors Company. After the samples are set up, you can find the samples
in Public Folders in IBM Cognos Connection, and in the source tree on the IBM Cognos pane.

The Sample Outdoors Company
The Sample Outdoors Company samples illustrate product features and technical and business best
practices.

You can also use them for experimenting with and sharing report design techniques and for
troubleshooting. As you use the samples, you can connect to features in the product.

The Sample Outdoors Company, or GO Sales, or any variation of the Sample Outdoors name, is the name
of a fictitious business operation whose sample data is used to develop sample applications for IBM and
IBM customers. Its fictitious records include sample data for sales transactions, product distribution,
finance, and human resources. Any resemblance to actual names, addresses, contact numbers, or
transaction values, is coincidental. Unauthorized duplication is prohibited.

Samples outline
The samples consist of the following:

• Two databases that contain all corporate data, and the related sample models for query and analysis
• Sample cubes and the related models
• A metrics data source including associated metrics and a strategy map for the consolidated company,

and a model for Metric extracts.
• Reports, queries, query templates, and workspaces

To run interactive reports, scripts are required. To see all the reports included in the samples packages,
copy the files from the samples content installation into deployment folder and then import the
deployments into IBM Cognos Analytics.

Security
Samples are available to all users.

To implement security, see the IBM Cognos Analytics Administration and Security guide.

The Sample Outdoors Group of Companies
To make designing examples faster, especially financial examples, some general information about The
Sample Outdoors Company is useful.

To look for samples that use particular product features, see the individual sample descriptions in this
section.

Revenue for The Sample Outdoors Company comes from corporate stores and from franchise operations.
The revenues are consolidated from the wholly-owned subsidiaries. There are six distinct organizations,
each with its own departments and sales branches. Five of these are regionally-based companies.

The sixth company, GO Accessories:

• Has its own collection of products, differentiated from the other GO companies by brand, name, price,
color and size.

• Sells from a single branch to all regions and retailers.
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• Functions both as an operating company based in Geneva, and as a part owner of the three GO
subsidiaries in Europe.

The following diagram illustrates the consolidated corporate structure of the Sample Outdoors Company.
The diagram also includes the percentage changes in ownership for GO Central Europe, and the reporting
currency and GL (general ledger) prefix for each subsidiary. In year 1, GO Asia Pacific owns 60% of GO
Central Europe, and in year 3, its ownership decreases to 50%. In year 1, GO Accessories owns 40% of
GO Central Europe, and in year 3 its ownership increases to 50%.

Figure 17. Consolidated corporate structure of the Sample Outdoors Company

Each corporation in the Sample Outdoors Company has the same departmental structure and the same
general ledger (GL) structure, as shown in the following table. Divisions may not report in the same
currencies. For example, the Americas subsidiary reports in US dollars, but the Corporate division local
currency reports in Canadian dollars, and the Operations division local currency is pesos.

Table 22. Departmental structure

Division (GL) Department (GL)

Corporate (1700) Sales (1720)

Marketing (1750)

IS&T (1760)

Human Resources (1730)

Finance (1740)

Procurement (1710)

Operations (1800) Production and Distribution (1820)

Customer Service (1820)
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Each corporation has a complete chart of accounts. Most of the accounts, such as those under non-
personnel expenses, are at the department level, and contain only summary amounts. For example,
although each marketing department has expenses, the cost is unspecified at the transaction level where
marketing promotions occur.

Employees
The Sample Outdoors data contains a full list of employees in all divisions, departments, and locations.

Data is available for reports about bonuses (Global Bonus report) and sales commissions (Sales
Commissions for Central Europe report), training (Employee Training by Year report), and performance
reviews and employee satisfaction surveys (Employee Satisfaction 2012). If you use Metric Studio,
sample metrics for human resources are also available.

In the GO Data Warehouse (analysis) package, groups of measures and the related dimensions are
organized into folders. The employees are organized in hierarchies for region and manager, to make
different kinds of aggregation easy to report on. Aggregation has been defined for the Employee Position
Summary measures, so that Position count and Planned position count aggregate correctly at each level
of time: monthly, quarterly, or yearly. For example, see the Planned Headcount report.

The employees are also listed in a sample LDIF file which could be used for any LDAP IBM product
authentication including Tivoli®. This authentication directory is necessary for IBM Cognos Planning
samples. No other samples depend on security profiles.

Sales and marketing
Data about sales and marketing is available for all of the companies in the Sample Outdoors group.

GO Accessories has richer details to support analysis examples. For example, see the Revenue vs % Profit
Margin by Product Brand analysis, based on the Sales and Marketing cube. Marketing and sales
campaigns are tied to the Sample Outdoors regional companies.

Overall, the GO companies have experienced solid growth across most product lines (Sales Growth Year
Over Year), in all regions (Revenue by GO Subsidiary 2011), because of factors like an increase in repeat
business and new or improved products, such as the high margin sunglasses product line. In the product
lines sold by the five regional companies (all but GO Accessories) promotions have had mixed success
(Promotion Success by Campaign, Bundle and Quarter). If you use Metric Studio, this can also be seen in
the sample metrics.

Customer surveys
The data also contains information from customer surveys. For example, the product line that includes
bug spray, sun screen, and so on has not been successful (Product Satisfaction - Outdoor Protection
2011) and a source of retailer dissatisfaction may be the level of customer service rather than the returns
(Customer Returns and Satisfaction). If you use Metric Studio, this information can also be monitored in
metrics.

Sales outlets
Revenue from the corporate outlets is available at the transaction level. Revenue from the franchise
outlets is available at the consolidated level only (Sales and Marketing cube). Metrics about retailers show
that the number of new retail outlets has dropped over the time period covered by this data.

GO Accessories sells worldwide, and sells only accessories. Transaction data for GO Accessories is the
primary source for analysis of product by brand, color and size. The other five subsidiaries in the group of
companies are regional and sell all product lines for retailers in their region. For example, the report Top
10 Retailers in 2011 uses sparklines and list data to review revenues at the retailer level.
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Sample Outdoors database, models, and packages
The Sample Outdoors Framework Manager models illustrate modeling techniques and support the
samples.

The models are based on the GO data warehouse and the GO sales transactional database and are the
basis for the sample reports and queries. Each model contains two packages for publishing analysis
(dimensional) and query views of the data.

You must have access to Framework Manager, the modeling tool in IBM Cognos Analytics, to look at the
sample models. You may also need to set up the sample databases and connections.

GO Data Warehouse

The GO Data Warehouse model, great_outdoors_data_warehouse.cpf, is based on the database
GOSALESDW. It contains data about human resources, sales and marketing, and finance, grouped into
business areas. In the Database view, the three business areas are grouped into separate namespaces.
The Database view contains a fourth namespace (GO Data) for the common information.

The Database view is very similar to the structure of the underlying database. All tables (database query
subjects) are unchanged. This enables IBM Cognos Analytics to retrieve metadata directly from the
package in most cases, instead of using a metadata call to the database. The following changes and
additions have been made in the Database view:

• Joins have been added as necessary.
• To allow for aggregation at different levels of granularity, some model query subjects have been created.

For example, see the relationships between Time and Sales or Sales fact.
• To allow single joins to be made between the lookup tables and each level in a dimension, lookup tables

have been copied. For example, see the Products look up tables.

The Business view contains only model query subjects, with no joins. The following changes and additions
have been made in the Business view:

• Calculations were added to the model query subjects. For example, the time dimension contains
language calculations.

• Where the database has multiple hierarchies, new dimensions have been created to organize each
hierarchy. For example, the employee hierarchies are organized into several categories, such as
manager and region.

The GO Sales transactional database

The GO Sales model, great_outdoors_sales.cpf, is based on the GOSALES database, which is
structured as a transactional database. It contains principally sales data.

The Database view is very similar to the underlying database structure. The following changes and
additions have been made in the Database view:

• To make it possible to join the fact tables to the time dimension, model query subjects and multipart
joins have been used.

• Other joins have been added as necessary.

The Business view contains only model query subjects, with no joins. The following changes and additions
have been made in the Business view:

• Calculations were added to the model query subjects.
• Model query subjects that were created in the Database view to enable joins on the time dimension

have been linked as reference shortcuts.
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• Where the database has multiple hierarchies, new dimensions have been created to organize each
hierarchy.

• Sales Staff is a subset of the slowly changing Employee dimension. There is no unique Employee key in
GO Sales, so a filter retrieves the current record only. This model does not use historical data.

The samples PowerCubes

The following cubes are delivered with the Sample Outdoors samples in English, French, German,
Japanese and Chinese:

• sales_and_marketing.mdc
• employee_expenses.mdc
• go_accessories.mdc
• go_americas.mdc
• go_asia_pacific.mdc
• great_outdoors_sales_en.mdc
• great_outdoors_7.mdc

The samples packages

The Sample Outdoors samples include six packages. A brief description of each available package is
provided.

Go Data Warehouse (analysis) is a dimensionally modeled view of the GOSALESDW database. This
package can be used in all studios, including IBM Cognos Analysis Studio. Using this package you can drill
up and down.

Go Sales (analysis) is a dimensionally modeled view of the GOSALES database. This package can be used
in all studios, including Analysis Studio. Using this package you can drill up and down.

Go Data Warehouse (query) is a non-dimensional view of the GOSALESDW database. This package can be
used in all studios except Analysis Studio, and is useful for reporting when there is no need for drilling up
and down.

Go Sales (query) is a non-dimension view of the GOSALES database. This package can be used in all
studios except Analysis Studio, and is useful for reporting when there is no need for drilling up and down.

Sales and Marketing (cube) is an OLAP package, based on the sales_and_marketing.mdc cube.

Great Outdoor Sales (cube) is an OLAP package, based on the great_outdoors_sales_en.mdc cube.

Note: The OLAP packages, Great Outdoor Sales (cube) and Sales and Marketing (cube), are not
multilingual. The IBM_Cognos_PowerCube.zip archive contains five versions of each package; one in
English, French, German, Japanese and Chinese.

Samples in the GO Data Warehouse (analysis) package
The following are some of the reports found in the GO Data Warehouse (analysis) package and GO Office
Report Samples.
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Employee Satisfaction Workspace
This workspace shows different measures of employee satisfaction, like training, bonuses, and employee
survey scores. The bonus list is filtered by country.

Return Quantity by Order Method
This report shows quantity sold, number of returns, and percentage of returns (with those greater than
5% highlighted) by return reason for each product in the Outdoor Protection product line. This report uses
the following features:

• filters
• lists
• conditional highlighting
• grouping

Return Quantity by Product Line Chart
This pie chart report shows return quantities of product lines for all subsidiaries.

Revenue Data Workspace
The workspace shows revenue by region, by country and product type (filtered with multiple values check
boxes), and by order method.

Samples in the GO Data Warehouse (query) package
The following reports are some of the reports found in the GO Data Warehouse (query) package and GO
Office Report Samples.

Baselines
This chart report shows the numeric baselines, mean and percentage, based on prompt values that are
used to filter on years.

Bursted Sales Performance Report
This list report shows how to burst a sales performance report to a manager of Northern Europe sales
staff. To successfully burst this report, IBM Cognos 10 must be configured to use an email server. This
report uses the following features:

• lists
• bursting
• conditional highlighting
• filters
• calculations
• summarizing
• blocks
• custom headers and footers
• sorting
• grouping
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Samples in the Sales and Marketing (Cube) package
The following reports are some of the reports found in the Sales and Marketing (Cube) package and GO
Office Report Samples.

Revenue by Product Brand
This report shows the revenue and gross profit by product filtered by the product brand. There is always
product turnover, so the report conditionally highlights products that are discontinued. This report uses
the following features:

• lists
• filters
• prompts
• combination charts
• bar charts
• HTML items
• grouping
• sorting
• axis titles

Samples in the GO Sales (analysis) package
The following reports are some of the reports found in the GO Sales (analysis) package and GO Office
Report Samples.

Sales Summary
This report summarizes revenue and gross profit and shows the top sales representatives by revenue and
quantity sold. This report uses the following features:

• lists
• filters
• combination charts
• axis titles
• custom headers and footers
• conditions

Samples in the GO Sales (query) package
The following reports are some of the reports found in the GO Sales (query) package and GO Office Report
Samples.

Horizontal Pagination
This report shows a very wide Exploration View rendered across several horizontal pages. The first
Exploration View shows the fit-to-page behavior, while the second Exploration View shows the horizontal
pagination.

This report uses the following features:

• multiple pages
• horizontal pagination
• Exploration Views
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• custom headers and footers

No Data
Each page of this report presents a different option for dealing with a No Data condition. It also generates
invoices of sales for the Order Invoices - Donald Chow, Sales Person report in the GO Sales (query)
package.

This report uses the following features:

• Exploration Views
• custom headers and footers
• no data
• lists
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Appendix B. Accessibility features
IBM Planning Analytics for Microsoft Excel has accessibility features that help users who have a physical
disability, such as restricted mobility or limited vision, to use information technology products
successfully.

The following list includes the major accessibility features :

• You can use accelerators and command keys for navigation.

In Microsoft Windows, press the Alt key, then the accelerator to trigger an action; for example, Alt+F
shows the File menu. If they are enabled, you can use extended accelerators as well.

• IBM Planning Analytics for Microsoft Excel uses Microsoft Active Accessibility (MSAA). This means that
people with limited vision can use screen-reader software, along with a digital speech synthesizer, to
listen to what is displayed on the screen.

• IBM Planning Analytics for Microsoft Excel supports your system's display settings, such as color
scheme, font size, and high-contrast display.

• IBM Planning Analytics for Microsoft Excel provides text through standard system function calls or
through an API (application programming interface) that supports interaction with assistive technology,
such as screen-reader software. When an image represents a program element, the information
conveyed by the image is also available in text.

https://helpline.hursley.ibm.com has other features that you can customize to fit your individual needs:

• “Increase font size for future sessions” on page 318
• “View explorations in Windows high contrast mode” on page 318

Keyboard navigation
You can use keyboard shortcuts to navigate and perform tasks. If an action you use often does not have a
shortcut key, you can record a macro in Microsoft Excel to create one.

This product uses standard Microsoft Windows navigation keys in addition to application-specific keys.

Note: The keyboard shortcuts are based on U.S. standard keyboards. Some of the content in this topic
may not be applicable to some languages.

Access and use menus
Keyboard shortcuts allow you to access menus and the IBM Planning Analytics ribbon without using a
mouse or other pointing device.

Note: Shortcut keys may vary depending on the individual setup and operating systems used.

Table 23. IBM Planning Analytics ribbon

Action Shortcut keys

Start IBM Planning Analytics for Microsoft Excel or
IBM Cognos for Microsoft Office.

ALT+Y, to place focus on the IBM Planning
Analytics tab in the ribbon.

When an item on the IBM Planning Analytics tab is
selected, select the next or previous button or
menu on the tab.

LEFT ARROW, RIGHT ARROW, UP ARROW, or
DOWN ARROW

Select the first or last command on the menu or
submenu.

HOME or END
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Table 23. IBM Planning Analytics ribbon (continued)

Action Shortcut keys

Open the selected menu, or perform the action for
the selected button or command.

ENTER

Open the context menu for the selected item or
area of focus.

SHIFT+F10

Close an open context menu. ESC

Access and use the task pane
Keyboard shortcuts allow you to access the task pane without using a mouse or other pointing device.

Table 24. Task pane

Action Shortcut keys

Selecting a database to log onto.

Note: A menu or the IBM Planning Analytics tab
must be active when performing this action.

Office 2013 and 2016 users:

• Move the focus to the task pane by holding Shift
and pressing F6 3 times.

Note: The focus will be moved to the task pane,
however, there is no visual representation to
indicate this.

• Select the server by pressing tab 2 times. The
Open icon will be highlighted. Press SPACE and
then press the DOWN ARROW to open and
navigate the sub menu.

• Select the database by pressing the RIGHT
ARROW and then pressing ENTER.

When the task pane is active, select a component,
such as IBM Planning Analytics for Microsoft Excel
or IBM Cognos for Microsoft Office

Office 2013 and 2016 users:

LEFT ARROW or RIGHT ARROW

Office 2010 users:

CTRL+TAB

LEFT ARROW or RIGHT ARROW

When the IBM Cognos Office pane is active, select
the next or previous option in the pane.

Office 2013 users:

TAB

Office 2010 users:

CTRL+TAB

Place the focus on the metadata tree. CTRL+M, T

Place the focus on the overview area of an
Exploration View.

CTRL+M, U

Place the focus on the IBM Planning Analytics tab. ALT+Y, 2
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Use filter window
Keyboard shortcuts allow you to use the Edit Filter window without using a mouse or other pointing
device.

Table 25. Edit Filter window

Action Shortcut keys

When the Edit Filter window is active, change the
focus on controls by moving between buttons, filter
lines and conjunctions, which are the AND and OR
operators.

TAB

Toggle the expression between AND and OR when
a conjunction control is active.

SPACE KEY

When a conjunction control, such as AND and OR
operators are active, compress the expression.

LEFT ARROW

MINUS KEY (-) on the numeric keypad

When a conjunction control, such as AND and OR
operators are active, expand the expression.

RIGHT ARROW

PLUS KEY (+) on the numeric keypad

Use windows
Keyboard shortcuts allow you to access dialog boxes without using a mouse or other pointing device.

Table 26. Dialog boxes or windows

Action Shortcut keys

Move to the next option or option group. TAB

Move to the previous option or option group. SHIFT+TAB

Move between options in an open drop-down list,
or between options in a group of options.

Arrow keys

Perform the action for the selected button, or
select or clear the selected check box.

SPACEBAR

Open the context menu, if it is closed, and move to
that option in the context menu.

SHIFT+F10, then press the first letter of an option
in a drop-down list

Open the selected drop-down list. DOWN ARROW

First letter of an option in a drop-down list

Close the selected drop-down list. Office 2013 users:

ESC

Office 2010 users:

First letter of an option in a drop-down list

Appendix B. Accessibility features  313



Table 26. Dialog boxes or windows (continued)

Action Shortcut keys

Expand or collapse a folder. Office 2013 users:

RIGHT ARROW, LEFT ARROW

Office 2010 users:

CTRL+ENTER

Cancel the command and close the window. ESC

Open the Select Package dialog box. CTRL+M, O

When the Open dialog box is active, open the
selected report locally.

ENTER

When the Select Package dialog box is open,
select a package.

Office 2013 users:

TAB, to place focus on the System box

DOWN ARROW, to select a Cognos system

ENTER to view the packages

Office 2010 users:

TAB, to place focus on the System box

ENTER to view the packages

When the Publish dialog box is active and the
appropriate folder is expanded, publish the
selected Microsoft Office document.

After selecting the file name, tab to the Publish
button and press ENTER.

In IBM Cognos for Microsoft Office, move to a tab
page, such as the Browse Content or the Manage
Data page, on the IBM Cognos pane.

CTRL+TAB

Use tree view
Keyboard shortcuts allow you to access tree view without using a mouse or other pointing device.

Table 27. Tree view

Action Shortcut keys

Move to the first selectable node.

If the node has children and the child node is
expanded, move to the first child node.

DOWN ARROW

Move to the next selectable node. UP ARROW or DOWN ARROW

Expand the selected node, or move to the first
selectable child node

RIGHT ARROW

Collapse the selected node, move to the parent
node, or move to the first selectable node.

LEFT ARROW
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Table 27. Tree view (continued)

Action Shortcut keys

Move to the first node in a tree control. HOME

Move to the last node in a tree control. END

Use report options
Keyboard shortcuts allow you to perform report actions.

Table 28. Report options

Action Shortcut keys

Rebuild a Dynamic Report. ALT+F9

Perform drill through ALT+Y, 2, D

Undo the most recent action in the exploration CTRL+M, Z

Redo the most recent action in the exploration CTRL+M, Y

Expand or collapse a consolidated element in a
Dynamic Report

CTRL+M, G

Edit the annotation for the selected cell CTRL+M, A

Commit the changed value for the selected cell CTRL+M, C

Hold the value in the selected cell, or release a
hold on a cell

CTRL+M, H

Refresh the current Quick Report or Exploration
View.

CTRL+M, R

Clear the data from the current Quick Report. CTRL+M, L

Refresh all Quick Reports on the worksheet CTRL+M, W

Show the properties for the current Quick Report. CTRL+M, P

Commit changed values in the current Quick
Reports.

CTRL+M, C

Use the set editor
The following keyboard shortcuts allow you to use the set editor without using a mouse or other pointing
device.

Note: When an area of the screen has focus, it has a contrasting line around it. When you open the set
editor, the first highlighted item is the Available Members pane.
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Table 29. Set editor

Action Shortcut keys

Move between enabled items in the set editor Press the Tab key to move to the next item.

Press Shift+Tab to go to the previous item.

Open a menu With the focus on the menu, press Enter or the
Space bar.

Move through items in a menu and members Press the up and down arrow keys. To move to a
sub menu, press the right-facing arrow key.

Select an option Press Enter.

Select consecutive members Highlight the first member that you want to select,
hold Shift, and then use the arrow keys to select
the next members.

Expand and collapse consolidated members Press Enter, or the right arrow to expand
consolidated members, and press Enter or the left
arrow to collapse.

Show a context menu Press Shift+F10. Use the up and down arrow keys
to move through the items.

Work in attributes menus

Tab to  and press Enter. Press the up and
down arrow keys to move through the menu, and
press Enter to select an attribute. Tab to OK and
press Enter to close the menu.

Navigate in the MDX Editor To move around the controls, press the Tab key to
move to the next control and press Shift+Tab to go
back to the previous control.

When the focus is inside the rich text editor, press
CTRL+F2 to move to the next control, and Shift
+CTRL+F2 to go to the previous control.

Supported languages
IBM Planning Analytics for Microsoft Excel supports different languages in its user interface as well as its
documentation.

The following table shows the languages supported in the user interface and in the documentation.

Table 30. Supported languages in Planning Analytics for Microsoft Excel.

Language User interface Documentation

Brazilian Portuguese

Croatian
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Table 30. Supported languages in Planning Analytics for Microsoft Excel. (continued)

Language User interface Documentation

Czech

Danish

Dutch

English

Finnish

French

German

Hungarian

Italian

Japanese

Kazakh

Korean

Norwegian (Bokmål)

Polish

Romanian

Russian

Simplified Chinese

Slovak

Slovenian

Spanish

Swedish

Thai

Traditional Chinese

Turkish
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Interface information
The following sections describe various ways that you can customize your settings to make IBM Planning
Analytics for Microsoft Excel more accessible.

Increase font size for future sessions
It is best to change the size of your IBM Planning Analytics for Microsoft Excel fonts by changing your
display fonts in Windows. Changing your Windows display fonts affects all programs on your computer.
For more information, refer to Windows Help.

View explorations in Windows high contrast mode
Microsoft Windows users with low vision can make IBM Planning Analytics for Microsoft Excel easier to
view by enabling High Contrast Mode. For more information, see the documentation for your operating
system.

Vendor software
IBM Planning Analytics for Microsoft Excel includes certain vendor software that is not covered under the
IBM license agreement. IBM makes no representation about the accessibility features of these products.
Contact the vendor for the accessibility information about its products.

IBM and accessibility
See the IBM Human Ability and Accessibility Center for more information about the commitment that IBM
has to accessibility.

http://www.ibm.com/able
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Appendix C. Rebrand Cognos Office Components
This section is intended for clients and partners who need to rebrand, customize, or localize labels,
messages, or other strings in IBM Cognos Office products, such as IBM Planning Analytics for Microsoft
Excel, IBM Cognos Office, and IBM Cognos for Microsoft Office.

Resource Files
All the customizable strings for IBM Cognos Office products are in XML-based resource (.resx) files.

The .resx resource file format consists of XML entries that specify objects and strings inside XML tags. One
advantage of a .resx file is that when opened with a text editor (such as Notepad) it can be written to,
parsed, and manipulated. When viewing a .resx file, you can see the binary form of an embedded object,
such as a picture when this binary information is a part of the resource manifest. Apart from this binary
information, a .resx file is readable and maintainable.

A .resx file contains a standard set of header information that describes the format of the resource
entries, and specifies the versioning information for the XML code that parses the data.

These files contain all the strings, labels, captions, and titles for all text in the three IBM Cognos Office
components. For each language, there are three files, one for each component. The following table
identifies each of the files.

Table 31. IBM Cognos Office resource files

Language IBM Planning Analytics
for Microsoft Excel files

(internal name cor)

IBM Cognos for
Microsoft Office files

(internal name coc)

IBM Cognos Office files

(internal name coi)

Language Neutral cormsgs.resx cocmsgs.resx coimsgs.resx

Chinese (simplified) cormsgs.zh-cn.resx cocmsgs.zh-cn.resx coimsgs.zh-cn.resx

Chinese (traditional) cormsgs.zh-tw.resx cocmsgs.zh-tw.resx coimsgs.zh-tw.resx

Croatian cormsgs.hr.resx cocmsgs.hr.resx coimsgs.hr.resx

Czech cormsgs.cs.resx cocmsgs.cs.resx coimsgs.cs.resx

Danish cormsgs.da.resx cocmsgs.da.resx coimsgs.da.resx

Dutch cormsgs.nl.resx cocmsgs.nl.resx coimsgs.nl.resx

English cormsgs.en.resx cocmsgs.en.resx coimsgs.en.resx

Finnish cormsgs.fi.resx cocmsgs.fi.resx coimsgs.fi.resx

French cormsgs.fr.resx cocmsgs.fr.resx coimsgs.fr.resx

German cormsgs.de.resx cocmsgs.de.resx coimsgs.de.resx

Hungarian cormsgs.hu.resx cocmsgs.hu.resx coimsgs.hu.resx

Italian cormsgs.it.resx cocmsgs.it.resx coimsgs.it.resx
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Table 31. IBM Cognos Office resource files (continued)

Language IBM Planning Analytics
for Microsoft Excel files

(internal name cor)

IBM Cognos for
Microsoft Office files

(internal name coc)

IBM Cognos Office files

(internal name coi)

Japanese cormsgs.ja.resx cocmsgs.ja.resx coimsgs.ja.resx

Kazakh cormsgs.kk.resx cocmsgs.kk.resx coimsgs.kk.resx

Korean cormsgs.ko.resx cocmsgs.ko.resx coimsgs.ko.resx

Norwegian cormsgs.no.resx cocmsgs.no.resx coimsgs.no.resx

Polish cormsgs.pl.resx cocmsgs.pl.resx coimsgs.pl.resx

Portuguese cormsgs.pt.resx cocmsgs.pt.resx coimsgs.pt.resx

Romanian cormsgs.ro.resx cocmsgs.ro.resx coimsgs.ro.resx

Russian cormsgs.ru.resx cocmsgs.ru.resx coimsgs.ru.resx

Slovenian cormsgs.sl.resx cocmsgs.sl.resx coimsgs.sl.resx

Spanish cormsgs.es.resx cocmsgs.es.resx coimsgs.es.resx

Swedish cormsgs.sv.resx cocmsgs.sv.resx coimsgs.sv.resx

Thai cormsgs.th.resx cocmsgs.th.resx coimsgs.th.resx

Turkish cormsgs.tr.resx cocmsgs.tr.resx coimsgs.tr.resx

Run Cognos Office components in English in a localized Microsoft
Windows environment

You can display English in Cognos Office components in a Microsoft Windows environment that is
configured to use another language.

About this task
For example, if Microsoft Windows is set to use French, Cognos Office components also use French by
default. But you can configure Cognos Office components to use English instead of French.

Procedure
1. Close all Microsoft Office windows.
2. In Windows Explorer, navigate to the Cognos Office installation location.

Tip: On Windows 7, the default installation location is C:\Program Files (x86)\IBM\cognos
\Cognos for Microsoft Office.

3. Find the folder that corresponds to the locale you are using in Windows, for example, fr if you are
using French in Microsoft Windows.

4. Move the folder to a location outside of the Cognos Office installation location.
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Example
For example, if your Region and Language settings in Windows are set to French (France), but you want to
see English in IBM Planning Analytics for Microsoft Excel, move the fr folder outside of the Cognos for
Microsoft Office folder. When you open IBM Planning Analytics for Microsoft Excel, or any other
Cognos Office component, the user interface is in English.

Rebrand or Localize Cognos Office Components
If you are setting the IBM Cognos component for a multilanguage environment, you must compile both
the language-neutral file and the language file for your locale. The program detects the user locale
settings in Windows and uses the appropriate language file.

For example, suppose you installed IBM Planning Analytics for Microsoft Excel and your locale is set to
French (France). You must make changes to the language-neutral files: cormsgs.resx and coimsgs.resx,
and to the French files: cormsgs.fr.resx and coimsgs.fr.resx.

To customize or localize the component names and text messages, follow these steps:

• Edit the language-neutral resource files, and if necessary, the language resource files for your locale.
• Download and then run the Resource File Generator (Resgen.exe) required for compiling the updated

resource files.
• Test your work.

Editing the resource (.resx) files
For each component, there exists a set of files that support the various languages. The country or region
code distinguishes the filenames.

With the exception of the language-neutral set of files (cormsgs.resx, cocmsgs.resx, and coimsgs.resx)
that serve as the default files, each file follows the following naming convention:

componentcodemsgs.languagecode.resx

You can change strings, not icon or graphic resources.

When changing text strings, consider the string length. The width of fields were created using the existing
strings. Significantly increasing string length may result in some strings getting truncated in some of the
dialog boxes.

The resource file contains metadata and comments that can help you determine when and where strings
are used in the software.

Important: To edit XML resource files, use an XML editor. It is important to preserve the Unicode
encoding and format, including white space. Simple text editors will likely corrupt the files. A validating
XML editor ensures that the contents of the files are well formed and valid. Modify only string information.
Do not change other information in the files.

Procedure
1. Install the IBM Cognos Office components locally to a workstation.

This gives you access to the resource files.
2. Locate the resource files.

If you install locally and accept all the defaults, they are found in the following location:

[installation directory]\Program Files\IBM\cognos\Cognos for Microsoft
Office\resources

3. In an XML Editor, open the componentcodemsgs.languagecode.resx file.

Use an editor such as Visual Studio or XMLSpy to change the branding details or to translate strings
into another language.
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If you are creating new language files, follow the naming convention by inserting the 2 or 5-character
language code into the middle of the file name. For example, if you add a Romanian language file for
IBM Cognos for Microsoft Office, you would save it as cocmsgs.ro.resx.

4. Save the file.
5. Repeat steps 3 and 4 for each component file associated with the language that you want to translate.

Results
The updated resource files are now ready to be compiled.

Compile the updated resource files
Before you can deploy updated files, you must download the Resource File Generator (Resgen.exe). The
Resource File Generator converts .txt files and .resx (XML-based resource format) files to common
language runtime binary .resources files that you can embed in a runtime binary executable or compile
into satellite assemblies.

The Resource File Generator is a Microsoft .NET Framework Software Development Kit (SDK) program
that generates compiled resource files. The resgen executable is shipped with the Microsoft .NET SDK and
comes with Microsoft Visual Studio development system. You must choose a version of the Resource File
Generator that is compatible with the version of .NET Framework that is used by IBM Cognos Office
components.

Resgen.exe performs the following conversions:

• Converts .txt files to .resources or .resx files.
• Converts .resources files to text or .resx files.
• Converts .resx files to text or .resources files.

Procedure
1. Download the resgen.exe from the Microsoft .NET developer Web site.
2. After downloading the Resource File Generator, open a command prompt window.
3. Find the location where Resgen was downloaded.

For example, cd C:\Program Files\Microsoft Visual Studio 8\v2.0\Bin
4. To compile the resource files, from the command prompt, type

resgen /compile "[resx file location]\[file name.resx]"

For example, resgen /compile "c:\ProgramFiles\Cognos\Cafe\resources
\cormsgs.resx"

Resource files are automatically renamed to include the .resource extension in their file name.
5. Copy the resulting files to the Resources directory.

Test your work
To test your work, run IBM Cognos Office using a variety of locales and start each component (IBM
Cognos Office, IBM Cognos for Microsoft Office, and IBM Planning Analytics for Microsoft Excel) to ensure
that your changes are reflected in each area.

Check the text changes in all the interfaces exposed to your users. Pay particular attention to generic
dialog boxes, which are easy to miss.
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Notices

This information was developed for products and services offered worldwide.

This material may be available from IBM in other languages. However, you may be required to own a copy
of the product or product version in that language in order to access it.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that only
that IBM product, program, or service may be used. Any functionally equivalent product, program, or
service that does not infringe any IBM intellectual property right may be used instead. However, it is the
user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.
This document may describe products, services, or features that are not included in the Program or
license entitlement that you have purchased.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A. 

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION
PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of
express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
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publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of
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IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.
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3755 Riverside Dr. 
Ottawa, ON 
K1V 1B7 
Canada

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by
IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any
equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurements may have been estimated
through extrapolation. Actual results may vary. Users of this document should verify the applicable data
for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without
notice, and represent goals and objectives only.

This information is for planning purposes only. The information here is subject to change before the
products described become available.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs
in any form without payment to IBM, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the operating platform for
which the sample programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these
programs. The sample programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must include a copyright
notice as follows:
© (your company name) (year). Portions of this code are derived from IBM Corp. Sample Programs. ©
Copyright IBM Corp. _enter the year or years_.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.

This Software Offering does not use cookies or other technologies to collect personally identifiable
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Index

Special Characters
.NET Framework

troubleshooting 294
version 292

.NET programmability support 292
#NAME! 162
#NAME? 295
#VALUE! 162

A
access privileges, See security
action buttons

adding 246
appearance 251
copying 252
deleting 252
editing 252
mapping fields 249, 250
navigating to a worksheet 248, 251
overview 245
recalculating or rebuilding a worksheet 251
renaming 252
running a process 247, 251
understanding processing 245

add-ins
TM1 Perspectives add-in 161
TM1 worksheet functions add-in 161

adding
measures to an Exploration View 208

aggregation
samples and time dimensions 305
using filters for BI data 220

alternate hierarchies 209
annotations, See comments
application programming interface, See API
applications

setting up startup 45
asymmetrical Exploration Views

layouts 110
attributes

modifying 163, 165
retrieving 163

authentication
forms-based authentication 46
logging on 39

Auto prompts 51, 54, 56
auto spread 52
automation

overview 253
running processes 93
security settings 253
using action buttons 245

B
base data 150, 152
Baselines sample 308
batch processing 253
best practices

Exploration Views for BI
best practices 213

BI reports
Exploration Views 101, 207
lists 100, 204

BI servers
logging on 39

blank columns
adding an Excel calculation 116, 225
inserting into Exploration Views 105, 211
inserting into lists 101, 205

blank rows
adding an Excel calculation 116, 225
inserting into Exploration Views 105, 211

bottom or top values
viewing in TM1 Exploration Views 109

BulkUploadAutoCommitValid 159

C
CA reports

cell-based 226
cache

clearing in Planning Analytics for Microsoft Excel 47
calculations

adding to BI lists 205
adding to Exploration Views 106, 116, 209, 225

capability assignments 148
cell styles 110, 123
cell-based reports

clearing data 73
cells

annotating 159
colors for sandbox data 152
converting to snapshot 77
displaying data source 130, 190, 229
excluding from data spreading 154
grouping 115, 214

Certificate Authority (CA)
unable to create trust relationship 297

changes
committing to TM1 153
discarding sandbox data 151
previewing 153

COGNAME
troubleshooting 230

Cognos Analysis servers
updating URLs 45

Cognos Analytics servers
connecting 38

Cognos Connection, See IBM Cognos Connection
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Cognos Office Reporting TM1 add-in 161
Cognos systems

changing 218, 229
CognosOfficeReportingSettings.xml

settings options for committing data 159
CognosOfficeTM1.xll 161
CognosOfficeXLLSettings.xml 161
COGVAL

troubleshooting 230
columns

calculated 106, 116, 205, 209, 225
inserting in a Dynamic Report 130
inserting into Exploration Views 105, 211
inserting into lists 101, 205
limiting 108
nesting 105, 212
sorting 205
swapping with rows 107, 218

Com Add-in
Excel workbook closes unexpectedly 294

comments
adding and editing 159

CommitWithoutConfirmation 159
compression

data queries 231
conditional formatting 116, 225
connections

adding 38
consolidation holds, See holds
content

automating 253
context

defining with formulas 191
filters 210

context area
using in TM1 Exploration Views 107

convert to formulas
errors 291, 296

CSV format 231
CSV formats 115, 214
cube

changing 117
changing for Quick Reports 124

cubes, See data sources
custom filters, See filters
Custom Report

#NAME? errors 295
best practices 230
changing the cube and datasource 135
changing the system and data source 229
converting to snapshot 77
creating from scratch 227
creating manually 135
displaying package 130, 190, 229
drilling down 229
example 228
expanding items 228
formulas 226
modifying DBRW formulas 190
overview 29, 226
refreshing 93
troubleshooting 230

Custom Reports
clearing 73

Custom Reports (continued)
overview 27, 134
publishing 94
refreshing 93

custom sets
creating using items in a drop zone 224
creating using items in the source tree 224

D
dashboards, See see workspaces
data

adding to BI Exploration Views 217
base 150
clearing 73
committing to TM1 113, 124, 153
converting to snapshot 77
discarding sandbox values 151
editing in a Quick Report 123
editing in a TM1 Exploration View 110
editing in TM1 153
filtering 210
finding 88
presenting for IBM Cognos Analytics 226
private 150
refreshing 93
restoring after clearing 73

data items
adding 208

data queries
compressing 231

data sets
large 231

data source
displaying for formulas cells 130, 190, 229
loading most recent 48

data sources
changing 40, 117, 218
changing for Quick Reports 124
dimensionally modeled relational (DMR) 96
logging on 39
OLAP 96
opening 39

data spreading
clearing 155
excluding cells 154
in TM1 reports 153
methods 155
overview 153
syntax 157

datasource
refreshing 40

Datasource
connection 38

datasources
changing 135
changing for Dynamic Reports 130

DBR
dragging members to modify 190
modifying 190
modifying a range 191
overview 163

DBRA
overview 163
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DBRW
dragging members to modify 190
in Custom Report 135
modifying 190
modifying a range 191
overview 164

DBS 164
DBSA 165
DBSS 166
DBSW 166
default measures

changing 215
DFRST 167
dimension

subsetname 197
dimensional data sources

using in a list 204
using in an Exploration View 207

dimensionally modeled relational (DMR) data sources, See
DMR
dimensions

nesting 105, 212
overview 96
retrieving names of 179
retrieving the first member 167
retrieving the number of levels 169
retrieving the number of members 168
searching 88, 89

DIMIX 167
DIMNM 168
DIMSIZ 168
direct writeback method 148
direct writeback mode 149, 150
DisableSandboxing parameter 150
display count

limiting 48
DMR

filter expressions 219
DNEXT 168
DNLEV 169
Double-click 55
DPR-ERR-2079 error 295
drop zones 20
DTYPE 169
Dynamic Reports

adding multiple 126
changing context members 130
changing the cube and datasource 130
collapsing rows 129
creating 126
displaying data source 130, 190, 229
editing sets 129
expanding rows 129
formatting 131–133
inserting columns 130
inserting rows 130
overview 125
publishing 94, 134
rebuilding 127, 251
recreating 127
refreshing 93, 127, 251
suppressing zeros 129
TM1ELLIST 180
TM1GLOBALSANDBOX 182

Dynamic Reports (continued)
TM1INFO 183
TM1RPTELISCONSOLIDATED 183
TM1RPTELLEV 184
TM1RPTELLSEXPANDED 184
TM1RPTFILTER 184
TM1RPTROW 185
TM1RPTTITLE 187
TM1RPTVIEW 187
TTM1PRIMARYDBNAME 183

Dynamic Reports Planning Analytics
overview 27

E
ELCOMP 170
ELCOMPN 171
elements, See members
ELISCOMP 171
ELISPAR 172
ELLEV 173
ELPAR 174
ELPARN 175
ELSEN 176
ELWEIGHT 177
Employee Satisfaction Workspace sample 308
equal across leaves spreading method 155
equal spreading method 155, 157
error messages

COI-ERR-2002 Block type is not valid 297
COI-ERR-2005 this version of Microsoft Office is not
supported 298
COI-ERR-2006 This Microsoft Office product is not
supported 298
COI-ERR-2008 Unable to retrieve from resources 298
COI-ERR-2009 Unable to perform this operation
because Microsoft Excel is in Edit mode 298
COI-ERR-2010 The name {0} is not valid. A name must
not contain both a quote (") character and an
apostrophe () character 298
COI-ERR-2011 The server did not return the expected
response 298
COI-ERR-2016 Worksheet protected, IBM Cognos styles
cannot be populated 299
COI-ERR-2305 Unable to perform this operation
because Microsoft Excel is in Edit mode 299
COI-ERR-2307 Login Failed 299
Convert to Formulas does not show value 291
COR-ERR-2004 Axis specification is not valid 300
COR-ERR-2007 error retrieving from resources 300
COR-ERR-2009 Name formula is not valid 300
COR-ERR-2010 Formula is not valid 300
COR-ERR-2011 Invalid range: Please enter a valid range
for crosstab or list 300
COR-ERR-2013 exploration cannot be converted to
formula based 300
COR-ERR-2014 Due to Excel Worksheet Limitations the
Results May Be Truncated 300
COR-ERR-2015 The current exploration cannot be
rendered at this location on the worksheet 300
COR-ERR-2016 Unable to retrieve package 301
Error: Exception from HRESULT:<location> 296
Excel workbook closes unexpectedly 294
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error messages (continued)
IBM Cognos Office fails to initialize in Microsoft Internet
Explorer 292
IBM Cognos Office Fails to Initialize in Microsoft Office
292
IBM Cognos Office unable to create trust relationship
297
Microsoft Office Excel does not open a workbook
published from IBM Cognos Office 293
reports unavailable in IBM Cognos Connection jobs after
using Save As command in IBM Cognos Report Studio
294
Results have exceeded the Excel row or column limit
296
server not available 292
This item cannot be expanded 296
unable to open published Microsoft Office documents
from IBM Cognos Analytics 293
unable to view reports after clicking view report 297
ValueNotInPickList (243) 301

errors
resolving data commit errors 159

examples
Custom Report 228

expand direction 115, 214
Expand direction 49
Expanding consolidated members 55
expired sessions 295
Exploration Views

Content Store 113
converting 126
layouts 110
MDX View 113
relational data 207
TM1 Native View 113

Exploration Views for BI
adding calculations 116, 225
best practices 213
creating 203
drilling down 217
filtering 210
inserting hierarchies 209
inserting members 215, 217
inserting rows and columns 105, 211
nesting rows and columns 211, 212
overview 29, 101, 207
publishing to IBM Cognos Connection 96
removing measures from 208
selecting measures 208
sorting rows 218
swapping rows and columns 107, 218

Exploration Views for IBM Cognos Analytics
adding calculations 106, 209

Exploration Views for Planning Analytics
overview 27

Exploration Views for TM1
adding calculations 106, 116, 209, 225
adding comments to cells 159
changing the system and data source 117, 218
committing data 113
converting to snapshot 77
creating from scratch 102
creating from views 102
drilling down 109

Exploration Views for TM1 (continued)
editing data 110
filtering data 107
inserting members 103, 104
inserting rows and columns 105, 211
limiting items 108, 216
nesting rows and columns 105
publishing 94
resolving data errors 159
setting options 115, 214
setting options for committing data 159
sorting rows 107
spreading data 153
swapping rows and columns 107, 218
viewing top or bottom values 109
zero suppression 108, 212

Exploration Views forIBM Cognos Analytics
limiting items 216

explorations
changing the system and data source 117, 218
clearing data 73
converting to snapshot 77
copying and moving 81
creating 203
Custom Report 226
displaying the information area 117, 218
Dynamic Reports 125
editing TM1 data 153
Exploration Views 101, 207
formula-based reports 134
lists 100, 115, 204, 214
publishing to IBM Cognos Connection 96
Quick Reports 119
refreshing 93
report types for BI data 29
report types for Planning Analytics data 27
spreading data (TM1) 153

F
file size

reducing 47
file types

registering 293
reregistering 293

filters
context 210
overview 219
top or bottom values 109

firewall security rejection 295
font colors 152
format definitions

applying 133
creating 133

format range 131–133
formats

CSV 115, 214, 231
raw XML 115, 214
refreshing 93

forms-based authentication 46
formula-based reports

creating from views 134
displaying data source 130, 190, 229
modifying SUBNM formulas 191
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formulas
Custom Report 226
displaying data source 130, 190, 229

function editor 161, 190, 191
functions

Custom Report formulas 226
MDX 192
TM1 160

G
GO Data Warehouse (analysis) package (samples) 307
GO Data Warehouse (query) package (samples) 308
GO Sales (analysis) package 309
GO Sales (analysis) sample 309
GO Sales (query) package 309
growth percent spreading method 155, 157
GZip compression

CSV lists 231

H
hierarchies

inserting 209
overview 96

holds
applying to cells 154
syntax 157

Horizontal Pagination sample 309

I
IBM Cognos Analytics servers

changing 229
IBM Cognos BI gateway addresses 298
IBM Cognos Connection

downloading Microsoft Office documents 43
opening Microsoft Office documents 42
troubleshooting unavailable reports 294
unable to open published Microsoft Office documents
293

IBM Cognos for Microsoft Office
downloading documents in IBM Cognos Connection 43
firewall security rejection 295
unable to view reports 297

IBM Cognos Office
downloading documents in IBM Cognos Connection 43
failure to initialize in Microsoft Office 292
numbered error messages 297
security issues 296
supported Microsoft Office applications 298
troubleshooting opening published documents 293

IBM pane
overview 20

IBM Planning Analytics for Microsoft Excel
numbered error messages 299

IBM Planning Analytics tab
showing or hiding 26

IBM Planning Analytics Workspace 94, 134
IBM TM1 Perspectives

feature differences 31
opening reports 33
upgrading action buttons 34

index
retrieving for a member 167
using to retrieve members 168

information area 117, 218
information folder 229
installations

COM add-in 292
Internet Explorer 292
items

searching for 89

K
Keep command 213
keep-only 108, 216
KEY_ERR 162

L
labels 115, 214
language 320
languages

troubleshooting pack subkeys 294
large data sets

system optimization 231
layouts

Exploration View 110
leaf holds 157
level

hierarchies 96
Level based indents 62
levels

determining for members 173
finding the number of 169
inserting 104
inserting in BI Exploration Views 216
inserting members from multiple levels 103, 215
overview 96

lists
creating a sample list report 273
examples 273
refreshing 93
understanding 204

lists for BI
adding calculations 205
creating 203
inserting members 215, 217
nesting rows 211
optimizing 231
overview 29, 100, 204
publishing to IBM Cognos Connection 96
sorting rows 205

lists for IBM Cognos Analytics
adding calculations 116, 225
CSV formatted 231
zero suppression 101, 206

lists for Planning Analytics
overview 27

lists for TM1
adding calculations 116, 225
converting to snapshot 77
creating from scratch 101
inserting columns 101, 205
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lists for TM1 (continued)
inserting members 103
nesting columns 105
zero suppression 101, 206

local cache, See cache
localization 320
log files

enabling 46
viewing 46

M
Macro trust access 33
macros

security 253
MapAddedRowColumnStyle 120
match title elements 250
MDX

functions 192
TM1-specific expressions 197
TM1-specific functions 194

measures
adding 208
adding to an Exploration View 215
default 215
removing from an Exploration View 208

member
ANCESTORS 197
MDX expressions 192
MDX functions 192
WEIGHT 198

member properties 96
members

adding to a Quick Report 120
adding to the context area 107
determining child members 171
determining level 173
determining name length 176
determining parents 172
determining the number of 168
determining the number of parents 175
determining the type 169
determining weight 177
folders 96
inserting from multiple levels 103, 215
inserting in a BI Exploration View 215–217
inserting in a TM1 exploration 103
inserting in a TM1 Exploration View 104
limiting 48, 108
replacing in a Quick Report 121
retrieving child members 170
retrieving parents 174
retrieving the index 167
retrieving the next 168
retrieving the number of 179
retrieving the number of children 171
retrieving using SUBNM 177
retrieving using the index 168
searching for 88
sorting by values 107
sorting by values or names 205, 218
viewing top or bottom values 109

metadata prompts 230
Microsoft Excel

Microsoft Excel (continued)
#NAME? errors 295
clearing cell contents 73
conditional formatting 116, 225
inserting calculations 116, 225
refreshing content, troubleshooting 298, 299
row and column restrictions, resolving 296
workbook closes unexpectedly 294

Microsoft Internet Explorer
cannot initialize IBM Cognos Office 292
setting security options 293

Microsoft Office documents
downloading from IBM Cognos Connection 43
opening from IBM Cognos Connection 42

model
refreshing 40

models
logging on 39
sample models and packages 306

Models
opening workbooks 41

N
named ranges

TM1RPTFMTIDCOL 187
TM1RPTFMTRNG 187

named sandboxes 148, 149
nest

rows and columns 105, 211, 212
nested

Exploration View layouts 110
nested cells

setting label options for Exploration Views 115, 214
No Data sample 310
non-English operating system

troubleshooting .NET Framework 294
null suppression, See zero suppression
numeric

MDX functions 192

O
OLAP

data sources 96
filter expressions 219

online analytical processing, See OLAP
options

setting for Planning Analytics for Microsoft Excel 45
overview area 20

P
package

displaying for formulas cells 130, 190, 229
loading most recent 48
refreshing 40, 93

package information 52
packages

changing 218, 229
GO Data Warehouse (analysis) 307
GO Data Warehouse (query) 308
GO Sales (analysis) sample 309
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packages (continued)
logging on 39
opening 39
overview 96
Sales and Marketing (Cube) 309
searching 89

percent calculations 106, 205, 209
percent change spreading method 155, 157
performance

TM1 data sources 295
personal workspace capability 148
Perspectives, See IBM TM1 Perspectives
PIAs (Primary Interop Assemblies)

installing subkeys 292
Planning Analytics for Microsoft Excel

clearing cache 47
overview 20
setting preferences 45
showing or hiding on the ribbon 26

Planning Analytics Workspace 122
port number 38
preferences

setting for IBM Planning Analytics for Microsoft Excel 45
Primary Interop Assemblies (PIAs) 292
private workspace, See sandboxes
processes

running 93
running with action buttons 247, 251

prompt values
report samples 310

prompts 230
proportional spread 52
proportional spreading method 155, 157
published documents

opening in Microsoft Office 293
unable to open from IBM Cognos Connection 293

Q
queries

compressing 231
Quick Reports

adding comments to cells 159
adding members 120
automatic refreshing 122
changing the cube and datasource 124
clearing data 73
committing data 124
converting 126
converting to snapshot 77
copying and moving 81
creating from views 119
deleting 123
editing data 123
overview 27, 119
publishing 94, 122
refreshing 93, 122
regions 119
replacing members 121
resolving data errors 159
setting options for committing data 159
spreading data 153
type-in refresh 122

R
raw XML 115, 214
RECALC_0_0 162
relational data

Exploration Views 207
relational data sources

using in a list 204
using in an Exploration View 207

repeat across leaves spreading method 155
repeat spreading method 155, 157
replacement system 45
report samples 303
Report Studio

saving changes in a job 294
report types

overview 26
reports

cell-based with #NAME? errors 295
copying and moving 81
downloading 43
lists 273
opening and saving 41, 42
running IBM Cognos for Microsoft Office reports after
expired session 295
securing 46
unable to view reports in IBM Cognos for Microsoft
Office 297

request formats 231
Return Quantity by Product Line sample 308
Revenue Data Workspace sample 308
ribbon

IBM Planning Analytics tab 20
showing or hiding the IBM Planning Analytics tab 26

rollup calculations 106, 209
rows

calculated 106, 116, 209, 225
editing set in a Dynamic Report 129
inserting in a Dynamic Report 130
inserting into Exploration Views 105, 211
limiting 108, 216
nesting 105, 212
sorting 107, 218
suppressing zeros 129
swapping with columns 107, 218

rows and columns
nesting 211

S
Sales and Marketing (Cube) package (samples) 309
Sample Outdoors Company

databases, models, and packages 306
samples 303

samples
Baselines 308
cubes 307
database, models, and packages 306
Employee Satisfaction Workspace 308
employees 305
GO data warehouse 306
GO Data Warehouse (analysis) package 307
GO Data Warehouse (query) package 308
GO Sales (analysis) package 309
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samples (continued)
GO Sales (query) package 309
GO Sales transactional database 306
horizontal pagination 309
No Data 310
packages 307
Return Quantity by Product Line 308
Revenue Data Workspace 308
Sales and Marketing (Cube) package 309
sales and marketing data 305

sandboxes
capability assignment 148
cell coloring 152
committing data 152
configuring for TM1 worksheet functions 161
consolidated values 151
direct writeback with named sandboxes 149
direct writeback without named sandboxes 150
disabling for a TM1 server 150
leaf values 151
merging data 152
named 148
overview 150
resetting values 151

search results
limiting the number of items 48

security
clearing the local cache 47
privileges 101, 102, 134, 203
settings for automation 253
using forms-based authentication 46

security issues 296
selection-based suppression 108, 212
server not available errror message 292
ServerMap 161
servers

changing 218, 229
updating URLs 45

set editor
opening for SUBNM formulas 191

set functions
MDX 193

sets
moving 211
nesting 211
retrieving members using SUBNM 177
retrieving the number of members 179

single signon
forms-based authentication 46

SiteMinder 46
snapshots 77
sort order 107
source tree

finding items 88
overview 20
refreshing 40
searching 88, 89
synchronizing 130, 190, 229

spreading, See data spreading
stacked

Exploration View layouts 110
starting cell 52, 53
startup application

setting up 45

static, converting to 123
straight spreading method 155, 157
styles

Dynamic Reports 132
SUBNM

in Custom Report 135
modifying 191

SUBSIZ 179
Sum 57
Sum context 55
suppression

in lists 101, 206
selection-based 108, 212
totals-based 108, 212

swap
rows and columns 107, 218

syntax
data spreading methods 157
holds 157

system
loading most recent 48

system information 52
system optimization

large data sets 231
systems

changing 218, 229
logging on 39
opening a data source or package 39
updating URLs 45

T
TABDIM 179
Task Pane

limiting the number of items 48
The Sample Outdoors Company 303
The Sample Outdoors Company samples 303
TM1

capability assignments 148
TM1 data

adding to Exploration Views 104
filtering in Exploration Views 107

TM1 data sources
improve performance 295

TM1 Perspectives, See IBM TM1 Perspectives
TM1 Perspectives add-in 161
TM1 reports

Dynamic Reports 125
Quick Reports 119

TM1 server
connection settings for worksheet functions 161
publishing workbooks 94

TM1 Server Application folder
opening workbooks 41

TM1 servers
committing data 153
connecting 38
disabling sandboxes 150
logging on 39
updating URLs 45

TM1 systems
logging on 39

TM1 worksheet functions
configuration settings 161
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TM1 worksheet functions (continued)
DBR 163
DBRA 163
DBRW 164
DBS 164
DBSA 165
DBSS 166
DBSW 166
DFRST 167
DIMIX 167
DIMNM 168
DIMSIZ 168
DNEXT 168
DNLEV 169
DTYPE 169
ELCOMP 170
ELCOMPN 171
ELISCOMP 171
ELISPAR 172
ELLEV 173
ELPAR 174
ELPARN 175
ELSEN 176
ELWEIGHT 177
enabling the add-in 161
modifying 161, 190, 191
modifying DBRW 190
modifying SUBNM 191
overview 160
sandboxes 161
SUBNM 177
SUBSIZ 179
TABDIM 179
TM1ELLIST 180
TM1GLOBALSANDBOX 182
TM1INFO 183
TM1PRIMARYDBNAME 183
TM1RPTELISCONSOLIDATED 183
TM1RPTELLEV 184
TM1RPTELLSEXPANDED 184
TM1RPTFILTER 184
TM1RPTROW 185
TM1RPTTITLE 187
TM1RPTVIEW 187
TM1USER 188
troubleshooting 162
VIEW 189

TM1-Specific MDX expressions 197
TM1-Specific MDX functions 194
TM1DRILLDOWNMEMBER 194
TM1ELLIST 180
TM1FILTERBYLEVEL 194
TM1FILTERBYPATTERN 194
TM1GLOBALSANDBOX 182
TM1INFO 183
TM1Member 194
TM1PRIMARYDBNAME 183
TM1RPTELISCONSOLIDATED 183
TM1RPTELLEV 184
TM1RPTELLSEXPANDED 184
TM1RPTFILTER 184
TM1RPTFMTIDCOL 133, 187
TM1RPTFMTRNG 187
TM1RPTROW 185

TM1RPTTITLE 187
TM1RPTVIEW 187
TM1SORT 195
TM1SORTBYINDEX 195
TM1SUBSETALL 195
TM1SubsetToSet 196
TM1TupleSize 197
TM1USER 188
top or bottom values

viewing in TM1 Exploration Views 109
totals

expand direction 115, 214
totals-based suppression 108, 212
troubleshooting

COGNAME 230
COGVAL 230
Custom Report 230
enabling logging 46
fixes

getting 288
getting fixes 288
identifying problems 287

TurboIntegrator processes
running with action buttons 247, 251
See also processes

U
Uncommitted changes 51, 54, 56
understanding

lists 204
URLs

for Cognos Analytics 38
for Planning Analytics 38
updating for servers 45

users
retrieving the current 188

utilities
update system URLs 45

V
values

committing to TM1 153
editing in TM1 153
filtering 210
sorting 107

VIEW 189
views

converting to formulas 134
creating Exploration Views from views 102
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